
Bell Labs Innovations
Lucent Technologies

MERLIN MAGIX 

Integrated System
Release 1.0i

Installation and Maintenance

Issue 1
June 2000



Copyright and Legal Notices

Notice Every effort has been made to ensure that the information in this guide is complete and accurate at the time of 
printing. Information, however, is subject to change. See Appendix A, “Customer Support Information,” in 
Feature Reference for important information. 

Your Responsibility for 
Your System’s Security

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized party—for example, 
persons other than your company’s employees, agents, subcontractors, or persons working on your company’s 
behalf. Note that there may be a risk of toll fraud associated with your telecommunications system, and, if toll 
fraud occurs, it can result in substantial additional charges for your telecommunications services.

You and your System Manager are responsible for the security of your system, such as programming and 
configuring your equipment to prevent unauthorized use. The System Manager is also responsible for reading 
all installation, instruction, and system administration documents provided with this product in order to fully 
understand the features that can introduce risk of toll fraud and the steps that can be taken to reduce that risk. 
Lucent Technologies does not warrant that this product is immune from or will prevent unauthorized use of 
common-carrier telecommunication services or facilities accessed through or connected to it. Lucent 
Technologies will not be responsible for any charges that result from such unauthorized use. For important 
information regarding your system and toll fraud, see Appendix A, “Customer Support Information,” in System 
Programming.

Federal Communica-
tions Commission 
Statement

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to 
cause harmful interference, in which case the user will be required to correct the interference at their own 
expense. For further FCC information, see Appendix A, “Customer Support Information,” in Feature Reference.

Year 2000 Compliance The MERLIN MAGIX Integrated System is certified to be Year 2000 compliant. Additional information on this 
certification, and other issues regarding Year 2000 compliance, is available online at http://www.lucent.com/
enterprise/sig/yr2000.

Trademarks 5ESS, AUDIX, CONVERSANT, CentreVu, DEFINITY, Magic On Hold, MERLIN, MERLIN LEGEND, MERLIN 
Mail, PARTNER, PassageWay, MLX-10, MLX-20L, MLX-28D, MLS-6, MLS-12, MLS-12D, MLS-18D, MLS-34D, 
SYSTIMAX, TransTalk, and Voice Power are registered trademarks and 4ESS, Intuity, Lucent Technologies, 
MERLIN MAGIX, and ProLogix are trademarks of Lucent Technologies in the U.S. and other countries.

Acculink, ACCUNET, MEGACOM, MulitiQuest, MLX-5, MLX-5D, MLX-16DP, MLX-10D, MLX-10DP, and 
NetPROTECT are registered trademarks of AT&T.

Microsoft, Windows, Windows NT, and MS-DOS are registered trademarks of Microsoft Corporation.

ProComm and ProComm Plus are registered trademarks of DataStorm Technologies, Inc.

Supra, Supra NC, StarSet, and Mirage are registered trademarks of Plantronics, Inc.

UNIX is a registered trademark of UNIX System Laboratories, Inc.

PagePac is a registered trademark and Powermate and Zonemate are trademarks of DRACON, a division of 
Harris Corporation.

Okidata is a registered trademark of Okidata Corporation.

Pipeline is a trademark of Ascend Communications, Inc.

Intel and Pentium are registered trademarks of Intel Corporation.

Apple and Macintosh are registered trademarks of Apple Computer, Inc.

IBM is a registered trademark of International Business Machines, Inc.

Novell and NetWare are registered trademarks of Novell Corporation.

CLASS is a servicemark of Bellcore.
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Support Telephone 
Number

If you need assistance when installing, programming, or using your system contact your support organization or 
your Lucent Technologies authorized dealer. 

Lucent Technologies 
Corporate Security

Whether or not immediate support is required, all toll fraud incidents involving Lucent Technologies products or 
services should be reported. Contact your support organization or your Lucent Technologies authorized dealer 
to report toll fraud incidents or for instructions on obtaining consultation on security issues, investigation 
support, referral to law enforcement agencies, and educational programs.

Lucent Technologies 
Fraud Intervention

If you suspect you are being victimized by toll fraud and you need technical support or assistance, contact your 
support organization or your Lucent Technologies authorized dealer.

Warranty Lucent Technologies provides a limited warranty on this product. Refer to “Limited Warranty and Limitation of 
Liability” in Appendix A, “Customer Support Information,” of Feature Reference.



Safety

IMPORTANT SAFETY INSTRUCTIONS

The exclamation point in an equilateral triangle is intended to alert the user to 
the presence of important operating and maintenance (servicing) instructions in 
the literature accompanying the product.

To reduce the risk of fire, electrical shock, and injury to persons, follow these basic safety precautions 
when installing telephone equipment:

■ Read and understand all instructions.

■ Follow all warnings and instructions marked on or packed with the product.

■ Never install telephone wiring during a lightning storm.

■ Never install a telephone jack in a wet location unless the jack is specifically designed for wet 
locations.

■ Never touch uninsulated telephone wires or terminals unless the telephone wiring has been 
disconnected at the network interface.

■ Use caution when installing or modifying telephone lines.

■ Use only Lucent Technologies-manufactured MERLIN MAGIX™ Integrated System circuit 
modules, carrier assemblies, and power units in the MERLIN MAGIX Integrated System control 
unit.

■ Use only Lucent Technologies-recommended/approved MERLIN MAGIX Integrated System 
accessories.

■ If equipment connected to the 024 TDL telephone modules, the 008 and 016 MLX telephone 
modules, or the 016 ETR telephone module is to be used for in-range out-of-building (IROB) 
applications, IROB protectors are required.

■ Do not install this product near water—for example, in a wet basement location.

■ Do not overload wall outlets, as this can result in the risk of fire or electrical shock.

■ The MERLIN MAGIX Integrated System is equipped with a 3-wire grounding-type plug with a 
third (grounding) pin. This plug will fit only into a grounding-type power outlet. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact an electrician to replace the 
obsolete outlet. Do not defeat the safety purpose of the grounding plug.

■ The MERLIN MAGIX Integrated System requires a supplementary ground.

■ Do not attach the power supply cord to building surfaces. Do not allow anything to rest on the 
power cord. Do not locate this product where the cord will be abused by persons walking on it.

■ Slots and openings in the module housings are provided for ventilation. To protect this equipment 
from overheating, do not block these openings.

■ Never push objects of any kind into this product through module openings or expansion slots, as 
they may touch dangerous voltage points or short out parts, which could result in a risk of fire or 
electrical shock. Never spill liquid of any kind on this product.
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■ Unplug the product from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not 
use cleaners or aerosol cleaners.

■ Auxiliary equipment includes answering machines, alerts, modems, and fax machines. To 
connect one of these devices, you must first have a Multi-Function Module (MFM).

■ Do not operate telephones if chemical gas leakage is suspected in the area. Use telephones 
located in some other safe area to report the trouble.

■ To eliminate the risk of personal injury due to electrical shock, DO NOT attempt to install or 
remove an MFM from your MLX telephone. Opening or removing the module cover of your 
telephone may expose you to dangerous voltages.

■ ONLY an authorized technician or dealer representative shall install, set options, or repair an 
MFM.

SAVE THESE INSTRUCTIONS

WARNING:
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Customer Support Information 0

Contact Information 0

If you need assistance installing, programming, or using your system, contact your support 
organization or your Lucent Technologies authorized dealer.

Federal Communications Commission (FCC)
Electromagnetic Interference Information 0

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference, in which case the user will be required to correct the interference at his own expense.

Security 0

As a customer of new telecommunications equipment, you should be aware of the significant and 
growing problem of theft of long distance services by third parties, known commonly as “toll fraud.” 
It is particularly important that you understand and take appropriate steps to deal with this crime 
because under applicable tariffs, you will be responsible for payment of associated toll charges. 
Lucent Technologies can not be responsible for such charges and will not make any allowance or 
give any credit resulting from toll fraud.

Toll fraud can occur despite the preventive efforts of network providers and equipment 
manufacturers. Toll fraud is a potential risk for every customer with telecommunications equipment 
having one or more of the following features: (1) remote access, (2) automated attendant, (3) voice 
mail, (4) remote administration and maintenance, and (5) call forwarding (remote). This is not a 
product or design defect, but a risk associated with equipment having one or more of the features 
described above. If your new telecommunications equipment possesses any of these features, 
please consult the relative portion of your documentation for further details and specific 
procedures to reduce the risk of toll fraud or contact your Lucent Technologies representative for 
further details. The Remote Access feature must be properly administered to help reduce the risk 
of unauthorized use. It is your responsibility to take the appropriate steps to implement the feature 
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properly, evaluate and administer the various restriction levels, and protect and carefully distribute 
access codes.

To reduce the risk of unauthorized access to your MERLIN MAGIX Integrated System, you should 
observe the following procedures:

■ Use a nonpublished Remote Access telephone number.

■ Assign passwords, barrier or access codes randomly to users on a need-to-know basis, 
keeping a log of ALL authorized users and assigning one code to one person.

■ Ensure that Remote Access users are aware of their responsibility to keep the telephone 
number and any access codes secure.

■ Use random sequence access codes. These are less easily broken.

■ Deactivate all unassigned access codes promptly.

■ When possible, restrict the off-network capability of callers via use of Call Restrictions and 
Disallowed Lists.

■ When possible, block off-hours calling.

■ Frequently monitor system call detail reports for quicker detection of any unauthorized or 
abnormal calling patterns.

Physical Security, Social Engineering, and 
General Security Measures 0

Criminals called hackers may attempt to gain unauthorized access to your communications system 
and voice messaging system in order to use the system features. Hackers often attempt to trick 
employees into providing them with access to a network facility (line/trunk) or a network operator. 
This is referred to as social engineering. Hackers may pose as telephone company employees and 
employees of Lucent Technologies or your authorized dealer. Hackers will go through a company’s 
trash to find directories, dialing instructions, and other information that will enable them to break 
into the system. The more knowledgeable they appear to be about the employee names, 
departments, telephone numbers, and the internal procedures of your company, the more likely it 
is that they will be able to trick an employee into helping them.

Preventive Measures. Take the following preventive measures to limit the risk of unauthorized 
access by hackers:

■ Provide good physical security for the room containing the communications equipment and the 
room with administrative tools, records, and system manager information. These areas should 
be locked when not attended.

■ Provide a secure trash disposal for all sensitive information, including telephone directories, 
call accounting records, or anything that may supply information about your communications 
system. This trash should be shredded.

■ Educate employees that hackers may try to trick them into providing them with dial tone or 
dialing a number for them. All reports of trouble, requests for moving extensions, or any other 
administrative details associated with the MERLIN MAGIX Integrated System should be 
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handled by one person (the system manager) or within a specified department. Anyone 
claiming to be a telephone company representative should be referred to this person or 
department.

■ No one outside of Lucent Technologies needs to use the MERLIN MAGIX Integrated System 
to test facilities (lines/trunks). If a caller identifies themselves as a Lucent Technologies 
employee, the system manager should ask for a telephone number where the caller can be 
reached. The system manager should be able to recognize the number as a Lucent 
Technologies telephone number. Before connecting the caller to the administrative port of the 
MERLIN MAGIX Integrated System, the system manager should feel comfortable that a good 
reason to do so exists. In any event, it is not advisable to give anyone access to network 
facilities or operators, or to dial a number at the request of the caller.

Limited Warranty and Limitation of Liability 0

Limited Warranty 0

LUCENT TECHNOLOGIES AND ITS AFFILIATES MAKE NO WARRANTIES, EXPRESS OR 
IMPLIED, ABOUT OR RELATING TO YOUR MERLIN MAGIX INTEGRATED SYSTEM AND 
SPECIFICALLY DISCLAIM ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

You should check with the reseller from whom you purchased your system to determine if it offers 
a limited warranty.
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Limitation of Liability 0

EXCEPT FOR PERSONAL INJURY, DIRECT DAMAGES TO TANGIBLE PERSONAL 
PROPERTY PROXIMATELY CAUSED BY LUCENT TECHNOLOGIES, AND LIABILITY 
OTHERWISE EXPRESSLY ASSUMED IN A WRITTEN AGREEMENT SIGNED BY AN 
AUTHORIZED REPRESENTATIVE OF AT&T, THE LIABILITY OF LUCENT TECHNOLOGIES, ITS 
AFFILIATES, SUPPLIERS AND AUTHORIZED RESELLERS FOR ANY CLAIMS, LOSSES, 
DAMAGES OR EXPENSES FROM ANY CAUSE WHATSOEVER (INCLUDING ACTS OR 
OMISSIONS OF THIRD PARTIES) REGARDLESS OF THE FORM OF ACTION, WHETHER IN 
CONTRACT, TORT OR OTHERWISE, SHALL NOT EXCEED AN AMOUNT EQUAL TO THE 
LESSER OF THE DIRECT DAMAGES PROVEN OR THE PURCHASE PRICE OF THE SYSTEM. 
IN NO EVENT SHALL LUCENT TECHNOLOGIES OR ITS AFFILIATES, SUPPLIERS OR 
AUTHORIZED RESELLERS BE LIABLE FOR INCIDENTAL, RELIANCE, CONSEQUENTIAL, OR 
ANY OTHER INDIRECT LOSS OR DAMAGE (INCLUDING, BUT NOT LIMITED TO, LOST 
PROFITS OR REVENUES AND LOSSES ARISING OUT OF UNAUTHORIZED USE (OR 
CHARGES FOR SUCH USE) OF COMMON CARRIER TELECOMMUNICATIONS SERVICES 
OR FACILITIES ACCESSED THROUGH OR CONNECTED TO THE MERLIN MAGIX 
INTEGRATED SYSTEM) INCURRED IN CONNECTION WITH YOUR SYSTEM. THIS 
LIMITATION OF LIABILITY SHALL SURVIVE FAILURE OF AN EXCLUSIVE REMEDY.
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About This Book 0

This book provides technical information about the MERLIN MAGIX™ Integrated System. It is 
intended for persons who install and maintain the system.

Ordering Information 0

If you wish to order copies of manuals, replacement parts, accessories, or other equipment that is 
compatible with the system, contact your Lucent Technologies representative.

Product Safety Labels 0

Throughout this book, hazardous situations are indicated by an exclamation point inside a triangle, 
along with the word “caution” or “warning.”

WARNING:

Warning indicates the presence of a hazard that could cause death or severe 
personal injury if the hazard is not avoided.

CAUTION:

Caution indicates the presence of a hazard that will or can cause minor personal 
injury, property damage, or loss of data if the hazard is not avoided.
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1Introduction 1

The MERLIN MAGIX system has been developed for the medium-size business market. 
Electronically, it is very similar to a MERLIN LEGEND Communications System. However, new 
modules and new telephones have been developed to work with the MERLIN MAGIX system. 

Modes of Operation 1

The system is designed for customers in the 10- to 200-station range. It can be configured to 
operate in one of two modes:

■ Hybrid/PBX

■ Key

Hybrid/PBX Mode 1

The Hybrid/PBX mode handles a large volume of calls and users and provides the most flexibility 
of the two modes. Outside facilities consist of loop-start trunks, direct inward dialing (DID) trunks, 
direct inward/outward dialing (DIOD) trunks, tie trunks, and E1 facilities. The trunks can either be 
grouped in pools for shared use, or can be assigned to line buttons on multiline telephones for 
users who need a Personal Line.

Users access inside lines and outside trunks via system access buttons. To make an outside call, 
the user enters a dial-out code (usually a 9), and the system automatically selects an available 
trunk. The Automatic Route Selection feature determines which trunk should be used for each type 
of outgoing call. Incoming calls can be handled by a direct-line console (DLC) or a queued call 
console (QCC), or by a combination of both console types.

Behind Switch mode is not supported in MERLIN MAGIX R1.0i.
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Key Mode 1

In the Key mode, each outside line appears on a button on one or more multiline telephones. The 
line buttons allow users to see activity on other telephones, join conversations, place calls, or 
receive calls. Separate intercom buttons are used to make and receive internal calls.

A Key system automatically assigns the first eight outside lines to all telephones. This arrangement 
can be customized through system programming by assigning lines to individual telephones or to 
selected groups of telephones.

System Components 1

The system consists of required and optional components:

■ Required components

— Control unit

— Telephones

■ Optional components

— Auxiliary equipment

— Adapters

— Applications

These components are described in the following pages.

The Control Unit 1

The control unit of the MERLIN MAGIX system consists of a basic carrier and, optionally, one or 
two expansion carriers. The carriers contain the power supplies, processor module, and line/trunk 
modules that comprise the system. The control unit is housed in a carrier for protection.

The Carriers 1

The basic and expansion carriers for the MERLIN MAGIX system are made of metal. Like the 
MERLIN LEGEND Communications System, the MERLIN MAGIX system can contain up to 17 
line/trunk modules. The basic carrier contains a power supply and a processor module and five 
slots for line/trunk modules. Each expansion carrier contains a power supply and six slots for line/
trunk modules. A maximum of two expansion carriers can be connected to a basic carrier.
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Power Supply Module 1

CAUTION:
Grounding circuit continuity is vital for safe operation of the MERLIN MAGIX system. Never 
operate with the grounding conductor disconnected. The ground-screw connection is located 
on the carrier.

The 491D1 (100–240 V AC) power supply modules can provide up to 96 unit loads of current per 
carrier; therefore, an auxiliary power unit is not required with these modules. In addition, three test 
points are provided for measuring DC voltage outputs.

Power Specifications 1

Each 491D1 power supply draws a maximum current of 5.4 amperes at 117 V AC (60 Hz); the 
491D1 power supply draws a maximum current of 3.1 amperes at 220 V AC (50 Hz). Output power 
is:

+5.1 V DC (10A), –5.1 V DC (1.5A), –48 V DC (3.0A)

Test Points 1

There are three voltage test points, one each for the +5.1 V DC, –5.1 V DC, and –48 V DC outputs. 
These test points enable service personnel to measure the +5.1 (± 5%), –5.1 (± 5%) and –48 V 
DC (± 10%) outputs delivered to the MERLIN MAGIX backplane. Use the ground terminal when 
measuring the output voltages at these test points.

Station Module Specifications 1

491D1 Power Supply Module:

■ Power Input: 100–240 V AC, 5A, 50/60 Hz 

■ Power Output: +5.1 V DC ±5% (10A), –5.1 V DC ±5% (1.5A), –48 V DC ±10% (3.0A)

■ Capacity: 96 unit loads

Outside the North American continent, the power cord plug on the 491D1 power supply 
module may need to be replaced with an IEC (International Electrotechnical 
Commission) approved plug (at least 10 amps and 250 volts).
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Processor Module 1

Placed in slot 00 of the basic carrier, the processor module controls system features and 
programming via the processor and memory boards. The processor module supports up to 80 CO 
or tie lines/trunks and 200 stations.

The main board contains the 68EC020 processor at 16 MHZ, a built-in 1200/2400 bps modem, 
built-in diagnostics, 1.5 MB RAM backup for 4 days, a real-time clock, interrupt circuitry, a PCMCIA 
interface, and interfaces to the other modules through the I/O bus on the carrier backplane.

The processor module has three modular RS-232 jacks: one for debugging (plugged to prevent 
access), one for Station Message Detail Recording (SMDR), and the other for system 
programming and maintenance via a PC.

Line/Trunk and Extension Modules 1

The system supports different types of modules that vary in the types of lines/trunks that they 
support and the types of telephones or other equipment that can be connected to them. Table 1-1 
describes the line/trunk extension modules in detail.

The names of the modules identify their capacities and capabilities. The first digit tells you the 
number of line/trunk jacks a module supports, while the last two digits describe the number of 
extension jacks it supports. Letters can follow to indicate the type of trunk it supports—for 
example, LS for loop-start or OPT for off-premise telephone; if the number indicates line/trunk 
support and no letters follow, the module supports trunks.

For example, the 024 TDL module has no line/trunk jacks but does have 24 extension jacks.

The two modes of operation support different lines/trunks, as follows:

■ Key mode

— Loop-start lines

— Tie trunks

— E1 facility programmed for tie or loop-start operation

■ Hybrid/PBX mode

— Loop-start trunks

— Tie trunks

— Direct inward dialing (DID) trunks

— E1 facility programmed for tie, loop-start, DID, or direct inward/outward dialing (DIOD)
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Table 1-1. Line/Trunk and Extension Modules

Module Line/Trunk Description

008 MLX1 none Capacity: 8 digital extension jacks; each extension jack is assigned 
two extension numbers. The second extension number is used for the 
device connected to the Multi-Function Module (MFM) installed in the 
MLX telephone.

Supports: MLX extensions, including:

■ MLX voice only
■ MLX voice with Voice Announce to Busy
■ MLX voice and MFM with T/R adjunct
■ MLX voice and MFM with Supplemental Station Adapter (SSA)
■ ISDN terminal adapter only
■ Access device for data communications between a PC on the 

system and a high-speed Internet connection, connection to 
remote node LAN access server, or ISDN router

008 OPT2 none Capacity: 8 T/R extensions on 2-way voice transmission path with 
support for telephones with message-waiting lights, 2 TTRs 

Supports: On-premises or off-premises single-line telephones

016 (T/R)1 none Capacity: 16 T/R extensions on 2-way voice transmission path with 
support for telephones with message-waiting lights, 4 TTRs

Supports: Single-line telephones, Intuity AUDIX®, Octel 100, T/R 
adjuncts (such as answering or fax machine), and analog data devices 
(such as modems)

016 ETR1 none, TTR Capacity: 16 ETR extension jacks including 4 TTRs

Supports: ETR, Business Cordless 905, and TransTalk 9031 MDW 
telephones

016 MLX1 none Capacity: 16 digital extension jacks; each extension jack is assigned 
two extension numbers. The second extension number is used for the 
device connected to the MFM installed in the MLX telephone.

Supports: MLX extensions, including:

■ MLX voice only
■ MLX voice with Voice Announce to Busy
■ MLX voice and MFM with T/R adjunct
■ MLX voice and MFM with SSA
■ ISDN terminal adapter only
■ Access device for data communications between a PC on the 

system and a high-speed Internet connection, connection to 
remote node LAN access server, or ISDN router

■ CTI link
■ Videoconferencing systems using 1 jack and 2B data feature or 2 

jacks with ISDN terminal adapters (depending on video system)
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024 TDL Module 1

The 024 TDL module contains 24 extension ports for connection to the 4400-Series telephones. 
The module has potential operator positions at the first, fifth, thirteenth, and seventeenth ports. If 
the 024 TDL module is in Slot 1, you can connect a 4424LD+ Telephone to the first extension port 
and use that telephone as the system programming console.

024 TDL none Capacity: 24 digital extension jacks; each extension jack is assigned 2 
extension numbers. The second extension number can be used as a 
“phantom” extension (for example, for voice mail configurations)

Supports: 4400, 4400D, 4406D+, 4412D+, 4424D+, and 4424LD+ 
Telephones 

100E1 E1 Capacity: 30 lines/trunks for voice and analog data with 2 channels 
used for signaling

Supports: E1 emulates 30 lines/trunks: loop-start, tie, Direct Inward 
Dial (DID; Hybrid/PBX mode only), and Direct Inward/Outward Dial 
(DIOD; Hybrid/PBX mode only). E1 supports transmission speeds up 
to 64 kbps per trunk. Signaling is DTMF or R2/CaS with the optional 
MFC06 module. Termination impedance is either 75 ohm or 120 ohm.

800 DID DID, TTR Capacity: 8 lines/trunks, 2 TTRs; there are two different models of the 
800 DID module: one for Argentina and Mexico, and one for Brazil

800 LS/CPTD LS Capacity: 8 lines/trunks, 2 dialtone detectors, 2 PFT telephone jacks; 
there are two different models of the 800 DID module: one for 
Argentina and Mexico, and one for Brazil

MERLIN 
Messaging3 

none Capacity: 7 internal, system-defined T/R jacks; 2 TTRs; internal 
remote maintenance device; serial port for PC connection

Supports: MERLIN Messaging System resides on this module

MFC06 none Capacity: 6 MFC dialers, each with a generator and a detector

Supports: Multifrequency Compelled (MFC) Register Signaling (R2)
1 For newer vintages of this module, firmware can be upgraded by using a PCMCIA card.

2 The system software recognizes the OPT module as having 12 jacks. Even though the OPT module has only 8 jacks, it 
uses 12 ports of capacity, thereby decreasing overall extension capacity by 4 extensions for every OPT module.

3 The system assigns 12 logical IDs and extensions to the MERLIN Messaging module. The first 6 are available for use as 
MERLIN Messaging ports and the 12th is used by the Remote Maintenance Device (RMD). The 7th –11th are not used and 
are not available for other tip/ring devices or applications.

The slot/port numbering for adjunct ports on a 024-TDL module begins at 25. For 
example, on a 024-TDL module in slot 1 of the carrier, to access adjunct port 710, you 
would enter 0125 as the slot/port number (01 indicates slot 1 on the carrier).

Table 1-1. Line/Trunk and Extension Modules— Continued

Module Line/Trunk Description
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Telephones 1

The MERLIN MAGIX Release 1.0i system supports the following telephones:

■ 4400-Series

■ MLX

■ ETR

■ Single-line

■ Transtalk® MDW 9031

For more information about the 4400-Series telephones, see the 4406D+, 4412D+, 4424D+, and 
4424LD+ Telephones User’s Guide; and the 4400 and 4400D Telephones User’s Guide.

System Operator Consoles 1

System operator consoles are telephones that are programmed for call handling and other 
operator duties. An operator console can be configured as a Direct-Line Console (DC) or a 
Queued Call Console (QCC).

DLCs 1

In a DLC configuration, lines/trunks are assigned to individual buttons, and the console can have 
several calls ringing at the same time. The following telephones can function as DLCs and must be 
connected to digital extension jacks on a 008 MLX, 016 MLX, or 024 TDL module:

■ 4424LD+ Telephone

■ 4424D+ Telephone

■ MLX-20L telephone

■ MLX-28D telephone

The MERLIN MAGIX Release 1.0i system does not support analog multiline telephones.

One or two Direct Station Selectors (DSSs) can be added to each 4400-Series or MLX 
DLC to provide 50 or 100 additional extension buttons.
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QCCs 1

In a QCC configuration, only one call rings at a time. Additional incoming calls are held in queue, 
and each call in turn is directed to a QCC as it becomes available. The system must be operating 
in Hybrid/PBX mode if QCCs are needed.

The QCC system operator console must be connected to the first jack on the first 024 TDL, 008 
MLX, or 016 MLX module. Additional QCCs can be connected, and they must be connected to one 
of these modules as well. See the System Programming guide for specifications.

PCMCIA Translation Card 1

The 2MB translation card (10A2) is used to maintain “Back-Up” System translations for the 
MERLIN MAGIX system. The procedures for using a 2MB translation card are the same as those 
for the 4MB card used with the MERLIN LEGEND Communications System.

Touch-Tone Receivers 1

See “Touch-Tone Receivers” in the MERLIN MAGIX Release 1.0 Feature Reference.

Auxiliary Equipment 1

The following table provides a list of other equipment that is available for use with the system. If 
you are interested in adding any of this equipment, contact your Lucent Technologies 
representative or authorized dealer.

In a Hybrid/PBX system, only the 4424LD+ and MLX-20L telephones can be QCCs.

Table 1-2. Auxiliary Equipment

Equipment Type Description

Alerts (AC) Any audible or visual alert—such as an external ringer—that operates on 
20–30 Hz ringing signals. These alerts are associated with a specific 
extension (MFM in T/R mode or connected to T/R extension jack). 

Alerts (DC) Any audible or visual alert—such as a bell, chime, or strobe—that operates 
on 48 V DC ringing signals. These alerts are associated with a specific 
extension (MFM in SSA mode) or work on a programmed trunk port 
(external alert).

Answer/record 
machine 

An industry-standard answering machine or remote answering system 
telephone with the ability to recognize 600-ms disconnect signal or other 
means of automatic disconnect.
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Cordless telephone Must have Touch-Tone dialing capability when connected via a Multi-
Function Module (MFM); rotary or Touch-Tone dialing can be used on a T/R 
port.

Credit card 
verification terminal 

Must have Touch-Tone dialing capability when connected via an MFM; 
rotary or Touch-Tone dialing can be used on a T/R port.

Dial dictation A device that requires contact closure can be used on an LS/GS line jack 
only with PagePAC®.

Direct Station 
Selector (DSS) 

Connects to telephones to enhance call handling capabilities of operator and 
programming consoles. A maximum of 2 DSSs can be connected to an 
operator console. 

The DSS 4450—which is nearly identical to the DSS that works with the 
MLX telephones—is used with the 4424D+ and 4424LD+ Telephones. An 
auxiliary power supply is required, and is ordered separately, when one or 
more DSSs is connected to a 4424D+ Telephone. The 4424LD+ Telephone 
requires an auxiliary power supply whether or not a DSS is connected; the 
auxiliary power supply automatically comes with the 4424LD+ Telephone.

If 2 DSSs are connected to an MLX-20L or MLX-28D telephone, an auxiliary 
power supply is also required.

Fax machine Must have Touch-Tone dialing capability when connected via an MFM; 
rotary or Touch-Tone dialing can be used on a T/R port. Rotary must be 
enabled if rotary dialing is used.

Group Calling delay 
announcement 

An industry-standard device which must provide automatic disconnect. Each 
of the 32 Calling Groups can have its own announcement (up to 10 primary 
and 1 secondary for each Calling Group). A device can provide delay 
announcement for more than one group.

Headset for Multiline 
4400-Series, MLX, 
MLS, and ETR 
telephones 

Connects to multiline 4400-Series, MLX, MLS, and ETR telephones via a 
modular base unit for hands-free telephone operation.

Loudspeaker Paging External paging system using dual-tone multi-frequency (DTMF) signaling 
connected to an LS or GS line jack. CPE paging systems require an 
interface unit; if CPE has 2-wire input, the PagePal interface can be used.

Message Waiting 
indicator unit 

Connects directly to single-line telephones.

Modem If the modem supports Touch-Tone dialing via the associated data terminal, 
the keyboard can be used for dialing. If the modem does not support Touch-
Tone dialing, a single-line telephone can be used for dialing.

Music-On-Hold Any FCC-registered 8-ohm music source or recorded announcement 
device. If you use equipment that re-broadcasts music or other copyrighted 
materials, you may be required to obtain a copyright license from and pay 
license fees to a third party such as the American Society of Composers, 
Artists, and Producers (ASCAP) or Broadcast Music Incorporated (BMI). Or 
you can purchase a Magic On Hold system, which does not require such a 
license, from Lucent Technologies or an authorized dealer.

Table 1-2. Auxiliary Equipment— Continued

Equipment Type Description



Installation and Maintenance

System Capacities

1-10

System Capacities 1

Table 1-3 lists the hardware and software capacities of the system. Some constraining factors 
appear with a checkmark (✔). These are discussed in detail in Table 1-4.

SMDR printer Connects to upper RS-232-C jack on the processor module. Must be located 
within 50 feet of the control unit, or an ADU and peripheral interface unit can 
be used to extend distance.

Speakerphone Connects directly to single-line telephones.

Table 1-3. System Capacities

Item Limit Constraining Factor

100E Module (maximum 2 per carrier) 3 ✔ 

800 NI-BRI Module (maximum 3 per carrier) 5

MFC06 Module (maximum 4 per carrier) 6 ✔

Account Codes 

Characters per code 16

Allowed/Disallowed Lists 

Number of lists

Entries per lists

Digits per entry

8

10

7

Authorization Codes 

Digits per code

400

11

Automatic Route Selection (ARS) 

Number of ARS tables

Subpatterns per table

Routes per subpattern

Entries per table

Entries across all tables

Default tables

16

2

6

100

1600

4

Callback Calls in Queue 64

Table 1-2. Auxiliary Equipment— Continued

Equipment Type Description
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Calling Groups 

Number of groups

Members per group

Local extensions only

Non-local extensions only

Total agents and supervisors

Total supervisors

Groups per member

Primary delay announcements per system

Secondary delay announcements per system

Primary delay announcements per group

Secondary delay announcements per group

Groups per delay announcement

External alerts per group

Coverage groups per group

Priority Queuing

Support group
Home group

32

20

1

200

8

1

200

32

10

1

32

1

1

31 home 
1 support 

✔ 

✔ 

✔ 

Carriers 

Line/trunk and extension module slots per basic carrier

Line/trunk and extension module slots per expansion carrier

Maximum slots available for line/trunk and extension modules

3

5

6

17

✔ 

Coverage Groups 

Number of groups

Senders per group

Groups per sender

Receiver buttons per group

Groups per QCC receiver

30

400

1

8

30

✔ 

Direct Inward Dialing; Direct Inward/Outward Dialing 

Number of blocks

Number of trunks

2

80

Table 1-3. System Capacities— Continued

Item Limit Constraining Factor
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Directories 

System Directory
Listings

Extension Directory
Listings

Personal Directory 
(4424LD+ and MLX-20L telephones only) Listings

1
130

1
200

48
50

Endpoints (devices) 400

Extensions 

Total physical jacks

Total endpoints

200

400

Fax machines with Message Waiting 16 ✔ 

Lines/Trunks 80

Message Waiting Lamp Messages 1499

Night Service 

Groups

Members per group 

Calling Groups per group

Groups per member

Emergency Allowed List entries

8

400

1

8

10

Park codes (number of codes) 8

Personal Lines 64

Pool Buttons 64

Ports (not simultaneously) 

Voice Announce to Busy extensions

Voice Messaging Interface (VMI)

ISDN Terminal Adapter

Paging

Primary delay announcements

Secondary delay announcements

200

24

200

3

200

32

✔ 

✔ 

✔ 

Remote Access 

Number of barrier codes

Digits per code, system-wide

16

4–11

Table 1-3. System Capacities— Continued

Item Limit Constraining Factor
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Service Observing Groups 

Number of groups

Observers per group

Members per group

16

1

400

✔ 

✔ 

Shared System Access Buttons 

Number of buttons per principal extension 27

Speed Dial 

Personal Speed Dial

Entries per telephone
Entries per system
Digits per entry

System Speed Dial

Entries per system
Digits per entry

24
1200
28

130
40

✔ 

System Operator Consoles 

Direct-line consoles (DLCs)

4424D+ or 4424LD+
MLX-20L or MLX-28D

Queued Call Consoles (QCCs)

4424LD+ or MLX-20L

Combination of DLCs plus QCCs

DSSs

Number of consoles per module

008 MLX

016 MLX or 024 TDL

8
8

4

8

16

2

4

✔ 

✔ 

System Programming Equipment 

4424LD+ or MLX-20L telephone

RS-232 jack for PC with WinSPM

Modem (built-in processor module)

1

1

1

✔ 

Table 1-3. System Capacities— Continued

Item Limit Constraining Factor
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Telephones (not simultaneously) 

4424LD+ or MLX-20L

All other MLX telephones
(with/without ISDN terminal adapter/MFM) 

All other 4400-Series telephones

Single-line

ETR

Power failure transfer

48

200

200

200

200

20

✔ 

✔ 

✔ 

✔ 

✔ 

Two-Party Conversations 108

Voice Messaging Systems 24

Table 1-4. Constraining Factors

Item Constraints

100E Modules The system can contain up to three 100E modules. Up to two 100E modules 
may be in a carrier with other modules. If an MFC06 module is in the same 
carrier, only one 100E module can be in the carrier.

Calling Groups Members of Groups. QCCs cannot be members of Calling Groups because 
the QCC position is set up as a system operator and has its own queue that 
is different from the group’s queue.

Members per Group. The maximum number of local extensions in a Calling 
Group is 20. The maximum number of non-local extensions in a Calling 
Group is 1. A Calling Group cannot contain both local and non-local 
extensions.

Primary and Secondary Delay Announcements. Up to 10 primary and 1 
secondary announcement device can be designated for each Calling Group. 
Each announcement device decreases the 200 tip/ring station capacity.

Carriers The first slot of the basic carrier is used for the processor module with a 
maximum of 5 port/board slots.

Coverage Groups Senders per Group. QCCs cannot be senders because they do not have 
coverage available and use Position-Busy instead.

Fax Machines with 
Message-Waiting 

The system can support more than 16 fax machines, but those in excess of 
16 cannot use fax message waiting indication.

MFC06 Modules The system can contain a maximum of 6 MFC06 modules. Up to 4 can be 
contained in a dedicated carrier, but only 2 can be in a carrier with other 
modules. If a 100E module resides in the carrier, only one MFC06 module 
can be in that carrier.

Table 1-3. System Capacities— Continued

Item Limit Constraining Factor
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Ports (not 
simultaneously) 

Voice Messaging Interface. Although the system software supports up to 
24 VMI ports, all VMI ports must be in the same Calling Group, and the 
maximum number of extensions in a Calling Group is 20.

Primary and Secondary Delay Announcements. Up to 10 primary and 1 
secondary announcement devices can be designated for each Calling 
Group. Each announcement device decreases the 200 tip/ring station 
capacity.

Service Observing 
Groups 

A Service Observer station must be a 4406D+, 4412D+, 4424D+, 4424LD+, 
or MLX telephone (except QCC). A Service Observing group member station 
may be any telephone except a QCC link. Maximum number of members per 
Service Observing group is equal to the maximum number of extensions in 
the system.

Service Observing may be subject to federal, state, or local laws, rules, or 
regulations or require the consent of one or both of the call parties. You must 
check in your jurisdiction and comply with all applicable laws, rules, and 
regulations before using this feature. Failure to comply may result in severe 
penalties.

Speed Dial Personal Speed Dial. Single-line and 5- or 10-button telephones.

System Operator 
Consoles

DLCs. Two consoles are allowed for each 008 MLX module. Up to 4 
consoles may be connected to an 016 MLX or an 024 TDL module. A 
maximum of 8 consoles is allowed per system. Up to two DSSs can be 
attached to an operator console.

QCCs. In Hybrid/PBX mode only. Two consoles are allowed for each 008 
MLX. Four consoles are allowed for each 016 MLX or 024 TDL module. Up 
to 4 consoles are permitted on a system.

System 
Programming 
Equipment 

Remote Access overrides onsite programming except during backup or 
restore.

Telephones (not 
simultaneously) 

4424LD+ and MLX-20L. RAM limit and the total includes the 4424LD+ or 
MLX-20L telephone used for system programming.

All other 4400-Series and MLX Telephones. RAM limit. An MFM and an 
ISDN terminal adapter cannot be connected to the same MLX telephone 
(including the MLX-20L) at the same time.

Single-Line. Software dial plan limit.

Power Failure Transfer. One for each 4 LS/GS line/trunk jacks.

MLS/ETR. RAM limit.

Distance limitations. All telephones within 1000 feet of the control unit, 
except 4400-Series and MLX telephones. 4400-Series telephones with 26-
gauge wire must be within 2000 feet; with 24-gauge wire within 3000 feet. 
MLX telephones must be within 3000 feet. Add IROBs if needed.

Table 1-4. Constraining Factors— Continued

Item Constraints
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2Installing the Control Unit 2

If you have not read Chapter 1, “Introduction,” do so before continuing with this chapter.

Overview 2

Installing the control unit involves the following procedures:

■ Preparation requirements

■ Installing the backboard

■ Meeting the power and grounding requirements

■ Checking the total unit load

■ Installing the carrier

■ Installing any expansion carriers

■ Installing the power supply

■ Installing the processor

■ Installing the line/trunk and extension modules

■ Connecting the control unit to AC power

■ Powering up the system

■ Powering down the system

The following sections provide detailed instructions for these installation procedures. Follow the 
procedures in the order in which they are presented. 
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Environment 2

The control unit must be installed on a backboard. The placement of the backboard, and the 
control unit on it, requires careful consideration. Make sure you install the backboard in an area 
that meets all of the environmental requirements listed in Table 2-1.

WARNING:

Do not install the control unit outdoors.

Electrical Noise/Radio-Frequency Interference 2

In most cases, electrical noise is introduced into the system through trunk or telephone cables. 
However, electromagnetic fields near the control unit can also cause noise in the system. 
Therefore, you should not place the control unit and cable runs in areas where a high 
electromagnetic field strength exists.

Radio transmitters (AM and FM), television stations, induction heaters, motors (with commutators) 
of 0.25 horsepower (200 watts) or greater, and similar equipment are leading causes of radio-
frequency interference (RFI). Small tools with universal motors are generally not a problem when 
they operate on separate power lines. Motors without commutators generally do not cause 
interference.

Field strengths below 1.0 volt per meter are unlikely to cause interference. To estimate the field 
strength produced by radio transmitters, divide (÷) the square root (√) of the emitted power, in 

Table 2-1. Environmental Requirements

Parameter Value

Operating
Temperatures

40ο–104οF (4ο–40οC)
Optimal temperature: 60οF (15.6οC)

Humidity 20%–80%

Airborne
Contamination

Do not expose the control unit to moisture, corrosive gases, dust, chemicals, 
spray paint, or similar material.

Ventilation Allow at least 1 inch (2.54 cm) on the right and left sides of the control unit and 
at least 12 inches (30.48 cm) above and below it to prevent overheating.

Do not place the control unit near extreme heat sources (for example: furnaces, 
heaters, attics, or direct sunlight).

Electrical Fields Do not expose the control unit to devices that generate electrical currents 
causing interference (such as arc welders or motors).

Heat Dissipation Basic carrier: 500 BTU/hr

Basic carrier: with one expansion carrier, 1000 BTU/hr

Basic carrier: with two expansion carriers, 1500 BTU/hr
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kilowatts, by the distance from the antenna, in kilometers, which equals (=) the field strength in 
volts per meter.

Example:  √49 kw = 7 kw ÷ 10 km (6.2 miles) = 0.7 volts per meter

This yields the approximate field strength in volts per meter and is relatively accurate for distances 
greater than about half a wavelength (492 feet, or 150 m, for a frequency of 1000 Hz). If the result 
exceeds 1.0 volt per meter, you may have to install shielded cables and/or Z200A filters. See 
Appendix A, “Customer Support Information,” in Maintenance and Troubleshooting, for FCC Part 
15 radio frequency regulations.

Control Unit Dimensions and Location 2

The following are the dimensions and location requirements for the control unit:

■ Dimensions

— Basic carrier: 11 inches wide by 20 inches high by 11 inches deep

— Basic carrier and one expansion carrier: 22 inches wide by 20 inches high by 11 inches 
deep

— Basic carrier and two expansion carriers: 33 inches wide by 20 inches high by 11 inches 
deep

■ Location

— Within 5 feet (152 cm) of an AC power outlet that is not switch-controlled

— Within 25 feet (762 cm) of the network interface, or use an Off-Premises Range Extender 
(OPRE)

— Within 1000 cable feet of telephones (except MLX and 4400-Series), or use an OPRE (for 
basic telephones)

— Within 3000 cable feet of MLX telephone (IROBS if needed)

— Within 2000 cable feet of any 4400-Series telephone when using 26 gauge cable

— Within 3000 cable feet of any 4400-Series telephone when using 24 gauge cable

— Within 5000 cable feet of any 4400-Series telephone when using 22 gauge cable

CAUTION:

The AC outlet for the control unit cannot be switch-controlled. Plugging the control 
unit into such an outlet invites accidental disconnection of the system.

Backboard Requirements 2

The backboard should be wide enough to accommodate the carrier and up to two additional 
carriers, assuming that system growth is anticipated. There should be enough room on each side 
of the control unit for the necessary wiring fields.
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To accommodate the maximum control unit size, make sure the backboard meets the following 
requirements:

■ Material

— ¾ inch plywood

— Check with the local building code enforcement agency to see whether fire-retardant 
material is required

— Make sure that the material meets local building codes

■ Dimensions

— With Systimax wiring: 7 feet wide by 4 feet high 

— Without Systimax wiring: 6 feet wide by 3 feet high

Installing the Backboard 2

When you are certain that the backboard meets the requirements indicated above, mount the 
backboard using the following mounting hardware:

■ For a wood mounting surface, use wood screws.

■ For brick, cinderblock, or concrete, use masonry anchors.

■ For plaster or plasterboard, use toggle bolts.

■ For sheet metal, use sheet-metal screws and attach them to the structural members.

The mounting hardware should resist a combined pullout force of at least 650 pounds 
(295 kilograms).
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AC Power and Grounding 2

Proper power and grounding are essential for the system to run correctly and safely.

CAUTION:
If any of the following requirements are not met, the customer must contact a licensed 
electrician. Do not install the system until all requirements are met.

Verify that all of the following power and grounding requirements are met:

■ The load center of appropriate current rating must be equipped with circuit breakers labeled 
120 V AC, 15 amps.

■ Each breaker must protect one dedicated quad AC outlet or two dedicated duplex AC outlets.

■ All AC outlets must connect to the same load center and the ground wire must connect to the 
single-point ground bar on the first AC outlet (see Figure 2-1).

■ One outlet must have an attached ground bar connected by a #6 AWG copper wire to an 
approved ground (see ‘‘Approved Grounds’’ later in this chapter for a description of approved 
grounds). This ground bar is the system’s single-point ground (see Figure 2-1). 

■ To prevent someone from accidentally shutting off the power, do not connect the control unit to 
a switch-controlled outlet.

■ The AC outlet should be within 5 feet (152 cm) of the control unit.

■ Each carrier requires one AC outlet receptacle.

■ Auxiliary equipment requires additional AC outlets.

■ If a printer or PC is installed on the system, it must be plugged into the same AC branch as the 
power supply of the basic carrier.

■ If the printer or PC is 50 feet (15 m) or more from the control unit, or is plugged into a different 
AC circuit, Asynchronous Data Units (ADUs) must be installed as well. 

■ The AC power requirements indicated in ‘‘AC Outlet Tests,’’ must be met.
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Figure 2-1.  AC Grounding Requirements

CAUTION:
The AC outlet for the control unit cannot be switch-controlled. Plugging the control unit into 
such an outlet invites accidental disconnection of the system. The AC outlet must be properly 
wired as described in ‘‘AC Outlet Tests.’’
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AC Outlet Tests 2

If the AC outlet tests indicate that any of the power requirements in Table 2-2 are not met, your 
customer must contact a licensed electrician. Do not install the system until all requirements are 
met. 

If the AC outlet tests reveal any of the following conditions, they must be corrected before you 
install the system:

■ Open ground

■ Hot and neutral reversed

■ Open hot

■ Open neutral

■ Hot and ground reversed

WARNING:

Hazardous voltages are present during the following tests. Follow all instructions carefully 
when working with AC power line voltages.

Using an Ideal 61-035 Circuit Tester (or Equivalent) 2

Follow these steps to use an Ideal 61-035 Circuit Tester or its equivalent:

1. Plug the circuit tester into the outlet that you want to test.

If the circuit is properly grounded, the yellow and white lights on the tester turn on.

2. Unplug the circuit tester.

Table 2-2. Power Requirements

Parameter Value

Nominal voltage 117 V AC

Voltage range 110–125 V AC

Frequency 60 Hz +/– 5%

Maximum current 5 amps per power supply
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Using a Volt-Ohm Milliammeter (VOM) 2

Follow these steps to use a VOM:

1. Set the VOM to the lowest scale on which you can read 
130 V AC.

2. Measure the AC outlet voltages. See Figure 2-2 on page 2-8.

■ Phase to ground should be 110 to 125 V AC.

■ Neutral to ground should be less than 1 V AC.

■ Phase to neutral should be 110 to 125 V AC.

Figure 2-2. Measuring the AC Outlet Voltages

WARNING:

If the voltage readings do not measure the values required, the AC outlet is improperly 
wired—do not install the system. Advise the customer to have a licensed electrician correct 
the problem.

Grounding Requirements 2

Proper grounding of the installation site safeguards the system by protecting it from the following:

■ Lightning

■ Power surges

■ Power crosses on central office trunks

■ Electrostatic discharge (ESD)
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WARNING:

When installing the control unit, make sure you meet the following grounding requirements:

■ The control unit, the central office trunk protector, and the AC power service panel should 
be as close to each other as possible.

■ Because equipment can be located throughout a building, the National Electrical Code 
requires that the ground point for the central office trunk protector be bonded to the AC 
power ground as shown in Figure 2-3.

■ The AC outlet and the single-point ground bar must be properly grounded as shown in 
Figure 2-1 and Figure 2-3.

■ Each control unit ground-screw terminal must be connected to the single-point ground bar 
by a #12 AWG or a #14 AWG solid copper wire. Figure 2-1 and Figure 2-3 show this 
connection.

■ This wire run should be as short as possible, preferably within 5 feet (152 cm), and not to 
exceed 10 feet (305 cm). See ‘‘Approved Grounds’’ later in this chapter for more 
information.

■ The AC outlet must be connected to the 145D protector with a #12 AWG or a #14 AWG 
solid copper wire.
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Figure 2-3. Central Office and AC Grounds

WARNING:

An improper ground can cause equipment failures, service outages, and electrical shock. 
Verify that the AC power uses an approved ground for its primary ground, that all voltage-
limiting devices are grounded to an approved ground, and that the ground is one of the 
approved grounds listed below.

DIW or
25-Pair Cable

Commercial 
Power

To Central
Office or
Serving
Facility

CO
Lines

Coupled Bonding
Conductor (optional)

D2R
Cords

Power 
ServiceSingle -

Point
Ground
Bar

Shield
Ground

#6 AWG
Ground

Wire

Power
Ground

RodBond
Wire

Earth
Ground

#12 or #14

Connection

Ground
Screw

AWG
Ground

Wire

CO
Line

Protector
Network
Interface

Power
Supply( )

Plug
AC

Outlet

GND (Green)

W

B

CO
Wiring
Field



Installing the Control Unit

AC Power and Grounding

2-11

Approved Grounds 2

Approved grounds are listed below, in order of preference:

■ Most preferred ground:

It must be a metal, not plastic or vinyl, underground water pipe at least 1/2 inch (1.27 cm) in 
diameter, and in direct contact with the earth for at least 10 feet (3 m).

It must be electrically continuous so that the protector ground is uninterrupted. (Check for 
insulated joints, plastic pipe, and plastic water meters that might interrupt electrical continuity.)

A metallic underground water pipe must be supplemented by the metal frame of the building, a 
concrete-encased ground, or a ground ring. If these grounds are not available, the water pipe 
ground can be supplemented by one of the following types of grounds:

— Other local metal underground systems or structures, such as tanks and piping systems, 
but not gas pipes.

— Rod and pipe electrodes, a 5/8 inch (1.58 cm) solid rod or 1/4 inch. (0.63 cm) conduit or 
pipe electrode driven to a minimum depth of 8 feet (244 cm).

— Plate electrode, a minimum of 2 square feet (61 square cm) of metallic surface exposed to 
the exterior soil.

■ Next preferred ground:

It must be an electrode consisting of one of the following:

— At least 20 feet (6.1 m) of one or more steel reinforcing rods, each at least 1/2 inch (1.27 
cm) in diameter

— 20 feet (6.1 m) of bare copper conductor not smaller than #4 AWG, encased in 2 inches (5 
cm) of concrete

— Ground ring, consisting of at least 20 feet (6.1 m) of bare copper conductor (not smaller 
than #2 AWG) encircling the building. The ground ring must be in direct contact with the 
earth and buried at least 2-1/2 feet (77 cm) below the earth’s surface.

WARNING:

Do not use a metal underground gas piping system—this is a safety risk.

Central Office Trunk Protection 2

The local telephone company is responsible for providing the following protection of central office 
trunks at the entrance to the site:

■ Carbon blocks or gas discharge tubes connected to an approved ground

■ Adequate bonding of the central office trunk protector ground and the power company ground

This electrode must be located within and near the bottom of a concrete 
foundation or footing that is in direct contact with the earth.
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CAUTION:

Check these requirements with a simple, visual inspection. If you cannot verify that the 
central office grounding requirements are met, contact the central office. Do not connect 
the control unit to the central office trunks until you are certain that these requirements 
are met.

Heavy Lightning Protection 2

The MERLIN MAGIX 491D1 power supply has built-in AC line protection. This built-in protection 
handles almost all situations. 

Occasionally, additional protection may be needed if the customer is located in a heavy lighting 
area. In such instances, the 145D and 146 protectors are available for the MERLIN MAGIX system 
as needed.

In addition to providing CO line protection, 146 protectors are designed as In-Range, Out-of-
Building (IROB) protectors. An IROB protector is used when telephones are installed within 1,000 
feet of the control unit but are in another building. You must use IROB protectors whenever out-of-
building telephones are installed.

Connect a 145D protector to the system to limit surges from the AC lines. For CO trunk and/or 
IROB protection, add any combination of 146 protectors shown in Table . For an example, see 
Figure 2-4.

146C and/or the 146F protectors are recommended for CO line protection at all potential 
lightning trouble sites.

Capacities and Recommended Application for 146 Protectors

Protector Recommended Application

146C 4 CO Lines
4 T/R IROB telephones

146D 2 T/R IROB telephones
2 MLS or ETR IROB telephones

146E 2 MLX IROB telephones
2 4400-Series IROB telephones

146F 25 CO Lines
25 T/R IROB telephones

145D 6 protected AC outlets

For detailed installation instructions, see the documentation packaged with the 
protectors.
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Figure 2-4. Configuring Power Surge and Protectors
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Unit Loads 2

A unit load is a measure of power (1.9 watts) that you use to determine the electrical load that the 
components listed below place on the control unit’s power supply.

■ Telephones and adjuncts

■ 800 DID modules

Only the telephones and adjuncts that connect to the digital extension jacks (ports) on the control 
unit require unit load calculation. When calculating unit load, do not include any equipment with its 
own power supply (for example DSS).

WARNING:

Warning: Never have more than two (2) DS1 modules (100D), two (2) INA modules (100R), 
or more than one (1) 100D and one (1) 100R module in a carrier. Also, you can have any 
combination of the following three -5 V DC modules per carrier, but do not exceed three: 
Processor, DS1 module, INA module, and the MERLIN Messaging module. If you exceed 
three -5 V DC modules in a single carrier, the system will fail to come on line.

Calculating Unit Loads 2

The 491D1 power supply for the MERLIN MAGIX Integrated System provides up to 96 unit loads 
of power. If the unit loads in a carrier exceed 96 unit loads, reconfigure the carrier so that the unit 
loads are 96 or less. For Example:

■ In Key mode, the MERLIN MAGIX 491D1 power supply can generally support up to three 016 
MLX, 024TDL, or 016 ETR modules, as long as no DID, TDL or E&M Tie Line modules are in 
the same carrier.

■ In the Hybrid/PBX mode, the 491D1 power supplies can generally support up to four 016 MLX, 
024TDL and 016 ETR modules, as long as no DID, TDL or E&M Tie Line modules are in the 
same carrier. 

In many circumstances a more accurate unit load calculation may be useful. This may include 
situations where modules are not fully utilized, a predominance of large multi-button sets are used, 
there is a change in the equipment, or you suspect that a particular carrier has more unit loads 
than the power supply can handle.

To calculate the actual unit loads per carrier:

1. Add up the unit loads for each type of module using Table 2-3 on page 2-15. If the total doesn't 
exceed 96, no further calculations are necessary. Table 2-3 assumes a mix of set types with 
no more than 50% of sets being large, multi-button sets (4424LD+, 4424D+, 4412D+, MLX 
20L & 28D, and/or ETR 34D & 18D) sets.
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2. If unit loads calculated fromTable 2-3 exceed 96 or if >50% of the sets are large multi-button 
sets, calculate the actual total using the Unit Load values in Table 2-4 on page 2-15 for each 
type of station device and trunk shown in Table 2-4 (include DSS and adjuncts powered from 
the Processor).

Table 2-3. Unit Loads Per Module (48vDC)

Circuit Module App Code Type UNIT LOAD

617A52 412 LS-TDL 13

617A58 024 TDL 24

617C21 008 MLX 13.5

617A54 016 MLX 27

617E34 016 T/R 12.8

617A56 016 ETR 24

617G20 800 DID 8.0

617 E28 008 OPT 8.0

617D14 400 E&M 8.0

617B31 800 LS/GS/ICLID 0

617 E29 408GS/LS-MLX/ICLID 13.5

617A49 MERLIN Messaging 0

Table 2-4. Unit Loads Per Port

Port Load Hybrid/PBX Mode Square-Key Mode

TDL module for 4400-Series Sets

4424LD+ 1.1 1.3

4412D+/4424D+ 1.1 1.3

4400/4400D/4406D+ 0.9 1.0

DSS 0 0

MLX Set/Adjunct

MLX 20L 1.1 1.6

MLX 28 1.2 1.7

MLX 5/10/16 w/ or w/o Disp 0.9 1.2

DSS 0.7 0.9

MFM (use local PSU) 0 0

Tip Ring

T/R Set 0.6 0.7

ETR Set/Adjunct

ETR-6 0.9 1.0

ETR-18 1.0 1.2

ETR-18D 1.2 1.4
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Installing the Carriers 2

Installation of the basic and expansion carriers involves mounting the carriers to the backboard, 
connecting the ground, placing the power supply, processor, and modules into the carriers, and 
attaching the front cover. 

Mounting the Carrier and Expansion Carriers 2

There are two different procedure that you can use to mount the carrier:

■ Mounting the carrier with the power supply and port modules already installed in the 
carrier.

■ Mounting the carrier with the power supply and port modules removed from the carrier. 

Mounting both the Carrier and Expansion Carriers With
the Power Supply and Port Modules Already Installed in
the Carrier 2

This installation procedure requires the use of 4 mounting brackets supplied with each carrier.

ETR-34D 1.5 1.7

Trunk

GS-LS 0 0

DID 1.0 1.0

E&M 1.4 1.4

DS1 0 0

If the total exceeds the maximum unit loads per power supply, try to exchange modules 
between carriers to reduce the load below the maximum. No empty slots are permitted 
between modules.

As a general rule, if you can distribute the 800 DID modules and telephone modules 
equally across the carriers, you prevent unnecessary drain on any one carrier.

A basic carrier should be mounted on a backboard with 29 inches (73.66 cm) of 
empty space to the right. This allows enough room for system expansion of two 
additional carriers. There should be at least 12" of clearance from the top of the 
control unit to the ceiling to allow adequate ventilation for cooling. 

Table 2-4. Unit Loads Per Port— Continued

Port Load Hybrid/PBX Mode Square-Key Mode
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WARNING:

Continue with this procedure only if you have met all of the requirements discussed earlier in 
this chapter.

To install the carrier, follow the steps below:

1. Install the horizontal mounting bracket on the backboard using at least two #10 X 3/4” long 
wood screws supplied. 

Make sure that the bracket is level.

2. Install the top of the vertical mounting bracket into the slot on the horizontal mounting bracket 
to form a “T” as shown in Figure 2-5. Secure the vertical mounting bracket with at least one 
#10 X 3/4” long wood screw in the bottom hole.

Figure 2-5. Mounting the T brackets 

3. Install the left and right mounting brackets on the rear of the carrier with the four #10 - 24 X 
1/2” long machine screws supplied as shown in Figure 2-6.
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Figure 2-6. Fastening the left and right brackets on the carrier

4. Place the carrier on to the horizontal mounting bracket approximately 2" to the right of its final 
position. 

The hook on the back of the carrier should rest on the top flange of the horizontal mounting 
bracket. 

5. Slide the carrier to the left until it stops when it bottoms out on the vertical mounting bracket. 

Make sure that the bottom of the carrier is secured by the vertical mounting bracket.

6. Secure the left and right mounting brackets to the backboard with a minimum of one #10 X 
3/4” long wood screw in each bracket as shown in Figure 2-7.

Figure 2-7. Securing the left and right bracket
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To Install the Expansion Carrier:

a. Abut the second horizontal mounting bracket to the first horizontal mounting bracket. 

b. Repeat steps 1 through 3 to secure the bracket and attach the mounts to the carrier.

c. Remove the filler plate from the right side of the basic (first) carrier. See Figure 2-7 
above.

d. Place the carrier on to the horizontal mounting bracket approximately 2" to the right of 
its final position. 

The hook on the back of the carrier should rest on the top flange of the horizontal 
mounting bracket. 

e. Slide the expansion carrier to the left, align the backplane connectors and seat the 
expansion carrier with the basic carrier.

Make sure the connectors are seated securely and completely as shown in Figure 2-8.

Figure 2-8. Connecting the Carriers

f. Secure the left and right mounting brackets to the backboard with a minimum of one 
#10 X 3/4” long wood screw in each bracket as shown in Figure 2-7.

7. Connect the ground-screw on the carrier to an approved ground using a #12 AWG or #14 
AWG solid copper wire. See Figure Figure 2-3 on page 2-10.

Basic Carrier Expansion Carrier

Basic Carrier Expansion Carrier

Backboard

Connector 

Carrier
Extender
(under the
breakaway tab)
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Mounting Both the Carrier and Expansion Carriers With
the Power Supply and Port Modules Removed from the
Carrier 2

This installation procedure does not require the 4 mounting brackets supplied with each carrier.

WARNING:

Continue with this procedure only if you have met all of the requirements discussed earlier in 
this chapter.

To install the carrier, follow these steps:

1. Mark the screw-hole locations on the backboard using the carrier or the diagram in Figure 2-9 
as a guide.

Make sure the carrier is level before marking the holes.

Figure 2-9.  Marking the Basic Carrier Screw Holes

2. Drill a pilot hole in the center of each of the three screw-hole marks.

3. Anchor the screws approximately halfway into the backboard.

4. Position the carrier on the screws and slide the carrier to the left.

5. Tighten the screws.

A basic carrier should be mounted on a backboard with 29 inches (73.66 cm) of 
empty space to the right. This allows enough room for system expansion of two 
additional carriers. There should be at least 12" of clearance from the top of the 
control unit to the ceiling to allow adequate ventilation for cooling. 

Backboard

Basic 
Carrier

Mounting
Screw

Mounting Surface
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6. Connect the ground-screw on the carrier to an approved ground using a #12 AWG or #14 
AWG solid copper wire.

To install the expansion carrier, follow these steps:

1. Remove the filler plate from the right side of the basic (first) carrier.

2. Align the two backplane connectors.

3. Repeat steps 1 to 3.

4. Slide the expansion carrier to the left, align the backplane connectors and seat the expansion 
carrier with the basic carrier.

Make sure the connectors are seated securely and completely as shown in Figure 2-10.

5. Secure the three screws.

6. Connect the ground-screw on the carrier to an approved ground using a #12 AWG or #14 
AWG solid copper wire.

Figure 2-10. Connecting the Carriers

Basic Carrier Expansion Carrier
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Installing the Power Supply 2

WARNING:

Do not install the power supply unless the carrier is connected to an approved ground.

Before touching leads, connectors, pins, and other components, use a properly grounded 
wrist strap to prevent damage from electrostatic discharge (ESD). The wrist strap can be 
clipped to the ground screw or plugged into the hole next to the ground screw.

Do not attach any cables or power cords to the power supply until it is installed in the carrier.

Do not power up the control unit until all of the modules and power equipment are installed. 
Once they are installed, refer to ‘‘Powering Up the System,” later in this chapter. Failure to 
comply with this procedure can result in shock hazard and/or damage to the equipment.

Installing the Power Supply Module in the Carrier 2

Follow these steps to install the power supply module in the carrier:

1. Align the circuit board guides inside the carrier, and slide the power supply module into the 
slot.

2. Make sure the connector on the back of the module mates properly with the connector on the 
carrier.

3. Secure the module with two screws, one on top and one on the bottom.

Installing the Processor 2

CAUTION:
Before touching leads, connectors, pins, and other components when handling the circuit 
board, use a properly grounded wrist strap to prevent damage from electrostatic discharge 
(ESD). The wrist strap can be clipped to the ground-screw or plugged into the hole next to 
the ground-screw.

Installing the processor includes the following procedures:

■ If both of the following conditions are true, follow the procedures in “Modifying the Processor 
for Key Mode” in Chapter 9 of the Installation, SPM, Maintenance, and Troubleshooting Guide.

— Form 1, System Planning, indicates Permanent Key mode.

The power supply may make a ticking sound when plugged in but not turned on. This 
is normal operation.
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— Form 2c, System Numbering: Line/Trunk Jacks, indicates no GS (ground-start) trunks in 
the Incoming Trunk Type column.

■ Insert the processor into the carrier as indicated in ‘‘Installing the Processor in the Carrier,” 
later in this chapter.

Installing the Processor in the Carrier 2

To install the processor in the carrier, follow the steps below. Refer to Figure 2-11.

1. Align the circuit board guides inside the carrier, and slide the processor module into the slot.

2. Make sure that the connector on the module mates properly with the connector on the carrier 
as you push the processor back into place.

CAUTION:

To avoid damage, do not force the module. If the module does not insert easily, pry the 
bottom-front locking tab with a flat-blade screwdriver, remove the module, and inspect 
the module and carrier for damage or obstruction. The bottom-front locking tab is shown 
in Figure 2-11. This tab is used on all modules.

If there is no damage and no obstruction, reinsert the module.

A damaged carrier or module must be replaced.

3. Firmly push the processor into the carrier until it locks into place.

The processor should be securely attached to the carrier and locked in place by the locking tab 
on the bottom front of the processor.

If the system is programmed for Permanent Key mode, check the switch setting. 
Refer to “Modifying the Processor for Key Mode” in Chapter 9 for detailed 
procedures. If the switch is set to Permanent Key-only operation, all trunks revert to 
loop-start. If the switch is not set, any programmed designation for ground-start 
trunks is retained.

The ground-start pool never has trunks assigned to it automatically but must be 
programmed after the ground-start ports are designated. Ground-start trunks are 
assigned to the ground-start pool on initialization, except in a system switched for 
Permanent Key mode operation.

The processor module contains a PCMCIA memory card interface capable of 
accommodating a 4MB memory card. This card is used to install or upgrade system 
software and perform firmware upgrades on circuit modules. It can be used to back 
up and restore system programming.
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Figure 2-11. Installing the Processor into the Carrier
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Installing the Modules 2

CAUTION:
When installing the modules, use a properly grounded wrist strap to prevent damage from 
electrostatic discharge (ESD), and avoid touching leads, connectors, pins, and other 
components. The wrist strap can be clipped to the ground-screw or plugged into the hole 
next to the ground-screw.

WARNING:

All unused slots must be covered with a blank panel. Remove back panels only from slots 
where modules will be installed.

Guidelines 2

Follow these guidelines when you install modules, as indicated on the Control Unit Diagram of 
Form 1, System Planning:

■ Do not leave empty slots between modules. The system ignores modules installed beyond any 
empty slot.

■ If a phantom module (a programmed empty slot) is indicated on the Control Unit Diagram, 
make sure the slot remains empty and do not install any modules to the right of it. The system 
ignores any modules installed to the right of a programmed empty slot.

■ Remove a blank panel from a slot by prying up the latch at the bottom of the panel with a flat 
bladed screwdriver.

■ Make sure you install each module in its assigned slot. If you install a module in the wrong slot, 
the system will not function properly.

■ Once you have installed the power supply and the processor in the basic carrier, use the 
remaining slots for the modules as follows:

— Basic carrier: slots 1 through 5

— First expansion carrier: slots 6 through 11

— Second expansion carrier: slots 12 through 17

Placing the Modules into the Carrier 2

To install modules starting from slot 1 (the first open slot next to the processor), follow the steps 
below:

1. Align the circuit board guides inside the carrier, and slide the module into the slot. See Figure 
2-11 on page 2-24.

2. Make sure the connector on the module mates properly with the connector on the carrier.

3. Firmly push the module into the carrier until it locks into place.
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CAUTION:

To avoid damage, do not force the module. If the module does not insert easily, pry the 
bottom-front locking tab with a flat-blade screwdriver, remove the module, and inspect 
the module and carrier for damage or obstruction. The bottom-front locking tab is shown 
in Figure 2-11. This tab is used on all modules.

If there is no damage and no obstruction, reinsert the module.

A damaged carrier or module must be replaced.

4. Repeat Steps 1 through 4 for each module you want to install.

Installing the Cover 2

The cover is installed only after all equipment has been connected to the control unit and after all 
system testing has occurred. The top edge of the front cover hooks over the top flange of the 
carrier. The bottom of the front cover is secured to the carrier with two captive screws.  

WARNING:

The cover must be installed for continued safe operation of the control unit.

The two captive screws should not be removed from the front cover.
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Labeling 2

After all modules have been installed, label the jacks by using the numbered labels provided with 
the feature module. There are two types of labels:

■ Line/trunk labels have green numbers on off-white background.

■ Telephone labels have blue numbers on off-white background.

See Figure 2-12 on page 2-28 for the locations of line/trunk jacks and telephone jacks on each 
module, and label them as described next.

Follow these steps to label the jacks on the modules:

1. Label each line/trunk jack on the modules sequentially, 1 through 80. Begin with the module in 
slot 1, numbering from bottom to top on each module and working from left to right across the 
carrier or carriers.

The 100E module has 32 numbers assigned to the line/trunk jack.

2. Label each telephone jack sequentially, 1 through 200. Begin with the module in slot 1, 
numbering from bottom to top on each module and working from left to right across the carrier 
or carriers.

CAUTION:

The 008 OPT module is assigned 12 logical IDs, and the last four numbers are not 
assigned to jacks. For example, if the previous module (on the left) is labeled with logical 
IDs 1 through 8, label the 008 OPT jacks with logical IDs 9 through 16. Skip numbers 17 
through 20. When you label the next module (on the right), label the first jack as logical 
ID 21. 
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Figure 2-12. Line/Trunk and Telephone Jack Locations on Each Module

Replacing a Module 2

CAUTION:
This section does not apply to the processor or power supply.

Before inserting or removing a module, the power switch on all power supplies must be 
turned off.

When you replace a module, use the same module type. For example, do not put a 008 MLX 
module in place of a 400 GS/LS/TTR module. If a module is replaced with another type of 
module, or if a module is added to the system without powering down the system first, a cold 
start (System Reset) occurs.

If you move any module to a different slot, be sure to renumber the modules by selecting 
Board Renumber from system programming. See System Programming for information 
about board renumbering.

PFT Jack

Line/Trunk
Jacks
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Extension Telephone
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Replacing a Module in a Carrier 2

To remove and replace a module in a carrier, follow the steps below. See Figure 2-13.

CAUTION:
Power down the system before removing or replacing modules. “Hot swaps” should not be 
performed.

1. Label all cords (if they are not labeled already), and then unplug them from the module.

For information about labeling trunk and extension cords, see Chapter 3, “Installing Icon-
Labeled 4400-Series Telephones,” and Chapter 4, “Connecting the Control Unit to the Network 
Interface.” For instructions on checking unlabeled wiring, see “Checking Unlabeled Wiring” in 
Chapter 3 of Maintenance and Troubleshooting.

2. Power down the system. To power down the system, follow the steps below.

CAUTION:

Follow these steps in the exact sequence.

a. Turn off the power supply on the basic carrier.

b. Turn off the power supplies on the expansion carriers.

c. Unplug the system from the AC outlet.

3. Remove the module from the carrier. Follow these steps:

a. Using a screwdriver, pry the tab at the bottom front of the module.

b. While prying the tab, pull the top handle on the module towards you and away from the 
carrier.

4. Inspect the module for visible damage.

5. Insert the new module (see Figure 2-11).

6. Restore the module. See System Programming for instructions.

7. Connect the trunk and extension cords.

8. Attach a tag, error printout, and any information that will help identify any visible problems or 
failure symptoms.
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Figure 2-13. Removing a Module from the Carrier

Connecting the Control Unit to an AC Outlet 2

CAUTION:
Make sure the AC outlet has been tested for proper grounding. The outlet should be 117 V 
AC, 60 Hz, 3-wire (phase, neutral, ground). See “AC Outlet Tests,” earlier in this chapter, for 
instructions.

To prevent someone from accidentally shutting off the power, do not connect the control unit 
to a switch-controlled outlet. The AC outlet should be within 5 feet (152 cm) of the control 
unit.
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To connect the control unit to a dedicated AC outlet, follow the steps below.

1. Turn the basic carrier’s power supply switch to the OFF position.

2. Turn off the power supply switches on the expansion carriers.

3. Plug one end of the power cord into the AC INPUT connector located to the right of the power 
switch on the front of the basic carrier’s power supply.

4. Plug the other end of the power cord into the AC outlet, allowing at least 1 foot (30.4 cm) of 
slack in the cord.

5. Repeat Steps 4 and 5 for each expansion carrier.

CAUTION:
Do not attach the power cord or cords to any building surfaces.

Powering Up the System 2

CAUTION:
Follow the procedure below to power up the system only if the system is completely installed. 
Failure to comply with this procedure can result in shock hazard or damage to the equipment.

Do not power up the system unless all carriers are connected to an approved ground.

1. Complete the procedure ‘‘Connecting the Control Unit to an AC Outlet’’ on page 2-30.

2. Turn on the power switch for each expansion carrier: start with the power supply in the 
rightmost carrier.

The green power lights on each expansion carrier power supply should turn on.

3. Turn on the power switch on the basic carrier power supply.

■ The dot on the one-character display LED flashes.

■ The green light on the power supply turns on.

■ The red light on the processor should turn on for 15 to 45 seconds and then turn off.

■ All indicators on the 100D, 100R, and 400EM line/trunk modules (if present) turn on and 
then off. They remain off when the modules are idle.

4. If any of these conditions are not met, refer to Maintenance and Troubleshooting.
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Installing the Cover on the Carrier 2

WARNING:

The cover must be installed for continued safe operation of the control unit.

A front cover is needed for the carrier. Follow these steps to install the cover (see Figure 2-14):

1. Be sure all wires have been passed through the wire managers and wire trays at the bottom of 
the control unit.

2. Hook the top of the cover onto the top of the carrier.

3. Push in the bottom of the cover until it locks securely onto the base of the wire managers on 
the carrier.

4. Tighten the two screws at the bottom of the cover.

Figure 2-14. Installing the Cover for the Carrier
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Overview 3

The icon-labeled 4400-Series telephones are digital single-line and multiline telephones designed 
for use with Lucent Technologies’ MERLIN MAGIX™ Integrated System Release 1.0i. Most of the 
instructions for the use of these telephones appear in the 4400 and 4400D Telephone User’s 
Guide and the 4406D+, 4412D+, 4424D+, and 4424LD+ Telephone User’s Guide.

IMPORTANT SAFETY INSTRUCTIONS

The exclamation point in an equilateral triangle is intended to alert the user to 
the presence of important operating and maintenance (servicing) instructions in 
the literature accompanying the product.

To reduce the risk of fire, electrical shock, and injury to persons, follow these basic safety precautions 
when installing telephone equipment:

■ Read and understand all instructions.
■ Placing equipment or other articles within two inches of the microphone, may decrease the quality 

of performance of the speakerphone. For 4424LD+ and 4424D+ telephones, care should be taken 
when connecting a DSS 4450 to ensure that placement of the DSS 4450 does not interfere with 
the performance of the microphone on the right side of the telephone.

■ Follow all warnings and instructions marked on or packed with the product.
■ This product is intended to be installed and serviced by qualified service personnel only. Do not 

disassemble this product. There are no user-serviceable parts inside.
■ Never push objects of any kind into this product through cabinet slots, as they may touch 

dangerous voltage points or may short out parts, which could result in a risk of fire or electrical 
shock.

■ Never install telephone wiring during a lightning storm.
■ Never touch uninsulated telephone wires or terminals unless the telephone wiring has been 

disconnected at the network interface.
■ Never install a telephone jack in a wet location (for example a wet basement) unless the jack is 

specifically designed for wet locations.
■ Do not install this product near water—for example, in a wet basement location.
■ Use caution when installing or modifying telephone lines.
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■ Use only Lucent Technologies 1151A Power Supply Unit (PEC 2404-010) with the appropriate 
input power cord PEC (24799). The Power Supply Unit is required for icon-labeled 4424LD+ 
telephones or with the icon-labeled 4424D+ when connecting a DSS 4450. The country-specific 
input power cord is ordered by selecting the appropriate country attribute.

■ The 1151A Power Supply Unit is to be connected only to the type of main power source indicated 
on the marking label. The main power source wall outlet must be installed near the equipment and 
be readily accessible. Do not overload the wall outlet or use an extension cord.

■ The input power cord used with the 1151A Power Supply Unit is equipped with a grounding-type 
plug appropriate for the country in which it is installed. This is a safety feature. If you are unable to 
insert the plug into the outlet, contact an electrician to replace the obsolete outlet. Do not defeat 
the safety purpose of the grounding plug.

■ Do not staple or otherwise secure the input power cord to the building surfaces. Do not allow 
anything to rest on top of the cord. Do not locate the equipment where the cord will be abused by 
persons walking on top of it.

■ Use only Lucent Technologies-recommended/approved 4400-Series telephone accessories.

Line Cords 3

Line cords are shipped with all 4400-Series telephones and the DSS 4450. The line cord varies 
according to the equipment:

■ Clear 14-foot, 6-position line cord with two conductors (D2R)—used to connect the 4400, 
4400D, 4406D+, 4412D+, and 4424D+ telephones to the communications system wall jack. If 
auxiliary power is needed, used to connect the 1151A Power Supply Unit to the 
communications system wall jack.

■ Silver-Gray 14-foot, round line cord (M4BK)—used to connect the 1151A Power Supply Unit 
to the 4424LD+ telephone or the 4424D+ telephone when connected to a DSS 4450. One end 
of the M4BK cord has an 8-position plug and the other end has a 6-position plug. 

■ 3-foot, 8-position line cord with eight conductors (D8Y)—used to connect a DSS 4450 to a 
4424LD+ or 4424D+ telephone or to another DSS 4450 via the jacks on the bottom of the DSS 
4450 and the telephone. 

1151A Power Supply Unit 3

An 1151A Power Supply Unit (PEC 2404-010) with the appropriate input power cord PEC (24799) 
is not automatically shipped with the telephone and must be ordered separately. The 1151A 
Power Supply Unit is required for icon-labeled 4424LD+ telephones or with the icon-labeled 
4424D+ when connecting a DSS 4450. The country-specific input power cord is ordered by 
selecting the appropriate country attribute. 

See “Jacks and Placement of Cords” later in this document for instructions on installing the 1151A 
Power Supply Unit for an icon-labeled 4424LD+ or with the icon-labeled 4424D+ when connected 
to a DSS 4450.
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CAUTION:

Do not use a different type of power supply from any other piece of equipment. Using 
another power supply can severely damage the DSS 4450, the 4424LD+ telephone, or 
the 4424D+ telephone.

Microphone 3

The microphone on the 4406D+ is located on the bottom right front of the telephone. The 
microphone on the 4412D+, 4424LD+, and 4424D+ telephones is located on the right side of each 
telephone. 

CAUTION:

Placing equipment or other articles within two inches of the microphone, may 
decrease the quality of performance of the speakerphone. For 4424LD+ and 4424D+ 
telephones, care should be taken when connecting a DSS 4450 to ensure that 
placement of the DSS 4450 does not interfere with the performance of the 
microphone on the right side of the telephone.

DSS 4450 3

One or two DSS 4450s can be connected to a 4424LD+ or 4424D+ telephone to enhance the call-
handling capabilities of a system operator with a Direct-Line Console (DLC) or a Queued Call 
Console (QCC). When connected to a 4424LD+ telephone used as a system programming 
console, the DSS 4450 facilitates system programming and centralized telephone programming 
procedures. Most of the instructions for the use of the DSS 4450 by a system operator appear in 
the Direct-Line Console Operator’s Guide and the Queued Call Console Operator’s Guide. 
Instructions for use of the DSS 4450 during system programming or centralized telephone 
programming appear in System Programming.

The DSS 4450 has three “pages” of 50 extensions or numbers. You can select the page you want 
by pressing one of the page buttons on the bottom of the DSS 4450.

The DSS 4450 has the following characteristics: 
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■ 50 line buttons with red 
LEDs

■ 3 page buttons with 
green LEDs

■ 6 buttons with green 
LEDs reserved for 
future use

Jacks and the Placement of Cords 3

Jacks exist on the bottom of the 4400-Series telephones as follows:

■ On the 4400 and 4400D telephones the jacks on the bottom accommodate the connection of 
the handset and the line cord. Refer to Figure 1 for jacks and placement of cords for the 4400 
and 4400D telephones.

Figure 3-1. Jacks and Placement of Cords for the 4400 and 4400D Telephones
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■ On the 4406D+, 4412D+, 4424D+, and 4424LD+ telephones the jacks on the bottom 
accommodate the connection of the handset, the line cord, and a headset. For the 4424LD+ 
and the 4424D+ telephone, a wider jack marked “ADJ” is used to connect a DSS 4450. 

Refer to Figure 2 for jacks and placement of cords for the 4406D+, 4412D+, and 4424D+ 
telephones when no auxiliary power is needed.

Figure 3-2. Jacks and Placement of Cords for the 4406D+, 4412D+ and 4424D+ Telephones 
(when no auxiliary power is needed)

Follow these instructions and refer to Figure 3 to connect the 1151A Power Supply Unit to the 
4424LD+ or to any 4400-Series telephone when auxiliary power is needed (for example, when 
connecting one or two DSS 4450s to a 4424D+):

1. Turn the telephone and each DSS 4450 face down.

2. Connect the one end of the D8Y line cord (supplied with the DSS 4450) to the ADJ jack on the 
telephone. Connect the other end of the D8Y line cord to the IN jack of the first DSS 4450 
(next to the telephone).

The 4406D+ telephone does not have a jack for the DSS 4450. The 4412D+ also has 
a jack marked “ADJ”, however, the jack is reserved for future use and cannot be 
used to connect a DSS 4450 

LINE

Line Cord
(D2R)

Handset Cord

Headset Cord

ADJ
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3. If you are connecting only one DSS 4450, go to Step 4.

If you are connecting a second DSS 4450, connect one end of the D8Y line cord (supplied with 
the DSS 4450) to the OUT jack of the first DSS 4450 connected in Step 2. Connect the other 
end of the D8Y line cord to the IN jack on the second DSS 4450 (farthest from the telephone).

4. Connect the 6-position plug at one end of the silver-gray M4BK line cord (ordered with the 
1151A Power Supply Unit) to the LINE jack of the telephone. Connect the 8-position plug at 
the other end of the silver-gray M4BK line cord to the PHONE jack of the 1151A Power Supply 
Unit.

IMPORTANT NOTE:

This drawing in Figure 3 includes the cords used for connecting the 1219A Power Supply Unit 
used with non-icon 4400-Series telephones. For 1151A Power Supply Unit used with icon-
labeled 4400-Series telephones substitute a silver-gray M4BK line cord for the satin-silver 
D4BU cord shown in the drawing.

5. Connect one end of the clear D2R line cord (packaged with the 4400-Series telephones and 
the DSS 4450) to the LINE jack of the 1151A Power Supply Unit. Connect the other end of the 
clear D2R line cord to communications system wall jack.

6. Connect the 1151A Power Supply Unit into a wall outlet.

7. Turn the telephone and the DSS 4450s face up. 

■ If the telephone will be wall mounted using the optional wall-mounting stand, you 
must run the headset and handset cords out the channel on the side of the 
telephone.

■ The 4424LD+ telephone and the DSS 4450 cannot be wall mounted.

■ If the telephone does not work properly after all cords are connected, check to be 
sure that the silver-gray M4BK line cord and the clear D2R line cords are 
connected properly as shown in Figure 3. 
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Figure 3-3. Jacks and Placement of Cords for the 4424LD+ and 4424D+ Telephones Including 
1151A Power Supply Unit and two DSS 4450s
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Wall-Mounting the Telephone 3

You can mount all the 4400-Series telephones except the 4424LD+ on a wall by using the optional 
color-contrasted stand. The DSS 4450 cannot be wall mounted.

The wall-mounting stand is available in gray only. The ordering codes are as follows:

■ Small Wall-Mounting Stand for use with the 4400, 4400D, and 4406D+ telephones:

— PEC 4499-SML, comcode 108541210

■ Large Wall-Mounting Stand for use with the 4412D+ and 4424D+ telephones:

— PEC 4499-LRG, comcode 108541293

To wall mount a 4400-Series telephone, follow these steps to attach a stand to a 4400-Series 
telephone:

1. Place the tab on the thicker end of the stand (this is the moveable tab) into the slot at the 
bottom of the back side of the 4400-Series telephone

The optional wall-mounting stand can also be used with all 4400-Series telephones 
and the DSS 4450 to increase the viewing angle when used on a desk.

■ Before you assemble the stand, you must have all cords attached and running 
through their proper channels. 

■ To use the stand to increase the angle of a 4400-Series telephone on a desk follow 
the steps below but turn the stand around so that the thinner end of the stand is at 
the bottom of the back side of the 4400-Series telephone and the thicker end is at 
the top of the 4400-Series telephone.

LINE
ADJ
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2. Push up on the stand toward the top of the telephone, and place the tab on the thinner end of 
the stand into the slot at the top of the 4400-Series telephone.

3. After you have attached the stand to the telephone, plug the line cord into the wall jack and 
store the extra line cord in the open pocket space between the telephone and the stand.

4. Place the telephone against the wall so that the screwheads on the mounting plate enter the 
holes in the stand. Then pull the telephone down so that the screwheads slide into the cutout 
channels.

Installing MLX Telephones 3

The control unit supports the MLX-5, MLX-5D, MLX-10, MLX-10D, MLX-10DP, MLX-16DP, MLX-
20L, and MLX-28D telephones. The MLX-20L and MLX-28D telephones may or may not be 
connected to a Direct Station Selector (DSS). Additionally, various auxiliary equipment is 
supported which may require Multi-Function Modules (MFMs) or other adapters for installation.

Installing Multi-Function Modules 3

The Multi-Function Module (MFM) is an optional adapter that provides a modular jack connection 
to MLX telephones for the two classes of auxiliary equipment listed below:

LINE

ADJ
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■ Tip/Ring (T/R) devices such as single-line telephones, fax machines, modems, and credit card 
verification terminals. Once connected, the MLX telephone and auxiliary equipment work 
independently of each other. This means both can send or receive calls at the same time. The 
MFM is the only T/R adapter you can use with MLX telephones.

■ Supplemental alerts such as bells, chimes, horns, and strobes. These alerts notify people in 
noisy areas of incoming calls.

Considerations 3

Review the following items before you begin the procedure.

■ If you install an MFM, do so before you assemble the MLX telephone.

■ You must connect the KS 22911 power supply to an electrical outlet within 50 feet (15 m) of 
cord length of the MLX telephone.

■ If you connect an MFM and two DSSs to a telephone, you must install a 406743419 power 
unit.

■ If a wall jack is more than 7 feet (213 cm) from an MLX telephone, you must use a longer D8W 
cord.

■ The MFM uses one of the two channels when it is active. This means that when auxiliary 
equipment, such as a fax machine, and the MLX telephone are in use at the same time, Voice 
Announce to Busy is not possible. (Voice Announce to Busy is a feature that allows users to be 
paged on the speakerphone even if they are on a call.)

■ The MFM has two jumper blocks that are factory-set for T/R operation. The MFM is packaged 
with the following items, shown in Figure 3-4:

— KS22911 power supply

— 400B or 400B2 adapter

— D6AP cord
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Figure 3-4. Multi-Function Module Packing List

RISK OF ELECTRICAL SHOCK: Follow all warnings and cautions.

WARNING:

Only a qualified technician should install, repair, or set options for an MFM.

Do not touch the circuitry on the MFM. Touching the circuitry may result in component 
damage from electrostatic discharge.

Before installing an MFM, disconnect all trunk and/or power cords that are attached to 
the MLX telephone. This is to ensure that no hazardous voltages are present during 
installation. Ringing voltage from the MFM attached to the MLX telephone can cause 
electrical shock if adjustments are made while the cords are connected.

To install or replace an MFM and change its pin settings, follow these steps:

If you are installing or replacing an MFM in a wall-mounted MLX-5, MLX-5D, MLX-10, 
MLX-10D, MLX-10DP, or an MLX-16DP telephone, start at Step 3.

. .
.. .

..

. . .
.

.

.

. ..

. .

. .

.

. ..
...

.

...

..

.
.

..

.

400B Adapter or 400B2 Adapter

D6AP Cord (7 feet long)Multi-Function Module

Power Supply 
(KS22911)



Installation and Maintenance

Installing MLX Telephones

3-12

1. Place the telephone face down on a flat surface; remove the user card tray and line cable from 
the bottom of the deskstand. See Figure 3-5.

Figure 3-5. Removing the User Card Tray and Line Cable

2. Release and remove the deskstand from the telephone. See Figure 3-6.

a. Press on the top rear center of the deskstand to release the tab.

b. Pull the deskstand up toward you and swing away from the telephone.

Figure 3-6. Releasing the Deskstand
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c. Lift the deskstand out of the locating slot in the telephone base and place to one side. See 
Figure 3-7.

Figure 3-7. Removing the Deskstand
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3. Release and remove the module cover.

a. Use a screwdriver to remove the screw in the lower right-hand corner of the module cover. 
See Figure 3-8.

Figure 3-8. Releasing the Module Cover Screw
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b. Press the center of the right side of the module cover with one hand to release the locking 
tab. See Figure 3-9.

Figure 3-9. Releasing the Module Cover

c. Swing open the module cover to release it from the left side locating slot.

d. Lift the module cover out of locating slot and set aside. See Figure 3-10.

Figure 3-10. Removing the Module Cover
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4. To install a new MFM, go to Step 5. To reset jumpers on an existing MFM, go to Step 6. To 
remove an existing MFM, continue (see Figure 3-11).

a. Disconnect any cords attached to the phone and note the connections so that you can 
reconnect the cords to the appropriate jacks later.

b. Locate the MFM locking tabs on the top and bottom of the telephone base; then spread 
the tabs apart to release the MFM.

c. Grasp the MFM by the edges, and pull it up to free the connector pins. Do not touch the 
connector pins.

d. Set the MFM aside on a clean surface.

Figure 3-11. Removing an MFM Module
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5. Install the new MFM. See Figure 3-12.

a. Hold the MFM circuit board by the edges with the long connector pins facing the socket. 
Take care not to touch the connector pins.

a. Lower the MFM to insert the pins into the socket in the telephone base.

a. Press firmly on the MFM board to snap the locking tabs into place. The connector pins and 
tabs must be secure.

Figure 3-12. Installing an MFM Module
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6. Set or adjust the MFM jumpers for either a T/R device or a supplemental alert device. See 
Figure 3-13.

a. Pull the four connectors off the MFM module.

b. Place the connectors over the appropriate pins for the required operation and push down 
to secure into place.

Figure 3-13. Setting and Adjusting the MFM Jumpers
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7. If the module cover has a square jack guard that protects the TEL/OTHER jack area, grasp 
and twist the guard to remove it (see Figure 3-14). Save the jack guard if you are wall-
mounting an MLX-5, MLX-5D, MLX-10, MLX-10D, or MLX-16DP telephone.

Figure 3-14. Removing the Jack Guard
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8. To replace the module cover:

a. Place the locking tab on the module cover into the slot on the left side of the telephone 
(see Figure 3-15).

Figure 3-15. Placing the Module Cover into the Locating Slot
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b. Lower the cover to the right and press firmly into the center slot to lock the tab in place. 
The tab must be secure (see Figure 3-16).

Figure 3-16. Lowering and Locking the Module Cover

c. Replace and tighten the module cover screw that you removed in Step 3 (see 
Figure 3-17).

Figure 3-17. Replacing and Tightening the Module Cover Screw
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9. Replace the deskstand. If you are wall-mounting an MLX-5, MLX-5D, MLX-10, MLX 10D, MLX-
10DP, or MLX-16DP telephone, go to Step 11; otherwise, continue with Step 9a.

a. Place the tab on the narrow edge of the deskstand, into the locating slot on the telephone 
base (see Figure 3-18).

Figure 3-18. Replacing the Deskstand

b. Lower the deskstand and lock into place (see Figure 3-19).

Figure 3-19. Lowering the Deskstand and Locking into Place

Lower
Into Inner
Center Slot

Lower
and
Press Into
Center
Slot



Installing Icon-Labeled 4400-Series Telephones

Installing MLX Telephones

3-23

10. Replace the user card tray and line cable. See Figure 3-20.

a. Insert the user card tray at an angle; then lower and slide into the deskstand. 

b. Replace the line cable into the line jack in the deskstand.

Figure 3-20. Replacing the User Card Tray and Line Cable
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11. Adjust the deskstand height. See Figure 3-21.

a. To change the deskstand’s height from low to high, press the top rear center of the 
deskstand to release the tab.

b. Pull the deskstand up and insert the tab into the slot in the module cover.

c. To readjust the stand, see the instructions on the bottom of the card tray.

Figure 3-21. Adjusting the Deskstand Height

12. Power up the telephone. See Figure 3-22.

a. Plug the D8W cord from the telephone into the 8-conductor (large) modular jack of the 
400B or 400B2 adapter.
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Figure 3-22. Powering Up the Telephone after Installing the MFM

b. Connect one end of the D6AP cord to the 2-conductor (small) modular jack on the 400B or 
400B2 adapter, and plug the other end into the modular jack of the 406943837 power 
supply. The total length of the cords connecting the power supply to the MLX telephone 
must be less than or equal to 50 feet (15 m).

CAUTION:

Do not plug the D6AP cord into the 8-conductor (large) modular jack on the 400B or 
400B2 adapter; doing so can cause electrical damage to the control unit and to the 
telephone.

c. Plug the power supply into a 117 V AC outlet that is not controlled by a wall switch.

d. Insert the plug end of the 400B or 400B2 adapter into the wall jack.

13. Test the MFM for T/R operation. (See “Testing MLX Telephones with MFMs” in Chapter 4.)

14. Attach the auxiliary equipment to the MFM. See “Installing Auxiliary Equipment.” 
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Installing Auxiliary Equipment to an MLX
Telephone 3

This section provides general instructions for connecting most auxiliary equipment.

1. Connect one end of the cord packaged with the auxiliary equipment (usually a D4BU cord) to 
the auxiliary equipment. See the documentation packaged with the auxiliary equipment for 
instructions.

2. Check the system form for the auxiliary equipment you want to connect. Then refer to the 
appropriate step below.

■ To connect auxiliary equipment to an MLX telephone, go to Step 3.

■ To connect auxiliary equipment to a single-line telephone, go to Step 4.

■ To connect auxiliary equipment to a 016 (T/R) module, go to Step 5.

When you connect auxiliary equipment to MLX telephones, make sure you route the auxiliary 
equipment and D8W telephone cords through the cord channel.

3. Insert the other end of the auxiliary equipment cord into the TEL/OTHER jack on the back of 
the MLX telephone. Go to Step 6. See Figure 3-23.

If you need to connect the auxiliary equipment differently from the instructions on the 
system forms, record each jack and auxiliary equipment change on the appropriate 
system numbering form. See the System Planning guide.
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Figure 3-23. Routing the Cord(s) on an MLX Telephone

4. To connect auxiliary equipment to a single-line telephone:

a. Connect a 26A2 bridging adapter to the telephone.

b. Connect the cord from the auxiliary equipment to the bridging adapter.

c. Reconnect the cord from the control unit to the bridging adapter.

d. Go to Step 6.

5. Insert the other end of the auxiliary equipment cord directly into the port for the logical ID on 
the 016 (T/R) module as indicated on the system form. Go to Step 6.

6. Test the auxiliary equipment by dialing its associated extension. 
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Installing Direct Station Selectors on an 
MLX Telephone 3

The Direct Station Selector (DSS) is an optional piece of telephone equipment. You can connect 
up to two DSSs to an MLX-28D or MLX-20L telephone that is programmed as an operator console.

Considerations 3

Review the following items before you begin the installation procedure.

■ Connect the DSSs before you assemble the MLX telephones.

■ Auxiliary power is required under the following circumstances:

— An MLX telephone with an MFM and two DSSs requires a 406743419 power unit. 

— An MLX telephone without an MFM, but with two DSSs, requires a 406943837 power unit, 
400B adapter, and the D6AP cord provided with the MFM.

— An MLX telephone with one DSS and an MFM requires a 406943837 power unit, 400B 
adapter, and the D6AP cord provided with the MFM.

— If one carrier has three or more MLX telephones, each with a DSS attached, use a 
406943837 power unit, 400B adapter, and D6AP cord for each MLX telephone and DSS 
after the first two.

■ The total length of cords between the KS22911-L2 or 406743419 power supply and the MLX 
telephone must not be more than 50 feet (15 m).

■ Do not replace the 2-foot (61-cm) D8AC cord (packaged with the DSS) with a longer cord. 
Improper operation may result.

■ Connect each KS22911-L2 power supply to an AC outlet that is not controlled by a wall switch.

To connect a DSS, follow the steps below. If you are connecting two DSSs to the telephone, 
unpack the second DSS before you start.

1. Adjust the angle of the DSS.

■ The DSS is packed fully assembled with the deskstand in the low position. If you prefer the 
low position, go to Step 2.

■ To adjust the angle of the DSS to the high position:

a. Place the DSS face down on a flat surface.

b. Press on the top rear center of the stand to release the tab; then pull the stand toward 
you and away from the DSS.

c. Insert the tab at the bottom of the stand into the other slot.

d. Lower the stand and press the tab at the top into the corresponding slot on the DSS.

2. Install the D8AC cord on the DSS.

a. Plug one end of the D8AC cord into the IN jack on the DSS.

b. Route the D8AC cord through the cord channel on the left side of the DSS.
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c. If you are installing only one DSS, go to Step 4. If you are installing two DSSs, repeat 
Steps 1 and 2 for the second DSS; then go to Step 3.

3. Wire the two DSSs. See Figure 3-24.

a. Place the two DSSs side by side and face down.

b. Route the D8AC cord from the IN jack on the second DSS (DSS2) through the cord 
channel on the first DSS (DSS1).

c. Plug this D8AC cord into the OUT jack on DSS1.

Figure 3-24. Connecting One or More DSSs

4. Wire the telephone to the DSS unit(s). See Figure 3-25.

a. Remove the handset from the telephone, then place the telephone face down on a flat 
surface to the right of the upside-down DSS unit(s).

b. Plug the D8AC cord from the IN jack on the DSS1 into the DSS jack on the telephone; 
then route the cord through the cord channel.

c. Plug the D8W line cord into the LINE jack on the MLX telephone. The D8AC and D8W 
cords share the cord channel on the telephone.
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Figure 3-25. Wiring for Auxiliary Power 

5. Turn the telephone and the DSS unit(s) face up with the telephone now to the left of the DSS 
unit(s). See Figure 3-25.

6. Insert one end of the coiled H4DU handset cord into the handset and the other end into the 
jack on the side of the telephone.

7. If auxiliary power is not required, plug the D8W cord into the wall jack and then go to Step 9.

8. If auxiliary power is required, refer to the following steps and Figure 3-25. The combined total 
length of the D6AP and D8W cords you use must not be more than 50 feet (15 m).

a. Plug the D8W cord from the telephone into the 8-conductor modular jack of the 400B or 
400B2 adapter.

b. Connect one end of the D6AP cord to the 2-conductor (small) modular jack on the 400B or 
400B2 adapter, and plug the other end of the D6AP cord into the modular jack of the 
406943837 or 406743419 power supply.

CAUTION:

Do not plug the D6AP cord into the 8-conductor (large) modular jack of the 400B or 
400B2 adapter. Doing so can cause electrical damage to the control unit and to the 
telephone.

c. Insert the plug end of the 400B or 400B2 adapter into the wall jack.

d. Plug the power supply into a 117 V AC outlet.

9. Label the DSS designation cards.

a. Pull the tab at the top of the large plastic cover and rotate the cover towards you.

b. Remove the cover and the large designation card.
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c. Write or type the button assignments on the card. (For DSS1, use the side that is labeled 
00–49; for DSS2, use the side labeled 50–99.)

d. The button assignments on the designation card should be by dial plan extension number, 
not by logical ID port number.

e. Replace the card and the plastic cover; make sure the coated side of the cover is facing 
up.

f. Repeat this step to remove the small plastic cover and to label the small designation card.

Assembling MLX Telephones 3

You must assemble an MLX telephone before connecting it to the control unit.

Considerations 3

Review the following items before you begin the procedure:

■ MLX telephones are packed with the deskstand in the low position. You can use the deskstand 
as is, raise it to a higher angle, or remove it. To adjust or remove the stand, see Step 1 of the 
following instructions. (The diagram on the bottom of the user card tray also shows how to 
adjust the stand.)

■ You cannot wall-mount MLX-20L and MLX-28D telephones.

■ If you wish to wall-mount an MLX-5, MLX-5D, MLX-10, MLX-10D, MLX-10DP, or MLX-16 DP 
telephone, you must remove the deskstand first. (Wall-mounting an MLX-5D, MLX-10D, MLX-
10DP, or MLX-16DP telephone can make the display hard to read.)

■ A 630B Phonemount (not included) is also required to mount an MLX-5, MLX-5D, MLX-10, 
MLX-10D, MLX-10DP, or MLX-16DP telephone on the wall.

■ To connect auxiliary equipment (such as an alert, modem, or fax machine) to an MLX 
telephone, the telephone must have an MFM installed in it. If you have not already done so, 
see ‘‘Installing Multi-Function Modules’’ on page 3-9.

If the MLX telephone attached to the DSS is unplugged from the control unit and then 
plugged in again, the display on the telephone may disappear. Press the Home button to 
bring back the display. 
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To assemble an MLX telephone, follow the steps below.

1. Remove or adjust the deskstand. See Figure 3-26.

■ If you want to leave the deskstand in the low position, go to Step 2.

■ If you want to adjust the angle of the deskstand, or remove it in order to wall-mount the 
telephone: 

a. Place the telephone face down on a flat surface.

b. Press on the top rear center of the deskstand to release the tab; then pull it up towards 
you. 

c. Insert the tab into the slot in the module cover to adjust the height.

d. To remove the deskstand, continue to pull it up and away from the telephone.

e. Release the deskstand from the front slot. 

Figure 3-26. Adjusting or Removing the Deskstand

Pull Up
and
Away

Press
Center Tab
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2. Connect the line cords. See Figure 3-27.

a. Plug one end of the D8W cord into the LINE jack on the bottom of the phone.

b. Route the D8W cord through the cord channel on the back of the telephone.

c. If the telephone is for desktop use, turn it face up and plug the D8W cord into the wall jack.

d. Insert the other end of the coiled H4DU handset cord into the jack on the side of the 
telephone. 

Figure 3-27. Connecting the Line Cords

3. Connect the handset by inserting one end of the coiled H4DU handset cord into the handset.

4. Label the extension identification card.

a. Insert a straightened paper clip into the hole on the side of the plastic cover while holding 
your finger on the opposite edge; use the paper clip to push and lift the cover. See 
Figure 3-28.
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Figure 3-28. Removing the Extension Label 

b. Type or write the assigned extension number on the card. See Figure 3-29.

Figure 3-29. Labeling the Extension

c. If you are wall-mounting an MLX-10, MLX-10D, or MLX-10DP telephone, go to Step 5. If 
you are assembling a desk telephone, go to Step 6.

5. Prepare the handset holder for wall-mounting.

a. Remove the handset holder by pushing it up and pulling it out. See Figure 3-30.
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Figure 3-30.  Removing the Handset Holder

b. Rotate the handset holder 180 degrees and replace it in its slot. See Figure 3-31.

Figure 3-31. Rotating the Handset Holder

6. Replace the extension label and plastic cover.

a. Insert one end into the slot and snap the other end into place. See Figure 3-32.

b. If you are mounting an MLX-5, MLX-5D, MLX-10, MLX-10D, MLX-10DP, or MLX-16DP wall 
telephone, go to Step 7. If you are assembling a desk telephone, go to Step 8.
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Figure 3-32. Replacing the Extension Label

7. Wall mounting an MLX-5, MLX-5D, MLX-10, MLX-10DP, MLX-10D, or MLX-16DP telephone. 

a. Turn over the telephone and remove the jack guard from the TEL/OTHER jack area; set 
the telephone aside.

b. Unpack the 630B Phonemount and remove the modular jack from the backplate.

c. Route the D8W cord (or DIW cable) through the hole in the backplate and have it exit at 
the top of the backplate; leave 10 inches (25 cm) of cord to connect the telephone. See 
Figure 3-33.

d. Attach the backplate to the wall; see the instructions provided with the 630B Phonemount.

e. Insert the two short screws provided with the Phonemount into the mounting plate. Be 
sure to thread the upper screw through the jack guard. See Figure 3-33.
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Figure 3-33. Mounting the Backplate

f. Plug the free end of the cord into the LINE jack on the back of the telephone. Route the 
cord through the cord channel above the jack. See Figure 3-34.

g. Position the telephone on the mounting plate studs and then slide the telephone down to 
lock it in place. To remove the telephone, slide it up and off.

Jack Plug

Mounting Plate

630B
Phone
Mount

Jack Guard
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Figure 3-34. Routing the Cord Through the Backplate

8. Label the button assignment card.

a. Pull the tab at the top of the plastic cover toward you.

b. Type or write the button assignments on the card.

c. Insert the card and replace the plastic cover. Be sure the textured side of the cover is 
facing you.

9. Adjust the contrast on the telephone’s display.

■ For an MLX-20L telephone, slide the lever on the top of the telephone.

■ For an MLX-5D, MLX-10D, MLX 10DP, MLX-16DP, or MLX-28D telephone, press the 
Menu button and select Cntrst; follow the display prompts. 

D8W

Mounting 
Plate
630B
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Connecting Telephones to the Control Unit 3

The way you connect telephones to the control unit depends on the number of telephones you are 
connecting. For 24 telephones or less, use a direct connection. For 25 telephones or more, use 
cross-connect fields.

For building cross-connect fields, use one of the following wiring kits:

■ Interconnect Wire. This complete wiring kit contains 110 jack-panel blocks, a template, wiring 
troughs, D-rings, and D8W cords.

■ Systimax. This complete wiring kit contains 110 termination blocks with modular jacks, a 
110A field-termination block, a template, wiring troughs, D-rings, and patch cords.

Considerations 3

Review the following items before you begin the procedure:

■ If the way you connect the telephones differs from the instructions on the system forms, record 
each jack and telephone change on Form 2a, System Numbering: Extension Jacks.

■ If you use staples to attach the cords to walls or baseboards, make sure you do not pierce the 
cords.

■ If a 4400-Series or MLX telephone is in a different building from the control unit, and is within 
1000 feet (305 m) of the control unit, connect the telephone to the control unit, using two In-
Range Out-of-Building (IROB) protectors.

Make sure you use the correct IROB protector each specific type of telephone (4400-Series 
and MLX telephones).

See the documentation packaged with the IROB protector for complete installation 
instructions.

■ If a single-line telephone is 1000 feet (305 m) or further from the control unit, connect the 
telephone to the control unit using an Off-Premises Range Extender (OPRE).

See the documentation packaged with the OPRE for complete installation instructions.
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CAUTION:

Take extreme care to make sure that you connect 4400-Series telephones only to the 
024 TDL module and MLX telephones only to MLX modules; a mismatch could damage 
the ports and cause them to stop functioning.

Incorrect wiring can result in users not being able to place outgoing calls. Make sure you 
use the proper cord. For all LS modules:

■ Use a D2R cable from an RJ11 jack. 

■ Do not use the Brand-Rex Quad cable from an E66 block.

If you cannot avoid using the Brand-Rex Quad cable, reverse the tip and ring 
leads at the E66 block to correct the mismatch. 

■ To avoid introducing power supply noise into system wiring, allow at least 3 inches 
(7.62 cm) of clearance between the basic carrier’s power supply and any wiring or 
termination hardware located to the left of the control unit. 

WARNING:

National and local building codes specify the type of cable required for 
telecommunication wiring. For example, indoor wiring (DIW cable) cannot be used inside 
or on top of air plenums or ducts, along hot pipes, or across walkways. 

Consult your local ordinances and regulations for proper cable selection.
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Installing Music-On-Hold and Magic On 
Hold 3

You can connect a Music-On-Hold device to an LS line/trunk jack programmed for Music-On-Hold. 
The system supports one such connection, either Magic On Hold or a customer-owned music 
source. The external music coupler (PEC 61398) uses an 8-ohm music source and two 
attenuation controls for setting the music level.

Figure 3-35 and Figure 3-36 show different background music configurations with single-zone and 
multizone paging.

PagePac Plus equipment can be used with a loudspeaker system to provide music. Or it 
can provide paging without a music coupler.

If the equipment uses rebroadcasted music or other copyrighted materials, the customer 
is required to obtain a copyright release and may also require a copyright license from, 
and pay license fees to, a third party, such as the American Society of Composers, 
Artists, and Producers (ASCAP), or Broadcast Music Incorporated (BMI). To bypass the 
release and license requirement, the customer can purchase a Magic On Hold system 
from Lucent Technologies, which does not require such a license. 
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Figure 3-35. Single-Zone Paging with Background Music and Magic On Hold
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Figure 3-36. Multizone Paging with Background Music, Magic On Hold, and 
Bidirectional Paging (Talk-Back) 
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Connecting a Printer to the Control Unit 3

Before you connect a printer to the control unit for the printing of Station Message Detail Recording 
(SMDR) reports, determine the distance from the control unit to the printer. Follow the appropriate 
procedure below according to that distance.

Connecting a Printer Within 50 Feet (15.2 m) 3

If the printer is within 50 feet (15.2 m) of the control unit and is connected to the same 117 V AC 
branch as the control unit, use this procedure to connect a printer to the control unit.

You need the following hardware for this procedure:

■ Z200A EMI filter

■ Adapter for the connector on the interface cable

— 355A for a male connector

— 355AF for a female connector

To connect a printer within 50 feet (15.2 m), follow the steps below. Refer to Figure 3-37.

1. Plug the short end of a Z200A EMI cord into the SMDR jack on the control unit.

2. Plug the other end of the Z200A EMI cord into a 355AF or 355A adapter.

3. Plug the female end of the adapter into either the 25-pin male connector on the printer’s 
interface cable or the serial port on the printer.

4. Set the appropriate printer options for SMDR. See “Setting Printer Options and DIP Switches” 
on ‘‘Setting Printer Options and DIP Switches’’ on page 3-49 for instructions.
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Figure 3-37. Connecting a Printer Within 50 feet (15.2 m)

Connecting a Printer 50 Feet (15.2 m) or More Away 3

Use this procedure to connect a printer to the control unit if the following conditions apply:

■ The printer is 50 feet (15.2 m) or more from the control unit.

■ The printer is not grounded to the same AC outlet as the control unit. The printer is not 
grounded to an outlet that is on the same 117 V AC branch as the control unit and that is 50 
feet (15.2 m) or closer to the control unit.

You need the following hardware for this procedure:

■ Z200A EMI filter

■ Adapter for the interface cable connector

— 355A for the male connector

— 355AF for the female connector

— 400B2 power adapter

■ Z3A2 ADUs

■ BR1A-4P adapter or 102 connecting block or 103 connecting block

If you are installing the printer in a different room than the control unit, make sure that 
both locations have working wall outlets and wall jacks, and that the building wiring 
has been connected so that the wall jacks in each location communicate with each 
other.
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■ 8-position wall jacks

■ EIA crossover cable

■ ADU crossover cable

■ 2012D transformer

■ 248B adapter

■ D8W cords

■ D6AP power cord

■ EIA-232-D cable

■ 4-pair plug-ended cable

To connect a printer 50 feet (15.2 m) or further away from the control unit, follow these steps (see 
Figure 3-38):

1. Plug the short end of a Z200A EMI cord into the SMDR jack on the control unit.

2. Plug the other end of the Z200A EMI cord into a 355AF adapter.

3. Plug the female end of the 355AF adapter into one end of an EIA crossover cable.

4. Plug the other end of the EIA cable into the 25-pin male connector of the Z3A2 ADU.

CAUTION:

If the printer is in a building outside the main building (control unit location), you must 
install an ADU and an additional protector in each building. The ADUs and protectors 
provide both the control unit and the printer with additional protection against lightning, 
inadvertent contact with power lines, and power currents induced by nearby power lines. 
See the installation notes packaged with the ADU for more information.

5. Plug one end of a D8W cord into the WALL jack on the Z3A2 ADU.

6. Plug the other end of the D8W cord into an ADU crossover cable.

7. Plug the other end of the ADU crossover cable into one of the jacks on a 400B2 power 
adapter.

8. Plug one end of a D6AP cord into the other jack of the 400B2 adapter.
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Figure 3-38. Connecting a Printer More Than 50 feet (15.2 m) Away

9. Plug the other end of the D6AP cord into the 2012D-50M transformer. If you are working with a 
248B adapter and 2012D transformer instead of a 2012D-50M transformer, plug the D6AP 
cord into the jack on the 248B adapter, and then connect the spade-tip wires on the 248B 
adapter to the screws on a 2012D transformer. See Figure 3-39.
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Figure 3-39. Connecting the 248B Adapter and the 2012D Transformer

10. Plug the 400B2 adapter into a wall jack, BR1 A-4P adapter, 102 connecting block, or 103 
connecting block.

11. Complete the 400B2 connection.

■ If the 400B2 is plugged into a wall jack, make sure that building wiring has been set up so 
that the wall jack for the control unit can communicate with the wall jack for the printer.

■ If the 400B2 is plugged into a BR1A-4P adapter, 102 connecting block, or 103 connecting 
block, use 4-pair plug-ended cable to connect the BR1A-4P adapter (or connecting block) 
to the wall jack for the printer.

12. On the printer side, plug one end of a D8W cord into the wall jack and the other end into the 
WALL jack on the Z3A2 ADU.

13. Plug one end of an EIA-232-D cable into the 25-pin male connector on the Z3A2 ADU and the 
other end into the serial port on the printer.

14. Plug the 2012D-50M (or 2012D) transformer into a wall outlet.

15. Set the appropriate printer options for SMDR. See ‘‘Setting Printer Options and DIP Switches’’ 
on page 3-49 for instructions.
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Setting Printer Options and DIP Switches 3

If the customer has a Lucent Technologies 572, Lucent Technologies 475/476, or Lucent 
Technologies Applications printer, use this section to set up printer options. If another type of serial 
printer is being used, review these setup options for guidance and consult the manual for the 
printer. Use the information below to determine the correct printer setting for the printer:

■ For the 572 printer, set the options on the printer according to Table 3-1. (See the user’s guide 
supplied with the printer for more information.)

■ For the 475/476 printer, set the DIP switches on the printer according to Table 3-2 on page 
3-50. (See the user’s guide supplied with the printer for more information.)

■ For the Applications printer, set all the DIP switches on the printer to off. (See the user’s guide 
supplied with the printer for more information.)

Table 3-1. Lucent Technologies 572 Printer Options

No. Function Menu Status

01 FORM LENGTH 09 11

02 LPI 01 6

03 CPI 01 10

04 LQ or NLQ 01 LQ

05 BUZZER 01 ON

06 FONT 01 BUILT-“IN”

07 RESOLUTION 01 144

11 BUFFER 02 ON-“LINE”

13 PW ON MODE 01 ON-“LINE”

14 DIRECTION 01 BI-DIR. 1

15 BUFFER FULL 02 LF + CR

16 P.E. 01 ACTIVE

17 AUTO CR 01 CR + LF

18 ZERO 01 0

22 AUTO LF 01 CR ONLY

31 1" SKIP 01 OFF

32 CHAR. SET (G0, GL) 02 USA

33 CHAR. SET (G1, GR) 01 UK

34 CHAR. SET (G2) 03 GE

35 CHAR. SET (G3) 0 “LINE” DRAWING

81 OFF- “LINE” STATE 01 ALL RECEIVE

82 DSR 02 OFF

83 RTS TIMING 01 RTS

84 CD 02 OFF

85 CTS 02 OFF
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Connecting a PC to the Control Unit 3

See System Programming for instructions about connecting a personal computer to the control 
unit.

91 OVER RUN 02 256

92 DATA BIT 02 8

93 PROTOCOL 03 XON/XOFF1

94 STOP BIT 01 2

95 PARITY O1 NON

96 BPS 04 1200
1 This is the default status, but the system cannot read the character sent by the printer.

Table 3-2. Lucent Technologies 475/476 Printer DIP Switch Settings 1

1 Open = off; Closed = on

Switch 1 Switch 2 Switch 21

DIP 1-Open DIP 1-Open DIP 1-Open

DIP 2-Closed DIP 2-Open DIP 2-Open

DIP 3-Open DIP 3-Open DIP 3-Open

DIP 4-Open DIP 4-Open DIP 4-Closed

DIP 5-Closed DIP 5-Open DIP 5-Open

DIP 6-Closed DIP 6-Open DIP 6-Open

DIP 7-Closed DIP 7-Closed DIP 7-Open

DIP 8-Open DIP 8-Open DIP 8-Closed

Switch 22 Switch 23 Switch 24

DIP 1-Open DIP 1-Closed DIP 1-Open

DIP 2-Closed DIP 2-Open DIP 2-Closed

DIP 3-Closed DIP 3-Open DIP 3-Closed

DIP 4-Open DIP 4-Open DIP 4-Open

DIP 5-Closed DIP 5-Open

DIP 6-Open DIP 6-Closed

DIP 7-Open

DIP 8-Closed

Table 3-1. Lucent Technologies 572 Printer Options— Continued

No. Function Menu Status
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4Connecting the Control Unit to the 
Network Interface 4

The way you connect the control unit to the network interface depends on the type of network 
interface that is installed. While there are many ways you can do this, the methods discussed in 
this chapter are usually best.

CAUTION:

The local telephone company is responsible for providing appropriate protection for 
central office trunks. Do not connect the central office trunks until you are certain that 
they are properly protected. See ‘‘Central Office Trunk Protection’’ on page 2-11 for 
details.

To avoid coupling power supply noise onto system wiring, allow at least 3 inches (7.62 
cm) of clearance between the basic carrier’s power supply and any wiring or termination 
hardware located to the left of the control unit.

If the network interface is greater than 25 feet (7.62 m) from the control unit, connect the 
control unit to the network interface, using an Off-Premises Range Extender (OPRE). 
See the documentation packaged with the OPRE for complete installation instructions.

If you use staples to attach the cords to walls or baseboards, make sure you do not 
pierce the cords.

National and local building codes specify the type of cable required for 
telecommunications wiring. For example, you cannot use indoor wiring (DIW) cable 
inside or on top of air plenums or ducts, along hot pipes, or across walkways. Consult 
your local ordinances and regulations for proper cable selection.

Wiring 4

The local telephone company should have installed the network interface (the central office trunks) 
already. Before you install the system, verify that the network interface is the proper type and that it 
is within 25 feet (7.6 m) of the control unit. If the network interface is more than 25 feet (7.6 m) from 
the control unit, make sure you have an OPRE.
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The adapter you need to connect the central office trunks to the control unit depends on the type of 
network interface installed, as shown in Table 4-1. 

After installing the adapter, label each jack that connects a central office trunk to the control unit 
with the trunk’s number. Use the list provided by the local telephone company.

In most installations, the network interface is connected through a cross-connect field to the 
control unit. However, for systems with fewer than 24 extensions, you can connect the trunk wires 
directly to the control unit.

When constructing wiring fields between the network interface and the control unit, you must order 
hardware as individual parts. Do not use Interconnect Wiring or Systimax wiring kits.

RJ21X Interface 4

The RJ21X network interface has a female 50-pin (25-pair) amphenol connector, as shown in 
Figure 4-1.

Table 4-1. Network Interfaces

Network
Interface Description Adapter

RJ11 Connects one outside ground-start (GS), 
loop-start (LS), or Direct Inward Dial (DID) 
trunk to one modular jack.

RJ14 Connects two outside trunks to one 
modular jack (GS, LS, or DID).

2-line adapter (267C-type)

RJ21X 50-pin connector connects 25 110AB1 
jack-panel block to outside trunks (GS, LS 
or DID).

110AB1 jack-panel block

RJ2GX 50-pin connector for up to eight tie trunks. 356A for eight or fewer tie 
trunks; 259A for one tie trunk

The E1 cable has a modular jack at one end and a BNC connector at the other. If the 
BNC connector is not appropriate for the network interface provided by the central office, 
cut the BNC connector end of the cable and set up a twisted-pair connection, using the 
transmit-and-receive pairs.

On the modular jack, the transmit pair is associated with pins 4 and 5 (the green and red 
wires). The receive pair is associated with pins 1 and 2 (the grey and brown wires).

If you need to connect the trunk cords differently from the instructions on the system 
forms, record each change on Form 2c, System Numbering: Line/Trunk Jacks. 



Connecting the Control Unit to the Network Interface

Wiring

4-3

To connect the RJ21X interface to the control unit, you must build a wiring field between the RJ21X 
interface and the control unit using a 66-type block (RJ21). This field converts the female 
amphenol connector to sets of four 1-pair modular jacks.

Figure 4-1. RJ21X Network Interface Connector

Building the Wiring Field 4

Build the wiring field between the network interface and the control unit by using 110AB1-100JP12 
termination blocks with modular jacks and associated hardware. Figure 4-2 shows the hardware 
you need, including 110AB1-100JP12 termination blocks with modular jacks, 110A1 wire troughs, 
D-rings, and D2R cords.
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Figure 4-2. RJ21X Wiring Field Hardware

To connect the RJ21X network interface to the control unit, follow the steps below. Figure 4-3 
shows the tools you need. 

1. For each piece of hardware, drill two diagonally opposite holes into the backboard, allowing for 
a 1/16-inch (1.6 mm) space between each piece of hardware.

2. Mount the wire troughs and the termination blocks. There is a wire trough above and below 
each termination block.

3. If necessary, repeat Steps 1 and 2 for a second column.

4. Run the 25-pair amphenol cable on the RJ21X interface to the termination blocks. If more 
length is needed, use an A25D male-connector, single-ended, 25-pair, nonplenum cable.

5. Mount the D-rings to properly dress the wires, as needed.

6. Cut off the amphenol connector nearest to the cross-connect field and strip the wires for each 
of the 25 pairs.

110AB1-100JP12 Terminal Block

110A1 Wire Trough

D-Ring

110 AB1-100FT
Field Terminal Block
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Figure 4-3. RJ21X Wiring Field Tools 

7. Punch down the 25-pair wires to the termination block.

a. Route the wires through the fanning slots on the termination block.

b. Insert the conductors into the designated 110 connecting blocks already on the 
termination block.

c. Use the D-impact tool to seat the conductors. See Figure 4-4.

d. Remove any insulation fragments with a spudger.

AT-8762 D 
Impact Tool

Spudger

788 K1 Retainer 
Tool

110 Impact Tool 
788J1

Modular Plug Pressers
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Figure 4-4. Using the D-Impact Tool to Seat the Conductors

8. Test the central office trunks for proper connection. See ‘‘Testing Trunks’’ on page 4-9 for 
instructions.

9. Label the network interface jacks, control unit module jacks, termination blocks, and D2R 
cords. See ‘‘Labeling Trunks’’ on page 4-10 for instructions.

10. For each trunk, plug one end of a D2R cord into the designated jack on the termination block 
and the other end into the line/trunk jack on the proper control unit module.

CAUTION:

Do not plug a 4400-Series telephone, an MLX telephone, or anything else that should be 
plugged into an extension jack into this wiring field: doing so will busy-out the trunk.

RJ11 and RJ14 Interfaces 4

RJ11 and RJ14 interfaces are connected to the control unit similarly. However, note the following 
differences:

■ RJ11 connects one central office trunk per jack.

■ RJ14 connects two trunks per jack.

Plug a 267C-type adapter into each RJ14 jack. You need D2R cords for RJ11 jacks. See 
Figure 4-5.

The modular jacks on the termination block are 8-wire jacks. The D2R cords, which 
are 6-wire, also plug into the 8-wire jacks.

D-Impact Tool
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Figure 4-5. RJ11 and RJ14 Interfaces

CAUTION:

Incorrect wiring can damage the ports and cause them to stop functioning. Make sure 
you use the proper cords. For all GS/LS modules, do the following:

— Use a D2R cable from an RJ11. 

— Do not use the Brand-Rex Quad cable from an E66 block. 

— If you cannot avoid using the Brand-Rex Quad cable, reverse the tip and ring 
leads at the E66 block to correct the mismatch. 

To connect the RJ11 and RJ14 network interfaces to the control unit, follow the steps below:

1. Test the central office trunks for proper connection. See ‘‘Testing Trunks’’ on page 4-9 for 
instructions.

2. Label the network interface jacks, the control unit module jacks, and the D2R cords properly.
See ‘‘Labeling Trunks’’ on page 4-10 for instructions.

3. Plug one end of a D2R cord into the jack at the network interface and the other end into the 
appropriate line/trunk jack on the control unit.

4. Dress the wires properly.

Single-Line Adapter (RJ11)

2-Line Adapter (RJ14)

(267C)
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RJ2GX Interface 4

The RJ2GX is a 25-pair amphenol interface that connects up to 8 tie trunks. Construct the cross-
connect field in the same way you did for the RJ21X interface. 

RJ21X and RJ2GX interfaces do not require separate termination blocks. If there is room on the 
termination block for the trunk wires, you can punch down both the RJ21X and the RJ2GX on the 
same 110AB1-100JP12 block. Leave any unused wires unterminated.

CAUTION:

Be careful not to connect tie trunks to LS or DID ports. Since all the jacks on the 
termination block are 8-wire jacks, it is possible to interchange tie trunk wires with LS or 
DID wires accidentally.

Removing Damaged Connecting Blocks 4

In some cases, a connecting block becomes damaged and must be removed.

To remove a damaged connecting block, follow the steps below (see Figure 4-6):

1. Remove the wires or the patch cord from the connecting block.

■ If you have Interconnect Wiring, use long-nosed pliers to remove the telephone wires, and 
tag the wires with tape to identify their positions.

■ If you have Systimax wiring, pull off the patch cord.

2. Place a 788K1 retainer tool against the conductor pairs beneath the connecting block to be 
removed.

3. Use pliers to grip the connecting block in the center.

4. Move the block gently up and down and pull it out. 

5. If a conductor wire is accidentally pulled from a block, pull it with the long-nosed pliers to get 
some slack. Use your fingers to lay the conductor wire back in its slot in the index strip, and 
then reseat it with the D-impact tool.

6. Seat the new connecting block by using the 788J1 impact tool.

7. Replace the telephone wire onto the connecting block.

■ If you have Interconnect Wiring, remove the tag from the telephone wires and use the 
D-impact tool to reseat the wires.

■ If you have Systimax wiring, attach the patch cord to the connecting block.
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Figure 4-6. Removing the Connecting Block

Testing Trunks 4

Before you connect the central office trunks to the control unit, verify that there is dial tone and that 
you can dial out on every trunk. DID trunks can be tested only through the control unit. Do not test 
DID trunks at this time.

CAUTION:

Do not use 4400-Series telephones or MLX telephones for testing. They do not work for 
these tests and can be damaged if you use them for this purpose.

Pliers
788 K1
Retainer Tool
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Testing Loop-Start Trunks 4

To perform this test, you need a single-line telephone or an installer’s test telephone (craft set). If 
you are installing rotary-dial trunks, use a rotary telephone to perform this test.

To test loop-start trunks, follow the steps below:

1. Plug the single-line telephone or the craft set into each central office line/trunk jack (either at 
the network interface or at the cross-connect field) and listen for dial tone.

2. If you find a central office trunk that does not have dial tone, check for a bad adapter or loose 
connection. If adapters and wiring are in working order but you still do not hear a dial tone, 
notify the Lucent Technologies Service Center acting as the customer’s agent.

3. When you hear a dial tone, dial a known telephone number to verify dialing. After the central 
office completes the connection, check that you have good two-way transmission.

4. If you cannot dial out on any of the trunks, notify the Lucent Technologies Service Center 
acting as the customer’s agent. It is the customer’s responsibility (or that of the customer’s 
agent) to report service outages to the local telephone company.

Labeling Trunks 4

You can have up to 80 central office line/trunk jacks on the system. This procedure describes how 
to label each D2R or D8W cord, network interface jack, and control unit module jack.

To label trunks, follow the steps below:

1. Review System Form 2c, System Numbering: Line/Trunk Jacks to determine each central 
office trunk assignment on the control unit.

2. Place a green cord label at each end of every D2R or D8W cord. (These labels are packaged 
with the basic carrier.) The green label indicates the number of the central office line/trunk jack 
to which the cord is connected.

3. Label the jacks on the termination blocks.

4. Leave a copy of System Form 2c in a secure place near the control unit. 
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5Initializing and Testing the System 5

When you have finished installation, you are ready to initialize and test the system as described in 
this chapter.

Initializing the System 5

To initialize the system, use one of the following methods:

■ Restore from a MERLIN MAGIX™ Release 1.0i system programming disk or Translation 
memory card.

■ Use the system programming forms and the System Programming guide.

Restoring from the Translation Memory Card 5

If you received the MERLIN MAGIX Release 1.0i Translation memory card, follow the steps below 
to initialize the system:

1. Perform a System Erase (frigid start).
See Chapter 6, “Maintenance and Troubleshooting,” for detailed instructions.
Console Procedure:Menu: Maintenance→Slot→Dial or Type 00→Enter→Demand 
Test→System Erase (Line 5, left button) twice→Yes 

2. Use the programming console and the translation memory card to perform the Restore 
procedure. See System Programming for instructions.

On initial installations, make sure you perform a System Erase (frigid start), as described 
in Chapter 6, “Maintenance and Troubleshooting,” either immediately before you restore 
from a disk or memory card or before you program the system. Failure to perform the 
System Erase (frigid start) can result in incorrect programming.
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Restoring from the System Programming Disk 5

If you received the MERLIN MAGIX Release 1.0i system programming disk, follow the steps below 
to initialize the system:

1. Perform a System Erase (frigid start).
See Chapter 6, “Maintenance and Troubleshooting,” for detailed instructions.
Console Procedure:Menu: Maintenance→Slot→Dial or Type 00→Enter→Demand 
Test→System Erase (Line 5, left button) twice→Yes 

1. Use WinSPM and the system programming disk to perform the Restore procedure.
See System Programming for instructions.

Setting the Time and Date 5

If the Control Unit Diagram indicates that you should set the time and date, do so before you test 
the system.

Follow this procedure: 

Menu: SysProg→System→Date→Drop→Dial current date→Enter 

See System Programming if you need additional instructions.

Testing the System 5

Once you have initialized the system, it is ready for system acceptance testing. Perform the basic 
tests below to test telephones, trunks, and features.

If any equipment is not working properly, see Chapter 6, “Maintenance and Troubleshooting,” for 
troubleshooting instructions.

You must restore the system by using either the system programming (or backup) disk or 
the memory card whenever a frigid start (System Erase) occurs.
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Testing 4400-Series Telephones 5

Use the following steps to check if the LEDs, ringer, buttons, switchhook, or display are working.

1. Pick up the handset. 

2. When you hear the dial tone, press *00 (the feature access code).

The telephone enters test mode. For some tests, this means the LEDs turn on; for others, it 
means the telephone starts ringing. 

■ This test connects a test tone to the B-channel and sends a repeated ring burst to the 
telephone.

■ On 4400, 4400D, and 4406D+ Telephones, and telephones with a DSS attached, all LEDs 
light and the telephone rings throughout the test.

■ On 4412D+, 4424D+, and 4424LD+ telephones, the left-most column of feature buttons 
that have associated LEDs light and the telephone rings periodically. To switch to another 
column of feature buttons that have associated LEDs, press a feature button in the column 
you want to select. 

3. Press each line/feature button (two LEDs each). 

The first press turns the red and green LEDs off. Subsequent presses should toggle the red 
and green LEDs on and off.

4. Press each fixed feature button that has an LED (Mute and Speaker). 

Each LED should toggle on and off.

5. Press each fixed-feature button or line/feature button that does not have an LED, and each 
dialpad button. 

When you press each one of these buttons, the Message LED should toggle on and off. 

6. Press the fixed-feature buttons and dialpad buttons in the order shown below to turn on all the 
LEDs.

a. Redial

b. Conference 

c. Transfer

d. Hold 

e. Dial 123456789*0# 

Mute and Speaker LEDs may not toggle consistently because they are managed by 
the control unit and the telephone. 

For 4412D+ telephones, pressing a fixed-feature button or line/feature button turns 
the current column of LEDs off (if lit), and toggles the Message Waiting Light (MWL) 
on and off.
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The LEDs should toggle on and off.

7. If the 4400-Series telephone does not have a display, hang up the telephone to end the test. If 
it does have a display, continue to the next step.

8. To test a 4400-Series telephone display, press each display button. 

Each button name should display in the upper-left corner.

9. If any of these tests fail, replace the telephone. 

Testing MLX Telephones 5

This switch-based software test verifies that the LEDs, ringer, buttons, switchhook, and B-channel 
operation for MLX telephones are working correctly. You cannot run this test when the telephone is 
in programming, forced-idle, or maintenance mode. When an MLX telephone is in test mode, the 
system considers it busy and therefore not available for use.

If you hang up during any of these procedures, test mode ends automatically.

Keep the following in mind when using the speakerphone:

■ If the Mute button is pressed before the Speaker button, the Mute LED cannot be turned off; it 
winks.

■ The Mute and Speaker LEDs remain steady during test mode.

■ The pressing of the Mute button is processed within the telephone.

■ When the telephone test is originated from the Speaker button, every second press of the 
Mute button causes the Mute LED to flash off momentarily. Also, both the Mute and Speaker 
LEDs may occasionally remain on after disconnecting with the Speaker button.

■ Press the fixed-feature buttons repeatedly to toggle the LEDs on and off.

To test the basic features of an MLX telephone, follow the steps below:

1. Pick up the handset of the telephone you are testing and push an ICOM button in Key or 
Behind Switch mode or an SA button in Hybrid/PBX mode.

2. When you hear dial tone, dial *00 to activate test mode.

You should hear a steady test tone over the handset and a ring burst over the speaker. The 
telephone’s red and green LEDs should be on.

3. To test the line buttons, press any line button with two LEDs (red and green).

The diagnostic tone should stop, and the LEDs for that button should go off.

4. Press the same line button repeatedly to toggle between the green and red LEDs. For a QCC, 
the display should show the name of the feature programmed on the button. 

5. To test a fixed-feature button with one LED, press the button.

The Feature and HFAI LEDs should turn off. The first press of the Speaker button should turn 
off the Mute LED. The second press of the Speaker button should turn off the Speaker LED.
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6. To test the red Message light, press a fixed-feature button without an LED (such as Transfer, 
Conf, or Drop) or any dialpad button.

The Message light should turn off.

7. Hang up the handset to leave test mode.

Testing MLX Display Telephones 5

While the MLX display telephone is in test mode, follow the steps below to test the display buttons:

1. Press each fixed display button (Home, Menu, Inspct, and More).

The display should spell out these button labels.

2. Press the unlabeled display buttons.

The display should indicate Display Button n, where n is the number of the display button, 
1 through 4.

Testing MLX Telephones with MFMs 5

You should test MLX telephones with MFMs for proper channel operation and test the MFM 
circuitry for the TTR, the ring generator, and the Message light.

To test an MLX telephone with an MFM installed and configured as a T/R adapter, follow the steps 
below:

1. Connect a working 2500-type single-line telephone with a Message light to the MFM adapter 
(the 2500 telephone also must have a mechanical ringer).

2. Pick up the handset and listen for dial tone. Dial *09.

You should hear another dial tone.

3. Press any button.

This deactivates the test tone.

4. Dial 123456789*0#. Press the switchhook quickly.

You should hear a confirmation tone.

5. Hang up.

The control unit should send a ring burst and the Message light on the 2500 telephone should 
turn on.

6. Turn off the Message light. Dial the appropriate feature code.
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Testing Telephones for Dial Tone 5

To test for dial tone, follow the steps below:

1. Press an ICOM or SA button (depending on the mode of operation).

The red LED next to this button should go on.

2. Press the Speaker button.

The green LED next to the ICOM or SA button should turn on; you should hear a dial tone, and 
the green LED next to the Speaker button should turn on.

3. Press the Speaker or ICOM or SA button again to disconnect intercom.

The green LEDs next to ICOM or SA and Speaker buttons should turn off and the dial tone 
should stop. The red LED remains on in some cases.

Testing Telephones for Outside Dial Tone 5

To test for outside line dial tone, follow the steps below:

1. Without lifting the handset, press one of the outside line buttons.

The red LED next to this button should turn on.

2. Pick up the handset or press the Speaker button.

The green LED next to the line button should turn on and you should hear a dial tone.

3. Hang up and repeat Steps 1 and 2 for each line button on the telephone.

Testing Single-Line Telephones 5

To test the basic operation of single-line telephones, follow the steps below:

1. Pick up the handset and wait for dial tone.

2. Dial the extension number of another working telephone.

You should hear ringback on your telephone and ringing at the called telephone.

3. At the called telephone, have someone pick up the handset; verify that you have good two-way 
communication.

4. At both telephones, hang up.
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Testing Loop-Start Trunks 5

To test the LS outgoing and incoming trunks at a telephone, follow the steps below:

1. Dial *03 followed by the trunk ID number (01 through 80).

You should hear dial tone for a working trunk, a reorder tone for a DID trunk or an invalid trunk 
number, or a busy tone if the trunk is in use.

2. Repeat Step 1 for all outgoing trunks.

3. Dial an incoming trunk on the system.

4. Have someone answer the call at another telephone; verify that you have good two-way 
communication.

5. Repeat Steps 3 and 4 for all incoming trunks.

6. Hang up to exit test mode.

Testing DID and Incoming DIOD Trunks 5

To test DID and incoming DIOD trunks, follow the steps below:

1. Have someone at the central office check all DID/DIOD trunks, or have someone call from the 
outside to check each DID/DIOD trunk.

2. When the first trunk rings, answer it.

3. Instruct the caller to put the call on hold or put down the handset while making the next call.

4. When the next trunk rings, put the previous call on hold and repeat this procedure until all DID/
DIOD trunks have been connected successfully.

5. When all trunks are connected with good communication, disconnect each call and have the 
caller do the same.

Dialing *03 on a single-line telephone works only if the telephone has a Touch-Tone 
dialpad and the trunk accepts Touch-Tone dialing.
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Testing Tie Trunks 5

Before you test tie trunks, make sure that the tie trunks for the system are connected and properly 
programmed. Have someone at the far end ready to place and receive calls throughout the testing 
procedures listed below.

The tie trunk testing procedures in this section are as follows:

■ Automatic-start two-way (both incoming and outgoing)

■ Automatic-start incoming only

■ Automatic-start outgoing only

■ Dial-repeating two-way (both incoming and outgoing)

■ Dial-repeating incoming only

■ Dial-repeating outgoing only

Testing Two-Way Automatic-Start Tie Trunks 5

For two-way automatic-start tie trunks, perform both the incoming and outgoing automatic-start tie 
trunk tests.

Before testing outgoing or two-way automatic-start tie trunks, have someone ready to take your 
call at the receiving telephone.

Testing Incoming Automatic-Start Tie Trunks 5

Perform this test for automatic-start tie trunks that are two-way or incoming only. If you are testing 
two-way automatic-start tie trunks, perform the outgoing test as well.

To test incoming automatic-start tie-trunks, follow the steps below:

1. At the far-end tie-trunk site, have someone pick up the handset and dial a tie trunk assigned to 
a button on your telephone.

Your telephone should ring and the LEDs next to the tie-trunk button should respond as 
follows: the red LED should turn on and the green LED should flash.

2. Pick up your handset and verify that you have good two-way communication.

The green LED should change from flashing to steady.

3. At both telephones, hang up.

The green LED should turn off, the red LED should turn off, and another red LED may turn on.

4. Repeat Steps 1 through 3 for all incoming and two-way automatic-start tie trunks.

Dial-repeating tie trunks are also called wink-, immediate-, and delay-type tie trunks. 
These terms are used in system programming to describe the type of signaling used 
on the trunk.
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Testing Outgoing Automatic-Start Tie Trunks 5

Perform this test for automatic-start tie trunks that are two-way or outgoing only. If you are testing 
two-way automatic-start tie trunks, perform the incoming test as well.

To test outgoing automatic-start tie trunks, follow the steps below:

1. At any telephone that has access to an automatic-start tie trunk, press the first tie-trunk button.

The red LED next to the tie-trunk button just pressed turns on.

2. Pick up the handset. (In Hybrid/PBX systems with pooled tie trunks, press an SA button and 
dial the pool dial-out code.)

The green LED next to the selected button turns on and you hear ringing.

3. When the person answers, verify that you have good two-way communication and hang up.

The green LED should turn off, the red LED should turn off, and another red LED may turn on.

4. Repeat Steps 1 through 3 for each outgoing and two-way automatic-start tie trunk.

Testing Two-Way Dial-Repeating Tie Trunks 5

For two-way dial-repeating tie trunks, perform both the incoming and outgoing dial-repeating tie 
trunk tests. 

Testing Incoming Dial-Repeating Tie Trunks 5

Perform this test for dial-repeating tie trunks that are two-way or incoming only. If you are testing 
two-way dial-repeating tie trunks, perform the outgoing test as well.

To test incoming dial-repeating tie trunks, follow the steps below:

1. Have the person at the far end place a dial-repeating call to your telephone by dialing the 
proper tie-trunk number.

Your telephone rings and the green LED next to ICOM (or SA for Hybrid/PBX systems) 
flashes.

2. Pick up the handset.

The red LED next to the ringing button turns on and the green LED changes from flashing to 
steady.

3. Verify that you have good two-way communication and hang up.

The green LED should turn off, the red LED should turn off, and another red LED may turn on.

4. Repeat Steps 1 through 3 for each incoming or two-way dial-repeating tie trunk.
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Testing Outgoing Dial-Repeating Tie Trunks 5

Perform this test for dial-repeating tie trunks that are two-way or outgoing only. If you are testing 
dial-repeating two-way tie trunks, perform the incoming test as well.

To test outgoing dial-repeating tie trunks, follow the steps below:

1. At any telephone that has access to a dial-repeating tie trunk, press the first tie-trunk button.

The red LED next to the pressed tie-trunk button lights.

2. Pick up the handset. (In Hybrid/PBX systems with pooled tie trunks, press an SA button and 
dial the pool dial-out code.)

The green LED next to the selected button lights.

3. Dial the tie-trunk number of the extension where someone is waiting for your call.

You should hear ringing.

4. When the person answers, verify that you have good two-way communication, then hang up.

The green LED should turn off, the red LED should turn off, and another red LED may turn on.

5. Repeat Steps 1 through 4 for each outgoing or two-way dial-repeating tie trunk.

Testing Selected System Features 5

This section provides procedures to test the following system features:

Automatic Route Selection (ARS). For Hybrid/PBX mode only. Use the same test for Idle Line 
Preference, a similar feature used in Key mode only. Use the same test for Station Message Detail 
Recording (SMDR), as explained in the test procedure. Refer to Planning Forms 3e, 3f, and 3g for 
ARS information.

Group Calling. Use the same test for the Listed Directory Number (the QCC queue), which is for 
Hybrid/PBX only. Use the same test for Group Paging. Refer to Planning Form 7d for Group 
Calling information.

Coverage. Refer to Planning Form 7c for Group Coverage information.

If any feature does not work properly, check system programming. You can run these tests easily 
from a 4400-Series or MLX telephone.

ARS and SMDR Tests 5

If ARS patterns have been programmed, you can test routing by placing toll calls and checking the 
trunk indicated on the SMDR printout. Check the report to see which line/trunk the system 
selected for an outgoing call.
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The length of each toll call must be equal to or greater than the minimum SMDR recording time. 
Otherwise, SMDR does not recognize the attempt as a call. To determine the minimum SMDR 
recording time, check with the customer’s System Manager (the factory setting is 40 seconds).

To verify ARS patterns, follow the steps below:

1. In Hybrid/PBX mode, determine which toll numbers to call by examining the System 
Manager’s ARS patterns.

2. At any multiline telephone, pick up the handset and dial the ARS access code and one of the 
toll numbers. Make sure the call is completed before hanging up.

3. Repeat Step 2 for additional toll numbers.

4. At the SMDR printer, verify that the call was made on the correct trunk group and check the 
number of seconds before the call is reported on the SMDR printout. If there are errors, check 
system programming.

Group Calling Test 5

To test Group Calling features, follow the steps below:

1. Make sure that each group member is logged into the group. 
To log in, each member dials #44.

2. At any telephone, pick up the handset and dial the trunk that is programmed to ring for a 
particular Calling Group.

3. At the ringing telephone, have someone pick up the handset and verify that you have good 
two-way communication.

4. Repeat Steps 2 and 3 for each Calling Group.

5. Make additional calls to check each member of each Calling Group.

6. At any telephone, pick up the handset and dial the group extension number. 

7. Test the Calling Group delay announcement (if provided) for each group.

a. Make the group busy or have all members log out of the group (by dialing #*44 at each 
group extension).

b. Repeat Step 2.

c. After listening to the delay announcement, hang up.

d. Repeat these steps for each group.

8. At the ringing telephone, have someone pick up the handset and verify that you have good 
two-way communication.

System Speed Dial Test 5

To test System Speed Dial numbers, follow the steps below:

1. Find out which numbers have been programmed for System Speed Dial. See the System 
Manager or use Form 10b as a reference for System Speed Dial numbers.
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2. From the test telephone, pick up the handset and dial a System Speed Dial code. Verify that 
you have good two-way communication and that the correct party was reached.

Coverage Test 5

To verify that coverage is in effect, follow the steps below:

1. Have someone call the covered telephone.

2. Count the number of rings at the covered telephone before the covering telephone starts 
ringing. This should be the same as the programmed number of rings.

3. Pick up the handset at the covering telephone and verify that you have good two-way 
communication.

4. Hang up the handset at the covering telephone.

5. Check both Individual and Group Coverage.

Testing the DSS 5

At each Direct Station Selector (DSS), check that all lights are operational. Then use the DSS to 
call a telephone in the system. Test the Page buttons on the DSS.

Testing Night Service 5

To test the Night Service feature on the system operator console, follow the steps below:

1. At the system operator console, press the Night Service button. If Night Service with Outward 
Restriction is programmed, you must also enter the password. (You can also activate Night 
Service on a DLC by pressing the Feature button and dialing 39.)

The Night Service LED turns on.

2. Pick up the handset and press a button for an outside trunk.

3. Dial the outside number that reaches an operator console that is programmed to receive Night 
Service coverage.

4. Verify that the telephones assigned to the Night Service group are ringing.

5. Have someone pick up the handset at a telephone in the Night Service group. Verify that you 
have good two-way communication.

6. At both telephones, hang up.

7. Repeat Steps 2 through 6 for each operator console that is programmed to receive Night 
Service coverage. 

8. Test telephones that are programmed for Night Service with Outward Restriction.

a. Pick up a handset on a restricted telephone and verify that outside calls are not allowed.

b. Using the password, make an outside call.
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c. Hang up the handset.

d. Press the Recall button and dial the password. (On an MLX telephone without a 
programmed Recall button, press the Feature button, and dial 775 and the password 
before picking up the handset.)

e. Pick up the handset and make an outside call.

f. Verify that you have good two-way communication and hang up.

9. At the operator console, press the Night Service button again. If you used a password in 
Step 1, enter the password again. Verify that the Night Service LED turns off.

Testing Music-On-Hold 5

To verify that music is provided to outside callers placed on hold, follow the steps below. Inside 
callers do not hear Music-On-Hold.

1. Pick up the handset at the test telephone.

2. Dial the central office trunk access code and the system’s published directory number; or, if 
you are using a DID trunk, dial any extension.

3. At the destination extension, answer the incoming call.

4. At the destination extension, press the Hold button.

The line button’s green LED should flash.

5. Verify that music is heard at the destination extension and adjust the volume as required. 

6. Hang up.

Testing the Power Failure Transfer Jacks 5

To test a power failure transfer (PFT) jack for proper operation, you must assign the outside line 
numbers to the module’s line/trunk jacks and the trunks must be operational.

To test PFT jacks, follow the steps below:

1. Plug a Touch-Tone or rotary dial telephone into a PFT jack.

2. Note the outside line number assigned to the lowest line/trunk jack on the module and be sure 
that the outside trunk is connected to the system.

If the customer uses equipment that rebroadcasts music or other copyrighted 
materials, the customer may be required to obtain a copyright license from and pay 
license fees to a third party such as the American Society of Composers, Artists, and 
Producers (ASCAP) or Broadcast Music Incorporated (BMI). Or the customer can 
purchase a Magic On Hold system, which does not require that you obtain such a 
license, from Lucent Technologies.
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3. Turn off power to the control unit. Follow the procedure in ‘‘Replacing a Module in a Carrier’’ on 
page 2-29.

4. Dial an outside number—make sure someone can answer the call.

5. After the call is answered, and you have verified that you have good two-way communication, 
give the person the telephone number assigned to the outside line bridged by the PFT jack to 
which you are connected. This is the number noted in Step 2.

6. Have that person call the number after you hang up.

Your telephone should ring after the caller completes dialing the number.

7. Answer the telephone and verify that you have good two-way communication. Hang up.

8. Repeat Steps 1, 2, and 4 through 10 to test all PFT jacks.

9. Turn the power back on. Follow the procedure in ‘‘Powering Up the System’’ on page 2-31.

Testing Touch-Tone Receivers 5

The 016 ETR and 016 (T/R) modules each provide four Touch-Tone receivers (TTRs). The 
008 OPT and 800 DID modules each provide two TTRs. The 024 TDL module provides eight 
TTRs.

To test TTRs, follow the steps below:

1. Pick up the handset of a Touch-Tone single-line telephone that is connected to 016 (T/R) or 
008 OPT module.

2. Dial *04 and the 2-digit number (starting with 01) of the TTR that you want to test.

You should hear a busy tone if the receiver is in use, or a reorder tone if you misdialed or 
addressed a receiver not in your system.

3. If you hear reorder tone, try again. If you hear dial tone after one to three seconds of silence, 
proceed with this test.

4. Dial 123456789*0#.

You should hear a dual-tone multifrequency (DTMF) signal as each button is pressed. When 
you finish dialing, you should hear a 3-beep confirmation tone.

5. Repeat the test for each TTR.
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Overview 6

The purpose of maintenance is to detect, report, and clear problems quickly with minimum 
disruption of service. To do this, the system isolates troubles to a single replaceable module 
whenever possible.

To isolate problems, the control unit (CU) runs automatic diagnostic, auditing, and monitoring tests. 
Errors found by the automatic tests go into error logs. In addition, you can run demand tests by 
using a 4424LD+ Telephone, an MLX-20L telephone, or a PC with Windows System 
Programming and Maintenance (WinSPM) software. See Chapter 2 of System Programming for 
details on using the WinSPM software for Maintenance activities.

Notification of trouble comes from users who report problems or from alarms generated by the 
system when it detects serious errors. Alarms can appear as an LED on an operator console and 
as a status display on the maintenance terminal.

Error records and alarms may be retired either automatically or manually. After a trouble or error 
has been cleared, the system retests the previously faulty area within a variable time interval. 
When the error is no longer detected, the error message and the alarm, if applicable, are retired. 
Maintenance personnel can retire error records and alarms either on-site or from a remote location 
(using a PC and WinSPM software).

If maintenance is being done by a local PC device, the System Programming Console 
(4424LD+ Telephone or MLX-20L telephone) can continue normal call processing and 
station programming operations. However, if you attempt to access maintenance tasks 
with the System Programming Console while a local PC is performing the same 
maintenance operations, you are denied access to the task and notified with a beep.

Using existing practices, record each station jack connection and each station change on 
the “System Technician's Run Sheet.”
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Equipment 6

To access the maintenance program on-site, you need a System Programming Console (4424LD+ 
or MLX-20L) or a PC with WinSPM software. In addition, you should have the following tools:

■ EIA breakout box

■ Digital voltmeter

■ 110/66-type punchdown tool

■ Dracon TS21 or equivalent Touch-Tone test telephone

■ Assorted flathead screwdrivers

■ Assorted Phillips-head screwdrivers

■ Long-nosed pliers

■ Regular pliers

■ Wrist grounding strap

■ Laptop PC with MS-DOS 3.3 or higher and SPM software

■ Troubleshooting guide

■ Any replacement parts that you may need

Remote Access to the maintenance program requires a PC with WinSPM software.

CAUTION:
The system contains components that can be severely damaged by electrostatic discharge 
(ESD). To minimize the possibility of damage due to ESD, it is recommended that you 
properly ground yourself using the wrist grounding strap whenever you are working on the 
control unit.

Maintenance Elements 6

This section describes the following important elements of the system’s maintenance:

■ Error logs

■ Alarms

■ Restarts

■ System status displays

■ Automatic tests

■ Demand tests
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Error Logs 6

Errors occur because of hardware malfunctions, recurring program logic inconsistencies (PLIs), or 
system restarts. Whenever an error occurs, it is entered into an error log.

Errors are classified as one of three types: major, minor, or warning, and are recorded in one of the 
following tables within the error log that is stored in battery backed-up RAM:

■ Permanent System Alarms—contains a list of the major system errors. Major errors are 
generally steady in nature and cause a degradation of service that requires immediate action. 
An example of a major alarm would be a ROM checksum failure.

■ Transient System Errors—contains a list of the minor system errors. Minor errors are generally 
intermittent in nature and cause a reduced level of service that may require action, but the 
system continues to process most calls normally. An example of a minor alarm would be a 
trunk or station out of service.

■ Last 30 System Errors—contains a list of warning errors. Warning errors cause no noticeable 
degradation of service. Some central office trunk errors are examples of warning errors.

All errors are initially entered into the thirty most recent error table. Each error in this table includes 
the Error Code, Slot, Port, and date and time information. The Error Logger checks the error 
against a list to determine if the error needs to be recorded in the alarm table. Only errors which 
qualify for transient or permanent status are entered into the alarm table. Each error has a 
threshold count that, when exceeded, escalates an error from transient to permanent. To be 
automatically cleared, each type of error must be trouble-free for a set time period.

Alarms 6

A permanent error causes an alarm which may cause an external alarm device to be activated (if 
such a device is installed and administered) and/or light a red LED next to a line or feature button 
(on a system operator console or other designated telephone) programmed for alarm notification. 
The alarm device and/or LED stays on until the error is cleared.

Alarms can be cleared:

■ Automatically by the system when the error condition no longer exists

■ Manually (via the maintenance menus)

— by replacing a module

— by clearing an error log entry via the Drop button on the System Programming Console 
(4424LD+ Telephone or MLX-20L telephone) telephone or via ALT-P on a PC with 
WinSPM software
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Restarts 6

Depending on the severity and duration of a problem, it may be necessary to restart the system 
either by a warm start, cold start, or frigid start. Certain errors can cause the system to 
automatically restart; cold starts and frigid starts can be initiated by the maintenance technician.

Frigid Start 6

In a frigid start, all calls are dropped, the system configuration information is erased and reset to 
the factory default, and the alarm tables are cleared. All system memory must be reinitialized, 
including customer translations. The entire system must be rebooted. When you select a frigid 
start from the maintenance terminal, a warning is issued stating that system translation information 
will be erased, and an option is provided to either continue or cancel the operation.

Cold Start 6

Unless the system is connected to an Uninterruptable Power Supply (UPS) a power interrupt of 
more than one second causes a cold start. All calls are dropped, but customer translations are 
retained.

A cold start can cause stations with the Extension Status feature to lose their Toll Restriction.

Warm Start 6

Warm starts occur automatically and are not initiated by a menu selection. Loss of power for less 
than 250 ms causes a power transfer to the internal battery backup and causes a warm start. 
Stable calls are not dropped, but calls in the process of being established may be. Call processing 
resumes from the point where new and stable calls are handled.

After a frigid start, the default printer is the PC printer, not the SMDR printer. If you want 
printouts on-site from the SMDR printer, make sure you change the print options from 
WinSPM.

A cold start does not blank out the screen on an MLX-28D telephone until the end of the 
cold start.

Power interruptions of less than 100 ms generally are not noticed by the system. Warm 
starts can cause a telephone to ring without having an associated call. To stop the 
ringing, place a new call to the telephone. Every restart causes an error log entry, and 
each type of restart has its own error code.
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System Status Displays 6

The System Status screen displays simulated LEDs for all modules in the control unit, except the 
power supply module. The only modules in the control unit that have physical LEDs are the power 
supply, processor, and 100E.

The simulated LEDs are R (red), Y (yellow), and G (green). R indicates an alarm or standby state; 
when a module enters a normal state, the R LED goes off. When a call is in progress on a module, 
the Y LED is on. The word “on” or “off” appears after the R, Y, or G.

Automatic Tests 6

The system automatically runs tests to:

■ monitor the status of equipment.

■ audit operations consistency.

■ detect hardware malfunctions.

The tests check hardware and software that are in service but do not disrupt normal service. Any 
errors detected are registered in the error logs. Errors are corrected automatically whenever 
possible. When automatic error correction is not possible, errors remain in the error logs until 
manually corrected.

Demand Tests 6

Demand diagnostic tests for the line/trunk and extension modules are selected and scheduled by 
using the menu screens. Demand tests accomplish the following:

■ Increase the effectiveness of on-site troubleshooting and repair

■ Verify complaints of malfunctioning equipment

When a demand test fails, the module being tested either was not busied-out or is faulty and may 
have to be replaced.

For some modules, the demand test does not test the shared memory.
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To run demand tests, the processor module, the power supply module, and the System 
Programming Console (4424 LD+ Telephone or MLX-20L telephone) or PC must be working.

To run a demand test, you must take the equipment out of service. You can choose “Busy-Out” or 
“Reset” to do this, but “Busy-Out” is preferred since:

■ Busy-Out removes lines and stations as they become idle but does not disrupt calls in 
progress.

■ Reset drops all calls in progress and removes equipment from service.

Once the equipment is out of service, you can select demand tests. After testing is finished, 
choose “Restore” from the menu to cancel “Busy-Out” or “Reset.”

On-Site Maintenance 6

You can do on-site maintenance with a System Programming Console (4424LD+ Telephone or 
MLX-20L telephone) or a PC with WinSPM software. The System Programming Console must be 
connected to the first jack on the first 024 TDL module if you are using a 4424 LD+ Telephone, or 
to the first jack on the first 008 MLX module or 016 MLX module if you are using an MLX-20L 
telephone. The first jack on the first TDL or MLX module is factory set as the system programming 
jack and as an operator position. When you program for the first time, you can change the system 
programming jack to any one of the first five jacks on the first 024 TDL module or on the first 008 
MLX module or 016 MLX module. This allows you to program without interfering with the operator’s 
call handling. Only one jack at a time can be used for system programming or maintenance. 

The PC plugs into the RS-232 system programming/maintenance port on the Processor module. 
Refer to Chapter 2 of System Programming for instructions on how to connect the PC to the 
Processor module.

You cannot run a demand test on the module to which the System Programming Console 
is attached (024 TDL for the 4424LD+ Telephone or 008 MLX or 016 MLX module for the 
MLX-20L telephone). However, you can run a demand test on this module from the PC 
with WinSPM software.

A cold start or a warm start does not restore equipment that has been busied-out or reset.
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Remote Maintenance 6

By using a PC with WinSPM software, maintenance personnel can remotely access the 
maintenance program. This Remote Access is provided by a built-in 1200-bps modem in the 
processor module.

Once in the maintenance program, the remote administrator can use the menu screens as the on-
site technician does to check error logs, check system status, and even cause restarts.

The remote administrator can access the maintenance program by:

■ dialing the listed directory number for the customer’s system. Usually this rings at the system 
operator’s console, and the operator transfers the call to the system programming/
maintenance (SPM) port. The remote administrator then enters the password. (When remote 
system programming is taking place, any local system programming is blocked.)

■ directly dialing the SPM port by using the Remote Access feature. The administrator enters an 
access barrier code and the password to connect to the SPM port.

Security 6

Certain security measures guard against unauthorized Remote Access. A barrier code can be 
used for access to the built-in modem. In addition to the barrier code, the WinSPM software has 
password validation.

CAUTION:
Precautions should be taken to prevent unauthorized use of the system’s outside lines by 
remote callers, also called toll fraud. See “Customer Support Information” at the front of this 
book for more information on security.

The following menu selections must be used with care. To eliminate any selection mishaps, you 
must confirm or cancel them.

■ Busy-Out

■ Reset

■ Restore

■ Poke

■ System Erase

Line noise can distort the WinSPM screen. When this happens, the remote administrator 
should hang up and redial.

The on-site system technician can also call the SPM port by using either method 
above. However, it is recommended that the technician connect the laptop PC directly 
to the RS-232 port on the processor module.
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Maintenance Strategy 6

The goal of maintenance is to isolate the trouble to one or more replaceable units and to replace 
the faulty units as quickly as possible. To help isolate the fault, check equipment in the following 
order:

1. Telephones, adjuncts, and station wiring

2. Line/trunk and station modules

3. Processor module

4. Power supply module

5. Carrier backplane

6. Central office connections (network interface)

Use the maintenance program as follows:

1. Check the error logs.

2. If the error logs indicate trouble in the processor module, correct that problem first since it may 
be causing trouble in the line/trunk and extension modules.

3. Run demand tests on the line/trunk and extension modules to further isolate the trouble.

4. If replacing the faulty equipment does not solve the problem, use the screen menus to find the 
hardware vintage, the software vintage, and the ROM ID of the modules.

5. Escalate the problem.

Using the Maintenance Screens 6

Using the maintenance screens involves selecting items on menus. The menu selections are 
identical whether you are using a System Programming Console (4424LD+ Telephone or MLX-20L 
telephone) or a PC with WinSPM software.

The only difference is that the function keys on the computer keyboard simulate the display buttons 
on the telephone.

In the following procedures, a representation of the menu screen is shown with the actions to take. 
To enter maintenance programming, press the button for “Menu” and then the button for 
“Maintenance.” The following Main menu appears:

Traffic problems can result from having more than 64 Personal Lines or pool buttons 
on the system. If you have traffic problems, check this first.
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System Screens 6

System screens are used for getting information; you cannot alter anything with system screens.

Checking Error Logs 6

Error logs show you what errors have occurred in the system. Follow the steps below to check the 
error logs.

Display Error Log Procedure 6

Console Procedure Menu: Maintenance→System→Error Log→Last 30 or Permanent or 
Transient 

PC Procedure: �→�→�→�or � or �

Once you have reviewed the error logs, you should print the error information. This helps you 
determine whether your work has resolved each problem. (Refer to the summary below or System 
Programming for additional information about printing.)

Print Error Log Procedure 6

Console Procedure Menu: System Programming→Exit→More→Print→More→More→ 
Error Log 

PC Procedure: �→�→�→�→�→�→� 

On the maintenance screens, the power supply modules are not shown and the 
processor module is numbered “00.”

The most recent alarm message stays on the System Error Log screen until it is replaced 
by another one.
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System Status 6

The power supply, processor, and 100E modules are the only modules that have LEDs. The 
System Status screen displays simulated LEDs for the processor and for each of these modules, 
but not for the power supply.

Summary 6

Console Procedure Menu: Maintenance→System→Status 

PC Procedure: �→�→� 

The screen appears with simulated LEDs for each module for red, yellow, and green. Press the > 
or More button to display more modules, up to 17. If a slot is empty, R, Y, and G appear, but not on 
or off.

Immediately following R, Y, or G is its status (for example BBB), which can be On, Off, or No status 
(an empty slot in the control unit):

Red LED—When the red LED is on, the module is not in service because it is in standby mode, is 
being tested, or is in an alarm condition. When a module resumes normal operations, the red LED 
turns off.

Yellow LED—When the yellow LED is on, it usually means that at least one call is in progress on 
that module. This is usually true for modules with trunks. When this is the status, you must reset 
the board if you want to terminate any calls in progress rather than waiting for them to terminate 
during a Busy-Out.

Green LED—The green LED is usually off. It may be on during power up or when an Internal 
Loopback or CSU Loopback Test is running.

Sample LED Display (Slot 4) 6

If a call is in progress on a module that is in a working or normal state, the System Status display 
for that module appears as:

Roff Yon Goff.

If a slot is empty, R, Y, and G appear without indicating a status. 

System Inventory 6

System Inventory shows the hardware vintage, software vintage, and ROM ID for each module in 
the control unit.

System Inventory Procedure 6

Console Procedure Menu: Maintenance→System→Inventory→More or >

PC Procedure: �→�→�→� 
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The processor module inventory information appears. Press More or > to show the inventory 
information for the other modules.

The inventory information for the first line/ trunk and station module appears. Press More or > to 
show information for the next module.

Slot Screens 6

With Slot screens, you can check the status of the module in a particular slot or perform 
maintenance activities such as demand tests or restore.

Slot Status 6

Slot Status provides the following information for a module in a particular slot:

■ LED status

■ Errors (yes or no)

■ Mode (initialization, standby, test, or normal)

■ Alarms (yes or no)

■ Maintenance busy (yes or no)

Slot Status Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Status 

PC Procedure: �→�→Type the slot no.→�→� 

For all MLX modules, BChLoopback is also displayed as an option on this screen. For 100E 
modules, CSU-lpbk, Error Events, and Clock are also displayed as options after you select 
Status. For the MFC06 module, MFC Tone is displayed as an option after you select Status.

Demand Tests 6

By running a demand test, you can check the performance of a module in a slot. However, before 
running a demand test, review the following:

■ System Components

■ Test Notes

■ Persistent Module Problems

■ Busy-Out and Reset

On the maintenance screens, the power supply modules are not represented and the 
processor module is numbered “00.”
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■ Restore

System Components 6

Before running a module test, make sure the following system components are working:

■ Power supply

■ Processor module. Back up the system programming onto a floppy disk. See Chapter 2 of 
System Programming for procedures. To back up onto a memory card, use existing 
procedures.

Before running a demand test, busy-out or reset the modules. Busy-Out is the best method, but it 
does not work if any line or extension is on a stable call. See ‘‘‘Demand Tests’’ on page 6-5 for 
more information about these features.

Maintenance Terminal (4424LD+ Telephone, MLX-20L telephone, or PC with WinSPM). To run 
tests on the TDL module connected to the 4424LD+ Telephone used as the System Programming 
Console or the MLX module connected to the MLX-20L telephone used as the System 
Programming Console, you must run the test from the PC, not from the System Programming 
Console.

Once you finish testing a module, you must restore it. Restoring a module terminates the Busy-out 
or Reset condition. 

Test Notes 6

For each test, note the following points:

■ When beginning the board controller test or the internal loopback module test, choose to run it 
once or repetitively.

■ You can interrupt any module test by selecting Exit (� on the PC).

■ A module test can fail for one of the following reasons:

— The module being tested was not busied-out. Exit the test, busy-out the module, and try 
again.

— The error messages indicate that the module is faulty.

If errors indicate that the module is faulty, record them on the module repair tag immediately after 
running the test.

Persistent Module Problems 6

If any of the module tests fail and replacing the module does not clear the trouble, either several 
modules may be faulty, or the connector on the carrier may be faulty.

Busy-Out and Reset 6

Before running any module test, be sure to busy-out or reset the module.
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Busy-out discontinues service from the module being tested to each line and extension only as 
they become idle. Busy-out is the preferred method, because it does not disrupt calls in progress.

Reset discontinues service to all lines and extensions on the module instantly.

■ In-progress calls are dropped if all of the calling parties on the call originate and terminate on 
the module being reset.

■ If a call is using a line or extension on the module being Reset and another line and/or 
extension is involved in the call, the call on the module being reset is put on hold. In this case, 
the module can be removed and replaced. However, a demand test cannot be performed, 
because the module is not busied-out.

Check the status of the reset module before performing a demand test.

In the following procedure, Busy-Out is shown, but choosing Reset works the same way.

Busy-Out Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Busy-Out→Yes

PC Procedure: �→�→Type the slot no.→�→�→� 

After you select Busy-Out, a screen appears that allows you to either confirm your selection or 
cancel and return to the previous screen.

When busy-out is successfully completed, you see Busy-Out Complete on the screen. If busy-out 
is not successfully completed, the message displayed is Busy-Out FAILED.

Once all calls are terminated, the busy-out completes in less than 1 second. If calls in progress 
take too long, ask the callers to hang up.

Restore 6

Once you complete module testing, restore it to terminate the Busy-Out or Reset condition. The 
Restore procedure generally takes less than one second.

Restore Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Restore→Yes

PC Procedure: �→�→Type the slot no.→�→�→� 
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Internal Loopback Test 6

This test checks communication between the processor and the module being tested. This test 
can be run on any module. The 100E module has two digital switch elements (DSEs); both DSEs 
are tested.

It takes approximately 1.5 minutes to run each test. The 100E module takes approximately 3 
minutes because each module has two DSEs.

Busy-Out, Reset Busy-out, or reset the module being tested prior to beginning the test. See ‘‘Busy-
Out and Reset,’’ on page 6-12, for additional information.

You can interrupt the test (both Test Once and Repetitive) by selecting Exit (� on the PC). 

Internal Loopback Test Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→
DemandTest→IntLoopback→Test Once or TestRepetitive 

PC Procedure: �→�→Type the slot no.→�→�→�→�%or � 

If the test is successful, the module ports are free from error. Continue with the next module test, 
or restore the module if you are through testing.

If the test fails, find the error message in Table 6-1, and proceed as indicated.

Table 6-1. Internal Loopback Test Error Messages

Error Messages Corrective Action

Slot is not busied-out Exit the test, busy-out the slot, and try again.

Slot empty or not valid Exit the test and try again; be sure to type the correct slot 
number. Do not indicate an empty slot or the processor (00).

FMWR not in Standby Mode Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being tested.

Test running too long Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being tested.

Not in TEST/STANDBY mode Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being tested.

Any other error Record the errors on the repair tag and replace the module.
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Board Controller Test 6

This procedure tests the module’s internal functions, such as ROM, RAM, the timer, dual-port 
RAM, and so on. This test can be run on all modules except the processor. The test generally 
takes less than 1 second to perform.

Board Controller Test Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Demand 
Test→BoardCntrlr→Test Once or Repetitive 

PC Procedure: �→�→Type the slot no.→�→�→�→� or � 

You can interrupt the test (Test Once or Repetitive) by selecting Exit (� on the PC).

If the test completes successfully, the module’s board controller is functioning properly. Continue 
with the next module test or restore the module if you are finished testing. If the test fails, find the 
error message in Table 6-2 and proceed as indicated.

Be sure to check the second screen if testing a 100E module.

Table 6-2. Board Controller Test Error Messages

Error Message Corrective Action

Slot is not busied-out Exit the test, busy-out the slot, and try again.

Slot empty or not valid Exit the test and try again; be sure to type the correct slot 
number. Do not indicate an empty slot or the processor 
(00).

FMWR not in Standby Mode Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being 
tested.

Test running too long Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being 
tested.

Not in TEST/STANDBY mode Exit the test and try again; if this error persists, record the 
errors on the repair tag and replace the module being 
tested.

Any other error Record the errors on the repair tag and replace the 
module.
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100E Module Selections 6

The 100E modules have the following unique selections: Error Events, Clock, and E1-lpbk 
(loopback) selection. Each of these is selected from the 100E Slot screen.

100E Module Error Events 6

This procedure allows you to check for 100E module errors. The screen shows the errors that have 
accumulated during the current or previous hour. If you have any questions about interpreting 
these errors, contact your technical support organization.

Error Events Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Error 
Events→Current hr. or Previous hr.

PC Procedure: �→�→Type the slot no.→�→
→� or � 

100E Module Clock Status 6

If you have not been trained to perform E1 maintenance, contact your technical support 
organization for instructions on using this procedure.

Summary 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→Clock→Exit 

PC Procedure: �→�→Type the slot no.→�→�→� 

100E Module E1 Loopback Test 6

This test verifies that specific communication paths on the100E modules are operational. This test 
can be run only on 100E modules and generally takes 2 minutes.

Before you select “E1-lpbk” from the 100E Slot screen, you must do the following:

1. Plug a loopback cable into the jack on the 100E module.

This causes the E1 signal to loop around at the signal jack. 

2. Using the maintenance screens, busy-out the 100E module (see ‘‘Busy-Out and Reset’’ on 
page 6-12).

Summary 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→E1-lpbk 

PC Procedure: �→�→Type the slot no.→�→� 
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MFC06 Module MFC Tone Test 6

This test verifies the functionality of the hardware associated with the MF tone generation and 
detection. In essence, this test is a digital loopback test that checks whether the DSP hardware 
used for MFC tone detection and generation can talk to the TDM bus without bit errors. This test 
can be run only on MFC06 modules and generally takes approximately 2 minutes.

Before you select MFC Tone from the 100E Slot screen, busy-out the 100E module (see ‘‘Busy-
Out and Reset’’ on page 6-12).

MFC Tone Procedure 6

Console Procedure Menu: Maintenance→Slot→Dial the slot no.→Enter→MFC Tone 

PC Procedure: �→�→Type the slot no.→�→� 

If the test is successful, the message MFC Tone Test Passed is shown on the screen. If the test 
fails, the message MFC Tone Test Failed appears, followed by additional information indicating 
which of the six channels failed the test.

Port Screens 6

You perform the following procedures from the maintenance terminal. By selecting Port from the 
Maintenance screen, you can check the maintenance-busy status and other information for 
individual trunks and extensions, as well as information for RS-232 ports, modems, and MFC 
channels.

Once you determine the maintenance-busy status, you may also be interested in the following 
other features on the Port menu:

■ Resetting EIA-232 ports and modems

■ Busying-out and restoring trunks and extensions

Checking Line/Trunk Maintenance-Busy Status 6

Console Procedure Menu: Maintenance→Port→Line/Trunk→Dial the dial plan 
no.→Enter→Status 

PC Procedure: �→�→�→Type the dial plan no.→�→� 

Checking Station Maintenance-Busy Status 6

Console Procedure Menu: Maintenance→Port→Station→Dial the dial plan 
no.→Enter→Status 
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PC Procedure: �→�→�→Type the dial plan no.→�→� 

Checking MFC Channel Maintenance-Busy Status 6

Console Procedure Menu: Maintenance→Port→MFC-Channel→Dial the slot (01-17) and 
port number ((01-06)→Enter→Status 

PC Procedure: �→�→�→Type the slot (01-17) and port number ((01-06)→�→� 

Busy Out a Line/Trunk 6

Console Procedure Menu: Maintenance→Port→Line/Trunk→Dial the dial plan 
no.→Enter→Busy Out 

PC Procedure: �→�→�→Type the dial plan no.→�→� 

Busy Out a Station 6

Console Procedure Menu: Maintenance→Port→Station→Dial the dial plan 
no.→Enter→Busy Out 

PC Procedure: �→�→�→Type the dial plan no.→�→� 

Busy Out a MFC Channel 6

Console Procedure Menu: Maintenance→Port→MFC-Channel→Dial the slot (01-17) and 
port number ((01-06)→Enter→Busy Out 

PC Procedure: �→�→�→Type the slot (01-17) and port number ((01-06)→�→� 

Restore a Line/Trunk 6

Console Procedure Menu: Maintenance→Port→Line/Trunk→Dial the dial plan 
no.→Enter→Restore 

PC Procedure: �→�→�→Type the dial plan no.→�→� 

Busy Out a Station 6

Console Procedure Menu: Maintenance→Port→Station→Dial the dial plan 
no.→Enter→Restore 

PC Procedure: �→�→�→Type the dial plan no.→�→� 
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Busy Out a MFC Channel 6

Console Procedure Menu: Maintenance→Port→MFC-Channel→Dial the slot (01-17) and 
port number ((01-06)→Enter→Restore 

PC Procedure: �→�→�→Type the slot (01-17) and port number ((01-06)→�→� 

Resetting an RS-232 Port 6

The ADMIN (SPM) port is RS-232 Port 1, and the SMDR port is RS-232 Port 2.

Console Procedure Menu: Maintenance→Port→RS232 Port1 or RS232 Port2→Dial the 
dial plan no.→Enter→Reset→Yes

PC Procedure: �→�→� or �→Type the dial plan no.→�→�→� 

Replacing Equipment 6

When an error has been isolated to one of the following pieces of equipment, you can replace the 
equipment:

■ Telephones, adjuncts, and station wiring

■ Line/trunk and station modules

■ Processor module

■ Power supply module

■ Carrier

Replacing the Telephones and Auxiliary Equipment 6

Once a problem has been isolated to a telephone (or a group of telephones), various tests can be 
done to see if the telephone is working properly (see ‘‘Testing 4400-Series Telephones’’ on page 
5-3 and ‘‘Testing MLX Telephones’’ on page 5-4). Check the telephone wire first. Also, swap a 
telephone you know is good with the one you think is faulty. These practical steps isolate the 
problem quickly.

Record each station jack connection and each station change on the “System 
Technician's Run Sheet.”
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Fixing Telephone Problems 6

When a user complaint or a system test identifies the telephone as the problem area, the trouble 
can be in the telephone itself, in the mounting cord, or in the wiring between the CU and the 
telephone. Check the wiring and the mounting cord before checking the telephone.

General Telephone and Wiring Troubles 6

Symptom: 6

Intermittent telephone trouble

Procedure: 6

1. Swap a known good telephone with the suspect telephone to determine if the problem is 
localized to the suspect telephone. If local power is provided, check the power supply.

2. If trouble disappears, the fault is with the suspect telephone. Replace it.

3. If the known good telephone does not work properly, the fault may be in the wiring and/or the 
line/trunk and extension module.

4. Check the other telephones connected to the same module. If they are working properly, the 
fault is probably in the wiring, or it may be a single-port failure on the line/trunk and extension 
module. Swap the wiring between the jack field and the telephone to see if it is a wiring 
problem. Fix the wiring problem.

5. If the other telephones connected to the same line/trunk and extension module are not 
working properly, the fault is probably in the line/trunk and extension module.

6. Check the circuit module translations from the maintenance terminal to ensure that the module 
has been properly translated.

7. Check the LEDs on the line/trunk and extension module.

8. Check the error log for relevant messages.

9. Replace the faulty line/trunk and extension module.

Single-Line Telephone Problems 6

Symptom: 6

Many single-line telephones cannot dial correctly even though they are receiving calls.

Procedure: 6

Using a single-line telephone, test the Touch-Tone receivers (TTRs) as follows:

1. Pick up the handset and dial *04 and the 2-digit number of the TTR to be tested.

■ If you hear a busy tone, the receiver is in use.

If the wiring has been crushed or severed, the auxiliary power supply may be shorted.
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■ If you hear a reorder tone, you have misdialed or have reached an invalid TTR.

■ If you hear a dialtone, continue this test.

2. Dial the digits 123456789*0#.

You should hear a DTMF signal as each button is pressed. If the test is successful, you hear a 
dialtone within one to three seconds after you enter #.

3. Repeat the test for each TTR.

4. Replace the module containing the faulty TTR if this test fails.

Symptom: 6

User cannot make outside calls on Touch-Tone telephone.

Procedure: 6

Check the individual line/trunk for rotary-dial programming.

Call Forward Problems 6

Symptom: 6

Users are getting other people’s calls.

Procedure: 6

Usually this problem results from someone unknowingly activating Call Forward. Cancel the 
forwarding of calls to the receiving telephone as follows:

■ For multiline telephones

1. Press the Feature button.

2. Dial *34*.

■ For single-line telephones and 4400/4400D Telephones

1. Pick up the handset.

2. Dial #*34*.

3. Hang up. 
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Replacing Modules 6

Power down the system before replacing modules. “Hot Swaps” are not recommended.

The module removed must be replaced with a module having the same type of circuit board, in 
other words, the same signature. If a module is replaced with another type of module, or if a 
module is added to the system without the system being powered down, a cold start occurs. If you 
move the first 024 TDL, 008 MLX, or 016 MLX module from its slot, you must renumber the 
modules by selecting Board Renumber from the System Programming menu.

This procedure is not the procedure for replacing the processor module.

Follow these steps to replace a line/trunk and extension module:

1. If possible, save all the translations to a floppy disk by using the backup function.

2. Label all line/trunk and extension cords (if they haven’t been labeled already) and unplug them 
from the module.

3. Run a demand test by entering the test mode.

4. Power down the system by turning off:

a. the power supply module on the basic carrier.

b. the power supply module(s) on the expansion carrier(s).

5. Remove the module and inspect it for visible damage.

6. Insert the new module.

7. Restore power by turning on:

a. the power supply module(s) on the expansion carrier(s).

b. the power supply module on the basic carrier.

The system automatically cold starts.

8. Plug in the line/trunk and extension cords.

9. Attach a tag identifying any visible problems or failure symptoms, and any relevant error 
reports to the replaced module.

Whenever you power up a system after working on it, be sure that you power up all the 
carriers. If you do not turn on all the carriers, you may cause a cold-start. See ‘‘Powering 
Up the System’’ on page 2-31.

When the processor module fails, backup is usually impossible.
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Replacing the Processor Module 6

A failed processor module must be repaired immediately. Follow these steps to replace a failed 
processor module:

1. If possible, save all the translations to a floppy disk by using the backup function.

2. Power down the system by turning off:

a. the power supply module on the basic carrier.

b. the power supply module(s) on the expansion carrier(s).

3. Unplug the SMDR printer and/or system programming PC cords if present.

4. Remove the processor module.

5. Inspect the processor module for any visible problems.

6. Inspect the carrier backplane.

7. Install the new processor module.

8. Restore power by turning on:

a. the power supply module(s) on the expansion carrier(s).

b. the power supply module on the basic carrier.

The system automatically cold starts.

9. Use the maintenance screens to select “System Erase” (frigid start).

10. Restore the system translations from the backup floppy disk.

11. Plug in the SMDR printer and/or administrative PC cords.

12. Attach a tag identifying any visible problems and any relevant error reports to the replaced 
processor module.

When the processor module fails, backup is usually impossible.
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Replacing the Power Supply Module 6

Failure of the power supply shuts down everything connected to the carrier.

If the power supply fails, check that the interlocking post in the power supply slot of the carrier has 
not broken off. Without this post, the power supply does not operate and the carrier must be 
replaced.

Follow these steps to replace the power supply module:

1. If possible, save the translations on a floppy disk by using the backup function.

2. Power down the system by turning off:

a. the power supply module on the basic carrier.

b. the power supply module(s) on the expansion carrier(s).

3. Unplug the system from the AC outlet.

4. Remove the power supply module and insert a new one.

5. Restore power by turning on:

a. the power supply module(s) on the expansion carrier(s).

b. the power supply module on the basic carrier.

The system automatically cold starts.

Replacing the Carrier 6

Typical carrier problems include power supply failure, sudden failure of one or more line/trunk and 
extension modules, or system problems that cannot be isolated to a specific module.

Follow these steps to check carrier problems:

1. Visually inspect the pins on the carrier. (Bent or broken pins often cause carrier problems.) To 
do this, you may have to remove one or more line/trunk and station modules by using Busy-
Out, Reset, and Restore.

2. If you find a problem with the carrier, you must replace it (but not the line/trunk and extension 
modules). Carriers cannot be repaired in the field.

3. Attach a tag to the faulty carrier that describes the problem.

If the power supply module on the basic carrier has failed, the system cannot save 
the translations to a disk.
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Central Office Troubles 6

The automatic maintenance program takes the ports out of service when a line/trunk is 
malfunctioning. The line/trunk is periodically tested to put it back in service.

Maintenance-Busy 6

When a line/trunk cannot be seized for an incoming or outgoing call, the line/trunk is automatically 
put into a maintenance-busy state. When a line/trunk is in a maintenance-busy state, no outgoing 
calls can be placed on it. However, the line/trunk still receives incoming calls.

The system-wide Automatic Maintenance Busy feature (if enabled) applies to all trunks, except 
DID trunks, which cannot be used to make outgoing calls. In addition, there is a programmable 
DTD Maintenance Busy parameter that applies to any trunk with DTD enabled (including trunks in 
a pool). If the DTD Maintenance Busy parameter is set to “Yes” and the DTD time-out interval is 
exceeded four times on a trunk without an intervening dial tone being detected, the trunk is marked 
as “unavailable for DTD.” Trunks busied out because dial tone was not detected remain busied out 
until manually restored to service.

While the line/trunk is in a maintenance-busy state, the software periodically runs tests to try to 
seize the line/trunk. If the seizure is unsuccessful, the line/trunk stays in a maintenance-busy state. 
If the seizure is successful, the line/trunk is placed back in service. If a test is running when an 
incoming call is received on the line/trunk, the test is dropped and the call is processed.

A permanent error is entered when more than 50 percent of the lines/trunks in a pool are 
maintenance busy. When the maintenance-busy level falls below 50 percent, the permanent error 
is automatically removed.

Conditions Causing a Maintenance-Busy State 6

The following conditions cause a maintenance-busy state:

■ Loop-Start Line/Trunk

— No loop currently exists when the LS line/trunk is seized.

No more than 50 percent of lines/trunks in a pool can be maintenance busy at one time. 
The only exceptions are:

n User-imposed maintenance busy (for example, module replacement)

n Module maintenance busy (for example, a loss-of-service alarm in the 100E module)

n No external release at the far end of the line

Make sure that no modules are in a maintenance-busy state during a backup procedure 
(see the System Programming guide). Any module in a maintenance-busy state will be 
recorded as such on the translations disk.
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A transient error is reported. After four occurrences, the port enters a maintenance-busy 
state and the error becomes permanent.

■ Tie Trunk

— A seizure of an outgoing tie trunk fails.

A transient error is reported. After four unsuccessful seizure attempts, the port is marked 
maintenance busy and the error becomes permanent.

— The far-end station fails to disconnect.

A transient error is reported. After two occurrences, the port is marked maintenance-busy 
and the error becomes permanent.

Maintenance-Busy Programming 6

You can select automatic maintenance busy as a system programming option. If you do, there is 
also a menu selection to include tie trunks.

Manual Correction of Line/Trunk Problems 6

If the system cannot seize a line/trunk even after repeated attempts, you may have to replace the 
module. To identify the line/trunk problem, first check for a dial tone at the CU. If you do not hear a 
dial tone, check the error logs and make a line/trunk test call.

It is sometimes difficult for the customer to detect line/trunk troubles. If a line/trunk is down, an 
error is recorded in the error log and the line/trunk is taken out of service. If an incoming-only line/
trunk is down, however, the only sign of trouble is customer complaints that incoming calls are not 
being received.

Check the error log for line/trunk-related error messages. Also check the wiring and the system 
parameters (for example, Touch-Tone/rotary/MFC, Toll Restriction, and disconnect time interval). 
Seize the line/trunk. 

Outgoing Line/Trunk Problems 6

Symptom: 6

Outgoing lines/trunks cannot be seized.

Procedure: 6

1. At the network interface, check for a dial tone from the central office. If a dial tone is not 
present, notify the customer.

2. Pick up the handset at a test station to get a system dial tone.

The test is not run on auto-out tie trunks.
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3. For a Hybrid/PBX system, dial *03.

4. Dial the 2-digit line/trunk number of the line/trunk to be tested (01 to 80).

5. Listen for a dial tone. If a dial tone is not present, use a test set to isolate the fault to the line/
trunk and extension module where the line/trunk terminates or to the location in the line/trunk 
access equipment.

6. If a dial tone is present, dial a working outside number. Verify that the call is complete.

If the line/trunk is busy, you hear a busy tone. You hear a reorder tone if a wrong line/trunk type 
(such as DID) or an invalid line/trunk number was dialed.

7. If the module continues to malfunction, replace it.

Incoming Line/Trunk Problems 6

Symptom: 6

Incoming lines/trunks do not work properly.

Procedure: 6

1. Place an incoming call through the troubled line/trunk.

2. For an LS line/trunk, connect a single-line telephone to the line/trunk at the network interface. 
Listen for ringing. Pick up the handset and check for dialtone. Dial an outside number and 
verify that you have good two-way transmission.

3. At the maintenance terminal, check the line/trunk translations to be sure this line/trunk has 
been properly translated. 

4. If the module continues to malfunction, replace it.

Line/Trunk Error Summary 6

Table 6-3 shows the line/trunk errors reported when a transient or permanent error is registered by 
the system. These errors are also recorded for E1 ports.

Dialing *03 on a single-line telephone works only if the line/trunk accepts Touch-Tone 
dialing. After you dial *03 on a single-line telephone, you may have to wait for a 
“click” before dialing the line/trunk number.

In some cases, errors occur not because a single port fails, but because the entire E1 link 
fails. If the entire E1 link fails, the periodic E1 board-level maintenance monitoring 
functions perform the testing and activate alarming.
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The 100E System Modules—E1 Maintenance 6

The system provides the following automatic maintenance activities on an ongoing basis:

■ Initialization—The system ensures that all E1 ports are properly initialized and placed into 
service. It also resolves the conflicts of different service levels (for example, between the 
individual ports or for the initialization of the ports to support features).

■ Error detection and handling—The system detects errors and takes the facility out of 
service, if appropriate. It attempts to restore the facility and put it back into service.

■ Error recording—The system records all errors and outages in the error logs.

■ Audits and updates—The system checks the state of the E1 facilities through audits, status 
checks, and error logging.

■ Maintaining the synchronization plan—The system maintains proper synchronization to the 
loop clock and switches to the local clock when the loop clock is not available (for example, 
during a loss of signal or a blue alarm). When the loop clock source is restored, the system 
switches back to the loop clock.

Table 6-3. Line/Trunk Errors

Error Line/Trunk

No loop current LS lines/trunks

No external release on far-end disconnect DID and tie lines/trunks

On-hook before ready to receive digits; trunk with delay-dial or wink-start DID and tie trunks

On-hook before wink; trunk with delay-dial or wink-start DID and tie trunks

Stuck ringing LS lines/trunks

Wink too short for valid signal Tie trunks

E1 maintenance pertains to 100E modules.
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Troubleshooting 6

Table 6-4 below is a quick reference for maintenance problems and possible solutions.

Table 6-4. Error Codes

Error Code Description Action

0001 TIMEOUT COLD START: 
System programming is okay.

No action required; however, if problem 
persists, troubleshoot the processor.

0002 POWER UP WARM START: 
System programming is okay.

No action required; however, if problem 
persists, troubleshoot the processor.

0003 SOFTWARE COLD START: 
System programming is okay.

If problem persists, troubleshoot the 
processor.

0004 SOFTWARE WARM START: 
System programming is okay.

If problem persists, troubleshoot the 
processor.

0005 Reset - DIAGNOSTIC SWITCH: 

0006 INCOMPLETE COLD START: 
System was cold-started while a 
restart was in progress.

If problem persists, troubleshoot the 
processor.

0007 SANITY TIMEOUT RESET: 
Faulty software, module, carrier, or 
processor sanity timer.

Troubleshoot module and or processor.

0008 MAX RESET COUNT EXCEEDED: 
System was cold-started (System 
Reset) because too many warm 
starts occurred.
System programming is okay.

If problem persists, troubleshoot the 
processor.

000A POWER UP COLD START: 
A RAM failure was detected in the 
processor. 
System programming is okay.

If problem persists, troubleshoot the 
processor.

000B CARD INSERTED/REMOVED: No action required.

000C SLOT STREAM CNT EXCEEDED: 
Slot has generated excessive 
interrupts or the system was 
powered down incorrectly. For 
example, Carrier 2 was powered 
down before Carrier 1. If errors 
exist because of the improper 
power-down, no action is required.

If problem persists, troubleshoot the 
module.

000D FMWR NOT IN STANDBY MODE: 
Module firmware is not in standby 
mode.

If problem persists, troubleshoot the 
module.

000E COMMAND BUFFER FULL: If problem persists, troubleshoot the 
processor and module.
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000F TASK RUNNING TOO LONG: No action required; however, if problem 
persists, troubleshoot the processor.

0009 FRIGID START: 
System was restarted and 
initialized to default programming.
This error is also logged after a 
System Erase.

If the processor was removed while in 
use, the system may perform a frigid 
start due to loss of system 
programming. Restore system as 
described in System Programming. 

0010 INVALID SLOT INTERRUPT: 
Cannot determine module 
responsible for generating the 
interrupt or the system was 
powered down incorrectly. For 
example, Carrier 2 was powered 
down before Carrier 1. If errors 
exist because of the improper 
power-down, no action is required.

Troubleshoot modules and replace if 
necessary. If the problem persists, 
troubleshoot the processor.

0011 STACK OVERFLOW: 
Processor problem.

Troubleshoot the processor.

0012 INVALID RESET FLAG: 
Processor problem.

Troubleshoot the processor.

0013 DUART STREAMING INT: 
Processor problem or the system 
was powered down incorrectly. For 
example, Carrier 2 was powered 
down before Carrier 1. If errors 
exist because of the improper 
power-down, no action is required.

Troubleshoot the processor.

0014 PROCESSOR ERR INTERRUPT: 
Processor problem.

Troubleshoot the processor.

0015 MODULE MISMATCH: 
Physical and logical type 
mismatch. Module inserted into 
wrong slot.

Change system programming to reflect 
the proper module or install the proper 
module.

0016 POWER UP COLD START: 
A module dual port RAM failure 
was detected.
System programming is okay.

If problem persists, troubleshoot the 
module for the slot indicated.

0017 REAL TIME CLOCK FAULT: 
Date and/or Time incorrect or 
unreadable.

If this problem persists, replace the 
processor module.

0018 RTC COLD START: 
This error is not displayed.

Table 6-4. Error Codes— Continued

Error Code Description Action
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0019 RESET TIME & DATE: 
The system performs a cold start 
because the real time clock chip is 
not working correctly.

If this problem persists, replace the 
processor module.

00DE MERLIN Messaging System 
software was upgraded.

No action required.

0401 ABK CARD NOT INSERTED: 
A PCMCIA memory card for 
Translation is not inserted.

Insert a Translation card or a card that 
has not been formatted.

0402 ABK INCORRECT CARD TYPE: 
A PCMCIA card other than a 
Translation card is inserted.

Remove the current card and insert a 
Translation card or a card that has not 
been formatted.

0403 ABK CARD WRITE-PROTECTED: 
The Translation card has the write 
protection switch on.

Flip the write protection switch on the 
card to off (non-write protect mode/
position). If this problem persists, try 
another card, then replace the 
processor module if the problem 
remains. 

0C01 NO I-VMS PORT IN SERV: 
This error indicates that the VMS 
machine may be down.

No action required.

0C02 DID INTERDIGIT TIMEOUT: 
May be noisy line or central office 
problem.

No action required. If problem persists, 
troubleshoot the DID line and inform the 
central office if necessary.

0C03 ALL TTRs UNAVAILABLE: 
The system needed to use a TTR 
but one was not available for any 
and all reasons including: in use, 
not physically present, and out of 
service.

Check count and first and last 
occurrences to determine if error occurs 
too frequently. If so, check to see if you 
can add TTRs to the system.
If you have the prompt out of queue 
active, you may want to shorten the 
delay announcement message length.
If you have the prompt out of queue 
feature and secondary 
announcement(s) active, you may want 
to increase the interval between the 
announcements.
If you reprogram the delay 
announcement unit, recheck it to verify 
that the problem no longer exists.
Check to see if you can add TTRs to the 
system.

Table 6-4. Error Codes— Continued

Error Code Description Action
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0C04 MWL FAC TIMEOUT 
Two consecutive messages to 
update Message Waiting lights 
have been sent across the private 
network on the same tandem trunk 
and have not been acknowledged. 
When this happens three times, 
the error becomes permanent. The 
alarm remains in the log until a 
message for the facility is 
acknowledged or five days pass.

Check the error log for additional error 
codes. If the error log contains errors 
indicating problems with the 100D 
module, troubleshoot the 100D module 
using instructions in Chapter 4 of this 
guide. If the error log also contains 
errors indicating problems with the 
400EM module, troubleshoot the 
400EM module using instructions in 
Chapter 4 of this guide.
If the 100D and/or the 400EM modules 
are functioning properly, troubleshoot 
the trunks using instructions in Chapter 
5 of this guide.

0C05 MWL DELIVERY DELAY 
A message to update non-local 
Message Waiting lights has 
exceeded the time period for 
delivery. A transient alarm occurs 
after one minute, and a permanent 
alarm occurs after 15 minutes. The 
alarm remains in the error log until 
a message is delivered or five 
days pass. 

Check the error log for additional error 
codes. Troubleshoot the trunks by using 
instructions in this chapter of this guide.
Check that the system receiving the 
message has enough TTRs to handle 
the volume of calls. Check the error logs 
on the sending system and then on the 
receiving system—more facilities may 
be needed.

1C01 POOL M-BUSY EXCEEDS 50%: 
More than half the trunks in the 
pool are busy.

Troubleshoot trunk.

1C02 DPR TEST NOT COMPLETED Slot did not complete initializing.

1C03 FW UPGRADE ATTEMPT: No action required.

1C04 FW UPGRADE COMPLETE: No action required.

1C05 INVALID FMW 29 DETECTED: 
Incompatibility problem. The 
specified video system or data 
device is connected to an 008 
MLX with firmware vintage 0x29.

Replace the 008 module with one of 
another firmware vintage and retire this 
permanent alarm manually. 

0404 ABK EXTENSION BUSY: 
An extension is in program, 
administration, or maintenance 
mode.

Wait until the extension changes mode. 
Make sure the programming device 
(WinSPM or the console) is not in 
programming mode when automatic 
backup is scheduled to occur.

0405 ABK FAULTY CARD: 
Unknown cause of a bad card.

Reset card and retry. It the problem 
remains, try another card. If the problem 
still remains, replace the processor 
module.

Table 6-4. Error Codes— Continued

Error Code Description Action
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1C06 BAD BOARDS IN SYSTEM: 
At least one incompatibility 
problem of type HER 0x1c05 
detected. Turns on CPU red LED.

Replace the 008 module with one of 
another firmware vintage and retire this 
permanent alarm manually. 

3001 ALARM TABLE FULL: 
The error logs are full, and no 
more errors can be added to them.
Turns on the processor LED.

Correct indicated errors, and then 
remove entries from the transient 
system error log to free up space. If 
problem persists, cold-start the system 
before continuing with troubleshooting. 
Sys Program→System→Restart 

4401 USER REQUESTED SYS ERASE: 
This error is logged after a System 
Erase. If the System Erase is 
successful, this error is removed 
immediately.

If this error remains in the transient log, 
do the System Erase again. If problem 
persists, troubleshoot the processor.

4402 USER REQST UPGRD/INSTALL: 
This is just a record of the event.

No action required.

4C01 POOL EMPTY: 
The system needed to use a trunk 
in a pool but no trunks were 
physically present in the pool, that 
is, all of the boards were removed 
from the system. See first 
argument number on the screen 
for pool index (1–11).

Check that the pool has a trunk 
assigned to it. If a trunk is assigned and 
the problem persists, replace the 
boards.

4C02 POOL BUSY: 
The system needed to use a trunk 
in a pool. Trunks are physically 
present; however, non are idle and 
available for use, therefore they 
must be in use or out of service. 
See first argument number on the 
screen for pool index (1–11).

Check the count and first and last 
occurrences. If occurring too frequently, 
determine if facilities can be added or 
moved to this pool.

4C03 POOL BUSY &/OR OOS: 
The system needed to use a trunk 
in a pool. Trunks are physically 
present, some may be busy but 
some are idle. However, the idle 
trunks are not in service. See first 
argument number on the screen 
for pool index (1–11).

Restore if out of service.

Table 6-4. Error Codes— Continued

Error Code Description Action
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5802 BOARD RENUMBER: 
A Board Renumber occurred.

If the system is functioning properly, 
remove the error from the Transient 
Error Log. If the system is not 
functioning properly, check the 
Transient Error Log to verify that a 
Board Renumber took place. Compare 
the system’s previous configuration to 
the one after the Board Renumbering to 
determine if logical IDs shifted.

7401 TRK UPLINK MESSAGE ERROR: 
Communication problems between 
processor and modules. 
Unrecognized message from 
module to processor.

Test the trunk with a single-line 
telephone. If the problem is not in the 
trunk, replace the module with one that 
is known to be working. If the problem is 
gone when using the known good 
module, replace the module and restart.

7402 LOOP CONTROL BIT NOT SET: 
No loop current on an outgoing 
call.
If this error occurs four times 
consecutively, and if Automatic 
Maintenance-Busy is enabled and 
the 50% maintenance-busy limit 
has not been exceeded, the trunk 
is busied-out automatically.

Test the trunk with a single-line 
telephone. If the problem is not in the 
trunk, replace the module with one that 
is known to be working. If the problem is 
gone when using the known good 
module, replace the module and restart.

7403 NO LOOP CURRENT: 
Communication problems between 
the module and central office.
No loop current.
If this error occurs four times 
consecutively, and if Automatic 
Maintenance-Busy is enabled and 
the 50% maintenance-busy limit 
has not been exceeded, the trunk 
is busied-out automatically.

Test the trunk with a single-line 
telephone. If the problem is not in the 
trunk, replace the module with one that 
is known to be working. If the problem is 
gone when using the known good 
module, replace the module and restart. 

7404 STUCK RINGING: 
Communication problems between 
the module and central office.
If this error occurs twice 
consecutively, the trunk is busied-
out automatically, whether or not 
Automatic Maintenance-Busy is 
enabled.

Test the trunk with a single-line 
telephone. If the problem is not in the 
trunk, replace the module with one that 
is known to be working. If the problem is 
gone when using the known good 
module, replace the module and restart.

Table 6-4. Error Codes— Continued

Error Code Description Action



Maintenance

Troubleshooting

6-35

7801 NOT IN NORMAL OP MODE: 
Module not in normal operation 
mode. Reported in background 
module check.
The MERLIN Messaging System 
reset at 2:00 a.m. or the MERLIN 
Messaging System was upgraded.

Reset the board. If problem persists, 
troubleshoot the module.
Maintenance→Slot→Slot 
Number→Reset 
If MERLIN Messaging System software 
was upgraded, no action is required.

7802 SANITY INT NOT GENERATED: 
Only applies to modules that have 
extension jacks.
Or MERLIN Messaging System 
software was upgraded.

Reset the board. If problem persists, 
troubleshoot the module. If MERLIN 
Messaging System software was 
upgraded, no action is required.

7803 NO PORT BOARDS AVAILABLE: 
This error is reported when 
modules are not present.

No action required. Delete this entry 
from the transient log.

7804 INVALID SANITY RESPONSE: 
This error occurs when a sanity 
test gets invalid responses. 
Applies only to modules that have 
extension jacks.
Or MERLIN Messaging System 
software was upgraded.

Reset the board. If problem persists, 
troubleshoot the module. If MERLIN 
Messaging System software was 
upgraded, no action is required.

7805 INVALID SLOT NUMBER: 
Rarely occurs.
Software could not process an 
event detection because the slot 
number was invalid.

No action required; however, if problem 
persists, restart the system.

7806 NOT IN STANDBY MODE: 
Reported during cold start or 
background check.

Reset the board. If problem persists, 
troubleshoot the module.

7807 SELF TEST NOT COMPLETED: 
Reported during cold start.

Reset the board. If problem persists, 
troubleshoot the module.

7808 TEST RESULT REGISTER BAD: 
A module error or processor error 
resulted while running test.

Reset the board. If problem persists, 
troubleshoot the module.

7809 TEST STATUS REGISTER BAD: 
A module error or processor error 
resulted while running test.

Reset the board. If problem persists, 
troubleshoot the module.

780A DPR TEST NOT COMPLETED: 
Reported during cold start.

If problem persists, troubleshoot the 
module.

780C RAM TEST FAILURE: 
Memory failed the RAM test. Turns 
on the processor LED.

If problem persists, replace the 
processor.

Table 6-4. Error Codes— Continued

Error Code Description Action
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780D UPPER ROM FAILURE: 
Memory failed the ROM test. 
Turns on the processor LED.

If problem persists, replace the 
processor.

780E LOWER ROM FAILURE: 
Memory failed the ROM test. 
Turns on the processor LED.

If problem persists, replace the 
processor.

8001 UNEXPECTED ETR MESSAGE: 
An unsupported ETR telephone is 
connected to a module; or an ETR 
telephone is faulty; or a 016 ETR 
module is faulty; or the software is 
showing the message in error.

If a single user complains, check the 
ETR telephone. If many users 
connected to the same 016 ETR 
module complain, troubleshoot the 
module and replace if needed. If no 
users are complaining, clear the error 
from the log.

8401 MISCELLANEOUS ERROR: 
Currently not reported.

No action required.

8402 WINK TOO SHORT: 
Outbound dialing problems on tie 
trunks. For a tie trunk with delay 
dial or wink start, the wink from the 
far end of the network interface is 
less than the minimum 100 ms. 
The tie trunk remains waiting for a 
valid signal.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
faulty cable. Replace the module.

8403 NO EXTERNAL RELEASE: 
Communication problems between 
the module and central office. Far 
end has not disconnected within 
four minutes.
If this error occurs twice 
consecutively, the trunk is busied-
out automatically, whether or not 
Automatic Maintenance-Busy is 
enabled.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
faulty cable.

8404 ON HOOK BEFORE WINK: 
Outbound dialing problems on tie 
trunks. For a tie trunk with delay 
dial or wink start, the far end of the 
network interface went on-hook 
before the handshake was 
completed.

If problem persists, troubleshoot the tie 
trunk configuration. Troubleshoot the far 
end to see if it is working and translated 
properly. Troubleshoot for faulty cable. 
Replace the module.

8405 ON HOOK BEFORE READY: 
Outbound dialing problems on tie 
trunks. For a tie trunk with delay 
dial or wink start, the far end of the 
network interface went on-hook 
before the guard time elapsed.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
wink start and faulty cable. 
Troubleshoot the far end of the private 
network. Replace the module.

Table 6-4. Error Codes— Continued
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8406 INTERDIGIT TOO SHORT: 
Inbound dialing problems on tie 
and DID trunks.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
faulty cable. Replace the module.

8407 BAD UPDATE: 
Communication problems 
occurred between the processor 
and the modules. Module may 
need to be replaced.

Turn the processor off and then on. 
Repeat system programming 
procedure. If problem persists, escalate 
to your technical support organization.

8408 ROTARY RATE > 12PPS: 
Inbound dialing problems on tie 
and DID trunks.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
faulty cable. Replace the module.

8409 ROTARY RATE < 8PPS: 
Inbound dialing problems on tie 
and DID trunks.

Troubleshoot the far end of the network 
interface to see if it is working and 
translated properly. Troubleshoot for 
faulty cable. Replace the module.

840A BAD DOWNLINK MESSAGE: 
Communication problems 
occurred between the processor 
and the modules. The module 
received an unrecognized 
message from the processor.

Turn the processor off and then on. 
Repeat system programming 
procedure. If the problem persists, 
replace the module.

840B NO LOOP CURRENT: 
Communication problems between 
the module and the central office. 
No loop current.
If this error occurs four times 
consecutively, and if Automatic 
Maintenance-Busy is enabled and 
the 50% maintenance-busy limit 
has not been exceeded, the trunk 
is busied-out automatically.

Replace the module with a similar 
module and test. If the problem is 
resolved, replace the bad module. If the 
problem persists, reinstall the old 
module and test the trunk. 

840C STUCK RINGING: 
Communication problems between 
the module and central office.
If this error occurs four times 
consecutively, and if Automatic 
Maintenance-Busy is enabled and 
the 50% maintenance-busy limit 
has not been exceeded, the trunk 
is busied-out automatically.

Replace the module with a similar 
module and test. If the problem is 
resolved, replace the bad module. If the 
problem persists, reinstall the old 
module and test the trunk.
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840D INCORRECT FIRMWARE STATE: 
If this error occurs four times 
consecutively, and if Automatic 
Maintenance-Busy is enabled and 
the 50% maintenance-busy limit 
has not been exceeded, the trunk 
is busied-out automatically.

Turn power off for at least 1 second and 
then turn it on. Repeat system 
programming procedure. If problem 
persists, replace the module.

840E UPLINK MESSAGE ERROR: 
Communication problems between 
the processor and the module. 
The module received an 
unrecognized message from the 
processor.

Turn the processor off and then on. 
Repeat system programming 
procedure. If the problem persists, 
replace the module.

840F LOST IDLE MESSAGE ERROR: 

8C01 SLOTS NOT EQUAL: 
The module that occupies the 
indicated slot does not match the 
slot information contained in the 
PC or PCMCIA card backup file.

Troubleshoot the slot descriptions in 
your backup file against the actual 
system modules that occupy those 
slots. After the mismatch is corrected, 
repeat the restore operation.

9801 MCARD WRITE ERROR: 
Write to the memory card is not 
succeeding or is too slow.

Reset the card and try again. If the 
problem persists, replace the card and 
try again. If the problem still persists, 
replace the processor.

9802 MCARD ERASE ERROR: 
Erasure of the memory card is not 
succeeding or is too slow.

Reset the card and try again. If the 
problem persists, replace the card and 
try again. If the problem still persists, 
replace the processor.

9803 MCARD 12-VOLT ERROR: 
The memory card voltage is 
incorrect.

Reset the card and try again. If the 
problem persists, replace the card and 
try again. If the problem still persists, 
replace the processor.

9C01 NW REJECTS SPID: 
Service on the link has been lost.

Check the programmed SPID for 
correctness. If it is incorrect, modify the 
programming; otherwise, contact the 
central office to correct the problem.

9C03 LINK ESTABLISHMENT FAIL: 
Service on the link has been lost.

Check that the line is securely 
connected to the port and that the LEDs 
on the board show proper operation. If 
the card appears to be working 
properly, make sure the central office 
has activated the line.

9C04 NW NOT RESPOND TO SETUP: 
Service on the link has been lost.

The private network is not responding to 
the MERLIN LEGEND messages. 
Contact the central office to correct the 
problem.
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9C05 NW NOT RESPOND TO RELEASE: 
Service on the link has been lost.

The private network is not responding to 
the MERLIN LEGEND messages. 
Contact the central office to correct the 
problem.

9C07 ENDPOINT UNINIT (L2/L3): 
Service on the link is uninitialized.

The link is in the process of initializing. If 
this error remains logged for more than 
a half hour, try re-plugging the DSL. If 
the problem persists, contact the central 
office to correct the problem.

9C08 PROTOCOL ERROR: 
Service on the line may be 
affected.

The private network has indicated that a 
protocol error has occurred. Verify the 
line provisioning by running the NI-BRI 
Provisioning Test or through other 
means. If the provisioning is correct, 
contact your technical support 
organization.

A401 CTI LINK BROADCAST RESET: 
Occurs during a broadcast reset.
The Red LED on the CPU will not 
turn on, but the Red LED for the 
slot will turn on.

If several of these occur:
Check that the system is in Hybrid/PBX 
mode.
Validate the wiring and the connections.
Press the Restart Button (see “Restart” 
on page 4–119).
Call the TSO’s Telephony Services 
Maintenance Group (800 242-2121) for 
the procedures to unload and reload the 
PBX driver.

A801 CTI LINK HIDDEN RESET: 
Occurs during a hidden reset.

If several of these occur, and the client 
application has “slow” response time:
Validate the wiring and the connections.
Press the Restart Button (see the 
procedure “Restart” on page 4–119).
Call the TSO’s Telephony Services 
Maintenance Group (800 242-2121) for 
the procedures to unload and reload the 
PBX driver.
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Number

If you need assistance when installing, programming, or using your system contact your support organization or 
your Lucent Technologies authorized dealer. 

Lucent Technologies 
Corporate Security

Whether or not immediate support is required, all toll fraud incidents involving Lucent Technologies products or 
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Liability” in Appendix A, “Customer Support Information,” of Feature Reference.



System Programming
Master Table of Contents

Master TOC i

Customer Support Information

Support Telephone Numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xv

Federal Communications Commission (FCC)
Electromagnetic Interference Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xv

Security  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xv

Physical Security, Social Engineering, and General Security Measures . . . . . . . . . . . xvi

Limited Warranty and Limitation of Liability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvii
■ Limited Warranty. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvii
■ Limitation Of Liability. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xviii

About This Book

Ordering Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xix

Product Safety Labels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xix

1 Programming Basics

Introduction to System Programming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
■ Planning Forms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
■ Types of Programming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

System Programming Console  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
■ Console Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
■ Console Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
■ Console Overlay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8
■ Console and DSS Lights. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

Programming Procedures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11
■ Procedure Organization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11
■ Procedure Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11
■ Programming Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-12
■ Verifying Data Entry  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-14
■ Saving Entries and Moving among Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-15
■ Using Enter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-16
■ Using Next  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-16
■ System Programming Hierarchy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-17

Access to System Programming from the 4424LD+ or MLX-20L or Console  . . . . . . 1-17
■ System Programming Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18

Idle States  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-20



System Programming

ii Master TOC

2 Programming with WinSPM

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2

Installing the WinSPM Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
■ CD-ROM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
■ Floppy Disks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3

Getting Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4
■ Desktop Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5
■ Defining Your Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
■ Setting Up a Site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
■ Connecting to a MERLIN MAGIX Integrated System . . . . . . . . . . . . . . . . . . . . . . . 2-13

WinSPM Main Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-16

Using Quick Access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17
■ Allowed/Disallowed Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17
■ Automatic Route Selection (ARS). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
■ Call Pickup Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
■ Calling Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
■ Capture Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20
■ Coverage Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20
■ Labeling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21
■ Personal Lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21
■ Set Date and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21
■ Speed Dial  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
■ System Inventory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
■ Telephone Programming  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23
■ Telephone Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23

WinSPM Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-25

Using Standard SPM Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-26
■ SPM Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-26

Basic System Management Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-28
■ Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-29
■ Boards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-31
■ Browse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-34
■ Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-36
■ Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-37
■ Pass-Thru . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-37
■ Password  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-37
■ Print Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-39
■ Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-40

System Programming  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-42
■ Basic Programming Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-42
■ Idle States. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-42



 Master Table of Contents

Master TOC iii

■ 100E 100R Module Idle  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-44
■ Accessing System Programming  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-45
■ Printing Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-45

Surrogate Mode Programming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-47

3 Programming Procedures

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

Basic System Operating Conditions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-2
■ System Restart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
■ System Programming Position Assignment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
■ System Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
■ Board Renumbering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
■ Mode of Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5
■ Automatic Maintenance Busy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
■ Set System Date . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
■ Set System Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
■ Rotary Break Timer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
■ Special Numbers Table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
■ Special Numbers Other Digits. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
■ Match Delay Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

System Renumbering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
■ Select System Numbering Plan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14
■ Single Renumbering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
■ Block Renumbering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-16
■ Direct Station Selector (DSS) Page Buttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-17

System Operator Positions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-18
■ Primary Operator Positions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
■ QCC System Operator Positions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
■ DLC Operator Positions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20

Lines and Trunks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21
■ Outmode Signaling for Loop-Start Trunks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
■ Rotary Trunk Digit Transfer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
■ Ringing Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-23
■ Second Dial Tone Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-23
■ Disconnect Signaling Reliability  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-24
■ Toll Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-25
■ Hold Disconnect Interval . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-26
■ Ring Disconnect Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-27
■ Dial Tone Detection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-28
■ Glare Guard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-32
■ Busy Tone Detection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-32



System Programming

iv Master TOC

■ Principal User for Personal Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-34
■ QCC Queue Priority Level  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-36
■ QCC Operator to Receive Calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-37
■ Clock Synchronization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-38
■ Trunks to Pools Assignment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-39
■ Copy Options for Lines/Trunks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-40

E1 Facilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-42
■ Type of E1 Facility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-42
■ Line Code Suppression  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-44

Channel Associated Signaling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-44
■ Country Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-45
■ Line Signaling Timing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-45
■ Pulse Dialing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-46
■ Tariff Pulse Meter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-47
■ Encoding. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-48

MultiFrequency Compelled (MFC) Register Signaling. . . . . . . . . . . . . . . . . . . . . . . . 3-49

Send Signals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-50
■ Expected Digits. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-51
■ Number to Send . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-52

Tie Trunks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-53
■ Direction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-53
■ Tie Trunk Seizure Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-54
■ E&M Signal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-54
■ Dial Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-55
■ Tie Trunk Dial Tone  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-56
■ Tie Trunk Answer Supervision Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-57
■ Disconnect Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-57

DID/DIOD Trunks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-58
■ Block Assignment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-58
■ DID Trunk Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-59
■ Disconnect Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-60
■ Expected Digits. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-60
■ Delete Digits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-61
■ Add Digits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-61
■ Signaling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-62
■ Invalid Destination  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-62

Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-63
■ Assign Trunks or Pools to Extensions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-64
■ Copy Line/Trunk Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-66
■ Assign Intercom or System Access Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-67
■ Rotary Signaling on Tip/Ring Ports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-70
■ Tip/Ring Functionality on 016 ETR Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-71



 Master Table of Contents

Master TOC v

Auxiliary Equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-71
■ Music-On-Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-71
■ Loudspeaker Paging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-72
■ Fax Machines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-73
■ Maintenance Alarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-74
■ Voice Messaging System and Automated Attendant . . . . . . . . . . . . . . . . . . . . . . . 3-74

Optional Extension Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-76
■ Extension Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-76
■ Pool Dial-Out Code. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-77
■ Calling Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-78
■ Copy Calling Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-79
■ ARS Restriction Level for Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-80
■ Forced Account Code Entry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-81
■ Microphone Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-82
■ Authorization Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-82
■ Remote Call Forwarding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-83
■ Delayed Call Forwarding. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-84
■ Trunk-to-Trunk Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-85
■ Primary Cover Ring Delay  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-86
■ Secondary Cover Ring Delay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-86
■ Group Coverage Ring Delay. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-87
■ HotLine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-88
■ Display Preference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-89
■ Service Observing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-89

Optional Operator Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-91
■ Operator Hold Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-91
■ DLC Operator Automatic Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-92

QCC Optional Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-92
■ Hold Return. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-93
■ Automatic Hold or Release . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-94
■ Queue over Threshold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-94
■ Elevate Priority . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-95
■ Calls-In-Queue Alert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-96
■ QCC Operator to Receive Call Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-96
■ Call Type Queue Priority Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-98
■ Message Center Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-99
■ Extended (Directed) Call Completion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-99
■ Return Ring. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-100
■ Position Busy Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-101
■ Voice Announce . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-101

Optional Group Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-102
■ Pickup Groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-102



System Programming

vi Master TOC

■ Group Paging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-103
■ Group Coverage Member Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-104
■ Group Calling Member Assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-105
■ Group Calling Line/Trunk or Pool Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . 3-106
■ Priority Call Queuing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-106

Optional Group Calling Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-107
■ Hunt Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-107
■ Group Calling Delay Announcements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-108
■ Group Calling Announcement Interval  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-109
■ Group Calling Repeat Announcement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-109
■ Group Coverage Receiver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-110
■ Group Calling Overflow and Thresholds. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-111
■ Group Calling Message-Waiting Indicator  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-112
■ Group Calling Calls-In-Queue Alarm Thresholds . . . . . . . . . . . . . . . . . . . . . . . . . 3-113
■ Group Calling External Alert for Calls-In-Queue Alarm  . . . . . . . . . . . . . . . . . . . . 3-114
■ Group Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-115
■ Queue Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-116

System Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-118
■ Transfer Return Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-119
■ One-Touch Transfer/One-Touch Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-119
■ Transfer Audible . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-121
■ Type of Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-121
■ Camp-On Return Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-122
■ Call Park Return Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-123
■ Automatic Callback Interval  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-123
■ Extension Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-124
■ SMDR Language  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-124
■ SMDR Call Report Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-125
■ SMDR Call Length  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-126
■ SMDR Calls Recorded on Call Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-126
■ SMDR Account Code Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-127
■ SMDR Talk Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-127
■ Inside Dial Tone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-128
■ Reminder Service Cancel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-129
■ Redirect Outside Calls to Unassigned Extension Numbers . . . . . . . . . . . . . . . . . 3-129
■ Recall Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-131
■ Interdigit Timers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-131
■ Allowed Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-132
■ Assign Allowed Lists to Extensions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-132
■ Disallowed Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-133
■ Assign Disallowed Lists to Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-134

Remote Access Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-134
■ Remote Access Trunk Assignment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-136
■ Remote Access Automatic Callback. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-136



 Master Table of Contents

Master TOC vii

■ Remote Access without Barrier Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-137
■ Remote Access Barrier Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-139
■ Remote Access with Barrier Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-141

Call Progress Tones. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-142

Automatic Route Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-146
■ 1 + 7-Digit Dialing Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-146
■ ARS Tables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-147
■ Start and Stop Times for Subpatterns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-148
■ Pool Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-149
■ Facility Restriction Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-149
■ Digit Absorption. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-150
■ Other Digits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-151
■ Dial 0 Table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-152
■ Voice and/or Data Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-152

Night Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-153
■ Night Service Group Assignment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-153
■ Night Service with Outward Restriction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-154
■ Night Service with Time Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-155
■ Night Service with Coverage Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-156

Labeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-157
■ Extension Directory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-158
■ Lines or Trunks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-159
■ Posted Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-160
■ Group Calling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-160
■ System Speed Dial Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-161

Print Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-162
■ Report Language  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-162
■ Printing System Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-163

Memory Card . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-166
■ Card Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-166
■ Inserting the Card . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-168
■ Memory Card Formatting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-169
■ Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-171
■ Automatic Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-172
■ Backup Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-174
■ Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-176
■ Restore Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-177

A Menu Hierarchy

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-1



System Programming
Master List of Figures

Master LOF ix

1 Programming Basics
1-1 4424LD+ Telephone  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

1-2 MLX-20L Telephone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

1-3 4424LD+ Display Buttons and Main Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

1-4 MLX-20L Display Buttons and Main Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

1-5 4424LD+ System Programming Console Overlay . . . . . . . . . . . . . . . . . . . . . . 1-9

1-6 MLX-20L System Programming Console Overlay . . . . . . . . . . . . . . . . . . . . . . 1-9

1-7 Selecting a Block of Lines/Trunks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

1-8 Information Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-12

1-9 Menu Selection Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-12

1-10 Data Entry Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-13

1-11 Inspect Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-14

1-12 Sample Inspect Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-14

1-13 Screen Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-15

1-14 System Programming Menu Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18

2 Programming with WinSPM
2-1 WinSPM Main Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4

2-2 Direct Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13

2-3 Direct Connection, PC More Than 50 Feet Away  . . . . . . . . . . . . . . . . . . . . . 2-14

2-4 Internal Connection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-14

2-5 External Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15

2-6 WinSPM Main Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-16

2-7 Sample WinSPM Help Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-25

2-8 Standard SPM Mode Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-26

3 Programming Procedures
3-1 2-Digit Numbering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-12

3-2 3-Digit Numbering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

3-3 Set-Up-Space Numbering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

3-4 PCMCIA Memory Card  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-167

3-5 Inserting the Memory Card . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-168



System Programming
Master List of Tables

Master LOT xi

1 Programming Basics
1-1 4424LD+ and MLX-20L Console Components  . . . . . . . . . . . . . . . . . . . . . . . . 1-4

1-2 Direct Station Selector (DSS) Components . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6

1-3 Fixed Display Buttons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8

1-4 Screen Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-15

1-5 System Programming Menu Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18

1-6 Exiting System Programming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-19

2 Programming with WinSPM
2-1 Function of PC Keys in WinSPM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-27

2-2 Management Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-29

2-3 Board Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-32

3 Programming Procedures
3-1 Maximum Number of Operator Positions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-18

3-2 Busy Tone Characteristics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-33

3-3 Programming Codes for Assigning Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . 3-69

3-4 Valid Selections for Further Programming  . . . . . . . . . . . . . . . . . . . . . . . . . . 3-145

3-5 Valid Next Actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-145

3-6 Memory Card Formatting Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-170



Safety

IMPORTANT SAFETY INSTRUCTIONS

The exclamation point in an equilateral triangle is intended to alert the user to 
the presence of important operating and maintenance (servicing) instructions in 
the literature accompanying the product.

To reduce the risk of fire, electrical shock, and injury to persons, follow these basic safety precautions 
when installing telephone equipment:

■ Read and understand all instructions.

■ Follow all warnings and instructions marked on or packed with the product.

■ Never install telephone wiring during a lightning storm.

■ Never install a telephone jack in a wet location unless the jack is specifically designed for wet 
locations.

■ Never touch uninsulated telephone wires or terminals unless the telephone wiring has been 
disconnected at the network interface.

■ Use caution when installing or modifying telephone lines.

■ Use only Lucent Technologies-manufactured MERLIN MAGIX Integrated System circuit modules, 
carrier assemblies, and power units in the MERLIN MAGIX Integrated System control unit.

■ Use only Lucent Technologies-recommended/approved MERLIN MAGIX Integrated System 
accessories.

■ If equipment connected to the TDL telephone modules (412 LS-ID-TDL and 024 TDL), the MLX 
telephone modules (008 MLX, 408 GS/LS-MLX, 408 GS/LS-ID-MLX, and 016 MLX), or the ETR 
telephone module (016 ETR) is to be used for in-range out-of-building (IROB) applications, IROB 
protectors are required.

■ Do not install this product near water—for example, in a wet basement location.

■ Do not overload wall outlets, as this can result in the risk of fire or electrical shock.

■ The MERLIN MAGIX Integrated System is equipped with a 3-wire grounding-type plug with a 
third (grounding) pin. This plug will fit only into a grounding-type power outlet. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact an electrician to replace the 
obsolete outlet. Do not defeat the safety purpose of the grounding plug.

■ The MERLIN MAGIX Integrated System requires a supplementary ground.

■ Do not attach the power supply cord to building surfaces. Do not allow anything to rest on the 
power cord. Do not locate this product where the cord will be abused by persons walking on it.

■ Slots and openings in the module housings are provided for ventilation. To protect this equipment 
from overheating, do not block these openings.

■ Never push objects of any kind into this product through module openings or expansion slots, as 
they may touch dangerous voltage points or short out parts, which could result in a risk of fire or 
electrical shock. Never spill liquid of any kind on this product.
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■ Unplug the product from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not 
use cleaners or aerosol cleaners.

■ Auxiliary equipment includes answering machines, alerts, modems, and fax machines. To 
connect one of these devices, you must first have a Multi-Function Module (MFM).

■ Do not operate telephones if chemical gas leakage is suspected in the area. Use telephones 
located in some other safe area to report the trouble.

■ To eliminate the risk of personal injury due to electrical shock, DO NOT attempt to install or 
remove an MFM from your MLX telephone. Opening or removing the module cover of your 
telephone may expose you to dangerous voltages.

■ ONLY an authorized technician or dealer representative shall install, set options, or repair an 
MFM.

SAVE THESE INSTRUCTIONS

WARNING:
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Customer Support Information 0

Support Telephone Numbers 0

If you need assistance installing, programming, or using your system, contact your support 
organization or your Lucent Technologies authorized dealer.

Federal Communications Commission (FCC)
Electromagnetic Interference Information 0

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference, in which case the user will be required to correct the interference at his own expense.

Security 0

As a customer of new telecommunications equipment, you should be aware of the significant and 
growing problem of theft of long distance services by third parties, known commonly as “toll fraud.” 
It is particularly important that you understand and take appropriate steps to deal with this crime 
because, under applicable tariffs, you will be responsible for payment of associated toll charges. 
Lucent Technologies can not be responsible for such charges and will not make any allowance or 
give any credit resulting from toll fraud.

Toll fraud can occur despite the preventive efforts of network providers and equipment 
manufacturers. Toll fraud is a potential risk for every customer with telecommunications equipment 
having one or more of the following features: (1) Remote Access, (2) Automated Attendant, (3) 
voice mail, (4) remote administration and maintenance, and (5) call forwarding (remote). This is not 
a product or design defect, but a risk associated with equipment having one or more of the 
features described above. If your new telecommunications equipment possesses any of these 
features, please consult the relative portion of your documentation for further details and specific 
procedures to reduce the risk of toll fraud or contact your Lucent Technologies representative for 
further details. The Remote Access feature must be properly administered to help reduce the risk 
of unauthorized use. It is your responsibility to take the appropriate steps to implement the feature 
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Physical Security, Social Engineering, and General Security Measures

xvi

properly, evaluate and administer the various restriction levels, and protect and carefully distribute 
access codes.

To reduce the risk of unauthorized access to your MERLIN MAGIX Integrated System, you should 
observe the following procedures:

■ Use a nonpublished Remote Access telephone number.

■ Assign passwords, barrier, or access codes randomly to users on a need-to-know basis, 
keeping a log of ALL authorized users and assigning one code to each person.

■ Ensure that Remote Access users are aware of their responsibility to keep the telephone 
number and any access codes secure.

■ Use random sequence access codes. These are less easily broken.

■ Deactivate all unassigned access codes promptly.

■ When possible, restrict the off-network capability of callers via use of Call Restrictions and 
Disallowed Lists.

■ When possible, block off-hours calling.

■ Frequently monitor system call detail reports for quicker detection of any unauthorized or 
abnormal calling patterns.

Physical Security, Social Engineering, and 
General Security Measures 0

Criminals called hackers may attempt to gain unauthorized access to your communications system 
and voice messaging system in order to use the system features. Hackers often attempt to trick 
employees into providing them with access to a network facility (line/trunk) or a network operator. 
This is referred to as social engineering. Hackers may pose as telephone company employees and 
employees of Lucent Technologies or your authorized dealer. Hackers will go through a company’s 
trash to find directories, dialing instructions, and other information that will enable them to break 
into the system. The more knowledgeable they appear to be about the employee names, 
departments, telephone numbers, and the internal procedures of your company, the more likely it 
is that they will be able to trick an employee into helping them.

Preventive Measures. Take the following preventive measures to limit the risk of unauthorized 
access by hackers:

■ Provide good physical security for the room containing the communications equipment and the 
room with administrative tools, records, and System Manager information. These areas should 
be locked when not attended.

■ Provide a secure trash disposal for all sensitive information, including telephone directories, 
call accounting records, or anything that may supply information about your communications 
system. This trash should be shredded.

■ Educate employees that hackers may try to trick them into providing them with dial tone or 
dialing a number for them. All reports of trouble, requests for moving extensions, or any other 
administrative details associated with the MERLIN MAGIX Integrated System should be 
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handled by one person (the System Manager) or within a specified department. Anyone 
claiming to be a telephone company representative should be referred to this person or 
department.

■ No one outside of Lucent Technologies needs to use the MERLIN MAGIX Integrated System 
to test facilities (lines/trunks). If a caller identifies themselves as a Lucent Technologies 
employee, the System Manager should ask for a telephone number where the caller can be 
reached. The System Manager should be able to recognize the number as a Lucent 
Technologies telephone number. Before connecting the caller to the administrative port of the 
MERLIN MAGIX Integrated System, the System Manager should feel comfortable that a good 
reason to do so exists. In any event, it is not advisable to give anyone access to network 
facilities or operators, or to dial a number at the request of the caller.

Limited Warranty and Limitation of Liability 0

Limited Warranty 0

LUCENT TECHNOLOGIES AND ITS AFFILIATES MAKE NO WARRANTIES, EXPRESS OR 
IMPLIED, ABOUT OR RELATING TO YOUR MERLIN MAGIX INTEGRATED SYSTEM AND 
SPECIFICALLY DISCLAIM ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

You should check with the reseller from whom you purchased your system to determine if it offers 
a limited warranty.
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Limitation Of Liability 0

EXCEPT FOR PERSONAL INJURY, DIRECT DAMAGES TO TANGIBLE PERSONAL 
PROPERTY PROXIMATELY CAUSED BY LUCENT TECHNOLOGIES, AND LIABILITY 
OTHERWISE EXPRESSLY ASSUMED IN A WRITTEN AGREEMENT SIGNED BY AN 
AUTHORIZED REPRESENTATIVE OF AT&T, THE LIABILITY OF LUCENT TECHNOLOGIES, ITS 
AFFILIATES, SUPPLIERS AND AUTHORIZED RESELLERS FOR ANY CLAIMS, LOSSES, 
DAMAGES OR EXPENSES FROM ANY CAUSE WHATSOEVER (INCLUDING ACTS OR 
OMISSIONS OF THIRD PARTIES) REGARDLESS OF THE FORM OF ACTION, WHETHER IN 
CONTRACT, TORT OR OTHERWISE, SHALL NOT EXCEED AN AMOUNT EQUAL TO THE 
LESSER OF THE DIRECT DAMAGES PROVEN OR THE PURCHASE PRICE OF THE SYSTEM. 
IN NO EVENT SHALL LUCENT TECHNOLOGIES OR ITS AFFILIATES, SUPPLIERS OR 
AUTHORIZED RESELLERS BE LIABLE FOR INCIDENTAL, RELIANCE, CONSEQUENTIAL, OR 
ANY OTHER INDIRECT LOSS OR DAMAGE (INCLUDING, BUT NOT LIMITED TO, LOST 
PROFITS OR REVENUES AND LOSSES ARISING OUT OF UNAUTHORIZED USE (OR 
CHARGES FOR SUCH USE) OF COMMON CARRIER TELECOMMUNICATIONS SERVICES 
OR FACILITIES ACCESSED THROUGH OR CONNECTED TO THE MERLIN MAGIX 
INTEGRATED SYSTEM) INCURRED IN CONNECTION WITH YOUR SYSTEM. THIS 
LIMITATION OF LIABILITY SHALL SURVIVE FAILURE OF AN EXCLUSIVE REMEDY.
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About This Book 0

The power and versatility of the MERLIN MAGIX™ Integrated System is due in part to its many 
options and features. These options and features have been recorded on system planning forms 
and initially programmed at the time of installation. Changes in use patterns, the addition of new 
equipment, or a change in operating mode may necessitate additional system programming.

This book provides information about programming the features and auxiliary equipment on the 
MERLIN MAGIX system.

Ordering Information 0

If you wish to order copies of manuals, replacement parts, accessories, or other equipment that is 
compatible with the system, contact your Lucent Technologies representative.

Product Safety Labels 0

Throughout this book, hazardous situations are indicated by an exclamation point inside a triangle, 
along with the word “caution” or “warning.”

WARNING:

Warning indicates the presence of a hazard that could cause death or severe 
personal injury if the hazard is not avoided.

CAUTION:

Caution indicates the presence of a hazard that will or can cause minor personal 
injury, property damage, or loss of data if the hazard is not avoided.
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1Programming Basics 1

This chapter presents the information you need to master before you begin the programming 
procedures covered in Chapter 3, ‘‘Programming Procedures.” It covers the following subjects:

■ An introduction to system programming basics

■ How to use the system programming console

■ How the programming screens and keys work

■ How to interpret and use the programming procedures

■ How to enter and exit system programming

■ Which system components require idle states for programming

Introduction to System Programming 1

The MERLIN MAGIXTM Integrated System offers easy-to-use, menu-driven software for system 
programming. After your system is installed, use this software to accommodate your company’s 
changing needs for such enhancements and modifications as upgraded lines, additional modules, 
and new extension programming. 

Planning Forms 1

Before you begin to program or modify your system, you should familiarize yourself with the 
system planning forms. Initially, system planning forms are used to plan your system and program 
your system during installation. After installation, they remain a source for all programming 
information on your system database. The information ranges from the system time and date to 
specific equipment configurations and feature programming. 

Each planning form is either required or optional:

■ Required forms are necessary to program the system.

■ Optional forms are needed only if the System Manager included the features or options shown 
on the forms.

Before you begin to program or modify your system, review the Control Unit Diagram on system 
planning Form 1 to identify the module types installed in the system’s control unit. Use this 
information to program or modify lines and trunks and assign or reassign lines to extensions. 



System Programming

Introduction to System Programming

1-2

Check the physical control unit to verify that the modules are placed in the slots identified on the 
diagram. Correct the diagram on Form 1 if there are any discrepancies.

Before you make any changes to your system, be sure to do the following:

■ Mark any system modifications or changes on the appropriate planning form. Keep your 
planning forms up-to-date. 

■ Check the Feature Reference for possible feature interactions.

■ Program the system or the system component during the appropriate idle state. See ‘‘Idle 
States’’ on page 1-20.

Types of Programming 1

The three types of programming available for the system are:

■ System Programming. This type of programming enables the System Manager to program 
features that affect all or most system users, and requires one of the following:

— A system programming console which is a 4424LD+ or MLX-20L telephone connected to 
one of the first five jacks of the first TDL or MLX module in the control unit.

— A PC with Windows System Programming and Maintenance (WinSPM) software. WinSPM 
provides two interfaces for system programming—Quick Access and Standard SPM 
Mode. Quick Access provides a graphical user interface (GUI) for those tasks most 
commonly performed by the System Manager (for example, add or delete members of 
groups, perform system inventories, create reports, program multiple systems, make 
station labels appear on display telephones, and more). Pictorial representations of 
system components, such as modules and their vintages, and the creation of 4400-Series 
or MLX telephone button labels, are available with WinSPM. 

The Standard SPM Mode interface provides an emulation display of the system 
programming console. It allows basic SPM programming of the MERLIN MAGIX system 
and supports SPM programming for options not included in the GUI.

The PC should be connected to the lower port (labeled ADMIN) on the processor module. 
A PC with a modem can perform system programming remotely through the public 
network, or by connecting to a tip/ring extension jack (016 (T/R) or 008 OPT module) on 
the system. A built-in modem in the processor allows the PC and the system to 
communicate.

■ Extension Programming. This type of programming enables individual extension users and 
system operators (except for Queued Call Console operators) to change their extension 
features to meet individual needs. For details about extension programming, see the 
appropriate user and operator guides.

■ Centralized Telephone Programming. This type of programming enables the System 
Manager to program any feature that can be programmed by individual extension users or 
system operators. Some features can be programmed only in centralized telephone 
programming. Centralized telephone programming can be done on the programming console 
or on a PC with the WinSPM software. 
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System Programming Console 1

The system programming console is a 4424LD+ or MLX-20L telephone connected to the system 
programming jack. When you begin system programming on a new system for the first time, the 
console must be connected to the first jack on the first 024 TDL module if you are using a 4424LD+ 
Telephone, or to the first jack on the first 008 MLX module or 016 MLX module if you are using an 
MLX-20L telephone. The first jack on the first TDL or MLX module is factory-set as the system 
programming jack and as an operator position. When you program for the first time, you can 
change the system programming jack to any one of the first five jacks on the first 024 TDL module, 
or on the first 008 MLX module or 016 MLX module. This allows you to program without interfering 
with the operator’s call handling.

You can also have one or two Direct Station Selectors (DSSs) connected to the system 
programming console. Each DSS adds 50 extension buttons to the console, which facilitates 
assigning features to extensions. The DSS for the 4424LD+ console is the DSS 4450.

A 4424LD+ Telephone is shown in Figure 1-1. An MLX-20L telephone is shown in Figure 1-2. 

Figure 1-1. 4424LD+ Telephone
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Figure 1-2. MLX-20L Telephone

Console Components 1

Table 1-1 describes the components that make up the 4424LD+ or MLX-20L Console. Refer to 
Figure 1-1 and Figure 1-2 for the location of the components. Table 1-2 describes the components 
that make up the DSS.

Table 1-1. 4424LD+ and MLX-20L Console Components

Component Function

Desk Stand
(not shown) 

An adjustable stand on the console and the DSS allows a 20- or 30-degree 
viewing angle (optional on the 4424LD+ Telephone).

Button Labeling 
Cards 

Cards labeled with the number or feature assigned to each line button.

Contrast Control
(not shown) 

A sliding control at the top of the console, used to brighten or dim the display 
screen.

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

OPER

1 2 3

4 5 6

7 8 9

0 #*

Direct 
Station Selector

(DSS)

Display Buttons

Display ScreenHandset

Volume

vv
Feature

HFAI

Mute

Speaker Hold

Drop

Conf

Transfer

Home

Menu

More

Inspct
00

Message Light

Volume Control

User Cards and Tray

Fixed-Feature Buttons (8)

Dialpad

Call and Fixed-Feature Buttons
Button Labeling Card

MLX-20L



Programming Basics

System Programming Console

1-5

Fixed Feature 
Buttons 

4424LD+ Telephone fixed display buttons for most-used features: 

Spkr (Speaker) for turning the speakerphone on and off.

Mute for turning the speakerphone’s microphone and, if applicable, the 
headset’s microphone on and off.

Trnsfr (Transfer) for sending a call to another telephone.

Conf for adding a line or extension to a conference call.

Redial for redialing the last number dialed from the telephone.

Hold for putting a call on hold.

MLX-20L telephone fixed display buttons for most-used features:

Feature for viewing the Feature screen and selecting features.

HFAI (Hands-Free Answer on Intercom) for answering voice-announced 
calls without the handset.

Mute for turning the speakerphone’s microphone on and off.

Speaker for talking on a call through the speakerphone without lifting the 
handset.

Transfer for sending a call to another telephone.

Conf for adding a line or extension to a conference call.

Drop for disconnecting an extension or line from a conference call.

Hold for putting a call on hold.

Dialpad Number pad for dialing telephone numbers.

Direct Station 
Selector (DSS)
(not shown) 

A device that adds extension buttons and other buttons to the console. See 
Table 1-2.

Display Buttons Four fixed display buttons and 10 unlabeled buttons used to view the 
different screens and select names, features, and options from the display 
screen. See ‘‘Console Buttons’’ on page 1-7.

Display Screen Screen with a 7-line by 24-character display area that shows call 
information, features, prompts, date, and time.

Handset The hand-held part of the console you pick up, talk into, and listen from.

LEDs (Light-Emitting Diodes) The lights on the console that assist in checking 
feature status.

Line Buttons Buttons to make and receive calls; unlabeled buttons are programmable for 
one-step feature use. The 4424LD+ has 24 line buttons, and the MLX-20L 
has 20 line buttons.

Message Light A red light that signals a waiting message.

Table 1-1. 4424LD+ and MLX-20L Console Components— Continued

Component Function
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User Cards and 
Tray (MLX-20 
only)

A slide-out drawer with erasable cards for noting telephone numbers and 
feature codes.

Volume Control A button for adjusting the volume of speaker, handset, headset, and ringer.

Table 1-2. Direct Station Selector (DSS) Components

Component Function

Covers Removable plastic covers to protect the designation cards. The top cover 
protects the 50 DSS button labels. The lower cover fits over the fixed 
buttons.

DSS Designation 
Cards 

Cards for labeling the extension or feature assigned to each button.

DSS Buttons Fifty buttons used for one-touch dialing of co-workers’ extensions to make 
or transfer calls. DSS buttons are also used to page co-workers over 
speakerphones, to park calls, and to handle outside calls.

Fixed Buttons Ten additional buttons, including Message Status, Direct Voice Mail (MLX 
DSS only), and three Page buttons. The five remaining buttons on the first 
DSS are not used. If a second DSS is connected to the console, the 10 
buttons at the bottom of the second DSS are not used.

Fixed Message Status button used with fixed Page buttons to see which 
telephones have Message Lights on.

Fixed Page Buttons are three buttons used to select the pages of 
extensions that the 50 DSS buttons represent.

LEDs (Light-
Emitting Diodes) 

The lights that assist in checking feature status.

Table 1-1. 4424LD+ and MLX-20L Console Components— Continued

Component Function
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Console Buttons 1

Use the 14 buttons located on either side of the 4424LD+ or MLX-20L console display area for 
system programming. These buttons are arranged in two columns of seven buttons, as shown in 
Figure 1-3 and Figure 1-4. On the 4424LD+ console, three of the four fixed display buttons have 
different labels than those on the MLX-20L console, although the same functionality is provided 
(see the following section, ‘‘Fixed Display Buttons”).

Figure 1-3. 4424LD+ Display Buttons and Main Menu

Figure 1-4. MLX-20L Display Buttons and Main Menu

Fixed Display Buttons 1

The top two buttons in each column have the same labels and functions regardless of the screen 
display. This type of button is called a fixed display button. Table 1-3 describes the functions of the 
fixed display buttons for the 4424LD+ and MLX-20L consoles.
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Unlabeled Display Buttons 1

Use the five unlabeled display buttons on each side of the screen to select commands, options, or 
items on the screen. The functions of these buttons vary, based on the option you select.

If you are using WinSPM for system programming, the simulated 4424LD+ or MLX-20L console 
screen on your PC screen shows the function keys that correspond to the console screen 
selections. For example, to save an entry, you select Enter on the console or click � in the 
emulation display on your PC. See Chapter 2, ‘‘Programming with WinSPM,” for details about 
using function keys and additional information about WinSPM.

Console Overlay 1

The programmable line buttons are on the main part of the console. There are 24 line buttons on 
the 4424 LD+; however, the four buttons on the top row are not used during system programming.

The MLX-20 console has 20 line buttons, but you can use the console overlay to program up to 28 
line buttons on any extension through centralized telephone programming. Select Page 1 to 
access line buttons 1 through 20 and Page 2 to access line buttons 21 to 34. The top line of 
numbers next to each line button on the console overlay represents line buttons. See Figure 1-5 
and Figure 1-6 that follow.

When labels or filenames are entered, the letters A through F are displayed on the console screen. 
Additional letters can be entered by using line buttons 1 through 20 to represent letters G through 
Z. These letters are also displayed on the top line of the console overlay.

Table 1-3. Fixed Display Buttons

MLX-20L 
Buttons

4424LD+ 
Buttons Function

Home Exit Return to normal call handling mode after you finish programming. 

Menu Menu Display the Main menu shown in Figure 1-3.

More Display more items when a menu is continued on more than one 
screen, indicated by an angle bracket (>) on the upper right of the 
screen.

Inspct (Inspect) View a list of lines or extensions on which a feature is 
programmed or the settings for a feature. On the 4424LD+ console, an 
Inspect button must be programmed (programming code *778).

Return to the previous screen; indicated by an angle bracket (<) on the 
upper right of the screen. The MLX-20L does not have an equivalent 
button.
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Figure 1-5. 4424LD+ System Programming Console Overlay

Figure 1-6. MLX-20L System Programming Console Overlay
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The Top Sys Prog labeled function shown on the console overlay in Figure 1-6 does not appear on 
the 4424LD+ console overlay. The 4424LD+ does not provide a fixed HFAI (Hands Free Answer on 
Intercom) button for this feature; however, the HFAI feature can be programmed onto a line button 
on the 4424LD+ Telephone and then used for system programming.

When programming lines/trunks, you can select a block of 20 lines/trunks, as shown in Figure 1-7, 
and toggle the green or red LED associated with each line button on the console to program each 
line/trunk. The bottom line of numbers next to each line button on the console overlay represents 
the twenty lines/trunks associated with each line button (see Figure 1-6).

Figure 1-7. Selecting a Block of Lines/Trunks

Console and DSS Lights 1

The red and green lights (LEDs) next to each of the 20 line buttons on the 4424LD+ and MLX-20L 
console, show the status of the line/trunk options. LEDs on the DSS show the status of features 
programmed on extensions. 

Console Lights 1

The green and red LEDs next to each button on the console display the status of the line/trunk 
option that is being programmed. For example, when you select Pools from the Lines Trunks 
menu, the red LED is off if the selected line is not in a pool or on if the line is in a pool. 

DSS Lights 1

The lights on the DSS (if one is attached to the console) show the status of features being 
programmed on the extensions. When you select a feature from a menu, the red LED next to the 
DSS button is on, off, or flashing, depending on whether the feature is already programmed on the 
corresponding extension. For example, when you select Toll Restrict from the Restrictions 
menu, the red LED next to the DSS button lights for each toll restricted extension.

OutTrunk Dial: For a single-line, go to:
Enter Trunks w/Touch Tone l Single-Line Procedure.
Lines 01-20 Entry Mode 

Lines 21-40 For a block of lines, go to:
Lines 41-60 u Block Procedure.
Lines 61-80 

Exit



Programming Basics

Programming Procedures

1-11

Programming Procedures 1

The programming procedures provide step-by-step instructions for programming the system. This 
section details how to make the best use of the programming procedures.

Procedure Organization 1

The programming procedures in Chapter 3, ‘‘Programming Procedures,” are organized into logical 
groups. The programming procedures associated with a specific aspect of the system are grouped 
together under one heading. For example, to assign network services for E1, you would go to the 
section titled ‘‘E1 Facilities’’ and then locate the network services procedure. For quick reference, 
see ‘‘Menu Hierarchy’’ in Appendix A. 

Procedure Contents 1

Each procedure begins with a general description of the feature, followed by a summary of 
programming information that includes the items listed below:

Programmable by Indicates who has permission to use the procedure.

Mode Specifies which system mode supports the procedure: Key or Hybrid/PBX 
or a combination.

Idle condition Specifies the idle state required before the procedure can be performed.

Planning form Indicates the planning forms that provide information for the procedure.

Factory setting Shows the factory settings, if any, for equipment or features affected by 
the procedure.

Valid entries Specifies the characters, numbers, or values accepted during data entry.

Inspect Specifies whether or not the feature status can be verified using the 
Inspect feature.

Copy option Indicates whether or not the feature can be copied to another system 
component once it has been programmed.

Console Procedure Provides a summary of the procedure steps using the system console.

PC Procedure Provides a summary of the procedure steps using WinSPM.
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Programming Screens 1

There are three types of system programming screens:

■ Information Screens. To view what is currently programmed on the system.

■ Menu selection screens. To select options from a menu.

■ Data entry screens. To enter values or to identify a specific extension or line/trunk you want to 
program.

Figure 1-8 shows a sample information screen. When you select Sys Program from the Main 
menu screen (shown in Figure 1-3 on page 1-7), the screen shown in Figure 1-8 appears with 
system setup information.

Figure 1-8. Information Screen

You cannot make changes on an information screen. Select Back (or click � in the PC emulation 
display) to continue to the next screen in the procedure. 

Figure 1-9 shows a sample menu selection screen.

 

Figure 1-9. Menu Selection Screen
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A menu selection screen prompts you to select one of the available options. The screen title is the 
first line on all screens. The second line contains a system prompt or instruction. The remaining 
lines of text vary, based on the selected option.

An angle bracket (>) appears in the upper right corner of menu selection screens that have 
additional option screens. Press  or More (or click � in the PC emulation display) to see the 
additional screens; continue to press or click these buttons to move through the screens and return 
to the original screen. Figure 1-10 shows a sample data entry screen.

Figure 1-10. Data Entry Screen

A data entry screen prompts you to enter specific data or to make specific choices. Data to be 
entered are displayed with n’s in the text. When n’s appear on the data entry screen, they indicate 
data currently programmed for the feature. An exception is the slot/port number, which is displayed 
as sspp to distinguish the 2-digit slot number from the 2-digit port number. Slot is the slot number 
in the carrier and port is the port number on the module. 

Many screens show data entered on a previous screen, such as an extension or trunk number. 
Within the programming procedures, this type of variable information is shown with x’s.

When information to be entered varies in the number of digits required (for example, a telephone 
number that can range from 7 to 20 digits), the data may be displayed as an uppercase X or N. 

Data entry screens may also contain menu selections. Instead of entering data from the dialpad, 
you select options on the screen, such as Yes or No, to enable or disable a feature. To select this 
type of option, press either the unlabeled display button next to the option name, or the function 
key that corresponds to the option name. Then your selection is highlighted. To program or save 
the highlighted selection, press the unlabeled display button next to Enter (or click � in the PC 
emulation display).

Assign Lines/Trunks: Selected Option
Enter extension Prompt

Data Entry Area

Backspace

Back Enter

The slot/port numbering for adjunct ports on MLX modules begins at 21. The slot/port 
numbering for adjunct ports on TDL modules begins at 25. For example, on an MLX 
module in slot 1 of the carrier, to access adjunct port 710, you would enter 0121 as the 
slot/port number (01 indicates slot 1 on the carrier), while, on a TDL module in slot 1 of 
the carrier, to access adjunct port 710, you would enter 0125.
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Verifying Data Entry 1

You can use the Inspect feature to view the entries you save.

The Inspect button is fixed on an MLX-20L. To use the Inspect feature on a 4424LD+ Telephone, 
you must program a line button with the Inspect feature (refer to the Feature Reference for 
programming the Inspect button). 

An example of how to use the Inspect feature begins with Figure 1-11. The figure shows a data 
entry screen with the adjunct extension number of an MLX port.

Figure 1-11. Inspect Example

After you enter and save 7108, you can enter and save another extension; the extensions you 
enter appear one at a time on the screen as you enter and save them. However, if you press the 
Inspect button (� in the PC emulation display), all extension numbers that you have 
programmed in this data entry screen appear. For example, if you entered 7108, 7109, and 7110, 
when you press the Inspect button, all the extension numbers appear as shown in the sample 
Inspect screen in Figure 1-12.

Figure 1-12. Sample Inspect Screen

Whenever you want to return to the previous screen, select Back (� in the PC emulation 
display).
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The Inspect feature also allows you to check a value that has already been programmed for a 
feature. This is helpful when you are changing or modifying features. You can also use it when you 
program sequential extensions or lines to verify the last number programmed. See the Feature 
Reference for details about the Inspect feature.

Saving Entries and Moving among Screens 1

At the bottom of each screen, one or more screen keys may appear representing functions that 
allow you to change your entry, save your entry, or return to a previous screen. Various 
combinations of these screen keys appear on each programming screen. Figure 1-13 shows the 
QCC Priority screen with a typical display of screen keys.

Figure 1-13. Screen Keys

The PC keys that correspond to the screen key selections are shown here for quick reference. 
These PC keys do not appear on the console display screen. Table 1-4 contains details on the use 
of the screen keys. 

QCC Priority x: x = QCC Priority entered in earlier step
Enter line/trunk number

 xxx xxx = line/trunk number (801–880)
Delete 
 

� Backspace Next � 
� Back Enter � 

Table 1-4. Screen Keys

Display PC Key Function

BackSpace � or  
> 

Change your entry. Select Backspace (click � or > in the 
PC emulation display) to correct your entry. Each time you select 
Backspace or click �, the screen cursor moves backward to 
erase one character at a time.

Enter � or 
1 

Save your entry. Typically, you select Enter (click � or 1 
in the PC emulation display) to complete a procedure and save the 
information. Occasionally, you must select Exit (click � in the 
PC emulation display) and return to a previous screen after you 
use Enter. If the entry is not valid, the system may beep and/or 
display an error message and does not save the entry.

Delete 
 Delete a current entry. Select Delete (click 
 in the PC 
emulation display).
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Using Enter 1

Pressing Enter to save your entry produces one of the following results:

■ The next screen in the procedure appears.

■ The screen does not change and you can enter another extension or line/trunk. In most of 
these cases, Delete is also an option. Enter is used either to assign the extension to a 
group or to assign a feature to the extension. Delete is used to remove the extension from a 
group or to remove the feature from the extension.

■ The procedure is complete and you return to a previous screen.

Using Next 1

When you program a feature that applies to a sequence of extensions, lines/trunks, or groups, the 
screen key Next appears on the console display. Next (� in the PC emulation display) permits 
you to save your current entry and display the next number in the sequence. You can continue to 
press Next until you finish programming the entire sequence. When the last number in the 

Display PC Key Function

Next � Program sequentially numbered items. If you are programming 
a group of sequentially numbered extensions, lines, or trunks, you 
may optionally select Next (click � in the PC emulation display). 
This saves your entry and automatically provides the number of 
the next extension or trunk in the sequence. Typically, you remain 
at the same screen until you select Next. In a few cases, you may 
return to an earlier screen in the procedure. 

Back � Return to the previous screen. Select Back (click � in the PC 
emulation display) when you complete a procedure, to move up 
one screen in the menu hierarchy. (Appendix A provides a 
reference to the entire System Programming menu hierarchy.)

Exit a screen without changes. In most cases, you select Back 
(click � in the PC emulation display) to exit from a screen without 
making any changes. Exceptions are noted as part of a procedure.

Complete a procedure. In a few cases, you return to the System 
Programming menu when you select Back. In most cases, you 
return to an intermediate step within the procedure. You can then 
select one of the options shown on the screen and continue 
programming, or you can continue to use Back until you return to 
the System Programming menu.

Table 1-4. Screen Keys— Continued
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sequence displays on the screen, press Enter (� in the PC emulation display) to save the final 
entry and move to the next step of the procedure. Procedures that allow the use of Next return 
you to the correct screen to continue programming.

System Programming Hierarchy 1

For a complete listing of the options available under each of the System Programming Main menu 
options displayed on the system programming console, see the fold-out in Appendix A.

Access to System Programming 
from the 4424LD+ or MLX-20L or Console 1

Follow the steps below to begin system programming. All of the procedures in Chapter 3, 
‘‘Programming Procedures” begin at the System Programming menu shown in Step 3 of the 
following procedure.

For information about accessing system programming through a PC with WinSPM, see Chapter 2, 
‘‘Programming with WinSPM.”

1. Press menu to display the Main menu.

2. Select System Programming. The System Set-Up screen appears.

MENU MODE: Select Feature

Press HOME to Exit

Directory

Messages

Posted Msg Sys Program

Alarm Clock Maintenance

Timer Ext Program

System Set-up: Ext Program does not appear 
Review and Exit  on this screen if the programming
Type: xxxx console is a QCC.
Mode: xxxx

Operator: xxxx xxxx On the System Set-up screen, system 
xxxx xxxx xxxx xxxx information appears in place of the x’s.
Back Type = Voice/Data

Mode = Key, Hybrid/PBX, 
or Behind Switch 
Operator = Position extension numbers 
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3. Select Back. The System Programming menu appears.

System Programming Menu 1

Figure 1-14 shows the two screens that make up the System Programming menu.

Figure 1-14. System Programming Menu Screens

Table 1-5 describes the options.

System Programming:    >

Make a selection

System Extensions

SysRenumber Options

Operator Tables

Lines/Trunks AuxEquip Press the button next to  
Back NightSrvce your selection.

System Programming:  > System Programming:  >

Make a Selection Make a Selection

System Extensions Labeling         Language

SysRenumber Options Data

Operator Tables Print

Lines/Trunks AuxEquip Cntr-Prg

Back NightSrvce Back

Table 1-5. System Programming Menu Options

Option Description

System Set system operating conditions.

SysRenumber Select the system numbering plan and/or reassign extension numbers with 1- 
to 4-digit numbers that are more appropriate or convenient for your company.

Operator Assign or remove operator positions, and program operator features (such as 
Operator Hold Timer or QCC options).

LinesTrunks Program line/trunk options.

Extensions Program extension features (such as line assignments).

Options Program system-wide features (such as Transfer Return).
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Exiting System Programming 1

Use the information in Table 1-6 to return to the System Programming menu, the Main menu 
(Menu Mode screen), or the Home screen from within a programming screen.

Tables Program features that require entering information in a table (such as Allowed 
Lists and Disallowed Lists).

AuxEquip Program auxiliary equipment connected to the system (such as loudspeaker 
paging and fax).

NightSrvce Program Night Service features.

Labeling Program the labels shown on display telephones (such as Posted Messages 
and entries in the System Directory).

Data Specify extensions that need voice and data capability.

Print Print system programming reports (such as system configuration and 
extension assignments).

Cntr-Prog Perform centralized telephone programming (assign features to specific 
buttons on telephones).

Language Select the language for: the system, 4400-Series or MLX display telephones, 
SMDR reports, and print reports.

Table 1-6. Exiting System Programming

To return to… On the console, press… On the PC display, click…

Previous menu Back � 

Main menu Menu � 

Normal Call-
Handling 

MLX-20L Console: Home 
4424LD+ Console: Exit

� 

Table 1-5. System Programming Menu Options— Continued

Option Description

+^OZ
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Idle States 1

Some programming procedures can be started only when the entire system, or some part of it, 
such as a trunk or an extension, is idle (not in use). Some procedures require that a trunk or 
extension be idle only at the instant of programming. Lengthy procedures require the system, 
trunk, or extension to remain idle until programming is completed. These procedures wait for the 
system, trunk, or extension to become idle and then prevent the initiation of any new calls. This 
condition is called forced idle.

For complete information, refer to “Idle States” in Chapter 2.

If a procedure requires an idle condition, do the programming outside of normal business 
hours.
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Overview 2

The Windows System Programming and Maintenance (WinSPM) software package offers an 
alternate method of programming the MERLIN MAGIX Integrated System by using a PC. This 
method frees the system programming console for other uses and also provides the following 
additional functions:

■ Backing up system programming information

■ Restoring system programming information from a backup

■ Printing, viewing, and storing reports

■ Programming the system remotely

■ Programming in surrogate mode

■ Creating button labels

■ Storing print report data and/or user annotation notes using Notepad Editor

WinSPM provides two modes for programming your MERLIN MAGIX Integrated System:

■ Quick Access Mode. A graphical user interface (GUI) for those tasks most commonly 
performed by the System Manager–for example, adding or deleting members of groups, 
performing system inventories, creating reports, programming multiple systems, making 
station labels shown on display telephones, and more. 

■ Standard SPM Mode. Provides an emulation display of the system programming console. It 
allows basic SPM programming of the MERLIN MAGIX system and supports SPM 
programming for options not included in Quick Access mode.

WinSPM is available on CD-ROM and floppy disks. You can use the WinSPM software directly 
from the floppy disks or CD-ROM on your PC. If your PC has a hard disk, however, you should 
install WinSPM from either the floppy disks or CD-ROM onto the hard disk.

This guide describes the use of WinSPM in Standard SPM Mode. If you are using Quick Access, 
refer to the documentation and online help provided with the WinSPM application for additional 
information. 
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System Requirements 2

WinSPM is designed to function with:

■ Windows 95, Windows 98, or Windows NT Release 4.0 or higher

■ IBM-compatible Personal Computer with a Pentium 100 or higher (Pentium II or higher 
recommended)

■ 40 MB or more of available space on the hard drive

■ 32 MB of RAM (64 MB recommended)

■ 1 COM Port

■ Modem with auto baud capabilities (PEC 2569-839 recommended), with specific drivers 
loaded

■ Video Card that supports at least 256 colors (65536 or more recommended)

Depending on how you connect the PC to the control unit, you also need the following items:

■ Direct local connection if the PC is within 50 feet of the control unit:

— Either a 355AF modular adapter (if there is a male connector on the interface cable) or a 
355A modular adapter (if there is a female connector on the interface cable)

— A four-pair modular cord (D8W)

■ Direct local connection if the PC is more than 50 feet from the control unit:

— 355AF adapter 

— EIA crossover cable

— Two Z3A2 Asynchronous Data Units (ADUs)

— ADU crossover cable

— 400B2 power adapter 

— 2012D transformer 

— BR1A-4P adapter and either a 102 connecting block or 103 connecting block

— 248B adapter

— Eight-position wall jacks

— Four-pair plug-ended cable

— D8W cords

— D6AP power cord

— EIA-232-D cables

■ Internal or External connection:

— Modem that supports 1200- or 2400-bps connections

— Modem cable

From the Display Properties window on your Windows desktop, be sure to select 
Small Fonts for the Font Size option. See ‘‘Font Size Settings’’ under ‘‘Desktop 
Setup,” later in this chapter.
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In addition, a parallel printer is useful for reports. The PC needs a parallel port for the connection.

Installing the WinSPM Software 2

The WinSPM software can be installed from either CD-ROM or floppy disks.

CD-ROM 2

1. Insert the CD-ROM into your CD-ROM drive.

2. From the Start menu, select Run.

3. When prompted for the file or folder you want to open, type D:\setup.exe. (If your CD-ROM 
drive is set up as a different drive letter, replace D as necessary.)

4. Installation creates a program group named “Lucent Solutions.” This group contains a folder 
titled “WinSPM,” which contains an icon titled “WinSPM.” Clicking on this icon starts the 
WinSPM application.

Floppy Disks 2

Before installing or running WinSPM, it is recommended that you make a backup copy (see your 
operating system guide) of the WinSPM disk. Store the original in a safe place. Use the backup 
copy to run the installation program.

1. Insert diskette number 1 into your 3.5” floppy disk drive.

2. From the Start Menu, click Run.

3. When prompted for the file or folder you want to open, type A:\setup.exe.

4. Insert additional diskettes when prompted to do so.

WinSPM uses Interrupt 4 and I/O address 3F8 for COM1. It uses Interrupt 3 and I/O 
address 2F8 for COM2. 
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Getting Started 2

Upon installation of the WinSPM software, the following initial screen appears:

Figure 2-1. WinSPM Main Screen

The First Time User Wizard assists you through the following four steps:

1. Set up your desktop:

■ Font Size Settings

■ Modem Definition

■ Setting the Start Bar “Auto Hide” Property/Changing the Screen Resolution

2. Define your Password.

3. Set up your site:

■ Direct Connection

■ Internal Connection

■ External Connection

■ Manual Connection

4. Connect to the MERLIN MAGIX Integrated System:

■ Direct Connection

■ Internal Connection

■ External Connection
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Desktop Setup 2

Font Size Settings 2

At present, WinSPM does not support large fonts. Some fonts may be virtually unusable if Large 
Fonts is selected on the settings tab of the Display Properties window. To correct this setting:

1. Anywhere on your desktop, right-click and select Properties on the pop-up menu. The Display 
Properties window appears.

2. Click the Settings tab.

3. In the Font Size field, select Small Fonts from the drop-down list box.

4. Click Apply.

5. To close the window, click OK.

Modem Definition 2

If you are using a modem to connect to a MERLIN MAGIX Integrated System, and you have set 
the Maximum Speed to above 2400 bps, the modem in the MERLIN MAGIX Integrated System 
may time-out before your modem has enough time to step down to 2400 bps and establish 
communications. For this reason, it is suggested that you use a modem definition with a Maximum 
Speed of 2400 bps. You can create a new modem definition while retaining your original, higher 
speed definition if you choose.

Modifying an Existing Modem Definition 2

If your system is dedicated for connection with WinSPM to the MERLIN MAGIX Integrated System 
for programming and the modem on that system will not be used for any other purpose, do the 
following:

1. From the desktop, click Start.

2. Go to Settings and choose Control Panel.

3. Double-click the Modems icon. A list of modems configured in the system is displayed.

4. Highlight the name of the modem that is used to connect to the MERLIN MAGIX Integrated 
System and click the Properties button.

5. On the General tab, change the value in the drop-down list under Maximum Speed to 2400.
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6. Verify the following settings:

Connection Preferences 

Data Bits: 8

Parity: None

Stop Bits: 1

[X] Wait for dial tone before dialing.

Advanced 

[X] Use Flow Control

[X] Hardware (RTS/CTS)

7. To save the new settings, click OK.

8. To close the Modem Properties dialog box, click Close.

9. From the Control Panel, click File, then choose Exit to close the Control Panel and return to the 
Windows desktop.

Adding a New Modem Definition 2

If the system you are using is not dedicated for connection with WinSPM to the MERLIN MAGIX 
Integrated System for programming and the modem on that system can be used for other 
purposes, do the following:

1. From the Windows desktop, click Start.

2. Go to Settings and choose Control Panel.

3. Double-click the Modem icon. A list of modems configured in the system is displayed.

4. Take note of the name of the modem that is currently being used in the system to make 
connection to the MERLIN MAGIX Integrated System.

5. Press the Add button. The Install New Modem Wizard appears.

6. Select the “Don’t detect my modem” check box and click Next.

7. Highlight the name of the modem manufacturer for your modem.

8. Highlight the name of your modem in the Models list and click Next.

9. Select the COM port that corresponds to the COM port used by your modem and click Next.

10. Once your modem is set up successfully, click Finish to complete the operation. The new 
modem now appears in the list of modems on the Modem Properties form (usually with the 
same name as the modem identified in Step 4) with a #2 after it.

11. Highlight the name of the new modem and click Properties.

12. On the General tab, change the value in the drop-down list under Maximum Speed to 2400.
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13. Verify the following settings:

Connection Preferences 

Data Bits: 8

Parity: None

Stop Bits: 1

[X] Wait for dialtone before dialing.

     Advanced 

[X] Use Flow Control

[X] Hardware (RTS/CTS)

14. To save the new settings, click OK.

15. To close the Modem Properties dialog box, click Close.

16. From the Control Panel, click File, then choose Exit to leave the Control Panel and return to the 
Windows desktop.

Setting the Start Bar “Auto Hide” Property/Changing the
Screen Resolution 2

Some WinSPM screens may be difficult to use in 640x480 resolution because they use the full 
height of the screen. For this reason, you must either turn “Autohide” on for the Taskbar or increase 
your screen resolution settings. If you cannot see the OK button at the bottom of the screen, 
perform one of the following procedures.

Setting the Start Bar “Auto hide” Property 2

1. Right click an area of the Taskbar that is not a button. By default, the Taskbar is located at the 
bottom of the screen.

2. Select “Properties” from the pop-up menu.

3. On the Taskbar Properties dialog box, make sure that the “Auto hide” check box is selected.

4. Click Apply, then click OK. The Taskbar disappears. To bring up the Taskbar, simply move your 
mouse to the edge of the screen where it was previously displayed.

5. You should now be able to see the OK button. Simply click it to continue your first-time 
execution of WinSPM.

Changing the Screen Resolution 2

1. On the Taskbar, click Start.

2. Select Settings, then Control Panel.

3. Click the Display icon.

Be sure to always select the new modem from the list presented during connection to 
WinSPM.
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4. When the “Display Properties” dialog box appears, click the Settings tab.

5. Move the Desktop Area slider so that the resolution setting is higher than 640 x 480.

6. Click Apply.

7. You should now be able to see the OK button. Simply click it to continue your first-time 
execution of WinSPM.

Defining Your Password 2

There are two passwords in WinSPM: 

■ Application Password. There is an application-level password that serves as a security 
measure for accessing the WinSPM software itself. You are prompted to enter this password 
during the application login. Any characters that can be entered with the keyboard are 
acceptable. An asterisk displays for each password character entered. Since the actual 
password characters are not displayed, you are prompted to reenter your password for 
confirmation. 

■ System Password. A password is always required to establish a modem connection with the 
MERLIN MAGIX Integrated System. You can perform remote system programming only if you 
enter the correct password. (See ‘‘Password’’ on page 2-37 for details on establishing your 
system password.)

SECURITY ALERT:
■ The password characters do not appear on the screen as you type them.

■ Use a minimum of five characters.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of 
characters.

Setting Up a Site 2

To use the WinSPM software, your PC must be connected to the MERLIN MAGIX Integrated 
System directly via a serial port on your PC; otherwise you must connect to the MERLIN MAGIX 
system’s internal modem using your PC’s modem. 

Once you install WinSPM on your PC, the First-Time User Wizard guides you through setting up 
your application password and using the Site Setup option to create “sites” that correspond to the 
MERLIN MAGIX Integrated System that you are responsible for programming. Each site can be 
labeled with as much information as you need to differentiate one site from another. 

When you set up a site, you must first determine how your PC will connect to the MERLIN MAGIX 
Integrated System you want to program. A site can have multiple connection types set up. There 
are four connection types available (setup instructions for each type are provided on pages 2-9 
through 2-12):
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■ Direct Connection. A serial port on your PC is connected directly to the MERLIN MAGIX 
system programming jack—the lower modular RS-232 jack on the processor module.

■ Internal Connection. You are using a modem (either connected to or built into your PC) that is 
connected to the MERLIN MAGIX Integrated System (for example, via a 016 T/R module) to 
access the MERLIN MAGIX internal modem.

■ External Connection. You are using a modem (either connected to or built into your PC) and 
using a dial-up connection to access the MERLIN MAGIX internal modem. The External 
Connection type requires use of the Remote Access feature to allow you to connect to the 
MERLIN MAGIX programming port without manual intervention.

■ Manual Connection. You are using a modem (either connected to or built into your PC) and 
using a dial-up connection to access the MERLIN MAGIX internal modem. The Manual 
Connection is used when you must reach the MERLIN MAGIX programming port by placing a 
call to the site and the person who answers transfers your call to the programming port.

Direct Connection 2

To set up a site for a Direct Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the TAB key. Site Names are limited to 30 
characters. You may only use characters that are acceptable for file names in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) you may want 
to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Direct tab.

5. Select the Enabled check box. A check mark appears in the box and the COM Port drop-down 
list box is no longer grayed out.

6. Click the arrow located on the right-hand side of the COM Port drop-down list box to get a list 
of the available COM ports on your PC. Click once on the number that corresponds to the 
COM port on your PC that is connected to the MERLIN MAGIX administration port.

7. Set the COM port speed to 2400 (most instances).

8. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site.
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9. When you finish adding sites, click OK.

Internal Connection 2

To set up a site for an Internal Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may only use characters that are acceptable for file names in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) that you may 
want to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Internal tab.

5. Select the Enabled check box. A check mark appears in the box and the Dial String dialog box 
is no longer grayed out.

6. Be sure that the Dial String check box displays *10.

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site.

8. When you finish adding sites, click OK.

■ If you have multiple modems installed in your system, after clicking OK, you may be 
prompted to select the modem you want to connect with.

■ Clicking Cancel from the Connection Selection screen causes you to return to either 
the Main screen or the First-Time User Wizard, depending on from where the screen 
was started.

■ If you have multiple modems installed in your system, after clicking OK, you may be 
prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to either 
the Main screen or the First-Time User Wizard, depending on from where the screen 
was started.
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External Connection 2

To set up a site for an External Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may use only characters that are acceptable for filenames in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) that you may 
want to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the External tab.

5. Select the Enabled check box. A check mark appears in the box and the Dial String dialog box 
is no longer grayed out.

6. Edit the contents of the Dial String dialog box for the exact dial string the modem will need to 
dial to access the remote MERLIN MAGIX administration port. The dial string must include the 
Remote Access line, the barrier code (if required), and the dial code for the MERLIN MAGIX 
admin port (*10). Use commas to create necessary pauses in the dial string.

Example: You are connecting to a remote MERLIN MAGIX Integrated System via a modem 
through the Remote Access line 800 555-9999. The Remote Access line is set up with barrier 
code 1234 for access to the remote dial tone. The site from which you are dialing requires you 
to dial 9 to get an outside line. Using commas for pauses in the dial string, the dial string would 
be 918005559999,,,,,1234,*10.

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site. 

8. When you finish adding sites, click OK.

■ If you have multiple modems installed in your system, after clicking OK, you may be 
prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to either 
the Main screen or the First-Time User Wizard, depending on from where the screen 
was started.
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Manual Connection 2

To set up a site for a Manual Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may use only characters that are acceptable for filenames in the Windows 
environment.

3. Complete the following fields to help you differentiate this site from any other site(s) that you 
may want to add. These fields are not required; therefore, you may fill in as many or as few as 
you determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Manual tab.

5. Click the Enabled check box. A check mark appears in the box and the Dial String dialog box is 
no longer grayed out.

6. When you try to connect using the Manual Connection type, WinSPM displays a dialog box 
with an OK button. Place a voice call to the system on a regular line and ask the operator to 
transfer you to the MERLIN MAGIX admin port by dialing *10. When you hear the modem 
answer tone, click OK to complete the connection and then hang up the handset. 

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site. 

8. When you finish adding sites, click OK.

■ If you have multiple modems installed in your system, after clicking OK, you may be 
prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to either 
the Main screen or the First-Time User Wizard, depending on from where the screen 
was started.

■ While setting up a Manual Connection, you will also be prompted to set the Maximum 
Speed for connection. It is recommended that you select 2400.
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Connecting to a MERLIN MAGIX Integrated System 2

Direct Local Connection 2

For a direct local connection, you must connect the PC to the system programming jack. This is the 
lower modular RS-232 jack on the processor module, as shown in Figure 2-2. (The upper jack is 
reserved for the SMDR printer.) 

To connect a PC more than 50 feet from the control unit, see Figure 2-3.

For direct local connections, the system supports speeds of 1,200 and 2,400 bps.

 

Figure 2-2. Direct Connection
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Figure 2-3. Direct Connection, PC More Than 50 Feet Away

Internal Connection 2

For an internal connection, you must use a modem (either connected to, or built into, the PC) to 
access the internal modem in the control unit. Connect the modem to a T/R jack on a 016 (T/R) 
module, as shown in Figure 2-4. 

The internal modem operates at speeds of 1200 and 2400 bps.

Figure 2-4. Internal Connection
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External Connection 2

For an external connection, you must use a modem (either connected to, or built into, the PC) to 
access the internal modem in the control unit. You must also use a dial-up connection, as shown in 
Figure 2-5. 

The internal modem operates at speeds of 1200 and 2400 bps.

Figure 2-5. External Connection
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WinSPM Main Screen 2

When you connect your PC to the MERLIN MAGIX Integrated System and start the WinSPM 
application, the WinSPM Main screen shown in Figure 2-6 appears.

Figure 2-6. WinSPM Main Screen

The Main screen icons shown on the left-hand toolbar provide the following functionalities:

■ Site Setup. Launches the Site Setup screen which depicts all of the sites defined in the 
WinSPM application. Used to set up a new site or modify an existing site. 

■ Disconnect. Disconnects you from a MERLIN MAGIX Integrated System once a connection 
has been established. 

■ Standard SPM. Launches the Standard SPM Mode.

■ Pass-Thru. This icon is not used with MERLIN MAGIX R1.0i systems.

■ View. Enables you to access the Log Viewer and browse notes and reports.

■ Settings. Enables you to define password, options, and TAPT settings.

■ Tools. Enables you to access the backup, restore, and convert features.

■ Quick Access. Enables you to access many common features including: Allowed/Disallowed 
Lists, Automatic Route Selection, Call Pickup Groups, Calling Groups, Capture Data, 
Coverage Groups, Labeling, Personal Lines, Set Date & Time, Speed Dial, System Inventory, 
Telephone Programming, and Telephone Restrictions. 
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Using Quick Access 2

The Quick Access interface allows you to complete common tasks in an extremely user-friendly 
manner. The Quick Access window (see Figure 2-6) displays a series of large graphic buttons 
representing each of the following supported Quick Access tasks:

— Allowed/Disallowed Lists

— Automatic Route Selection

— Call Pickup Groups

— Calling Groups

— Capture Data

— Coverage Groups

— Labeling

— Personal Lines

— Set Date and Time

— Speed Dials

— System Inventory

— Telephone Programming

— Telephone Restrictions

Descriptions of each of the Quick Access tasks are provided in the following sections.

Allowed/Disallowed Lists 2

Used in conjunction with Calling Restrictions (Outward and Toll), an Allowed List is a list of 
numbers that the caller is allowed to dial, despite restrictions. For example, an Allowed List 
assigned to an outward-restricted extension can allow calls to specific local numbers, such as 
(911) or toll numbers. For toll-restricted extensions, an assigned Allowed List can allow calls to 
specific area codes and/or exchanges needed for daily tasks.

A Disallowed List is a list of local or toll numbers that the extension user is not allowed to dial, even 
if the extension is otherwise unrestricted. Disallowed Lists can be used as an alternative to or in 
conjunction with Calling Restrictions.

Both Allowed Lists and Disallowed Lists are assigned to individual extensions. Disallowed Lists 
can also be used in conjunction with Remote Access to restrict calls made through the system 
from remote locations. In this case, Disallowed Lists can be assigned either to specific Remote 
Access barrier codes or (if barrier codes are not used) to specific types of lines/trunks (all Tie/
Direct Inward Dialing (DID) and all non-Tie/non-DID trunks). For more information, refer to 
‘‘Allowed Lists,’’ on page 132, and ‘‘Disallowed Lists,’’ on page 133.

For additional information on programming your MERLIN MAGIX Integrated Systems 
in Quick Access mode, refer to the documentation and online help provided with the 
WinSPM application. For information on programming your MERLIN MAGIX 
Integrated System in Standard SPM Mode, see page 2-26.
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Automatic Route Selection (ARS) 2

ARS allows outgoing calls to be dynamically routed over selected facilities after dialing an ARS 
access code. This enables the system to select the least expensive route for each call. ARS is 
available only in Hybrid/PBX mode.

Programmable lists, called tables, indicate the desired routes (line/trunk facilities) for specified 
area codes and/or exchanges. There is a different ARS table for each type of call (local, toll, 
special number, and so on). The tables are chosen according to the telephone number digits that 
are dialed by a user. Each ARS table has a particular pool to which it routes calls. For more 
information, refer to ‘‘Pickup Groups,’’ on page 102.

Call Pickup Groups 2

An extension that is a member of a Call Pickup Group can program a button on the telephone or 
dial a feature code to pick up a call ringing on the telephone of any other member extension in that 
group. There is a limit of 30 groups with15 extensions per group. An extension may be a member 
of only one Pickup Group. For more information, refer to ‘‘Automatic Route Selection,’’ on page 
146.

Call Pickup Groups contain the following:

■ Available Extensions. The list of extensions in the system. Double-click or use the right-arrow 
button to move extensions into the Selected Extension.

■ Selected Extensions. The list of extensions that are members of the Call Pickup Group that is 
selected with the tabs. Double-click or use the right-arrow button to remove extensions to the 
Available Extensions. Note that this list is limited to 15 extensions per group.

■ Group Number. Select the Call Pickup Group to display its members in the Selected 
Extensions list box.

Calling Group 2

This feature is used to define the extensions that are members of a Calling Group, and to assign 
the lines/trunks pools that you want to ring directly into this Calling Group. 

From the Calling Group Quick Access screen, you pick the Calling Group you wish to modify by 
highlighting it. There are seven tabs that can be modified for each Calling Group. These are: 
General, Primary Delay, Overflow, Queue, Members, Lines & Pools, and Coverage.

■ General:

— Group Type. Choose from the drop-down list box.

— Hunt Type. Allows you to specify whether the Hunt Type is circular, linear, or most 
available. Choose from the drop-down list box.
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— Secondary Delay Announcement. Select from the drop-down list box the extension to be 
used as a secondary delay announcement.

— Delay Interval. Select an interval from 0-900 seconds for the secondary delay.

— Delay Announce Repeat. Select Yes or No if you wish the secondary delay.

— Message Waiting Receiver Extension. Select the extension at which you wish to light a 
message waiting light if the group is covered by a voice mail box.

■ Primary Delay: 

— Select the extensions you want to provide primary delay announcements for the chosen 
Calling Group.

■ Overflow:

— Overflow Coverage Calling Group Number or QCC LDN extension. From the drop-
down list box, choose a Calling Group or the QCC queue that you want to provide overflow 
coverage for this Calling Group.

— Overflow Threshold (Calls). Choose the number of calls (1-99) that are allowed to stay 
“queued” in this Calling Group before “overflowing.”

— Overflow Threshold Time (seconds). Choose the number of seconds (0-900) the oldest 
waiting call must wait before overflowing.

— Prompt-Based Overflow. Choose Yes or No to allow or disallow a waiting caller the ability 
to press the pound (#) key on their telephone to initiate overflow.

■ Queue:

— Calls In Queue Alarm Thresholds (seconds). For each choice, choose the flash rate 
interval. For example:

■ If the number of waiting calls is fewer than the value programmed for Threshold 1 or 
drops below that level, the LED is unlit.

■ If the number of waiting calls is greater than or equal to the Threshold 1 value, but less 
than the Threshold 2 value, the LED flashes.

■ If the number of waiting calls is greater than or equal to the Threshold 2 value, but 
fewer than the value for Threshold 3, the LED winks.

■ If the number of waiting calls is greater than or equal to the highest value, Threshold 3, 
the LED lights steadily. 

An external alert only signals when the number of calls in the queue is greater than or 
equal to the programmed Threshold 3 value.

— External Alert for calls in Queue Alarm. Choose the adjunct extension associated with 
the external alert device. There are two choices:

■ An LED on any 4400-Series or MLX telephones can be associated with a Calls-in-
Queue Alarm button.

■ An external alert on an MLX telephone using a Multi-Function Module set for 
Supplemental Alert Adapter operation and programmed as the alert.

— Queue Control. Choose the number of calls (0-99) allowed to back up in queue before 
sending a network busy signal.

■ Members: 
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— Choose extensions from the list to place them into the selected Calling Group. Note that 
only the extensions for the tip/ring ports associated with a voice messaging system may 
be in VMI Calling Groups; there is a system maximum of 20 VMI Calling Groups, and any 
one Calling Group may have a maximum of 20 members. An extension may be a member 
of only one Calling Group.

Capture Data 2

This feature allows you to read from the MERLIN MAGIX system in one large batch. This is useful 
if you are setting up the MERLIN MAGIX system for the first time or if you are making significant 
changes. Capture Data reads all of the data needed for each selected Quick Access form.

■ Task Selection. Check the items that you want to read from the MERLIN MAGIX system. 
Some of the items are for the whole Quick Access form, some are broken down into the 
individual tabs that appear on the Quick Access forms. As you check/uncheck items, the 
estimated number of minutes for completion changes to give you a “best guess” as to how long 
the reading will take.

■ Baseline Values. These values help calculate the estimated number of minutes for 
completion. Some of these values will be changed to the correct values if the data has been 
retrieved. Other values need to be entered manually. These values are not retained after the 
Capture Data form is closed.

Coverage Groups 2

This feature is used to assign or remove an extension from a Coverage Group. A Coverage Group 
is a group of senders. Group Coverage is an arrangement where calls from a group of senders are 
redirected to one or more receivers. For more information, refer to ‘‘Group Coverage Member 
Assignments,’’ on page 104.

Coverage Groups include the following:

■ Available Extensions. The list of extensions in the system. Double-click or use the right-arrow 
to move extensions into the Selected Extensions.

■ Selected Extensions. The list of extensions that are members of the Coverage Group that is 
selected with the tabs. Double-click or use the right-arrow to remove extensions to the 
Available Extensions.

■ Group Number. Select the Calling Group Number to display its members in the Selected 
Extensions list box.
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Labeling 2

This feature allows you to edit the various system labels. System Speed Dial changes are 
performed separately. A simple dialog box containing the following fields is available.

■ Label Type. A group of options including: System Directory, Extensions, Adjuncts, Lines and 
Trunks, Posted Messages, and Group Calling. Select the type for which you want to edit labels.

■ Entry Number. This field prompt changes to reflect the option you selected for Label Types. 
Use this field to select the extension number, line, trunk, posted message, or Calling Group 
that you want to change.

■ Name. Text for this label. Different label types are limited to different string lengths – for 
example, extensions and Calling Groups are limited to 7 characters.

Personal Lines 2

This feature allows you to add lines and pools to buttons on a telephone.

CAUTION:
After you click the Apply button, you will be able to see where the lines and pools were 
placed on the telephone. Keep in mind that adding a line that is a member of a pool results in 
a pool being assigned to the button on the telephone. You cannot assign the same line or 
pool to more than one button on the telephone twice. Also remember that lines and pools are 
added on the buttons immediately following the System Access buttons and overwrites any 
other feature programmed to those buttons.

Set Date and Time 2

This feature sets the current time and date on the MERLIN MAGIX Integrated System. The dialog 
box contains the following:

■ The PC’s date and time.

■ The MERLIN MAGIX system date and time, which can be edited and applied back to the 
MERLIN MAGIX system.

All labels are always printed in capital letters, exactly as they appear on the MERLIN 
MAGIX display telephones.

By default, each added line or pool is programmed on available successive buttons 
starting with the lowest button on the telephone, and overwrites any programming that 
may already exist on these buttons. 
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■ A Synchronize button that gives you the ability to set the MERLIN MAGIX system date and 
time to match the PC’s.

■ An OK button that applies any changes you made to the MERLIN MAGIX system date and 
time.

Speed Dial 2

This feature allows you to modify System Speed Dial entries. It consists of a simple display grid 
containing the following:

■ Speed Dial Code. A number field defining the system speed dial code (in the range of 600 to 
729).

■ Company/Name. A description of the directory entry.

■ Number. The number to dial.

■ Display Number. Select Yes to display the Name when dialing; select No to display the 
number being dialed.

Use the following buttons to edit the System Speed Dial entries:

■ Add. Adds a new entry.

■ Modify. Modifies an existing entry.

■ Delete. Removes an existing entry.

System Inventory 2

This feature offers a report on the MERLIN MAGIX Integrated System hardware configuration. 
Starting with the processor (installed in slot zero), it obtains the characteristics of the hardware 
components available in each slot in the MERLIN MAGIX system carrier.

By default, the Hardware Inventory screen lists the Board Type, Hardware Vintage, Firmware 
Vintage, and Application Vintage of each available control unit module (scroll down for more). To 
quickly obtain the specifications of a given module, click the module’s image. To obtain a total 
report, click the corresponding Print button.

Use the Print button to view the printed report on the screen (Print Preview). You can either print a 
paper copy of the report or save the report to a file.
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Telephone Programming 2

Telephone programming allows the centralized programming of a subscriber’s telephone. When 
you select this feature, a window is displayed containing the following elements:

■ A list of extensions, labels (if read), and logical IDs. To sort this list, click the arrow on the 
header bar for the column you want to sort by.

■ Notes window. Use this window to create or edit annotations.

■ OK button. Highlight the extension you wish to program and click OK. (Double-click the 
extension to go to the next screen.)

■ Print button. Use this button to print the list of extensions, labels, and LIDs.

■ Cancel button. Use this button to cancel and return to the previous menu.

■ Help button. Use this button to display Help information.

Telephone Restrictions 2

This feature is used to configure Calling Restrictions for an extension. Calling Restrictions include 
extension restrictions, Automatic Route Selection (ARS) restriction level, and Forced Account 
Entry. This feature is also used to assign Allowed Lists and Disallowed Lists to an extension.

This feature includes the following:

■ Authorization Code. Enter a unique 2 to 11-digit Access code for this extension. (Optional)

■ Restriction Level. Select Unrestricted, Outward Restrict, or Toll Restrict.

■ Facility Restriction Levels. Select ARS restriction level (0-6).

■ Delayed Call Forwarding Rings. Select the number of rings (0-9) before a call is forwarded 
using the Forward or Follow Me Feature.

■ Allow Trunk-to-Trunk Transfers. If checked, the extension user must enter an account code 
before making an outside call.

■ Remote Call Forwarding. Allows the extension user to forward all calls to an outside 
telephone number.

■ Pool Dial-Out Codes. The list of trunk pools that the extension user is allowed to use to make 
outside calls. A list box appears, plus two buttons (>>> and <<<). To add pools, highlight the 
pool dial-out code in the Available box and then click the >>> button. To remove pools, 
highlight one or more in the Selected list box and then click the <<< button.

■ Allowed Lists. Use to assign one or more Assigned Lists to the extension. Use the Allowed 
List tab to view the current extensions in that list. Use the ‘Is User’ check box to add/remove 
the selected extension from the lists. Allowed List defines area codes and exchange prefixes 
that this extension user is allowed to dial when making an outside call.
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■ Disallowed Lists. Use to assign one or more Unassigned Lists to the extension. Use the 
allowed list tab to view the current extensions in that list. Use the ‘Is User’ check box to add/
remove the selected extension from the lists. Disallowed List defines area codes and 
exchange prefixes that this extension user is not allowed to dial when making an outside call.

■ Show Number List. If checked, the Allowed or Disallowed List is read from the MERLIN 
MAGIX system and displayed for the currently selected Allowed/Disallowed List.

■ The Standard SPM Mode Interface must be used to define Night Service 
Coverage.

■ Automatic Route Selection (ARS) allows outgoing calls to be dynamically routed 
over selected facilities after dialing an ARS access code (usually 9). This enables 
the MERLIN MAGIX Integrated System to select the least expensive route for each 
call based on the area code and prefix that the extension user dials.
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WinSPM Help 2

To access the WinSPM Help screens, perform one of the following:

■ Press �.

■ Press 7/R.

■ Click the Help button (when available).

Figure 2-7. Sample WinSPM Help Screen
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Using Standard SPM Mode 2

This section describes how to use the Standard SPM Mode screens.

SPM Screens 2

Standard SPM Mode screens simulate the system programming console. Each Standard SPM 
Mode screen includes a 7-line by 24-character console simulation window that corresponds to the 
display area of the MLX-20L or 4424LD+ telephone. To the right and left of this console simulation 
window are columns that list the keys corresponding to similarly located buttons on the MLX-20L 
or 4424LD+ telephone. Figure 2-8 illustrates the Standard SPM Mode display screen.

Figure 2-8. Standard SPM Mode Display

� through � and � through � display on either side of the console simulation screen. They 
represent the function keys to use when you select screen options. When a screen contains 
several choices, click the function key identified by the label next to your choice. (If you were 
programming on the console, you would press the telephone button next to your choice.)

If you are using Quick Access, Backup and Restore can be selected from the Main menu. 
The System Inventory option in the Quick Access mode provides a graphical 
representation of your system inventory, which includes all modules and versions. All of 
the options listed above are available in the Standard SPM Mode. For additional 
information on using Quick Access, refer to the documentation and online Help provided 
with WinSPM. 
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Below the console simulation window are 20 simulated line buttons. The 20 line buttons can be 
selected by clicking on the appropriate button. By clicking � (the Inspect feature), you can 
determine the status of each line and the features programmed on each line according to the letter 
that appears next to the line number. 

The labels along the bottom of the screen correspond to buttons on the 4424LD+ or MLX-20L 
telephone. Table 2-1 describes the function of PC keys in WinSPM.

Table 2-1. Function of PC Keys in WinSPM

PC Key MLX-20L 4424LD+ WinSPM Function

� Home Exit Quit. Exit from WinSPM when you finish with 
system programming. If you are using a modem, 
the call is disconnected.

� Menu Menu Return to the WinSPM Main menu.

� More > Display more menu items (when there is another 
screen and the ! symbol appears next to the 
key).

�% Inspct (MLX- 
20L only)

Display the current information that has been 
programmed for a feature or button. (There is no 
fixed Inspct button on the 4424LD+ console. This 
button must be programmed onto a feature key 
on the 4424LD+ console.) 

7+I Drop Drop Enter a stop in a speed-dialing sequence. This 
combination also deletes an entry in a field on 
any screen, except the one in which you are 
entering a speed-dialing sequence. 

7+P Conf Conf Flash. Enter a switchhook flash in a speed-
dialing sequence.

7+Z n/a n/a TopSP. Return to the top of the System 
Programming menu.

6 Hold Hold Pause. Enter a pause in a speed-dialing 
sequence.

7+- n/a n/a Toggle modem speed between 1200 and 
2400 bps.

<+� n/a n/a Help. Display a Help screen about WinSPM 
operations. 

<+� n/a n/a Reset. Reset the communications port. For 
example, if the information on the screen is 
garbled, try exiting from and then re-entering the 
screen. If the screen remains garbled, use 
<+� to clear the screen and return to the 
WinSPM Welcome screen. Note that using 
<+� drops the modem connection.
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Basic System Management Procedures 2

This section demonstrates how to complete the following procedures using WinSPM operating in 
Standard Mode or the WinSPM menu:

■ Backup

■ Boards

■ Browse

■ Language

■ Maintenance

■ Monitor

■ Pass-Thru

■ Password

■ Print Options

■ Restore

■ System Programming

<+
 n/a n/a Browse. View print reports saved with Print Opts.

1 Enter Enter The 1 key on your PC can be used instead 
of �%when Enter appears as a choice in the 
console simulation window.

> Backspace Backspace The 3 key on your PC can be used instead of 
� (Backspace) when Backspace appears as 
a choice in the console simulation window.

9 Delete Delete The 9 key on your PC can be used instead of 

 (Delete) when Delete appears as a choice 
in the console simulation window.

� # 

� � 

n/a n/a The up, down, left, and right arrow keys can be 
used to highlight selections in a menu and to 
select the 20 line buttons below the console 
simulation window.

Table 2-1. Function of PC Keys in WinSPM— Continued

PC Key MLX-20L 4424LD+ WinSPM Function
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Table 2-2 gives a brief description of each procedure. 

The Backup procedure is used by qualified service personnel to create a file of system 
programming information either in a specified directory (on the hard drive of the PC) or on a floppy 
disk. 

Table 2-2. Management Procedures 

 Option Function

Sys Program To program the system.

Backup1 

1 WinSPM option only. Not available on the system programming console. To be used only by qualified service 
personnel.

Backup 1

To make a backup copy of your system programming and store it on a floppy 
disk or on hard disk.

Boards1 To show which modules (port boards) are in each slot of the control unit and 
allows you to assign boards to slots.

Print Opts1 To direct reports to printer or to the PC for storage on a floppy disk or on hard 
disk.

Monitor Restricted to use by your technical support organization.

Maintenance Restricted to use by your technical support organization and qualified 
technicians.

Restore1 To restore your system programming from floppy disk or from hard disk.

Pass-Thru Not used with MERLIN MAGIX Integrated System Release 1.0i.

Password To change the password for remote entry into the system.

Language To select a language (U.S. English, Canadian French, Latin American 
Spanish, or Brazilian Portuguese) for the console simulation window on the 
PC. (There is also a Language option available on the System Programming 
menu that allows you to set the System Language.)

Back up your system programming information on a regular basis. A current backup file 
allows you to quickly and easily restore your system, if the need arises.
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Considerations 2

Review the following items before you begin the backup procedure:

■ The system does not have to be idle during backup; however, extension programming is 
blocked.

■ Any objects that are in a maintenance-busy state are stored in that state. When you restore 
system programming, these objects are busied out, even if they have since been released 
from the maintenance-busy state.

■ If you plan to store your backup file on a floppy disk, format a DOS disk.

■ Uncompressed backup files are 100,000 to 210,000 bytes in size; compressed files are about 
70,000 to 85,000 bytes. 

■ Maintenance data (error logs and other data used by qualified service technicians) is not 
saved in the backup file.

To perform the backup procedure, follow the steps below:

Standard SPM �→Select GOTO FLOPPY or GOTO HARD DISK→1→ 
Specify default filename or Make new file name→1→ *2to 
continue or 0 to abort→0 to abort or 1%to return to the 
Standard SPM Main menu

WinSPM 

1. From the WinSPM Main window Outlook bar, select Tools.

2. From the Outlook bar, click the Backup icon.

A selection dialog box displays.

3. Select the File option.

4. Click Ok.
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The Save dialog box displays.

5. Enter the name and location of the file to be saved.

6. Click Save. 

The progress dialog box displays.

7. Click Cancel to exit.

Boards 2

The Boards option allows qualified service personnel to add a board to the next available slot. The 
system must be idle to use this option. This option is not available from the system programming 
console.

The Boards option is also available in Surrogate mode. In Surrogate mode, you can assign trunk 
and extension modules (boards) to slots, even though the boards have not actually been installed. 
This type of board is referred to as a “phantom” or “null” board.

You cannot use the Boards option to change an actual board type. All boards assigned with the 
Boards option, including phantom boards, are cleared (unassigned) if you perform a board 
renumber (System→Board Renum).
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■ You must assign phantom boards to higher slot numbers than those you assign to any real 
boards. If you assign a phantom board to a lower slot number than a real board, the control 
unit does not recognize the real board or boards that follow the phantom board.

■ If you remove a board but do not replace it, and then perform a board renumber, the control 
unit will not recognize any boards that follow the empty slot. You must reseat all of the boards 
to fill the empty slot before you perform the board renumber.

The Inspect function (�) lets you see which modules have been assigned to slots on the control 
unit. Note that both phantom boards and real boards display if you use the Inspect feature. 
Table 2-3 shows the type of boards that you can select. To see only real board assignments, you 
must print the System Information report: System→More→Print→SysSet-up.

Table 2-3. Board Types

Board Type Description

024TDL 24 digital extension jacks with 8 Touch-Tone Receivers

016MLX 16 MLX extension jacks (32 endpoints); upgradable with PCMCIA card

008MLX 8 MLX extension jacks (16 endpoints)

016ETR 16 ETR extension jacks with 4 Touch-Tone Receivers 

016TRR 16 tip/ring extension jacks with 4 Touch-Tone Receivers

MsgOPT 008 OPT - 8 tip/ring extension jacks with 2 Touch-Tone Receivers

or

MERLIN Messaging - 7 internal tip/ring extension jacks with 2 Touch-Tone 
Receivers; MERLIN Messaging System resides on this module

100E 32 channels (“virtual” lines/trunks); upgradable with PCMCIA card

800DID 8 DID line jacks

800LTD 

Reviewers: 
What is the 
designation 
here? 

8 loop-start line jacks with dial tone detection and Call Progress Tone 
detection.

MFC06 6 Multifrequency Compelled Register Signaling generators/receivers
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Follow the steps below to assign modules:

1. At the Standard SPM Mode Main menu, click � to select Boards.

2. Click the function key that corresponds to the module you want to select.

3. If the module you want to assign is not shown on the first screen of the Boards menu, click 
� to display the next menu screen.

4. Type the control unit slot number (01 through 17) in which the module is to be installed.

   SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

Boards:                >

Make a selection

412LUP 016ETR

024UPO 016TTR

016MLX MsgOPT

008MLX 100D

Back 800BRI

Boards:                

Make a selection

408GLM 400E&M

100R

800DID

800LID

Back

module name module name = option selected in Step 2
Enter slot numbers

(01–17)

 Delete

Backspace Next

Back Enter
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5. Assign or remove the module from the slot entered in the previous Step.

■ To remove the module type from the specified slot number, click 
 (Delete). The 
Boards menu reappears.

■ To assign the module type to the specified slot number and assign that same module type 
to another slot, click � (Next).

■ To assign the module type to the specified slot number and assign a different module type 
to another slot, click � (Enter).

■ To terminate the procedure and assign a different module, click � (Back) and repeat 
Steps 2 through 4.

■ To view types of modules assigned to all slots, click � (Inspect).

6. To save your entry, click � (Back).

The programming session terminates and the system restarts.

Browse 2

The Browse option allows you to browse through reports and notes saved in WinSPM.

Standard SPM <+
→Select hard disk or floppy→�→Select a Report→ 
�→ 02to Exit

 To view the next page of a report, click �.

To view the previous page of a report, click �.

To return to the beginning of a report, click �.

WinSPM 

1. From the WinSPM Main window Outlook bar, select View.

2. From the Outlook bar, click the Browse Notes & Reports icon.

module name module name = option selected in Step 2
Enter slot numbers

(01–17) nn = slot entered in Step 5 (second digit will 
not display. 

nn 

 Delete

Backspace Next

Back Enter
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The Browse Notes & Reports dialog box displays.

3. From the Type field, select whether you want to view reports or notes.

4. From the drop-down list, select the report/notes you want to view.

5. Click Print to print the report to your default printer.

or 

Click Export.

The Save dialog box displays.

6. Enter the name and location of the file to be saved.

7. Click Save.

8. Click Close to exit the Browse Notes and Reports dialog box.
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Language 2

A Language attribute in WinSPM specifies whether WinSPM menus, pop-up windows, and other 
messages are presented in U.S. English, Canadian French, Latin American Spanish, and Brazilian 
Portuguese. A Second Language selection option affects messages from the control unit to 
WinSPM, and controls the display on the console simulation window for the duration of the 
session. These two language options operate independently of each other.

The following discussion refers to the console window language.

Console Window Language 2

By default, the language used in the console simulation window is the language specified in the 
ams.cfg file; however, you can select a different language for this window for the duration of the 
current session. 

To select a different language for the current session, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Language.

2. Click the function key that corresponds to your language selection.

The Display Language screen reappears with the language you selected.

3. Click � (Back) to return to the Standard SPM Mode Main menu or select another language.

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language 

Display Language

Make a Selection:

English

French

Spanish

Portuguese

Back 
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Maintenance 2

CAUTION:
This option is for use by qualified technicians only. Maintenance procedures are provided in 
the documentation for qualified technicians. 

CAUTION:
This is a password-protected option and is for use by your technical support organization 
only.

Pass-Thru 2

The Pass-Thru option is not used with MERLIN MAGIX Integrated System Release 1.0i.

Password 2

The Password option is used by qualified service personnel to change the modem connection 
password. A password is always required to establish a connection with the built-in modem. The 
password always consists of seven characters. You can perform remote system programming only 
if you enter the password correctly. A default password is set at the factory. You must obtain this 
password from your system consultant (SC).

To change the modem connection password, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Password.

  SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password 

Monitor Language
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2. Type the old (current) password. Do not press 1.

If you type the old password incorrectly, the bottom of the screen displays the message, Not 
Equal. Repeat Step 2.

If you fail to enter the password correctly after three attempts, the bottom of the screen 
displays the message Old Password in Use, and the procedure terminates. Press 1 
to return to the Standard SPM Mode Main menu.

3. Type the new password (any seven characters). Do not press 1

SECURITY ALERT:
■ The password does not appear on the screen as you type it.

■ Always use the longest length password allowed on the system.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of 
characters.

4. Type the new password again. Do not press 1.

5. To return to the Standard SPM Mode Main menu, click �%(Back).

Password:

Enter Old Password

Password

Enter New Password

Password

Enter New Password again

New Password in use
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Print Options 2

The Print Opts option allows qualified service personnel to direct the output of system 
programming reports either to the PC (where you can save them, browse through them, or print 
them with the system programming Print option) or to the SMDR printer. 

To direct the output of the system programming reports, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Print Opts.

2. Select the target device for the reports.

3. To return to the Standard SPM Mode Main menu, click �%(Back).

SMDR Port Output 2

See ‘‘Printing System Reports,” on page 3-163, for more information about the print procedure 
using the system console and the SMDR port.

PC Port Output 2

See ‘‘Printing Reports,” on page 2-45, for more information about the print procedure using 
WinSPM and the PC port. 

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

Printer Options

Make a selection

SMDR Port

PC Port

Back
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Restore 2

The Restore option allows qualified service personnel to load system programming from either a 
disk or from the hard disk into the processor module memory.

This procedure is used either to program a new system if a disk was created through surrogate 
mode programming, or to restore information (using a backup disk) lost through system failure. It is 
also part of the upgrade procedure.

Considerations 2

Review the following items before you begin the restore procedure:

■ The system will be forced idle during a restore procedure.

■ You must have a backup file containing system programming before you use this procedure. 
See ‘‘Management Procedures’’ on page 2-29.

■ Features that were not programmed when the backup file was created are reset to factory 
settings.

■ The data restored reflects the number of extensions and lines available on the system at the 
time the backup was created. The remaining extensions and lines are set to the factory 
settings that are initialized during a Restart (cold start).

■ Restore is terminated under the following conditions:

— If fewer boards are listed on the backup disk than on the control unit.

— If any real board is out of sequence with the boards listed on the backup disk.

— If phantom boards are not listed last.

— If the operating mode of the system being restored is Hybrid/PBX, but the control unit 
processor module has been modified to operate only in Key mode.

■ A successful restore is followed automatically by a Restart (cold start).

WARNING:

An unsuccessful or terminated restore results in a System Erase (frigid start). All calls 
are dropped. The system configuration is erased. All system programming is lost and the 
system returns to the factory settings. If the restore is being done remotely, the 
connection is dropped immediately. If this happens, attempt to reconnect to the control 
unit and immediately perform another restore. If this is not successful, programming 
must be restored on site. 

Standard SPM 	→Select Restore→Select hard disk or floppy→�→ 
Select a file→1→<� to abort→1

WinSPM 

1. From the WinSPM Main window Outlook bar, select Tools.

2. From the Outlook bar, click the Restore icon.
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A selection dialog box displays.

3. Select the File option.

4. Click Ok.

The Restore dialog box displays.

5. Enter the name and location of the file to be restored.

6. Click Open. 

The progress dialog box displays.

7. Click Cancel to exit.
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System Programming 2

A primary function of WinSPM is to provide a method for programming the system. The Sys 
Program option gives you access to all of the system programming features available from the 
system programming console. 

Basic Programming Information 2

To begin programming, you must perform one of the following to display the System Programming 
menu on the MLX-20L or 4424LD+ console, or on the PC:

In most cases, you can click � (Back) to exit from a screen without making any changes. 
Exceptions to this are noted as part of a procedure. When you complete a procedure and click � 
(Back), you usually move up one screen in the menu hierarchy. Occasionally, when you click � 
(Back), you return to the previous screen. In a few cases, clicking � (Back) brings you back to 
the System Programming menu, where you can select another option to program or exit from 
system programming.

To complete a procedure and save the information you have programmed, click � (Enter).

If you are programming a group of sequentially numbered extensions or trunks, you may have the 
option of clicking 
 (Next). This saves your entry and automatically provides the number of the 
next extension or trunk in the sequence, thus saving you a couple of steps. If Next displays on the 
screen, you can use it with the current option.

In most cases, you will be at an intermediate step in the procedure you have just completed. At 
that point, you can select one of the options shown on the screen and continue programming, or 
you can click � (Back) again. This usually takes you back to the System Programming menu. If 
not, you again can continue programming on the current screen or click � (Back) again. 

Idle States 2

A few of the programming procedures can be started only when the entire system or some part of 
it, such as a trunk or an extension, is idle (not in use). Some procedures require that the trunk or 
extension be idle only at the instant of programming. Other procedures, which take longer, require 
the system, trunk, or extension to be forced to remain idle until programming is completed. These 
procedures wait for the system, trunk, or extension to become idle and then prevent the initiation of 
any new calls. This condition is called forced idle.

On the console: Menu→Sys Program →Back 
On the PC: Type spm →1→Press any key→�→� 

If a procedure requires an idle condition, perform the programming outside of normal 
business hours.



Programming with WinSPM

System Programming

2-43

If a procedure requires that the system be in an idle state and the system is busy when you begin, 
the screen shown below displays.

The screen changes to the appropriate programming screen when the system is no longer busy.

System Forced Idle 2

When the entire system is forced idle, no calls can be made or received. The procedures listed 
below can be performed only when the entire system (every line and every extension) is idle:

■ Select system mode

■ Identify system operator positions

■ Renumber boards

■ Renumber system

■ Restore system programming information

■ Identify the Music-On-Hold jack

When the system is forced idle, the following occurs: multiline telephone users hear a reminder 
tone that indicates the telephone cannot be used; display telephone users see the message 
Wait: System Busy; single-line telephone users do not hear a dial tone.

Line or Trunk Idle 2

Since these procedures require the line or trunk to be idle only at the instant of programming, the 
line or trunk is not forced idle. The following procedures can be performed only when the line or 
trunk being programmed is idle:

■ Identify loudspeaker paging line jack

■ Assign trunks to pools

■ Specify incoming or outgoing DID/DIOD- or tie-trunk type

■ Specify tie-trunk direction

■ Specify tie-trunk E&M signal

Reviewers: Should these tie-trunk bullets be removed since Release 1.0i does not support 
the 400EM module? 

System Busy   Pls Wait

 

Dial Code:    nnnn 

Slot/Port:    ss/pp 

Exit 
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Extension Forced Idle 2

When an extension is forced idle, no calls can be made or received on that extension. The 
following procedures can be performed only when the extension being programmed is idle:

■ Assign call restrictions

■ Assign pool dial-out restrictions

■ Copy extension assignments

■ Assign lines, trunks, or pools to extensions

■ Assign labels to a personal directory

■ Use centralized telephone programming

When the extension is forced idle, the following occurs: multiline telephone users hear a reminder 
tone that indicates the telephone cannot be used; display telephone users see the message 
Wait: System Busy; single-line telephone users do not hear a dial tone.

Forced Idle Reminder Tone 2

The forced idle reminder tone is a high-low “door-telephone” tone → 400 ms of 667 Hz tone 
followed by 400 ms of 571 Hz tone. The tone is provided under the following circumstances:

■ At the extension, to remind the user that the system or the extension is in the forced idle state.

■ At the programming console or at a PC running WinSPM, to remind the System Manager that 
the system (or at least one extension) is in the forced idle state because of administrative 
activity.

Forced idle reminder tones occur every 20 seconds. You can adjust the volume of these tones with 
the volume control on the system console or PC.

100E 100R Module Idle 2

The following procedures can be performed only when the 100E module is idle:

■ Specify board type

■ Specify frame format

■ Specify board signaling format

■ Specify board suppression format

■ Specify board facility compensation
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Accessing System Programming 2

Follow the steps below to access system programming.

1. At the Standard SPM Mode Main menu, click � to select Sys Program.

2. Click the function key next to the option you want.

3. If the option you want does not appear on the first screen of the System Programming menu, 
click �%to display the second screen of the menu.

Printing Reports 2

Use the following procedure to print system reports using WinSPM at the PC. The WinSPM Print 
Opts must be set to PC Port. See ‘‘Print Options’’ on page 2-39 for details about setting the printer 
output port.

1. At the second page of the System Programming menu, click � to select Print.

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

System Programming:    > System Programming:    >

Make a selection Make a selection

� System Extensions � � Labeling Language � 
� SysRenumber Options 	 � Data

� Operator Tables 
 � Print

� LinesTrunks AuxEquip � � Cntr-Prg

� Back NightSrvce � � Exit

System Programming:    >

Make a selection

Labeling

Data

Print 

Cntr-Prg

Back



System Programming

System Programming

2-46

2. Click the function key that corresponds to the report to be printed.

3. Use one of the methods shown after this procedure to print the report or reports.

4. View the print status screen.

To interrupt printing and return to the Standard SPM Mode Main menu, press �.

Print Hard Copy 2

To print a hardcopy of the report, use the arrow keys to highlight LPT1: and press 1.

Print to Hard Disk 2

To print the reports to the hard disk if the print file does not exist, use the arrow keys to highlight 
MAKE NEW FILE and press 1.

■ To save to the default print filename (print.ams), press 1.

■ To save to the filename of your choice, type [filename] and press 1.

To print the reports to the hard disk if the print file already exists, use the arrow keys to highlight the 
filename and press 1.

Print (English):      >

Make a selection

All Trunk Info

SysSet-up T1 Info

Dial Plan Pri Info

Labels RmoteAccess

Back Oper Info

LPT1:

Please enter file name GOTOFLOPPY 

to store print
(default is print.ams)

MAKE NEW FILE PRINT.AMS 

Press Esc to Abort.

Print in Progress ...

Back
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Print to Floppy Disk 2

Use the arrow keys to highlight GOTO FLOPPY: and press 1. Use one of the methods shown 
below.

■ To print the reports to a floppy disk if the print file does not exist, use the arrow keys to highlight 
MAKE NEW FILE and press 1.

— To save to the default print filename (print.ams), press 1.

— To save to the filename of your choice, type [filename] and press1.

■ To print the reports to a floppy disk if the print file already exists, use the arrow keys to highlight 
the filename and press 1.

Surrogate Mode Programming 2

Surrogate mode allows qualified service personnel to perform system programming at an offsite 
service location. The actual system hardware does not have to be installed — the programmer 
needs a power supply, carrier, processor, and a direct connection from the PC to the processor 
module. By following a customer’s set of completed planning forms, the system can be 
programmed as if the appropriate modules, trunks, telephones, and other communications 
equipment have been installed. When system programming is completed, a system backup is 
performed to save the information on disk. This backup disk is then taken to the new installation 
site and used with the Restore option to provide complete system programming for a new system.
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Overview 3

This chapter contains all of the procedures required for programming each of the features and 
options that is available for the MERLIN MAGIX Integrated System. 

Each of the procedures begins at the System Programming menu. Use one of the methods shown 
below to display the System Programming menu.

■ At the console: Menu→Sys Program→Back 

■ At a PC with WinSPM using Standard SPM Mode, do the following:

1. On your desktop, double-click the WinSPM icon. (Depending on options selected during 
installation, you might select WinSPM from your Start Menu or Lucent Solutions folder.)

2. Enter your user name and password, then click OK. The WinSPM main screen appears. 

3. On the toolbar on the left side of the WinSPM main screen, click the Connect button. The 
Connection Selection screen appears. 

4. From the Connection Selection screen, click the site name for the site you want to connect 
to.

5. Click the Connection Type for the session, then click OK.

6. On the toolbar on the left side of the WinSPM main screen, click the Standard SPM icon. 
The system programming console appears in the emulation window.

7. Click �, then �.

Before you begin any of the procedures in this chapter, you should read and understand all of the 
information presented in Chapter 1, ‘‘Programming Basics.” 
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Basic System Operating Conditions 3

The procedures in this section are all related to the system, rather than to the operation of 
telephones, operator positions, lines, or trunks. These are operating conditions that must be set 
only once—when the system is new or when you reset the factory settings. 

This section contains the following programming procedures:

■ System Restart

■ System Programming Position Assignment

■ System Language

■ Board Renumbering

■ Mode of Operation

■ Automatic Maintenance Busy

■ System Date

■ System Time

■ Rotary Break Timer

■ Special Numbers Table

■ Digits Prepended to Special Numbers

■ Match Delay Timer

System Restart 3

CAUTION:
This procedure is to be performed by qualified support personnel only.

Use this procedure to perform a System Restart (cold start). All calls are dropped when you 
perform this procedure. Existing system programming is saved. Telephones with the Extension 
Status feature may lose Toll Restrictions as a result of a System Restart.

Summary: System Restart 3

Programmable by Qualified support personnel

Mode All

Idle Condition Not required

Planning Form Not applicable

You must reset the system time when Daylight Savings Time begins and ends.
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Factory Setting None

Valid Entries None

Inspect No

Copy Option No

Console Procedure System→Restart→Yes 

PC Procedure �→�→� 

System Programming Position Assignment 3

Use this procedure to reassign the extension used for system programming. This extension should 
not be the same extension used for the operator position. The system programming position can 
be reassigned only to one of the first five extension jacks on the first TDL Module if you are using a 
4424LD+ telephone, or the first MLX Module if you are using a MLX-20L telephone. Only one 
system programming console is allowed per system.

If you are programming on the 4424LD+ or MLX-20L console, be aware of the following:

■ The console must be connected to the extension currently assigned for system programming.

■ As soon as you change the system programming extension, the system programming session 
is terminated. To proceed with system programming, you must connect the system 
programming console to the newly assigned extension and enter system programming again.

Summary: System Programming Position Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting First extension jack on the first TDL module if you are using a 
4424LD+ telephone, or the MLX module if you are using a MLX-20L 
telephone (also set as an operator position)

Valid Entries Extension number of one of the first five extension jacks on the first 
TDL or MLX module

Inspect No

Copy Option No

Console Procedure System→SProg Port→Drop→Dial ext. no.→ Enter→Back 

PC Procedure �→�→7+I→Type ext. no.→�→� 
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System Language 3

Your system offers you a choice of four languages (U.S. English, Canadian French, Latin American 
Spanish, and Brazilian Portuguese) for the following options:

■ System Language. For system programming.

■ Station Message Detail Recording (SMDR) Reports. See ‘‘SMDR Language’’ on page 
3-123.

■ Print Reports. See ‘‘Report Language’’ on page 3-159.

■ Extensions. See ‘‘Optional Extension Features’’ on page 3-75.

Use this procedure to set the system language. See the sections listed above to set a different 
language for SMDR reports and print reports, as well as for 4400-Series or MLX display 
telephones.

Summary: System Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English

Valid Entries U.S. English, Canadian French, Latin American Spanish, Brazilian 
Portuguese

Inspect No

Copy Option No

Console Procedure More→Language→SystemLang→Yes→
Select a language (English, French, Spanish or Portuguese)→Enter 

PC Procedure �→�→�→�→Select a language (English, French, 
Spanish, or Portuguese)→� 

Board Renumbering 3

CAUTION:
This procedure is to be performed by qualified support personnel only.

Use this procedure to renumber boards that have already been installed. This procedure restarts 
the system (system programming is not lost). Note that this is not the same procedure used with 
the Boards option, which is available to qualified service personnel with WinSPM only. 
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Board Renumbering is a system programming procedure that is required only when an existing 
module is replaced by a different type of module. When a Board Renumbering is performed, the 
system reassigns the logical ID numbers to the extension and line ports sequentially from left to 
right in the control unit and from bottom to top of each module. 

Summary: Board Renumbering 3

Programmable by Qualified support personnel only

Mode All

Idle Condition System idle

Planning Form Not applicable

Factory Setting None

Valid Entries Not applicable

Inspect Not applicable

Copy Option Not applicable

Console Procedure System→Board Renum→Yes 

PC Procedure �→�→� 

Mode of Operation 3

The system mode—Key, or Hybrid/PBX—determines how the system operates and directly affects 
the following operations:

■ How lines and/or trunks are provided to users

■ Types of operator consoles allowed

■ Features available

Changing this option causes a system restart and terminates the programming session. You must 
enter system programming again to program other features.

The following options cannot be programmed for Key systems:

■ Automatic Route Selection (ARS)

■ Pools

■ Queued Call Consoles (QCCs) and associated features

■ The Behind Switch mode of operation is shown on the Select Mode screen but is not 
supported in MERLIN MAGIX Integrated System Release 1.0i.

■ The Hybrid/PBX option is not available if the control unit processor module has been 
modified to operate in Permanent Key mode only. See the Feature Reference for more 
information.
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■ Direct Inward Dialing (DID) or Direct Inward or Direct Outward Dialing (DIOD) Trunks

■ System Access buttons

Summary: Mode of Operation 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 1, System Planning

Factory Setting Hybrid/PBX

Valid Entries Key, Hybrid/PBX

Inspect No

Copy Option No

Console Procedure System→Mode→Select mode (Key or Hybrid/PBX)→Enter 

PC Procedure �→�→Select mode (Key or Hybrid/PBX)→� 

Automatic Maintenance Busy 3

Automatic Maintenance Busy allows the system to take a malfunctioning trunk out of service for 
outgoing calls (incoming calls are never blocked). This prevents faulty outside facilities from 
causing disruptions in outgoing calling patterns.

For optimal performance, enable Automatic Maintenance Busy for Hybrid/PBX systems with 
pooled trunks.

Summary: Automatic Maintenance Busy 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting Disabled

Valid Entries Enabled, Disabled

Inspect No

No more than half of the trunks in a trunk pool are allowed to be placed in the 
Maintenance Busy state at one time, unless the central office has failed to disconnect a 
trunk (which prevents anyone from using that trunk) or an entire trunk module is manually 
taken out of use (a Maintenance-Busy state deliberately caused by the user).
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Copy Option No

Console Procedure To disable Automatic Maintenance Busy:
System→MaintenBusy→Disable→Enter→
Back 

To enable Automatic Maintenance Busy 
excluding tie trunks: 
System→MaintenBusy→Enable→Enter→Back

To enable/disable with tie trunks:
System→MaintenBusy→Enable→Enter→
Enable or Disable→Enter→Back 

PC Procedure To disable Automatic Maintenance Busy:
�→�→�→�→� 

To enable Automatic Maintenance Busy excluding tie trunks:
�→�→�→�→� 

To enable/disable with tie trunks:
�→�→�→�→Enable or Disable→�→� 

Set System Date 3

The System Date feature allows you to set the month, day, and year that appear on 4400-Series 
and MLX display telephones as well as on Station Message Detail Recording (SMDR) reports.

Summary: Set System Date 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting 01-01-00

Valid Entries Month: 01 to 12
Day: 01 to 31
Year: 00 to 99

Inspect No

Copy Option No

Console Procedure System→Date→Drop→Dial current date (Month: 01–12; 
Day: 01–31; Year: 00–99)→Enter→Back 

If you plan to use the SMDR feature, make sure the current date is set.
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 PC Procedure �→	→7+I→Type current date (Month: 01–12; 
Day: 01–31; Year: 00–99)→�→� 

Set System Time 3

Summary: Set System Time 3

Programmable by System Manager

Mode All

Idle Condition Not Required

Planning Form 1, System Planning

Factory Setting 0000

Valid Entries 0000 to 2359

Inspect No

Copy Option No

Console Procedure System→Time→Drop→Dial current time (0000–2359)→ 
Enter→Back 

PC Procedure �→
→7+I→Type current time (0000–2359)→�→� 

Rotary Break Timer 3

The Rotary Break Timer increases the compatibility between the MERLIN MAGIX system and the 
local exchange by improving the timing signaling when digits are outpulsed over analog loop-start 
central office lines connected to an 800 LS/CPTD module. This module supports up to eight loop-
start lines and provides Dial Tone Detection and Call Progress Tone Detection.

The MERLIN MAGIX system uses the Rotary Break Timer value to calculate automatically the 
Make Timer value (Make Timer value = 100 – Break Timer value).

■ The System Time feature allows you to set the time that appears on 4400-Series, MLX, 
and ETR display telephones and on SMDR reports.

■ If you are planning to use the SMDR feature, make sure the system time is set 
accurately. If you change the system time while the system is in Night Service mode, 
Night Service is deactivated and must be manually reactivated. If you have installed 
applications such as MERLIN Messaging or Intuity AUDIX, you may need to set the 
time in the applications software whenever you reset the system time.

See for information on programming the digital E1 Rotary Break Timer.
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Summary: Rotary Break Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting 60 ms

Valid Entries 60-80 ms in 5 ms increments

Inspect No

Copy Option No

Console Procedure System→CO Interface→Break Timer→Drop→Dial duration 
for Rotary Break Timer (50-80 ms in increments of 5 seconds)→
Enter→Back→Back 

 PC Procedure �→�→�→7+I→Type duration for Rotary Break Timer 
(50-80 ms in increments of 5 seconds)→�→�→� 

Special Numbers Table 3

The Special Numbers Table is a programmable table of telephone numbers that is separate from 
ARS and can be accessed in the Key and Hybrid/PBX mode. These “special numbers” include 
emergency numbers, directory assistance, and repair service numbers. Because these special 
numbers vary in different countries, the table of special numbers is fully programmable. (Release 
1.0 of the MERLIN MAGIX system contained a fixed Special Numbers Table as part of the 
Automatic Route Selection feature.)

The facility restriction level (FRL) of the Special Numbers Table is fixed at 0, thereby allowing all 
users to dial any number programmed in this table. Use Disallowed Lists to deny access to certain 
non-emergency numbers (for example, directory assistance) contained in this table. Give users 
unrestricted toll access so they may dial emergency numbers that begin with “1” or “0.”

The Special Numbers Table may consist of 1 to 20 entries, with 1 to 6 digits per entry.

Summary: Special Numbers Table 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting Not Applicable

Valid Entries Not Applicable

Inspect Yes

Copy Option No
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Console Procedure System→Tables→SpeclNumbers→Table Input→Dial 
entry number (1-20)→Enter→Drop→Dial 6-digit special 
number→Enter→Back→Back

PC Procedure �→
→
→�→�→Type entry number (1-20)→
�→7+I→Type 6-digit special number→�→�→�

Special Numbers Other Digits 3

Use this procedure to specify other (extra) digits that the system must dial before it dials out a 
number in the Special Numbers Table.

A maximum of 20 digits can be added in any combination of the digits 0 through 9.

Special characters such as switchhook flash, Stop, and # cannot be included as extra digits. Pause 
is allowed in every position but the first.

Summary: Special Numbers Other Digits 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting 0

Valid Entries Up to 20 digits (any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure System→Tables→SpeclNumbers→Other 
Digit→Drop→Dial digits to be added (up to 20 digits; any 
combination of 0–9)→Enter→Back→Back

PC Procedure �→
→
→�→7+I→Type digits to be added (up to 20 
digits; any combination of 0–9)→�→�→�

Match Delay Timer 3

To provide faster connection to special numbers dialed, Release 1.0i of the MERLIN MAGIX 
system contains a Match Delay Timer. The Match Delay Timer resets the inter-digit timer to the 
value of the Match Delay Timer when a match is found between digits already dialed and numbers 
in the Special Numbers Table. For example, the standard emergency number in Mexico is 060. As 
soon as someone dials 060 and a match is made between the dialed number and the number in 
the Special Numbers Table, the Match Delay Timer cuts through so that the digits can be sent 
quickly to the central office, instead of waiting for the inter-digit timer’s delay.

Set the value for the Match Delay Timer to be less than the value for the Inter-Digit Timer.
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Consider the parameters for your specific central office when you program the Match Delay Timer.

The Match Delay Timer value ranges from 1 to 90 seconds.

Summary: Match Delay Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting 5 seconds

Valid Entries 1 to 90 seconds

Inspect No

Copy Option No

Console Procedure System→Tables→SpeclNumbers→Match Delay→Drop→
Dial number of seconds for Match Delay Timer (1-90)→Enter→ 
Back→Back 

PC Procedure �→
→
→�→7+I→Type number of seconds for Match 
Delay Timer (1-90)→�→�→� 

System Renumbering 3

The procedures in this section are used to assign the 2-digit, 3-digit, and Set-Up-Space numbering 
plans for the local MERLIN MAGIX Integrated System. 

Do not attempt to assign a numbering plan without Planning Forms 2a, System Numbering: 
Extension Jacks; 2b, System Numbering: Digital Adjuncts; and 2d, System Numbering: Special 
Renumbers. Form 6a, Optional Operator Features, is needed to assign a DSS Page button. This 
section contains the following programming procedures:

■ Select System Numbering Plan

■ Single Renumbering

■ Block Renumbering

■ Direct Station Selector (DSS) Page Button Assignment

For the local system, you then select only one of the numbering plans (2-digit numbering, 3-digit 
numbering, or Set-Up-Space numbering). In addition, you may need to perform single and/or block 
renumbering. You do not need to assign DSS Page buttons unless the system programming 
console or one of the operator positions is connected to a DSS. No matter which procedures you 
need to perform, assign the numbering plan first, then do single and/or block renumbering, and 
finally, assign DSS Page buttons (if necessary).

Use the single renumbering procedure whenever the extension numbers you are changing from or 
to are not sequential.
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Block renumbering is quicker, but you can use block renumbering only when the extension 
numbers you are changing from and to are sequential.

When trunk or extension modules are removed from the control unit, the remaining modules must 
be rearranged so that no empty slots remain. The system does not acknowledge any modules 
installed after an empty slot; therefore, if the system is renumbered, extensions are not assigned to 
extension jacks after the empty slots.

Figure 3-1. 2-Digit Numbering

Figure 3-1, Figure 3-2, and Figure 3-3 show the factory settings in the gray spaces. 
Extensions can be renumbered to any number shown in the white spaces.

0 Operator Console (not flexible) 0
1 Extensions 10–19 
2 Extensions 20–29 
3 Extensions 30–39 
4 Extensions 40–49 
5 Extensions 50–59 
6 Extensions 

60–66

Extra Extensions 

6700–6842 6843–6849

Extra 4400-
Series 

Adjuncts/
MFMs/ 

Terminal 
Adapters

6850–6992 6993–6999
7 Main Pool

70

Adjuncts

710–766 767– 769

Calling Groups

770–791,7920–7929

Paging Groups 

793–799
8

8001

1 LDN (QCC Queue)

Lines/Trunks 

801–880

Park

881–888 8892

2 Remote Access

Pools

 890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9
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Figure 3-2. 3-Digit Numbering

Figure 3-3. Set-Up-Space Numbering

0 Operator Console (not flexible) 0
1 Extensions 100–199
2 Extensions 200–299
3 4400-Series/MLX Adjuncts 300–399
4 4400-Series/MLX Adjuncts 400–499
5 500–599
6 600–699
7 Main Pool 

70 71–76

Calling Groups

770–791, 7920–7929

Paging 
Groups

793–799
8

8001

1 LDN (QCC Queue)

Lines/Trunks

801–880

Park

881–888 8892

2 Remote Access

Pools

890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9

0 Operator Console (not flexible) 0
1 100–199
2 200–299
3 300–399
4 400–499
5 500–599
6 600–699
7 Main Pool

70

Extensions

7100–7299

4400-Series/
MLX Adjuncts

7300–7499

7500–7699 Calling Groups

770–791,
7920–7929

Paging 
Groups

793–799
8 8001

1 LDN (QCC Queue)

Lines/Trunks

801–880

Park

881–888

8892

2 Remote Access

Pools

890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9
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Select System Numbering Plan 3

WARNING:

To avoid possible loss of system programming information, renumber the system before you 
program the rest of the options described in this chapter.

The three available local system numbering plans listed below appear on System Planning Form 
2a.

■ Two-Digit. This plan is for systems with fewer than 50 extensions and no plans to exceed that 
number in the foreseeable future. Each of the first 58 extension jacks is assigned a 2-digit 
extension number, beginning with 10 and ending with 67. Any remaining extensions are 
assigned 4-digit numbers, starting with 6700 and ending with 6842.

■ Three-Digit. This plan is for systems with 50 or more extensions or plans to grow to that 
number in the foreseeable future. All extensions are assigned a 3-digit number, starting with 
100 and ending with 299.

■ Set-Up-Space. This plan is for systems with a need to customize extension numbers or use 
extension numbers of varying lengths (one to four digits). All extensions are assigned 4-digit 
numbers in the 7000 range. Extension numbers 1000–6999 are also available for use when 
you renumber.

In all three local numbering plans, the system assigns 3-digit extension numbers to pools (Hybrid/
PBX only), Calling Groups, Paging Groups, Remote Access codes, the Listed Directory Number, 
park codes, and Idle Line Access (Key only). In addition, the system assigns 9 for Automatic Route 
Selection (Hybrid/PBX only) and Idle Line Access (Key only). Zero (0) represents a special 
extension number—actually a fixed dial code—for the primary operator or QCC queue. Any 
extension number except 0 can be renumbered.

Extension numbers can be composed of any combination of digits; however, no number can begin 
with 0. Trunk numbers (801–880) are considered to be extensions and can be renumbered.

The system does not provide a message to indicate a successful renumber when either the 2-digit 
or 3-digit numbering plan is selected. For the Set-Up-Space numbering plan, the system provides 
a message indicating that all extensions are in the 7000 range.

CAUTION:
Select Back on the console, or click%� on the PC display, when you have finished selecting 
the numbering plan. If you press Exit (4424LD+ console) or Home (MLX-20L console), 
extensions may remain in the forced idle condition (indicated when the LED next to each 
DSS button is on). To restore extensions to their normal operating state, restart the system.
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Summary: Select System Numbering Plan 3

Programmable by System Manager

Mode All 

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting 2-Digit

Valid Entries 2-Digit, 3-Digit, SetUp-Space

Inspect No

Copy Option No

Console Procedure SysRenumber→Default Numbering→ Select numbering plan
(2-Digit, 3-Digit, SetUp-Space)→Back→Back 

PC Procedure �→�→Select numbering plan (2-Digit, 3-Digit, SetUp-Space)→ 
�→� 

Single Renumbering 3

Use this procedure to assign a specified extension number to a telephone, accessory, line, pool 
(Hybrid/PBX only), Calling Group, Paging Group, or Listed Directory Number. Single renumbering 
is also used for Remote Access, Park, Idle Line Access (Key only), and Automatic Route Selection 
(Hybrid/PBX only).

CAUTION:
Select Back on the console, or click � on the PC display, after renumbering extensions. If 
you press Exit (4424LD+ console) or Home (MLX-20L console), extensions may remain in 
the forced idle condition (indicated when the LED next to each DSS button is on). To restore 
extensions to their normal operating state, restart the system.

When required, this procedure should be performed immediately following the selection of a 
system numbering plan.

Summary: Single Renumbering 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers

Factory Setting Not applicable

Valid Entries Old and new extension numbers
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Inspect Yes

Copy Option No

Console Procedure SysRenumber→Single→Select item→Dial old ext. no.→
Enter→Dial new ext. no.→Enter→Back→Back 

PC Procedure �→�→Select item→Type old ext. no.→�→
Type new ext. no.→�→�→� 

Block Renumbering 3

Use this procedure to assign extension numbers to a group of extensions, accessories, or lines. 
Both the original numbers and the numbers they are being changed to must be sequentially 
numbered.

When required, this procedure should be performed immediately following the selection of a 
system numbering plan.

CAUTION:
Select Back on the console, or click � on the PC display, when you have finished 
renumbering extensions. If you press Exit (4424LD+ console) or Home (MLX-20L console), 
extensions may remain in the forced idle condition (indicated when the LED next to each 
DSS button is on). To restore extensions to their normal operating state, restart the system.

Summary: Block Renumbering 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers

Factory Setting Not applicable

Valid Entries Old and new extension numbers

Inspect Yes

Copy Option Yes

Console Procedure SysRenumber→Block→Select type of group→
Dial no. of first group member→Enter→
Dial no. of last group member→Enter→Dial new beginning no.→ 
Enter→Back→Back→Back

PC Procedure �→�→Select type of group→Type no. of first group 
member→�→Type no. of last group member →�→
Type new beginning no.→�→�→�→� 
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Direct Station Selector (DSS) Page Buttons 3

Use this procedure to set the three Page buttons on the DSS to correspond to the system 
numbering plan. This procedure assigns extension numbers to DSS buttons. The procedure is the 
same for MLX DSS and DSS 4450 when used with 4424LD+ and 4424D+ telephones. You cannot 
program individual buttons on a DSS; this is the only method for programming DSS buttons.

Page button assignment should be sequential. If only one DSS is attached, each Page button 
assignment sets the console for a range of 50 extension numbers: Page 1: 0 to 49; Page 2: 50 to 
99; Page 3: 100 to 149.

If two DSSs are attached, each Page button assignment sets the console for a range of 100 
extension numbers. If two DSSs are attached to the console, change the factory setting so that the 
difference between extension numbers assigned to the range is at least 100. For example, assign 
Page 1 to begin with extension 10, Page 2 to begin with extension 110, and Page 3 to begin with 
extension 210.

Operator Park Zone codes must be included in the extension number range specified for one of 
the Page buttons.

CAUTION:
Select Back on the console, or click � on the PC display, when you have finished this 
procedure. If you press Exit (4424LD+ console) or Home (MLX-20L console), extensions 
may remain in the forced idle condition (the LED next to each DSS button is on), and the 
system may have to be restarted.

Summary: Assign Direct Station Selector Page Buttons 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting Page 1=0; Page 2=50; Page 3=100

Valid Entries 1, 2, 3

Inspect Yes

Copy Option No

Console Procedure SysRenumber→Single→More→DSS Buttons→ 
Dial page no. (1–3)→Enter→Dial first ext. no.→ Enter→Back→
Back 

PC Procedure �→�→�→�→Type page no. (1–3)→�→
Type first ext. no.→�→�→� 
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System Operator Positions 3

A system operator position, for a Queued Call Console (QCC) operator or a Direct-Line Console 
(DLC) operator, should be programmed before you program lines or trunks.

Use the following procedures to add an operator position or change an existing operator position. 

The QCC operator position is available only for Hybrid/PBX systems. The DLC operator position is 
available in any mode and must be programmed if you have Call Management Systems connected 
to any operator extension jacks.

Table 3-1 shows the maximum number of operator positions allowed for any one system.

Any combination of operator positions can be assigned as long as no more than four operator 
positions are QCCs and the total number of operator positions does not exceed eight.

If you want to designate a new operator position and the system already has the maximum number 
of operator positions, you must change an existing operator position to a nonoperator position 
before you designate a new operator position.

Table 3-1. Maximum Number of Operator Positions

Position Type Type of Telephone Maximum Positions

QCC 4424LD+

MLX-20L

4

DLC 4424D+

4424LD+

MLX-20L 

MLX-28D

8

Total QCC + DLC 8

When you change an extension to an operator position, or vice versa, the system returns 
the port (extension jack) type of that extension to the factory setting. You must reprogram 
lines and any features for that telephone or console. You may also need to change any 
attached accessory equipment and optional features.
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Primary Operator Positions 3

The primary operator position is the extension to which your call is directed when 0 is dialed on a 
System Access button. The first extension jack on the first TDL or MLX module in your system is 
assigned as the primary operator position. If your system has QCC operator positions, this position 
must be changed from the factory setting (DLC) to a QCC operator position. (The primary operator 
extension cannot be changed from the first extension on the first TDL or MLX module.)

QCC System Operator Positions 3

This procedure applies to Hybrid/PBX systems only. Note that both QCC and DLC operator 
positions can be assigned with this procedure, although its primary purpose is to assign QCC 
operator positions.

QCC operators serve as central answering positions for all incoming calls. Incoming calls are held 
in the QCC queue and are directed to each QCC operator in a prioritized sequence. The calls are 
received one at a time, regardless of the number of incoming calls to the system.

Additional QCC operator positions can be assigned only to the first and fifth extension jacks of the 
008 MLX module. You can also assign QCC operator positions to the first, fifth, thirteenth, and 
seventeenth extension jacks of the 024 TDL modules or to the first, fifth, ninth, and thirteenth 
extension jacks of the 016 MLX modules. A maximum of four QCC operator positions can be 
assigned. Use this procedure to specify QCC operator positions that serve as central answering 
positions for all incoming calls.

Summary: QCC Operator Positions 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Type: DLC

If you want to add or remove QCC operator positions, the following conditions apply:

■ If other QCC positions remain in your system, the primary QCC operator position 
cannot be removed.

■ When QCC operator positions are added, the primary QCC operator position should be 
the first one added.

■ If QCC operator positions are being removed, the primary QCC operator position must 
be the last one removed.
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Valid Entries First or fifth extension jack on the 008 MLX module (maximum: two 
per module; four QCCs per system).
First, fifth, thirteenth, or seventeenth extension jack on an 024 TDL 
module.
First, fifth, ninth, or thirteenth extension jack on an 016 MLX module.

Inspect Yes

Copy Option No

Console Procedure Operator→Positions→Queued Call→Dial ext. no.→ 
Enter or Delete→Store All 

PC Procedure �→�→�→Type ext. no.→� or 
→� 

DLC Operator Positions 3

DLC operator positions can be assigned to the first and fifth extension jacks on the first 008 MLX 
module with extension jacks. You also can assign DLC operator positions to the first, fifth, 
thirteenth, or seventeenth extension jacks on the 024 TDL module or to the first, fifth, ninth, and 
thirteenth extensions jacks on the 016 MLX modules. A maximum of eight DLC operator positions 
can be assigned. Any combination of operator positions can be assigned as long as there are no 
more than four QCC operator positions and no more than a total of eight operator positions.

Use this procedure to specify extensions that serve as central answering positions for all incoming 
calls or as Calling Group supervisor extensions. (You do not need to use this procedure in a Key 
system unless you have more than one DLC position.) For a new system, remove the factory-set 
DLC operator position assignment for any telephone not used as an operator position.

Lines and trunks are assigned to individual buttons.

Summary: Identify or Remove DLC Operator Positions 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Type: DLC

Valid Entries First or fifth extension jack on the 008 MLX module (maximum: two 
per module; eight DLCs per system).
First, fifth, thirteenth, or seventeenth extension jack on an 024 TDL 
module First, fifth, ninth, or thirteenth extension jack on the 016 MLX 
module.

Inspect Yes

Copy Option No
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Console Procedure Operator→Positions→Direct Line→Dial ext. no.→ 
Enter or Delete→Store All 

PC Procedure �→�→�→Type ext. no.→� or 
→� 

Lines and Trunks 3

The procedures in this section are used to assign optional features to individual lines and trunks. 
The following optional features can be assigned:

■ Outmode Signaling for Loop-Start Trunks

■ Rotary Trunk Digit Transfer

■ Disconnect Signaling Reliability

■ Toll Type

■ Hold Disconnect Interval

■ Ring Disconnect Timer

■ Dial Tone Detection Options

■ Glare Guard

■ Principal User for Personal Line

■ QCC Queue Priority

■ QCC Operator to Receive Calls

■ Incoming Call Line Identification Delay

■ Trunks to Pools Assignment

The Copy Options feature (described at the end of this section) allows you to copy several optional 
features from an idle trunk. This option eliminates the need to individually enter each feature.

A slot is the physical location of the individual module on the control unit. There is a maximum of 
17 slots, which are numbered as follows:

■ Basic carrier: slots 1 through 5

■ First expansion carrier: slots 6 through 11

■ Second expansion carrier: slots 12 through 17

A port is a line or trunk jack on the module. Individual modules support different numbers of ports. 
On any module, port 1 is the lowest physical jack position. 
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Outmode Signaling for Loop-Start Trunks 3

Use this procedure to identify either touch-tone signaling or rotary-dial signaling for outgoing calls 
placed by using the specified loop-start trunk.

Summary: Outmode Signaling for Loop-Start Trunks 3

Programmable by System Manager

Mode Loop-Start: All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Touch-Tone

Valid Entries Touch-Tone, Rotary

Inspect No

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→TT/LS Disc→Outmode→Select entry mode 
(Touch-Tone or rotary)→Dial no. of line/trunk→Enter or Delete→
Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→TT/LS Disc→OutMode→Select block of lines/
trunks→Toggle LED On/Off→Enter or Delete→Back→Back→
Back 

PC Procedure To program a single-line/trunk:
�→�→�→� (Touch-Tone or rotary)→Type no. of the line/
trunk→� or 
→�→�→� 

To program a block of lines/trunks:
�→�→�→Select block of lines/trunks→Toggle letter G On/
Off→� or%
→�→�→� 

Rotary Trunk Digit Transfer 3

Use this procedure to designate whether dialed digits on rotary-dial lines/trunks are sent one by 
one as they are dialed (no delay), or are stored and sent when dialing is completed (delay). 
Contact your service provider for more information about the appropriate setting.

Since the factory setting is Touch-Tone, this procedure is not required if your system has 
only Touch-Tone lines/trunks.
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Summary: Rotary Trunk Digit Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 8a, System Features

Factory Setting No Delay

Valid Entries Delay, No Delay

Inspect No

Copy Option No

Console Procedure Options→More→Rotary→Select option (Delay or No Delay)→ 
Enter→Back 

PC Procedure 	→�→�→Select option (Delay or No Delay)→�→� 

Ringing Frequency 3

Use this procedure to program the ringing frequency on an 016 (T/R) module. Contact your service 
provider for more information about the appropriate setting. 

Summary: Ringing Frequency 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 8a, System Features

Factory Setting 20 Hz

Valid Entries 20 Hz, 25 Hz

Inspect No

Copy Option No

Console Procedure Options→More→Ringing Freq→Dial slot no. (1–17)→
Select 20Hz or 25Hz→Enter→Back 

PC Procedure 	→�→
→Type slot no. (1–17)→Select 20Hz or 25Hz→
�→� 

Second Dial Tone Timer 3

Use this procedure to program the second dial tone timer. The second dial tone timer sets a delay 
in providing a dial tone after a star code is dialed to obtain special services from the central office. 
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See the Feature Reference for information about programming the second dial tone timer to 
prevent toll fraud. 

Summary: Second Dial Tone Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 0 ms

Valid Entries 0–5,000 ms, in increments of 200 ms

Inspect No

Copy Option No

Console Procedure Options→More→SecDT→Drop→Dial second dial tone timer 
value (0–5000 ms, in increments of 200 ms)→Enter→Back 

PC Procedure 	→�→�→7+I→Type second dial tone timer value
(0–5000 ms, in increments of 200 ms)→�→� 

Disconnect Signaling Reliability 3

Use this procedure to classify the disconnect signal sent by the central office on loop-start trunks 
as one of the following:

■ Reliable. Signal sent within a short time.

■ Unreliable. Signal may not be provided.

SECURITY ALERT:
Toll fraud can occur if you have loop-start trunks with unreliable disconnect. In this situation, 
if someone calls you and you hang up, the central office could send dial tone before the caller 
hangs up, allowing the caller to place another call as if it originated at your company.

The setting selected applies to all trunks in the system because trunks cannot be programmed 
individually. The reliable/unreliable setting does not apply to loop-start trunks emulated on a T1 
facility. If you specify a reliable disconnect for trunks programmed with a short hold disconnect 
interval (see ‘‘Hold Disconnect Interval’’ on page 3-26), active calls, as well as trunks on hold, may 
be disconnected. For more information about reliable and unreliable disconnect and its 
implications, see the Feature Reference.

Certain features (Remote Call Forwarding and Transfer to outside numbers) and 
applications (MERLIN Messaging System, Octel 100, and Intuity AUDIX) are not 
recommended with loop-start trunks. See ‘‘Hold Disconnect Interval’’ on page 3-26.
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Summary: Disconnect Signaling Reliability 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Unreliable

Valid Entries Unreliable, Reliable

Inspect No

Copy Option No

Console Procedure LinesTrunks→TT/LS Disc→LS Disconnect→ Select 
Yes or No→Enter→Back→Back 

PC Procedure �→�→�→Select Yes or No→�→�→� 

Toll Type 3

Use this procedure to specify whether users have to dial a toll prefix (1 or 0) before dialing an area 
code and telephone number. (Your local telephone company should verify toll prefix requirements 
for each line/trunk.)

This setting is used by the system to classify calls as local or long distance, so that appropriate Toll 
Restrictions can be applied.

Summary: Toll Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Toll prefix required

Valid Entries Required, Not required

Inspect No

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→Toll Type→Select entry mode→
Dial no. of the line/trunk→Enter or Delete→Back→Back→Back 

This option applies only to loop-start trunks; it does not apply to tie trunks or DID trunks.
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To program a block of lines/trunks:
LinesTrunks→Toll Type→Select block of lines/trunks→
Toggle LED On/Off→Enter or Delete→Back→Back→Back

PC Procedure To program a single-line/trunk:
�→�→�→Type no. of the line/trunk→� or 
→ 
�→�→� 

To program a block of lines/trunks:
�→�→Select block of lines/trunk→Toggle letter G→On/Off→
Select Enter or Delete→�→�→� 

Hold Disconnect Interval 3

Use this procedure to specify the number of milliseconds before a loop-start line/trunk is released 
when a caller on hold hangs up and abandons the call. This can be specified as either a long 
interval (450 ms) or a short interval (50 ms). The hold disconnect interval applies to loop-start 
trunks; it does not apply to emulated loop-start trunks (E1 facility).

For more information on Hold Interval Disconnect and Reliable and Unreliable Disconnect, see the 
Feature Reference.

Summary: Hold Disconnect Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Long interval (450 ms)

Valid Entries Long interval, Short interval

Inspect No

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→More→HoldDiscnct→Select entry mode→ 
Dial no. of the line/trunk→ Enter→Back→Back 

■ If the disconnect interval is longer than the telephone company setting, the line is 
not released when a caller on hold hangs up.

■ Do not program a short interval unless the local telephone company’s central 
office is the crossbar type.

■ Do not program a reliable disconnect for lines/trunks with a short hold disconnect 
interval. This can cause active calls as well as lines/trunks on hold to be 
disconnected. See ‘‘Disconnect Signaling Reliability’’ on page 3-24.
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To program a block of lines/trunks:
LinesTrunks→More→HoldDiscnct→Select block of lines/
trunks→Toggle LED On/Off→Enter→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→�→Type no. of the line/trunk→%
�→�→� 

To program a block of lines/trunks:
�→�→�→Select block of lines/trunks→ 
Toggle letter G On/Off→�→�→� 

Ring Disconnect Timer 3

Use this procedure to activate and set the amount of time in seconds for a system-wide time 
interval for calls on trunks that do not have Reliable Disconnect. The Ring Disconnect Timer is 
applied only to those calls that are using a facility that has its Reliable Disconnect parameter set to 
“no.” 

The Ring Disconnect Timer begins for each call that is ringing at an extension where no internal 
user is active (off-hook, speakerphone, delay announcement) on the call. Also, it starts only after 
all other system actions have taken place (such as all coverage paths or the Transfer Return 
interval). The Ring Disconnect Timer stops every time the call is answered at a MERLIN MAGIX 
extension.

The Ring Disconnect Timer can be set in the range of 50 to 300 seconds in 5-second increments. 
The factory setting is 50 seconds.

Summary: Hold Disconnect Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting Activation: On
Ring Disconnect Timer duration: 50 seconds

Valid Entries Activation: On or Off
Ring Disconnect Timer duration: 50 to 300 seconds in 5-second 
intervals

Inspect No

Copy Option No

Console Procedure To turn the Ring Disconnect Timer on or off:
Options→More→Ring Disc→Activation→Select On or 
Off→ Enter→Back→Back→Back→Back 
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To set the Ring Disconnect Timer duration:
Options→More→Ring Disc→Timer→Dial number of seconds 
for Ring Disconnect Timer (50-300 in increments of 5 seconds)→ 
Enter→Back→Back→Back 

PC Procedure To turn the Ring Disconnect Timer on or off:
	→�→�→�→� or �→ �→�→�→�→�%
To set the Ring Disconnect Timer duration:
	→�→�→�→Type number of seconds for Ring 
Disconnect Timer (50-300 in increments of 5 seconds)→ 
�→�→�→� 

Dial Tone Detection 3

Dial Tone Detection prevents the MERLIN MAGIX system from dialing out digits to the public 
network central office before the public network central office provides dial tone. Users of trunks 
with Dial Tone Detection enabled always hear internal dial tone, but the digits they dial are held by 
the system until it detects a dial tone from the public network central office. Dial Tone Detection 
enables users to go off-hook, hear internal dial tone, dial an external number, and stay off-hook 
and wait for the system to dial the number when the public network central office provides dial 
tone. 

You can specify the following Dial Tone Detection options:

■ Whether the Dial Tone Detection feature is activated for the entire system (Yes or No). The 
factory setting is No.

■ If you activate Dial Tone Detection for the entire system, you can specify which loop-start 
trunks connected to an 800 LS/CPTD module require Dial Tone Detection. The factory setting 
is no Dial Tone Detection on any trunks.

■ Dial codes that require a second dial tone (for example, long distance calls). The list of 
numbers should not contain ambiguous entries. The system does provide an error beep or 
error message is you enter an ambiguous entry.

■ The number of calls waiting for dial tone that can be placed on hold for each extension. The 
factory setting is one call per extension.

■ The length of time that the system waits for dial tone from the public network central office 
before timing out. The default is 240 seconds. After time-out, the system does not dial the 
number to the public network central office. 

Single-line telephones (tip/ring), 4400, and 4400D telephones can have a maximum 
of one call waiting for Dial Tone Detection. If you set the number to more than one, 
the system ignores the setting and allows a maximum of one.
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■ What the system does after the time-out interval is exceeded. The system can either 
disconnect the call (Reorder Tone—Disconnect setting) or connect the caller to the public 
network central office (Cut-through setting). The factory setting is Reorder Tone-Disconnect, 
and the trunk is disconnected from the public network central office when the user hangs up or 
after a 15-second timeout.

■ Whether a trunk with Dial Tone Detection activated is automatically busied out if the time-out 
interval is exceeded four consecutive times

Summary: Dial Tone Detection 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting Activation: No
Loop-start trunks requiring Dial Tone Detection: None
Dial codes requiring second dial tone: None
Limit of Dial Tone Detection calls on hold: One call per extension
Dial Tone Detection Timeout Interval: 240 seconds
After timeout action: Reorder tone-disconnect
Dial Tone Detection Maintenance Busy: Disable

Valid Entries Activation: Yes or No
Loop-start trunks requiring Dial Tone Detection: Required, not 
required
Dial codes requiring second dial tone: 1 to 10 entries, with 1 to 10 
digits per entry
Limit of Dial Tone Detection calls on hold: 0-80
Dial Tone Detection Timeout Interval: 1 to 2000 seconds
After timeout action: Cut-through or Reorder tone-disconnect
Dial Tone Detection Maintenance Busy: Enable or Disable

Inspect Loop-start trunks requiring Dial Tone Detection: Yes
Dial codes requiring second dial tone: Yes
All other options: No

Copy Option All options: No

Console Procedure To activate or deactivate Dial Tone Detection system-wide:
LinesTrunks→More→More→DialTone Det→Activation→
Select Yes or No→Enter→Back→Back→Back→Back

To program Dial Tone Detection for a single-line/trunk:
LinesTrunks→More→More→DialTone Det→Lines/
Trunks→Select entry mode→ Dial no. of the line/trunk→ 
Enter→Back→Back→Back→Back

To program Dial Tone Detection for a block of lines/trunks:
LinesTrunks→More→More→DialTone Det→Lines/
Trunks→Select block of lines/trunks→Toggle LED On/
Off→Enter→Back→Back→Back→Back
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To set the Dial Tone Detection Timeout Interval:
LinesTrunks→More→More→DialTone Det→Time-out→
Drop→Dial interval (1-2000 seconds)→Enter→Back→Back→
Back→Back

To set the system action after time-out:
LinesTrunks→More→More→DialTone Det→AfterTimeOut
→Select Cut-through or ReorderTone - Disconnect→
Enter→Back→Back→Back→Back

To program dial codes requiring second dial tone:
LinesTrunks→More→More→DialTone Det→Second 
DT→Dial entry number (1-10)→ Enter→ Dial digits of dial code 
requiring second dial tone (0-9, maximum of 10)→ 
Enter→Back→Back→Back→Back

To program limit of Dial Tone Detection calls on hold for extensions:
LinesTrunks→More→More→DialTone Det→DT on 
Hold→Dial extension number→ Enter→Drop→Dial number of 
calls waiting Busy Tone Detection that can be put on hold for this 
extension (1-80)→ Enter→Back→Back→Back→Back

To enable or disable Dial Tone Detection Maintenance Busy:
LinesTrunks→More→More→DialTone Det→
MaintenBusy→Select Enable or Disable→Enter→
Back→Back→Back→Back 

PC Procedure To activate or deactivate Dial Tone Detection system-wide:
�→�→�→�→�→� or �→%�→�→�→
�→� 

To program Dial Tone Detection for a single-line/trunk:
�→�→�→�→�→�→Type no. of the line/trunk→%
�→�→�→�→� 

To program Dial Tone Detection for a block of lines/trunks:
�→�→�→�→�→Select block of lines/trunks→ 
Toggle letter G On/Off→�→�→�→�→� 

To set the Dial Tone Detection Timeout Interval:
�→�→�→�→�→7+I→Type interval (1-2000 
seconds)→%�→�→�→�→� 

To set the system action after time-out:
�→�→�→�→�→� or �→%�→�→�→
�→� 

To program dial codes requiring second dial tone:
�→�→�→�→�→�→Type entry number (1-20)→%
�→Type digits of dial code requiring second dial tone (0-9, 
maximum of 10)→%�→�→�→�→� 
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To program limit of Dial Tone Detection calls on hold for extensions:
�→�→�→�→	→Type extension number→%
�→7+I→Type number of calls waiting Busy Tone Detection 
that can be put on hold for this extension (1-80)→%�→�→�→
�→� 

To enable or disable Dial Tone Detection Maintenance Busy:
�→�→�→�→
→� or �→%�→�→�→
�→� 

Glare Guard 3

The Glare Guard feature helps reduce the occurrence of glare. Glare occurs when a user goes off-
hook (such as picking up the handset of the telephone) to make an outgoing call and is connected 
to an incoming call instead of receiving dial tone to place a call. This incoming call arrives at the 
user’s telephone without ringing. Glare is caused by the public network central office and the user 
accessing the same trunk at the same time.

Use this procedure to set the Glare Guard Duration Timer, which is programmed on a system-wide 
basis and applies to all 800 LS/CPTD modules. The Glare Guard Duration Timer ranges from 0 to 
25500 milliseconds (ms). The factory setting is 1500 ms.

Summary: Glare Guard 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting 1500 milliseconds (ms)

Valid Entries 0 to 25500 milliseconds (ms) in 100-ms increments

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→Glare Guard→Drop→Dial 
duration of Glare Guard Timer (0-25500 ms in increments of 100 
ms→ Enter→Back→Back 

PC Procedure �→�→�→�→7+I→Type duration of Glare Guard 
Timer (0-25500 ms in increments of 100 ms)→%�→�→� 

Glare Guard does not apply to E1 facilities that are programmed to emulate loop-start 
trunks.
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Busy Tone Detection 3

Busy Tone Detection is a built-in feature on the 800 LS/CPTD module. Busy Tone Detection allows 
the MERLIN MAGIX system to automatically recognize an in-band busy signal from the public 
network central office as a disconnect signal. When the busy signal is received, the MERLIN 
MAGIX system releases the analog loop-start trunk. The feature can be set to On or Off for each 
loop-start trunk connected to the 800 LS/CPTD module. The default is On for all available ports on 
the module.

The Busy Tone Detection feature is activated when the MERLIN MAGIX user finishes dialing an 
outside number or when a MERLIN MAGIX system user answers an incoming call. The feature 
operates as follows:

You can program the following parameters for the Busy Tone Detection feature to ensure that the 
MERLIN MAGIX system can recognize the busy tone as a signal to disconnect the call:

■ Assign or remove Busy Tone Detection to each trunk on the 800 LS/CPTD module

■ Specify the cadence of the busy tone

■ Specify the level (intensity) of the busy tone

■ Set the duration of the Busy Tone Detection Threshold Timer

Table 3-2 shows the busy tone characteristics for the three MERLIN MAGIX R1.0i countries.

Table 3-2. Busy Tone Characteristics

Country Frequency (in Hz) Intensity (in dB) Cadence (in ms)

Argentina 450 (+/–5%) –5 to 0 On 250, 
Off 250 ms

Brazil 425 (+/–5%) –20 to –5 On 250, Off 250 (+/–
10%)

Mexico 425 (+/–25) –10 (+/–5) On 250, 
Off 250
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Summary: Busy Tone Detection 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting Cadence:
On duration: 250 ms; Off duration: 250 ms
Level: Medium (-6 dB)
Busy Tone Detection Timer: 0 seconds

Valid Entries Cadence:
On duration: 100 ms–1000 ms in 10-ms increments
Off duration: 100 ms–1000 ms in 10-ms increments
Level: High (0 dB), Medium (-6 dB), Low (-10 dB), 
Very Low (-12.5 dB)
Busy Tone Detection Timer: 0–60 seconds in 1 second increments

Inspect No

Copy Option No

Console Procedure To program Busy Tone Detection for a single-line/trunk:
LinesTrunks→More→More→Busy Tone Det→BTD Trunk 
Status/Change→Select entry mode→ Dial no. of the line/trunk→ 
Enter→Back→Back→Back→Back

To program Busy Tone Detection for a block of lines/trunks:
LinesTrunks→More→More→Busy Tone Det→BTD Trunk 
Status/Change→Select block of lines/trunks→Toggle LED On/
Off→Enter→Back→Back→Back→Back

To specify cadence of the busy tone
LinesTrunks→More→More→Busy Tone Det→BTD 
Feature→Cadence→Select cadence (on duration or off 
duration)→Drop→Dial new duration (100-1000 ms in increments of 
10 ms)→ Enter→Back→Back→Back→Back

To specify level (intensity) of the busy tone
LinesTrunks→More→More→Busy Tone Det→BTD 
Feature→Level→Select level (High, Medium, Low, or Very 
Low)→ Enter→Back→Back→Back→Back

To program Busy Tone Detection Threshold Timer
LinesTrunks→More→More→Busy Tone Det→BTD 
Feature→BTD Threshold Timer→Drop→Dial new duration (1-
60 seconds in increments of 1 second)→ Enter→Back→Back→
Back→Back

PC Procedure To program Dial Tone Detection for a single-line/trunk:
�→�→�→�→�→�→Type no. of the line/trunk→%
�→�→�→�→� 

To program Dial Tone Detection for a block of lines/trunks:
�→�→�→�→�→Select block of lines/trunks→ 
Toggle letter G On/Off→�→�→�→�→� 
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To specify cadence of the busy tone:
�→�→�→�→�→�→Select cadence (on duration 
or off duration)→7+I→Type new duration (100-1000 ms in 
increments of 10 ms)→%�→�→�→�→� 

To specify level (intensity) of the busy tone:
�→�→�→�→�→�→Select level (High, Medium, 
Low, or Very Low)→%�→�→�→�→� 

To program Busy Tone Detection Threshold Timer:
�→�→�→�→�→�→7+I→Type new duration 
(1-60 seconds in increments of 1 second)→%�→�→�→
�→� 

Principal User for Personal Line 3

Use this procedure to assign or remove one telephone as principal user for a Personal Line. When 
a telephone with Remote Call Forwarding activated is assigned as principal user, calls received on 
the Personal Line are forwarded to an outside telephone number. In addition, calls received on that 
line are sent to that telephone’s individual and/or Group Coverage receivers unless the Personal 
Line button is set to No Ring.

The principal user assignment must be removed before the trunk can be removed from a button on 
the telephone.

When no principal user is assigned for a Personal Line, calls received on the Personal Line are not 
forwarded to outside telephone numbers; calls received on the Personal Line follow the coverage 
patterns for all users who share the line.

Summary: Principal User for Personal Line 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4l, Extension Copy: Multiline 4400-Series Telephone Template
4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX telephone
4f, Tip/Ring Equipment
5b, Direct Line Console
5c, MFM Adjunct: DLC

Factory Setting No principal user

Valid Entries Not applicable

Inspect No

Copy Option No
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Console Procedure LinesTrunks→More→PrncipalUsr→Dial line/trunk 
no.→Enter→Dial ext. no.→Enter or Delete→Back→Back

PC Procedure �→�→�→Type line/trunk no.→�→ Type ext. no.→
Select Enter or Delete→�→� 

QCC Queue Priority Level 3

Use this procedure to assign QCC queue priority level values (1 to 7) to each loop-start and 
automatic-in tie trunk in your system. The value assigned determines the order in which calls are 
sent to the QCC operator positions. Call priority 1 is the highest priority, and 7 is the lowest priority.

Summary: QCC Queue Priority Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting 4

Valid Entries 1 to 7

Inspect Yes

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→More→QCC Prior→Dial priority level (1–7)→
Enter→Select entry mode→Dial trunk no.→Enter→Back→Back 

 To program a block of lines/trunks:
LinesTrunks→More→QCC Prior→Dial priority level (1–7)→
Enter→Select block of lines→Toggle LED On/Off→Enter→
Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→Type priority level (1–7)→Select entry mode→
Type trunk no.→�→�→� 

To program a block of lines/trunks:
�→�→�→Type priority level (1–7)→�→
Select block of lines→Toggle letter G On/Off→�→�→� 

This procedure applies to Hybrid/PBX mode only in a system that includes QCC operator 
positions.
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QCC Operator to Receive Calls 3

Use this procedure to specify whether or not incoming calls on each line/trunk ring into the QCC 
queue and to identify the QCC system operator positions that receive incoming calls on each 
line/trunk.

Summary: QCC Operator to Receive Calls 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting No QCC operator is assigned to receive calls.

Valid Entries Extension number of first or fifth extension jack

Inspect Yes

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→More→QCC Oper→Dial ext. no.→Enter→
Select entry mode→Dial line/trunk no.→Enter→Back→Back 

To program a block of lines/trunks:
LinesTrunks→More→QCC Oper→Dial ext. no.→Enter→
Select block of lines/trunks→Toggle LED On/Off→Enter→Back→
Back

■ This procedure applies to Hybrid/PBX mode only in a system that includes QCC 
operator positions.

■ Each loop-start, or automatic-in tie trunk programmed to ring into the QCC queue 
can be associated with one or more QCC operator positions. 

■ If a trunk assigned to ring into the QCC queue is also used for shared Remote 
Access, see ‘‘Remote Access Features’’ on page 3-133 for instructions. You must 
assign Remote Access before you assign a QCC system operator to receive 
calls. See ‘‘QCC Operator to Receive Call Types’’ on page 3-95 for more 
information.

■ Do not change the factory setting of No QCC Operator Assigned to Receive Calls 
for trunks dedicated to incoming calls for Calling Groups, trunks used as Personal 
Lines, DID trunks, unequipped DS1 trunks, or dial-in tie trunks.
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PC Procedure To program a single-line/trunk:
�→�→�→Type ext. no.→�→�→Type line/trunk no.→
�→�→� 

To program a block of lines/trunks:
�→�→�→Type ext. no.→�→
Select block of lines/trunks→Toggle letter G On/Off→�→�→ 
� 

Clock Synchronization 3

Use this procedure to specify the primary, secondary, and tertiary clock source. See the Feature 
Reference for more information about the appropriate setting. If the clock is taken from a 100E 
module, you can also specify whether the clock is synchronized to the outside endpoint (loop) or to 
the clock reference source (local). 

Summary: Clock Synchronization 3

Programmable by System Manager

Mode All

Idle Condition  Not required

Factory Setting Primary clock: the first 100E module in the control unit 
carrier

Valid Entries Primary, Secondary, Tertiary, Loop/Local

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→ClockSync→Primary→
Dial slot no. (1–17)→Enter→Dial port no. or select source of 
synchronization→Enter→Secondary→ Dial slot no. (1–17)→ 
Enter→Dial port no. or select source of synchronization→ 
Enter→Tertiary→Dial slot no. (1–17)→Enter→Dial port no. or 
select source of synchronization→Enter→Back→Back 

PC Procedure �→�→	→�→Type slot no. (1–17)→�→
Type port no. or select source of synchronization→�→�→
Type slot no. (1–17)→�→Type port no. or select source of 
synchronization→�→�→Type slot no. (1–17)→�→
Type port no. or select source of synchronization→�→�→� 

This procedure is necessary only if your system includes more than one 100E module.
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Trunks to Pools Assignment 3

Use this procedure to create trunk pools (groups of outside lines/trunks connected to the system). 
Trunk pools are used to specify preferred routes for Automatic Route Selection (ARS). In addition, 
trunk pools enable users to select a line/trunk by dialing a pool dial-out code or by pressing a 
single button on the telephone. (A separate button for each line/trunk is not needed.) Each pool 
should contain trunks of the same type (for example, loop-start or DIOD trunks). A maximum of 11 
trunk pools is allowed. A trunk can be assigned to only one pool.

Do not mix different service areas of WATS (Wide Area Telecommunications Service) trunks or FX 
(Foreign Exchange) lines to different cities. Do not include both incoming-only and outgoing-only 
lines/trunks in the same pool.

If you want to reassign a line/trunk to a different pool, you must remove it from the current pool 
before you assign it to the new pool. Once you assign a line/trunk to a pool, it can be assigned to a 
button only on a direct-line console operator position; individual lines intended for personal use on 
telephones other than the DLC console should not be assigned to pools.

DID trunks cannot be grouped in pools. Loop-start trunks are automatically placed in pools and 
must be removed manually if used for paging loudspeakers, Music-On-Hold, or maintenance 
alarms.

Dial-in tie trunks should not be grouped in pools if you intend to assign Pool buttons on telephones.

If you are using Automatic Route Selection, the main pool (factory-set dial-out code 70) must 
contain loop-start trunks.

The system provides an error tone when a line/trunk is in use, or if a loudspeaker paging system, 
Music-On-Hold, or maintenance alarm is already assigned; however, the system does not indicate 
the reason for the error tone.

Summary: Trunks to Pools Assignment 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Trunk idle

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting All loop-start trunks are assigned to the main trunk pool (factory-set 
extension number 70); all tie trunks are assigned to the trunk pool 
with the factory-set extension number 891. 

Valid Entries Line numbers

Inspect Yes

This procedure applies to Hybrid/PBX mode only.
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Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→Pools→Dial pool dial-out code→Select entry 
mode→Dial no. of the line/trunk→Enter→Back→Back 

To program a block of lines/trunks:
LinesTrunks→Pools→Dial pool dial-out code→Select block of 
lines/trunks→Toggle LED On/Off→Enter→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→Type pool dial-out code→�→�→Type no. of the 
line/trunk→�→�→� 

To program a block of lines/trunks:
�→�→Type pool dial-out code→�→Select block of lines/
trunks→Toggle letter R On/Off→�→�→� 

Copy Options for Lines/Trunks 3

Use this procedure to copy options assigned to loop-start trunks, tie trunks, DIOD, or DID trunks. 
Note that many of these options apply to Hybrid/PBX systems only. The following information is 
copied for each line/trunk type:

■ Loop-Start Trunks (including those emulated on E1 facilities). Toll type, signaling type, and 
trunk pool assignment (Hybrid/PBX only).

■ Tie Trunks. Direction, tie trunk type, E&M signal, dial mode, dial tone, answer supervision time, 
disconnect time, and trunk pool assignment (Hybrid/PBX only).

■ DIOD and DID Trunks (Hybrid/PBX only). Block assignment and disconnect time.

To find out whether there is an optional feature assigned that you would like to copy, use Inspect 
from the system programming console, or click � in the console emulation display on the PC.
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Summary: Copy Options for Lines/Trunks 3

Programmable by System Manager

Mode All (but note differences)

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 
3c, Incoming Trunks: TIE
3d, Incoming Trunks: DID

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option Not applicable

Console Procedure To copy individual lines/trunks:
LinesTrunks→Copy→Single→Dial copy-from trunk no.→ 
Enter→Dial copy-to trunk no.→Enter→Back→Back→Back

To copy blocks of lines/trunks:
LinesTrunks→Copy→Block→Dial copy-from trunk no.→
Enter→Dial first copy-to trunk no. in block→Enter→
Dial last copy-to trunk no. in block→Enter→Back→Back→Back

■ You can copy options to a block of lines/trunks only if they are all of the same type 
(loop-start, Tie, DIOD, or DID). If you attempt to copy assignments and there is a 
mismatch in line/trunk type, information is copied to that point only. You receive 
no error message.

■ If you are copying options to a block of lines/trunks, they must be sequentially 
numbered.

■ If the block you are copying to includes an invalid line/trunk type, the copying 
process stops at the invalid type. Only the lines/trunks that were copied to before 
the invalid type was found are copied successfully.

■ If you are copying assignments to a block of lines/trunks and one of the lines or 
trunks is in use, you see the message Trunk Busy - Pls wait on your display. 
The copying for the rest of the lines/trunks in the block is delayed until the busy 
line/trunk becomes idle. If you exit without waiting for the copying to complete, the 
copying done up to that point is not cancelled.

■ The Inspect feature must be programmed on a line button on the 4424LD+ 
telephone and is a fixed button on the MLX-20L telephone.
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PC Procedure To copy individual lines/trunks:
�→	→�→Type copy to trunk no.→�→
Type copy-from trunk no.→�→�→�→� 

To copy blocks of lines/trunks:
�→	→�→Type copy-from trunk no.→
Type first copy-to trunk no. in block→�→�→
Type last copy-to trunk no. in block→�→�→�→� 

E1 Facilities 3

Use the procedures in this section to program the following options for E1 facilities connected to a 
100E module: 

■ Type of E1 facility

— Loop start

— TIE

— Direct Inward Dial (DID)

— Direct Inward/Outward Dial (DIOD)

■ Line Code (Suppression)

Type of E1 Facility 3

Use this procedure to specify the type of channel emulation for the E1 channels on a 100E 
module. The system supports the following types of trunk emulation in any combination:

■ Loop start

■ TIE

■ Direct Inward Dial (DID)

■ Direct Inward/Outward Dial (DIOD)

If the type of channel emulation is tie trunk, you must specify whether the lines/trunks are TIE-
PBX, Toll, or Switched 56 Data service. The valid settings are as follows:

■ TIE-PBX. Select when emulated tie trunks are used to connect to another system (such as 
PBX or Centrex). The transmit/receive gain is set to 0/4.

■ Toll. Select when emulated tie trunks are used for network services. Note that unused 
channels must be specified as unequipped. The transmit/receive gain is set to 0/6.

Summary: Type of E1 Facility 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle



System Programming

E1 Facilities

3-42

Factory Setting Unequipped

Valid Entries Loop Start, TIE, DID, DIOD, All Loop, All TIE, All DID, All DIO, 
Unequipped, All Unequipped

Inspect Yes

Copy Option No

Console Procedure  To select All Loop, All DID, or All DIOD:
LinesTrunks→Modules→Dial slot no. (1–17)→Enter→ 
Type→Select type of emulation→Enter→Back→
Back→Back

To select All Unequip:
LinesTrunks→Modules→Dial slot no. (1–17)→Enter→
Type→More→All Unequip→Enter→Enter→
Back→Back→Back 

To select Loop Start, DID or DIOD for individual channels:
LinesTrunks→Modules→Dial slot no. (1–17)→Enter→
Type→Select type of emulation→Enter→Dial channel no. (2-32; 
channels 1 and 17 are reserved for signaling)→Enter or 
Delete→Back→Back→Back→Back 

To select All TIE:
LinesTrunks→Modules→Dial slot no. (1–17)→Enter→
Type→All TIE→Enter→TIE-PBX or Toll→Enter→
Back→Back→Back→Back 

To select TIE for individual channels:
LinesTrunks→Modules→Dial slot no. (1–17)→Enter→
Type→TIE→Enter→TIE-PBX or Toll→Enter→Dial channel 
no. (1-32; channels 1-17 are reserved for signaling)→Enter or 
Delete→Back→Back→Back→Back 

PC Procedure To select All Loop, All DID or All DIOD:
�→�→Type slot no. (1–17)→�→ �→Select type of 
emulation→�→�→�→�
To select All Unequip:
�→�→Type slot no. (1–17)→�→�→�→�→�→
�→�→� 

To select Loop Start, DID or DIOD for individual channels:
�→�→Type slot no. (1–17)→�→�→Select type of 
emulation→�→Type channel number (1-32; channels 1-17 are 
reserved for signaling)→�%or%
→�→�→�→� 

To select All TIE:
�→�→Type slot no. (1–17)→�→	→�%or%
�→�→�→�→ �→� 

To select TIE for individual channels:
�→�→Type slot no. (1–17)→�→�→�→�%or 
�→�→Type channel no. (1-32; channels 1-17 are reserved for 
signaling)→�%or%
→�→%�→�→� 
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Line Code Suppression 3

Use this procedure to specify the type of line coding suppression mechanism for the 100E module 
as Alternate Mark Inversion (AMI) or Alternate Mark Inversion with High Density Bipolar of Order 3 
(HDB3). Your selection must match the suppression at the far end of the DS1 facility.

Summary: Zero Code Suppression 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting HDB3

Valid Entries AMI or HDB3

Inspect No

Copy Option No

Console Procedure LinesTrunks→Module→Dial slot no. (1–17)→ Enter→
Suppression→AMI or HDB3→ Enter→Back→Back

PC Procedure �→�→Type slot no. (1–17)→�→�→� or 
�→�→�→� 

Channel Associated Signaling 3

Use these procedures to program the following Channel Associated Signaling options for E1 
facilities:

■ Select a country code 

— 1=Mexico (default)

— 2=Argentina

— 3=Brazil

■ Line Signaling Timing

■ MFC Dialing (See MFC Register Signaling)

■ Pulse Dialing

■ Tariff Pulse Meter

■ Encoding

Setting the country code automatically sets the values for the following options and it 
is usually not necessary to change the settings.
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Country Code 3

Use this procedure select a specific channel associated signaling protocol by selecting the country 
code that most closely matches your country.

Summary: Country Code 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting 1 - Mexico

Valid Entries 1 = Mexico, 2 = Argentina, or 3 = Brazil

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→R2/CaS Signl→CountryCode→
Dial a country code (1 = Mexico, 2 = Argentina, or 3 = Brazil)→ 
Enter→Back→Back→Back→Back

PC Procedure �→�→�→�→�→Type a country code (1 = Mexico, 2 
= Argentina, or 3 = Brazil)→�→�→�→�→� 

Line Signaling Timing 3

Use this procedure set the following line signaling timers:

■ out seize

■ clear forward

■ clear back

■ disconnect guard

■ answer validation

■ dialing delay

Summary: Line Signaling Timing 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory settings are as follows:
Out Seize: 200 ms
Clear Forward: 220 ms
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Clear Back: 250 ms
Disconnect Guard: 500 ms
Answer Timeout: 20 ms
Dialing Delay: 0 ms

Valid Entries Out Seize: 0 ms to 10000 ms in increments of 100 ms
Clear Forward: 20 ms to 1000 ms in increments of 20 ms
Clear Back: 20 ms to 1000 ms in increments of 20
Disconnect Guard: 0 ms to 2000 ms in increments of 50
Answer Timeout: 20 ms to 500 ms in increments of 10
Dialing Delay: 0 ms to 1000 msms in increments of 100

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→R2/CaS Signl→
Timing→Select the timer you want to change→Drop→Dial the new 
setting for the timer (see valid entries above for each 
timer)→Enter→
Back→Back→Back→Back

PC Procedure �→�→�→�→�→Select the timer you want to 
change→7+I→Type the new setting for the timer (see valid 
entries above for each timer)→�→�→�→�→� 

Pulse Dialing 3

Use this procedure to set the following pulse dialing parameters:

■ Pulse dialing bit - used for selecting the bit used for pulse dialing

■ Break timer - used for the make/break ratio of pulse dialing

Summary: Pulse Dialing 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory settings are set as follows:
Pulse Dialing Bit: Bit B
Break Timer: 60 ms

Valid Entries Bit A, Bit B, Bit C
Break Timer: 50 ms to 80 ms in increments of 10 ms

Inspect No

Copy Option No
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Console Procedure To set the Pulse Dialing Bit:
LinesTrunks→More→More→R2/CaS Signl→
Pulse Dial→Dialing Bit→Select Bit A, Bit B or Bit C→ 
Enter→Back→Back→Back→Back

To set the Break Timer:
LinesTrunks→More→More→R2/CaS Signl→
Pulse Dial→Break Timer→Drop→Dial the duration of the 
Break Timer (50-80 ms in increments of 10 ms→ 
Enter→Back→Back→Back→Back

PC Procedure To set the Pulse Dialing Bit:
�→�→�→�→�→�→� or �→�
→�→�→�→� 

To set the Break Timer:
�→�→�→�→�→�→7+I→Type the duration 
of the Break Timer (50-80 ms in increments of 10 ms→�
→�→�→�→� 

Tariff Pulse Meter 3

Use this procedure to activate tariff pulse metering on E1 trunks and set the following Tariff Pulse 
Meter parameters:

■ Tariff Pulse Meter activation

■ meter bit

■ minimum pulse

■ minimum pause

Summary: Tariff Pulse Meter 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory settings are as follows:
Activation: Off
Meter Bit: Bit B
Minimum Pulse Duration: 100 ms
Minimum Pause Duration: 40 ms

Valid Entries Activation: On or Off
Meter Bit: Bit A, Bit B or Bit C
Minimum Pulse Duration: 20 ms to 1000 ms in increments of 10 ms
Minimum Pause Duration: 20 ms to 1000 ms in increments of 10 ms

Inspect No
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Copy Option No

Console Procedure To turn Tariff Pulse Metering on or off:
LinesTrunks→More→More→R2/CaS Signl→
Tariff Pulse→On/Off→Select On or Off→ 
Enter→Back→Back→Back→Back

To select the Meter Bit:
LinesTrunks→More→More→R2/CaS Signl→
Tariff Pulse→Meter Bit→Select Bit A, Bit B or Bit 
C→Enter→Back→Back→Back→Back

To set the Minimum Pulse Duration:
LinesTrunks→More→More→R2/CaS Signl→
Tariff Pulse→Min Pulse→Drop→Dial the Minimum Pulse 
Duration (200-1000 ms in increments of 10 ms) →Enter→Back
→Back→Back→Back

To set the Minimum Pause Duration:
LinesTrunks→More→More→R2/CaS Signl→
Tariff Pulse→Min Pause→Drop→Dial the Minimum Pause 
Duration (20-1000 ms in increments of 10 ms) →Enter→Back
→Back→Back→Back

PC Procedure To turn Tariff Pulse Metering on or off:
�→�→�→�→	→�→� or �→�
→�→�→�→� 

To select the Meter Bit:
�→�→�→�→	→�→�, �� or �→→�
→�→�→�→� 

To set the Minimum Pulse Duration:
�→�→�→�→	→�→7+I→Type the Minimum 
Pulse Duration (200-1000 ms in increments of 10 ms) →�
→�→�→�→� 

To set the Minimum Pause Duration:
�→�→�→�→	→�→7+I→Type the Minimum 
Pulse Duration (20-1000 ms in increments of 10 ms) →�
→�→�→�→� 

Encoding 3

Use this procedure to specify the encoding algorithm that the system uses to interface with the 
public-switched telephone network. Most countries expect the A-law.

if A-law is selected, the information selected and received to and from the network 
will be in A-law and then a conversion is done to Mu-law since the system backplane 
works in Mu-law.
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Summary: Encoding 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory setting is A-law

Valid Entries Mu-law or A-law

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→R2/CaS Signl→
Encoding→Select Mu-law or A-law→Enter→Back→Back→
Back

PC Procedure �→�→�→�→�→� or �→�→�→�→� 

MultiFrequency Compelled (MFC) Register 
Signaling 3

Use these procedures to program the following MultiFrequency Compelled (MFC) Register 
Signaling options for E1 facilities:

■ Signals

■ Send Signals

■ Expect Digit

■ Number to Send

Use this procedure to map forward and backward signals to their meanings. 

Summary: Signals 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory setting is the settings required for operation in 
Mexico; see Feature Reference for details.

Valid Entries Group I, Group III, Group A, or Group B

Inspect No

Copy Option No
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Console Procedure LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→Signals→Dial the signal number you want to 
set→Drop→Enter→Select the appropriate meaning for the 
signal→Enter→Back→Back→Back→Back

PC Procedure �→�→�→�→�→�→Type the signal number you 
want to set→7+I→�→Select the appropriate meaning for the 
signal→�→�→�→�→� 

■ Specify the number of digits the system expects for incoming TIE calls using MFC Dialing.

Send Signals 3

Use this procedure to specify what signal the system sends in certain points of the dialing protocol. 
You can set the following signals:

■ End of Number

■ II Response

■ End of Address

■ Group A Congestion

■ Ringing

■ Busy

■ Reorder 1

■ Reorder 2

■ Reorder 3

■ End of ANI

The settings are not normally changed. Check with your representative before changing the 
settings.

Summary: Send Signals 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory setting is the settings required for operation in 
Mexico; see Feature Reference for details. These settings are not 
normally changed.

Valid Entries See Feature Reference

The number of digits the system expects for incoming DID calls is specified during 
DID trunks programming.
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Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→Send Signals→Select the send signal you want 
to change→Drop→Dial the new setting→Enter→Back→Back
→Back→Back

PC Procedure �→�→�→�→�→�→Select the send signal you 
want to change→7+I→Type the new setting→�→�→�
→�→� 

Expected Digits 3

Enables you to specify the number of digits the system expects for incoming TIE calls using MFC 
Dialing.

Summary: Expected Digits 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Values defined by country code chosen; if a specific country code is 
not chosen, the factory setting is the settings required for operation in 
Mexico.

Valid Entries 1-4

Inspect No

Copy Option No

Console Procedure LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→ExpectDigit→Drop→Dial the number of digits to 
expect (1-4)→Enter→Back→Back→Back→Back

PC Procedure �→�→�→�→�→�→7+I→Type the number of 
digits to expect (1-4)→�→�→�→�→� 

Expected digits for DID trunks are set under DID programming.
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Number to Send 3

Use this procedure to specify which number the system sends in response to a “send ANI” request. 
You can specify the system to send one of the following numbers:

■ Extension Only

■ Extension and Base (only one base telephone number is permitted per system)

■ Line Telephone Number

Summary: Number to Send 3

Programmable by System Manager

Mode All

Idle Condition 100E module idle

Factory Setting Extension Only

Valid Entries Extension Only, Extension and Base, or Line Telephone number

Inspect No

Copy Option No

Console Procedure To specify Extension Only:
LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→NumberToSend→Extension 
Only→Enter→Back→Back→Back→Back

To specify Extension and Base:
LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→NumberToSend→Extension and 
Base→Drop→Dial the base telephone number (maximum 12 
digits)→Enter→Back→Back→Back→Back

To specify Line Telephone Number:
LinesTrunks→More→More→R2/CaS Signl→
MFC Dialing→NumberToSend→Line Telephone 
Number→Enter→Dial the line number (1-80)→Enter→Drop→
Dial the telephone number to send on outgoing calls (maximum 12 
digits)→Enter→Back→Back→Back→Back

PC Procedure To specify Extension Only:
�→�→�→�→�→�→�→�→�→�→�
→� 

To specify Extension and Base:
�→�→�→�→�→�→�→7+I→Type the 
base telephone number (maximum 12 digits)→�→�→�→
�→� 
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To specify Extension and Base:
�→�→�→�→�→�→�→�→Dial the line 
number (1-80)→�→7+I→Type the telephone number to send 
on outgoing calls (maximum 12 digits)→�→�→�→�
→� 

Tie Trunks 3

Reviewers: Is this section still valid since Release 1.0i does not support the 400EM 
module? Does this procedure apply to the emulated tie trunks for the 100E module?

This section covers programming procedures for the following tie trunk options:

■ Direction

■ Tie Trunk Seizure Type

■ E&M Signal

■ Dial Mode

■ Tie Trunk Dial Tone

■ Tie Trunk Answer Supervision Time

■ Disconnect Time

Direction 3

Use this procedure to specify whether tie trunks operate in a one- or two-way direction. For one-
way tie trunks, you must also specify whether the direction is out or in.

Summary: Direction 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Two-way

Valid Entries Two-way, Outgoing, Incoming

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Direction→Dial trunk no.→ 
Enter→Specify direction (Two-way, Outgoing, or Incoming)→
Enter→Back→Back 
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PC Procedure �→�→�→Type trunk no.→�→
Specify direction (Two-way, Outgoing, or Incoming)→�→�→� 

Tie Trunk Seizure Type 3

Use this procedure to specify whether the seizure type of incoming or outgoing tie trunk is wink, 
delay, immediate, automatic, R2/CaS Automatic, or R2/CaS Dial.

Summary: Tie Trunk Seizure Type 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting R2/CaS Automatic

Valid Entries Wink, Delay, Immediate, Automatic, R2/CaS Automatic, or R2/CaS 
Dial

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Intype or Outtype→
Dial trunk no.→Enter→Specify seizure type (Wink, Delay, 
Immediate, Automatic, R2/CaS Automatic, or R2/CaS 
Dial)→Enter→Back→Back 

PC Procedure �→�→� or%�→Type trunk no.→�→
Specify seizure type (Wink, Delay, Immediate, Automatic R2/CaS 
Automatic, or R2/CaS Dial)→�→�→� 

E&M Signal 3

Use this procedure to specify the type of tie trunk signal, as follows:

■ E&M Mode:

— 1S, Type 1 Standard. Tie trunks that are connected through the local telephone company.

— 1C, Type 1 Compatible. Tie trunks that are connected directly to a system that uses 1S 
signaling.

■ Simplex Mode: 

— 5, Type 5 Simplex. Tie trunks that are connected to a system using Type 5 signaling.



System Programming

Tie Trunks

3-54

Summary: E&M Signal 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 1S

Valid Entries 1S, 1C, 5

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→E&M Signal→Dial trunk no.→ 
Enter→Specify signaling type (1S, 1C, or 5)→Enter→Back→
Back 

PC Procedure �→�→�→Type trunk no.→�→
Specify signaling type (1S, 1C, or 5)→�→�→� 

Dial Mode 3

Use this procedure to specify whether an incoming or outgoing tie trunk is Touch-Tone, Rotary, or 
MFC.

Touch-Tone cannot be programmed for incoming immediate signaling tie trunks. Users of Touch-
Tone single-line telephones cannot make calls by using individual trunks programmed for rotary 
operation. The Touch-Tone signals generated from the telephone while the user is dialing are 
transmitted to the central office at the same time the rotary signals are sent to the system. The 
central office receives both signals and cannot process the call.

Summary: Dial Mode 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting MFC

Valid Entries Rotary, Touch-Tone, MFC

Inspect Yes

Copy Option Yes
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Console Procedure To program a single-line/trunk:
LinesTrunks→TIE Lines→Inmode or Outmode→
Entry Mode→Dial line/trunk no.→ Enter or Delete→Back→ 
Back→Back 

To program a block of lines/trunks:
LinesTrunks→TIE Lines→Inmode or Outmode→
Select block of lines→Toggle LED On/Off→Back→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→� or 	→�→Type line/trunk no.→� or 
→
�→�→� 

To program a block of lines/trunks:
�→�→� or 	→Select block of lines→
Toggle letter G On/Off→�→�→� 

Tie Trunk Dial Tone 3

Use this procedure to specify whether the system provides dial tone for people calling in on a tie 
trunk. The settings are remote (system provides dial tone) and local (system does not provide dial 
tone).

Summary: Tie Trunk Dial Tone 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Remote

Valid Entries Remote, Local

Inspect Yes

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→TIE Lines→Dialtone→Entry Mode→
Dial trunk no.→Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→TIE Lines→Dialtone→
Select block of lines/trunks→Toggle LED On/Off→Back→
Back→Back 
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PC Procedure To program a single-line/trunk:
�→�→
→�→Type trunk no.→� or 
→�→� 

To program a block of lines/trunks:
�→�→
→Select block of lines→Toggle letter G On/Off→
�→�→� 

Tie Trunk Answer Supervision Time 3

Use this procedure to specify the tie trunk answer supervision time in milliseconds. This is the time 
limit for the called system to respond.

Summary: Tie Trunk Answer Supervision Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 300 ms

Valid Entries 20 to 4,800 ms, in increments of 20 ms

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→AnsSupvr→Dial trunk no.→
Enter→Drop→Dial no. of ms (20–4,800)→Enter→Back→Back 

PC Procedure �→�→�→Type trunk no.→�→7+I→
Type no. of ms (20–4,800)→ �→�→� 

Disconnect Time 3

Use this procedure to specify the tie trunk disconnect time limit in milliseconds.

Summary: Disconnect Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 300 ms

Valid Entries 140 to 2,400 ms
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Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Disconnect→Dial trunk no.→ 
Enter→Drop→Dial no. of ms (140–2,400)→Enter→Back→
Back

PC Procedure �→�→�→Type trunk no.→�→7+I→
Type no. of ms (140–2,400)→�→�→� 

DID/DIOD Trunks 3

This section covers programming DID/DIOD trunks and includes procedures for the following:

■ Block Assignment

■ DID/DIOD Trunk Type

■ Disconnect Time

■ Expected Digits

■ Delete Digits

■ Add Digits

■ Signaling

■ Invalid Destination

Block Assignment 3

Use this procedure to assign each DID/DIOD trunk connected to the system to Block 1, 2, 3, or 4.

Summary: Block Assignment 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID

Factory Setting Block 1

Valid Entries Block 1, Block 2, Block 3, Block 4

Inspect Yes

Copy Option Yes

These procedures apply to Hybrid/PBX mode only.
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3Programming Procedures

Console Procedure To program a single-line/trunk:
LinesTrunks→DID/DIOD→Block→Dial trunk block no. (1-4)→ 
Enter→Entry Mode→Type the line/trunk no.→
Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→DID/DIOD→Block→Dial trunk block no. (1-4)→ 
Enter→Select trunk lines→Toggle LED On/Off→Enter→Back→
Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→Type trunk block no. (1-4)→�→
Type the line/trunk no.→� or 
→�→�→� 

To program a block of lines/trunks:
�→�→�→Type trunk block no.(1-4)→�→
Select trunk lines→Toggle letter G On/Off→�→�→�→� 

DID Trunk Type 3

Use this procedure to specify the DID/DIOD trunk type as either immediate-start or wink-start. 
Wink-start is more reliable if the local telephone company supports it.

Summary: DID Trunk Type 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition DID/DIOD trunk idle

Planning Form 3d, Incoming Trunks: DID/DIOD 

Factory Setting Wink-start

Valid Entries Immediate-start, Wink-start

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID/DIOD→Type→Dial trunk block 
no.→Enter→ Immed or Wink→Enter→Back→Back 

PC Procedure �→�→�→Type trunk block no.→�→Select Immed or 
Wink→�→�→� 
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Disconnect Time 3

Use this procedure to specify the DID/DIOD trunk disconnect time limit in milliseconds.

Summary: Disconnect Time 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 500 ms

Valid Entries 10 to 2,400 ms, in increments of 10 ms

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→DID/DIOD→Disconnect→Dial trunk no.→ 
Enter→Drop→Dial no. of ms (10–2,400)→ Enter→Back→Back 

PC Procedure �→�→�→Type trunk no.→�→7+I→
Type no. of ms (10–2,400)→�→�→� 

Expected Digits 3

Use this procedure to tell the system how many digits are sent by the local telephone company.

Summary: Expected Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 3 digits

Valid Entries 1 to 4 digits

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID/DIOD→ExpectDigit→Dial trunk block no. 
(1 or 2)→Enter→Drop→Dial no. of digits (1–4)→Enter→ 
Back→Back 

PC Procedure �→�→�→Type trunk block no. (1 or 2)→�→7+I→ 
Type no. of digits (1–4) �→�→� 
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Delete Digits 3

Use this procedure to specify the number of leading digits to be deleted from the digits sent by the 
local telephone company. Use this procedure when the number of digits sent by the telephone 
company is greater than the number in the system numbering plan.

Summary: Delete Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 0 digits

Valid Entries 0 to 4 digits

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID/DIOD→DeleteDigit→Dial trunk block no. 
(1 or 2)→Enter→Drop→Dial no. of digits (0–4)→Enter→Back→
Back 

PC Procedure �→�→�→Type trunk block no. (1 or 2)→�→7+I→ 
Type no. of digits (0–4)→�→�→� 

Add Digits 3

Use this procedure to specify the number of leading digits that must be added to the digits sent by 
the local telephone company. Use this procedure when the number of digits sent by the telephone 
company is fewer than the number in the system numbering plan.

Summary: Add Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID/DIOD 

Factory Setting 0

Valid Entries 1 to 9999

Inspect No

Copy Option No
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Console Procedure LinesTrunks→DID/DIOD→Add Digits→Dial trunk block no. (1 or 
2)→ Enter→Drop→Dial added digits (1–9999)→Enter→ 
Back→Back 

PC Procedure �→�→	→Type trunk block no. (1 or 2)→�→7+I→
Type added digits (1–9999)→�→�→� 

Signaling 3

Use this procedure to specify whether the type of dialing signal from the local telephone company 
is ouch-tone, rotary or MFC. Touch-Tone dial mode cannot be programmed for immediate-start 
DID/DIOD trunks. 

Touch-Tone single-line telephone users cannot make calls by using individual trunks programmed 
for rotary operation. The Touch-Tone signals generated from the telephone while dialing are 
transmitted to the central office at the same time the rotary signals are sent to the system. The 
central office receives both signals and cannot process the call.

Summary: Signaling 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not Required

Planning Form 3d, Incoming Trunks: DID/DIOD 

Factory Setting Rotary

Valid Entries Rotary, Touch-Tone, MFC

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID/DIOD→Signaling→Dial trunk block no.→ 
Enter→Rotary, TouchTone or MFC→Enter→Back→Back

PC Procedure �→�→
→Type trunk block no.→�→� �%or 
�→�→�→� 

Invalid Destination 3

Use this procedure to specify where to direct outside calls (received on DID/DIOD trunks) for 
unassigned extension numbers. Calls can be either directed to a backup position (normally the 
primary system operator) or given a fast busy signal. See ‘‘QCC Operator to Receive Call Types’’ 
on page 3-95 for information on assigning a backup position.



System Programming

Extensions

3-62

Summary: Invalid Destination 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, incoming Trunks: DID 

Factory Setting Backup (calls are sent to the primary system operator)

Valid Entries Send to Backup Extension, Return Fast Busy

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→InvalDstn→Select Send to Backup 
Extension or Return Fast Busy→ Enter→Back→Back 

PC Procedure �→�→�→Select Send to Backup Extension or Return 
Fast Busy→�→�→� 

Extensions 3

This section contains the following procedures: 

■ Assigning outside lines or trunks to the buttons on a telephone (including lines and trunks 
used for loudspeaker paging)

■ Copying line button assignments from one extension to either an individual extension or a 
block of extensions

■ Assigning the following buttons on telephones (for Hybrid/PBX systems only):

— System Access or Intercom Voice

— System Access or Intercom Ring

— System Access or Intercom Originate Only

— Shared System or Intercom Access

■ Programming rotary signaling on tip/ring ports
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3Programming Procedures

Assign Trunks or Pools to Extensions 3

Use this procedure to assign outside lines/trunks (connected to the control unit) to specific buttons 
on each telephone. The lines/trunks assigned to a button on a telephone are called Personal 
Lines.

This procedure is used only to change or add Personal Lines, Loudspeaker Paging, or Pool 
buttons (Hybrid/PBX only) to telephones. See ‘‘Assign Intercom or System Access Buttons’’ on 
page 3-66 to add or change Intercom (ICOM) or System Access (SA) buttons.

Individual lines/trunks can be assigned to a maximum of 64 extensions. Individual pools can be 
assigned as a Pool button on a maximum of 64 extensions.

The following lines/trunks cannot be assigned to a button on a telephone:

■ Lines/trunks used for Music-On-Hold

■ Lines/trunks used for maintenance alarms

Pool buttons cannot be assigned to or removed from extensions unless the pool has trunks 
assigned. If all trunks are to be removed from a pool, all Pool button assignments must first be 
removed from extensions. Another way of handling this situation is to program another trunk into 
the pool and then remove the Pool button assignments from the extensions.

■ Hybrid/PBX only. Individual lines/trunks assigned to a pool can be assigned to a button only 
on a DLC operator position. If one of the lines/trunks in a pool is assigned to a button on a 
non-DLC telephone, the result is a Pool button assignment.

■ Key only. The system assigns the first eight line numbers to buttons on multiline telephones 
whether or not an outside line is physically connected. If a line is not connected, the button 
assignment must be removed so the user can assign a feature to the button.

■ For the Transtalk 9031 wireless multiline telephone. The system assigns the first eight 
lines connected to the control unit even though the telephone has fewer than eight buttons 
available. Remove the extra lines in system programming so that the appropriate number of 
lines is assigned to buttons on these telephones.

Lines and trunks are assigned to buttons in the order in which you press each line button on the 
system programming console or keyboard. Existing line assignments can be rearranged by 
removing all current assignments and then pressing the line buttons on the console or keyboard in 
the order in which they should appear on the buttons. For information on the order of the 
programmed buttons, refer to the button numbers on the applicable planning form for each 
telephone.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be 
required to obtain a copyright license from and pay license fees to a third party (such as 
the American Society of Composers, Artists, and Producers or Broadcast Music 
Incorporated). Magic On Hold requires no such license and can be purchased from 
Lucent Technologies.
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If you want to reserve some blank buttons for features between line buttons, a line must be 
assigned as a placeholder for each blank button. After all lines are assigned, remove the lines 
used as placeholders on the buttons reserved for features.

Summary: Assign Trunks or Pools to Extensions 3

Programmable by System Manager

Mode All, but note differences in factory settings.

Idle Condition Extension idle

Planning Form 4l, Extension Copy: Multiline 4400-Series Telephone Template
4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting Key Mode. An Intercom Ring (ICOM Ring) button, an Intercom Voice 
(ICOM Voice) button, and the first eight lines connected to the control 
unit are assigned to all multiline 4400-Series telephones, ETR, and 
MLX telephones (excluding operator positions), and MFMs connected 
to MLX telephones. Two ICOM Ring buttons are assigned to 4400, 
4400D, and single-line telephones; no outside lines are assigned.

Behind Switch Mode. Not supported in MERLIN MAGIX Integrated 
System Release 1.0i.

Hybrid/PBX Mode. System Access Ring (SA Ring), System Access 
Voice (SA Voice), and System Access Originate Only (SA Orig Only) 
buttons are assigned to all multiline 4400-Series telephones, ETR, 
and MLX telephones (excluding operator positions). Five Call buttons 
are assigned to QCC operator positions. Two SA Ring buttons and 
one SA Orig Only button are assigned to 4400, 4400D, and single-line 
telephones. No Personal Line or Pool buttons are assigned.

Valid Entries Extension numbers

Inspect Yes

Copy Option Yes

Console Procedure To program a single-line/trunk:
Extensions→Lines/Trunks→Dial ext. no.→ Enter→
Entry Mode→Dial line/trunk no.→Enter→Back→Back 

To program a block of lines/trunks:
Extensions→Lines/Trunks→Dial ext. no.→Enter→
Select trunk range→Toggle LED On/Off→Enter→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→Type ext. no.→�→�→Type line/trunk no.→�→
�→� 
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To program a block of lines/trunks: →�→�→Type ext. no.→ 
�→Select trunk range→Toggle letter G On/Off→�→�→� 

Copy Line/Trunk Assignments 3

Use this procedure to copy outside line/trunk button assignments, pool dial-out code restrictions 
(Hybrid/PBX only), and (for operator positions only) Night Service information from one extension 
to another extension or block of extensions with identical requirements.

If you are copying assignments to a block of extensions and one of the extensions in the block is in 
use, the display shows the Station Busy - Pls Wait message. Copying for the rest of the 
extensions in the block is delayed until the busy extension becomes idle. The number of the busy 
extension is not shown. If a DSS is attached, the LED associated with the busy extension is on. If 
you exit instead of waiting for the busy extension to become idle, copying for the rest of the 
extensions is cancelled; however, the assignments that have already been copied are not 
cancelled.

If you are copying assignments from an operator position to a block of extensions that includes 
both operator and non-operator extensions, the information is copied to only the operator 
positions; the non-operator positions are not affected. Similarly, if you are copying assignments 
from a non-operator position to a block of extensions that includes both operator and non-operator 
extensions, the information is copied to only the non-operator positions; the operator positions are 
not affected. The system does not provide an error tone to signal that the copy did not work for all 
of the extensions in the block.

Summary: Copy Line/Trunk Assignments 3

Programmable by System Manager

Mode All

Idle Condition Extension idle

Planning Form 4l, Extension Copy: Multiline 4400-Series telephone Template
4c, Extension Copy: MLX Telephone Template
4g, Extension Copy: ETR Telephone Template

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes: lines/pools assigned to an extension.

Copy Option Not applicable

Console Procedure To copy to a single extension:
Extensions→Line Copy→Single→Dial copy from ext. no.→
Enter→Dial copy to ext. no.→Enter→Back→Back 

To copy to a block of extensions: 
Extensions→Line Copy→Block→Dial copy from ext. no.→
Enter→Dial ext. no. of first extension in block→Enter→
Dial ext. no of last extension in block→Enter→Back→Back 
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PC Procedure To copy to a single extension:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→� 

To copy to a block of extensions:
�→�→�→Type copy from ext. no.→�→
Type ext. no. of first extension in block→�→
Type ext. no. of last extension in block→�→�→� 

Assign Intercom or System Access Buttons 3

Use this procedure to assign or change the assignments for Intercom (ICOM) buttons used to 
make and receive inside calls. This includes the following types of ICOM buttons:

■ Ring

■ Voice

■ Originate Only (Ring or Voice)

In Hybrid/PBX mode only, use this procedure to assign or change assignments for System Access 
(SA) buttons used to make or receive inside and outside calls. This procedure includes the 
following types of System Access buttons:

■ Ring

■ Voice

■ Originate Only (Ring or Voice)

■ Shared (Ring or Voice)

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

■ You cannot change the factory setting for Call buttons assigned to QCC operator 
positions, and you cannot assign Ring, Voice, Originate Only, or Shared buttons to 
QCC operator positions. However, the Call 5 (Ring/Voice) button on a QCC can be 
programmed for Voice Announce. See ‘‘Voice Announce’’ on page 3-100

■ System Access or Intercom buttons can be assigned to only the first 10 buttons on 
a multiline telephone. This allows for a combination of up to 10 SA or ICOM buttons 
for each telephone (excluding QCC operator positions).

■ You can remove SA or ICOM buttons, but at least one must remain on the 
extension.
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Summary: Assign Intercom or 
System Access Buttons 3

Programmable by System Manager

Mode All, but note differences in factory settings

Idle Condition Extension idle

Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjuncts: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct (DLC)

Factory Setting Key Mode. An Intercom Ring (ICOM Ring) button, an Intercom Voice 
(ICOM Voice) button, and the first eight lines connected to the system 
are assigned to all multiline 4400-Series and MLX telephones, 
excluding operator positions. Two ICOM Ring buttons are assigned to 
4400 and 4400D Telephones and to tip/ring equipment connected to 
an 016 (T/R) module or to an 016 ETR port when the port is 
programmed for T/R operation. An ICOM Ring and an Intercom 
Originate Only (ICOM Orig Only) button are assigned to tip/ring 
equipment connected by an MFM. No outside lines are assigned.

Behind Switch Mode. Not supported with MERLIN MAGIX 
Integrated System Release 1.0i.

All Modes. System Access Ring (Hybrid/PBX mode) or Intercom 
Ring (Key and Behind Switch modes), System Access Voice (Hybrid/
PBX mode) or Intercom Voice (Key and Behind Switch modes), and 
the first 18 through 29 lines connected to the control unit are assigned 

■ When 4400, 4400D, and single-line sets are programmed with only one SA or ICOM 
button, the Transfer, Conference and Drop features are disabled. Other features that 
require a second dial tone, such as Account Code/Number Entry, After Call Work 
States, Call Pickup, Call Waiting, and Privacy, are also affected. For more information, 
see the Feature Reference.

■ Each System Access Ring or Voice on an individual telephone can be assigned as a 
Shared System Access (SSA) button on up to 16 other extensions.

■ Shared SA buttons cannot be assigned to 4400, 4400D, and single-line telephones or 
other tip/ring equipment connected to an 016 (T/R) or 008 OPT module. Shared SA 
buttons can be assigned to a tip/ring or external alert device connected to an MFM in 
an MLX telephone. Shared SA buttons cannot be assigned when the corresponding SA 
button is on a 4400, 4400D, and single-line telephone.

■ Each System Access Ring or Voice on an individual extension can be assigned as a 
SSA button on up to 27 other extensions

■ SA and ICOM buttons are centrally programmed and cannot be programmed by 
individual extension users.
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to all DLC operator positions. The number of lines assigned depends 
on the type of telephone used as a DLC operator position. Refer to 
the appropriate telephone planning form for details.

Valid Entries Not applicable.

Inspect Yes: specific button options.

Copy Option Yes. (You can copy additional SA buttons to another extension, but 
you cannot overwrite SA buttons that are already assigned.)

Console Procedure To program an extension:
More→Cntr-Prg→Program Ext→Dial ext. no.→Enter→ 
Start→Select button→Dial feature code (*16 or *18)→Enter→ 
(repeat from beginning to program another button)→Back→Back 

To copy extension programming:
More→Cntr-Prg→Copy ext→Dial copy from ext. no.→
Enter→Dial copy to ext. no.→Enter→ Back→Back 

PC Procedure To program an extension:
�→�→�→Type ext. no.→�→�→Select button→Type 
feature code (*16 or *18)→�→(repeat from beginning to program 
another button)→�→� 

To copy extension programming:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, using programming codes to perform these functions speeds the button 
assignment process.

Table 3-3 provides the programming codes for assigning Ring and Voice buttons. You can handle 
errors in data entry as follows:

■ If you enter a code incorrectly while programming, the display shows the Programming 
Error message and the red LED next to the button flashes. If this happens, press the button 
again and repeat the procedure.

■ If you make a mistake and program the wrong feature on a button, press the button, select 
Delete (� on the PC display), and press the button again.

Table 3-3. Programming Codes for Assigning Buttons

To... On the console... On the PC...

Assign SA or ICOM Ring button Dial *16 Type *16 

Assign SA or ICOM Voice 
button

Dial *16, press button being 
programmed again, and dial *19 

Type *16, press V + 
function key for button 
being programmed again, 
and type *19 

Assign SA or ICOM Originate 
Only Ring button

Dial *18 Type *18
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Rotary Signaling on Tip/Ring Ports 3

Use this procedure to enable or disable rotary signaling on tip/ring ports. You can program any tip/
ring port on an individual basis. The factory setting is that rotary signaling is disabled.

Whenever the system receives a rotary digit on a port, it determines if the port is programmed as 
rotary-enabled. If the port is rotary-enabled, the system processes the digit. If the port is not 
rotary-enabled, the digit is rejected. Touch-Tone digits are always accepted by the port, regardless 
whether it is rotary-enabled or not.

Summary: Rotary Signaling on Tip/Ring Ports 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 4f, Tip/Ring Equipment

Factory Setting Touch-Tone

Valid Entries Extension numbers for rotary dial telephones

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→  or More→RotaryEnabl→
Type rotary ext. no.→Enter→Back→Back 

Assign SA or ICOM Originate 
Only Voice button

Dial *18, press button being 
programmed again, and dial 
*19 

Type *18, press V + 
function key for button 
being programmed again, 
and type *19 

Assign SA button Dial *17, press the extension 
number of principal telephone 
[nnnn] then press the button 
number being shared [nn] 

Type *17, press the 
extension number of 
principal telephone 
[nnnn] then press the 
button number of specific 
button being shared [nn] 

Change current assignment for 
SA or ICOM Voice, Originate 
Only or Shared SA buttons 
from Voice to Ring

Dial **19 Type **19 

Table 3-3. Programming Codes for Assigning Buttons—Continued

To... On the console... On the PC...
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PC Procedure �→�→	→Type rotary ext. no.→�→�→� 

Tip/Ring Functionality on 016 ETR Modules 3

Tip/ring functionality for ports on a 016 ETR module is not supported in MERLIN MAGIX Release 
1.0i.

Auxiliary Equipment 3

The procedures in this section describe the steps needed to perform the following:

■ Identify the line/trunk jacks used for Music-On-Hold, loudspeaker paging, and maintenance 
alarms.

■ Identify the extension jacks used for fax 

■ Specify parameters for the MERLIN Messaging System, Octel 100 Messaging, and Intuity 
AUDIX.

Music-On-Hold 3

Use this procedure to identify the line/trunk jack reserved for connection of a music source, such 
as a radio, tape player, or stereo system.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be required 
to obtain a copyright license from and pay license fees to a third party [such as the American 
Society of Composers, Artists, and Producers (ASCAP) or Broadcast Music Incorporated (BMI)]. 
Magic On Hold requires no such license and can be purchased from your Lucent Technologies 
dealer.

Only one Music-On-Hold line/trunk jack is allowed per system.

You cannot assign the line/trunk identified for Music-On-Hold to a line/trunk pool. If the line/trunk is 
currently assigned to a pool, you must remove it before you program this option.

You cannot assign the line/trunk identified for use with Music-On-Hold to a button on any extension 
or as a Remote Access trunk, and you cannot use the line/trunk jack identified for Music-On-Hold 
for a loudspeaker paging system or maintenance alarm.

Summary: Music-On-Hold 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode the line/trunk designated for Music-On-
Hold cannot be assigned to a line/trunk pool.

Idle Condition System idle
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Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk number

Inspect No

Copy Option No

Console Procedure AuxEquip→MusicOnHold→Dial line/trunk no.→Enter→Back 

PC Procedure �→�→Type line/trunk no.→�→� 

Loudspeaker Paging 3

Use this procedure to identify the line/trunk jack reserved for connection of loudspeaker paging 
equipment.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be required 
to obtain a copyright license from and pay license fees to a third party (such as ASCAP or BMI). 
Magic On Hold requires no such license and can be purchased from your Lucent Technologies 
dealer.

A maximum of three single-zone or multizone loudspeaker paging systems can be connected to 
the system.

You cannot assign the line/trunk identified for loudspeaker paging equipment to a line/trunk pool. If 
the line/trunk is currently assigned to a pool, you must remove it before you program this option.

You cannot assign the line/trunk identified for loudspeaker paging equipment as a Remote Access 
line/trunk, and you cannot use its jack for Music-On-Hold or maintenance alarm.

Summary: Loudspeaker Paging 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode the line/trunk designated for loudspeaker 
paging cannot be assigned to a line/trunk pool.

Idle Condition Line/trunk idle

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk numbers

Inspect Yes

Copy Option No

Console Procedure AuxEquip→Ldspkr Pg→Dial line/trunk no.→Enter→Back 

PC Procedure �→�→Type line/trunk no.→�→� 
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Fax Machines 3

Use this procedure to add a fax machine by assigning the extension jack used to connect the fax 
machine. To remove a fax machine and free the extension jack for another use, you must remove 
the extension jack assignment.

In addition, you can specify the extensions to receive a message-waiting indication (MWI) when a 
fax transmission is received, and specify the length of time before the system registers that a fax 
has arrived and sends the message-waiting indication.

A maximum of 16 fax machines can have the Fax Message Waiting feature. Additional fax 
machines (more than 16) can be installed, but these machines cannot have this feature.

You can specify up to four telephones to receive the message-waiting indication when a fax 
transmission is received. Note that fax machines can only send and not receive message-waiting 
indications.

Summary: Fax Machines 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 10 seconds

Valid Entries 0 to 30 seconds

Inspect Yes

Copy Option No

Console Procedure To program an extension for a fax machine:
AuxEquip→Fax→Extension→Dial ext. no.→Enter→Back

To have a message waiting light for a fax machine:
Fax→Extension→Dial ext. no.→Enter→Back→
Msg Waiting→Dial fax machine ext. no.→Enter→
Dial MWI ext. no.→Enter→Threshold→Drop→
Dial no. of seconds (0–30)→Enter→ Back→Back
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PC Procedure To program an extension for a fax machine:
�→�→�→Type ext. no.→�→�

To have a message waiting light for a fax machine:
�→�→Type ext. no.→�→�→�→ 
Type fax machine ext. no.→�→Type MWI ext. no.→�→�→
7+I→Type no. of seconds (0–30)→�→�→� 

Maintenance Alarms 3

Use this procedure to identify the line/trunk jack that connects an external alerting device that 
sounds or flashes when major maintenance problems occur.

You cannot assign the line/trunk identified for the maintenance alarm to a button on any telephone 
or as a Remote Access trunk, and you cannot use its line/trunk jack to connect a loudspeaker 
paging system or Music-On-Hold.

Summary: Maintenance Alarms 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode, the line/trunk designated for the 
maintenance alarm cannot be assigned to a line/trunk pool. 

Idle Condition  System idle

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk number

Inspect No

Copy Option No

Console Procedure AuxEquip→MaintAlarms→Dial line/trunk no.→Enter→Back→
Back 

PC Procedure �→�→Type line/trunk no.→�→�→� 

Voice Messaging System and Automated Attendant 3

Use this procedure to specify the Touch-Tone duration and the interval between digits in codes 
sent between a voice messaging system and the MERLIN MAGIX system. The Touch-Tone 
duration and interval between digit assignment must be the same as those programmed on the 
voice messaging system.

In addition, this procedure can be used to specify the number of rings before a call transferred to a 
local extension by the voice messaging system is sent to the backup position for both integrated 
and generic VMI ports. The number of rings cannot be programmed for individual voice messaging 
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systems; the single setting applies for all. Use the Group Type procedure in ‘‘Optional Group 
Features’’ on page 3-101 to assign VMI ports as either integrated or generic.

Summary: Voice Messaging System and Automated 
Attendant 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form See forms packaged with application

Factory Setting Touch-Tone duration: 100 ms 
Interval between digits: 50 ms 
Number of rings before transfer sent to backup: 4

Valid Entries Touch-Tone duration: 50 to 200 ms, in increments of25 ms
Interval between digits: 50 to 200 ms, in increments of 25 ms
Number of rings before transfer sent to backup: 0 to 9

Inspect No

Copy Option No

Console Procedure AuxEquip→VMS/AA→TransferRtn→Drop→
Dial no. of rings (0–9)→Enter→TT Duration→Drop→
Dial no. of ms (50–200 ms, in increments of 25 ms)→Enter→
TT Interval→Drop→Dial no. of ms (50–200 ms, in increments of 
25 ms)→Enter→ Back→Back 

PC Procedure �→�→�→7+I→Type no. of rings(0–9)→�→ 
�→7+I→Type no. of ms (50–200 ms, in increments of 25 
ms)→�→�→7+I→Type no. of ms (50–200 ms, in 
increments of 25 ms)→�→�→� 
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Optional Extension Features 3

The summaries in this section detail the steps in programming the following optional features:

■ Extension Language

■ Pool Dial-Out Code

■ Calling Restrictions

■ Copy Calling Restrictions

■ ARS Restriction Level for Extensions

■ Forced Account Code Entry

■ Microphone Operation

■ Authorization Codes

■ Remote Call Forwarding

■ Delayed Call Forwarding

■ Trunk-to-Trunk Transfer

■ Primary Cover Ring Delay

■ Secondary Cover Ring Delay

■ Group Coverage Ring Delay

■ Hotline (single-line telephone only)

■ Display Preference

■ Service Observing

Extension Language 3

Use this procedure to change the language for 4400-Series, ETR, and MLX display telephones.

Summary: Extension Language 3

Programmable by Users and System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
4h, ETR Telephone
4k, 4400/4400D Telephone
5b, Direct-Line Console (DLC)
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting U.S. English
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Valid Entries U.S. English, Canadian French, Latin American Spanish, Brazilian 
Portuguese

Inspect No

Copy Option No

Console Procedure To program a single extension:
 or More→Language→Extensions→Single→Dial ext. no.→

Enter→Select a language (U.S. English, Canadian French, Latin 
American Spanish, Brazilian Portuguese)→Enter→Back→Back 

To program a block of extensions:
 or More→Language→Extensions→Block→

Dial starting ext. no.→Enter→Dial ending ext. no.→Enter→
Select a language (U.S. English, Canadian French, Latin American 
Spanish, Brazilian Portuguese)→ Enter→Back→Back 

PC Procedure To program a single extension:
�→�→�→�→Type ext. no.→�→Select a language 
(U.S. English, Canadian French, Latin American Spanish, Brazilian 
Portuguese)→�→�→� 

To program a block of extensions:
�→�→�→�→Type starting ext. no.→�→
Type ending ext. no.→Select a language (U.S. English, Canadian 
French, Latin American Spanish, Brazilian Portuguese)→ 
�→�→� 

Pool Dial-Out Code 3

Use this procedure to allow or restrict dialing pool dial-out codes and placing calls on specific line/
trunk pools. The factory settings restrict all extensions from dialing any line/trunk pool dial-out 
code. 

Summary: Pool Dial-Out Code 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Extension idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment

The factory settings allow all extensions to dial any line/trunk pool dial-out code. Entering 
a pool dial-out code and then deleting that code restricts the user from using the pool 
associated with the entered code.
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4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct (DLC)
5d, Queued Call Console (QCC)

Factory Setting Main pool: 70; All other pools: 890 to 899. All telephones are 
restricted from dialing any pool dial-out code.

Valid Entries Pool numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→Dial OutCd→Dial ext. no.→Enter→
Dial pool dial-out code→Enter→Back→Back 

PC Procedure �→�→Type ext. no.→�→Type pool dial-out code→�→
�→� 

Calling Restrictions 3

Use this procedure to change individual extension calling restrictions to one of the following:

■ Unrestricted

■ Restricted from making all outgoing calls

■ Restricted from making toll calls

SECURITY ALERT:
Toll fraud can occur if extensions are not properly restricted. 

Summary: Calling Restrictions 3

Programmable by System Manager

Mode All

Idle Condition Extension idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting Unrestricted

Valid Entries Unrestricted, Outward Restricted, Toll Restricted
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Inspect No

Copy Option Yes

Console Procedure Extensions→Restriction→Dial ext. no.→Enter→
Select restriction (Unrestricted, Outward restricted, or Toll 
Restricted)→Enter→Back 

PC Procedure �→�→Type ext. no.→�→Select restriction (Unrestricted, 
Outward restricted, or Toll Restricted)→�→� 

Copy Calling Restrictions 3

Use this procedure to copy calling restrictions, Allowed Lists, and Disallowed Lists. Feature 
assignment must be completed for the “copy from” extension. These features can then be copied 
to an individual extension or block of extensions with identical calling restriction requirements.

If you are copying restrictions to a block of extensions and one of the extensions in the block is in 
use, the display shows the Station Busy - Pls Wait message. Copying for the rest of the 
extensions in the block is delayed until the busy extension becomes idle. The number of the busy 
extension is not shown. If a DSS is attached, the LED associated with the busy extension is on. If 
you exit instead of waiting for the busy extension to become idle, copying for the rest of the 
extensions in the block is cancelled; however, the restrictions that have already been copied are 
not cancelled.

If you are copying restrictions to a block of extensions, they must be sequentially numbered.

The extensions you are copying to and from can be both operator and nonoperator positions.

Summary: Copy Calling Restrictions 3

Programmable by System Manager

Mode All

Idle Condition “Copy to” extension or extensions idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting Not applicable

Dial-out code restrictions are not copied.
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Valid Entries Not applicable

Inspect No

Copy Option Not applicable

Console Procedure To copy to a single extension:
Extensions→RestrctCopy→Single→Dial copy from
ext. no.→Enter→Dial copy to ext. no.→Enter→Back→ 
Back→Back 

To copy to a block of extensions:
Extensions→RestrctCopy→Block→Dial copy from ext. no.→
Enter→Dial first no. in copy to block→Enter→
Dial last no. in copy to block→Enter→Back→Back→Back 

PC Procedure To copy to a single extension:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→�→� 

To copy to a block of extensions:
�→�→�→Type copy from ext. no.→�→
Type first copy no. in copy to block→�→�→�→� 

ARS Restriction Level for Extensions 3

Use this procedure to assign an ARS restriction level to an extension. Outgoing calls can be made 
only to routes that have a Facility Restriction Level (FRL) lower than or equal to that of the 
extension for which the call is being made. Only outgoing calls are affected; users can receive 
inside, local, and toll calls on restricted telephones and can join any type of call in progress. 

The restriction level assigned to extensions is opposite to the FRL assigned to routes, where 0 is 
the most and 6 is the least restrictive.

Summary: Assigning ARS Restriction Level For an 
Extension 3

Programmable by System Manager

Mode Hybrid/PBX only

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
6g, Call Restriction Assignments and Lists
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Factory Setting  3

Valid Entries 0–6 (0 is most restrictive and 6 is least restrictive)

Inspect No

Copy Option No

Console Procedure Extensions→  or More→ARS Restrict→Dial ext. 
no.→Enter→Drop→Dial restriction level (0–6)→Enter→Back 

PC Procedure �→�→�→Type ext. no.→�→7+I→
Type restriction level (0–6)→�→� 

Forced Account Code Entry 3

Use this procedure to assign or remove Forced Account Code Entry. When this feature is 
programmed on individual extensions, the user must enter a 1- to 16-digit account code before 
making an outside call.

Summary: Forced Account Code Entry 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting Not assigned

Valid Entries Assigned, not assigned

Inspect Yes

Copy Option No

Console Procedure Extensions→Account→Toggle LED On/Off or dial ext. no.→
Enter→Back→Back 

PC Procedure �→	→Toggle letter R On/Off or type ext. no.→�→�→� 
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Microphone Operation 3

Use this procedure to enable or disable microphones on MLX telephones (except QCC operator 
positions). When the microphone is disabled, users cannot use the speakerphone to conduct 
conversations.

Summary: Microphone Operation 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
5b, Direct-Line Console (DLC)

Factory Setting Enabled

Valid Entries Enabled, Disabled

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Mic Disable→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→	→Toggle letter R On/Off or type ext. no.→�→ 
�→� 

Authorization Codes 3

The Authorization Code feature allows you to pick up someone else’s telephone, enter your 
authorization code, and complete a call with the restrictions that apply to your own telephone 
(home extension). This includes Toll Restrictions, Outward Restricted, FRL, Allowed Lists, 
Disallowed Lists, Forced Account Code Entry (FACE), Night Service Exclusion List, and Dial 
Access to Pools.

The microphone cannot be disabled on MLX telephones used as QCC operator positions.

A user can activate Call Forwarding and Remote Call Forwarding by entering his or her 
home extension authorization code while at any telephone in the system; this is useful 
when activating Call Forwarding or Remote Call Forwarding at phantom stations. It is also 
useful when a single-line telephone extension needs a PAUSE character in the Remote 
Call Forwarding digit string.
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Use this procedure to assign or remove an authorization code to an extension. The authorization 
code can range from 2 to 11 characters (0 – 9, *) and must be unique for each extension. An 
authorization code cannot begin with an “*.”

If you are assigning authorization codes for a group of sequential extensions, begin programming 
the lowest extension number to take advantage of the Next screen key (see “Standard 
Procedures”).

Summary: Authorization Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6h, Authorization Codes

Factory Setting Not assigned

Valid Entries 2–11 characters (0–9, *)

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Auth Code→Dial ext. no.→Enter→
Dial authorization code (2–11 digits, 0–9, *)→ Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→Type authorization code 
(2–11 digits, 0–9, *)→�→�→� 

Remote Call Forwarding 3

Use this procedure to allow or disallow the Remote Call Forwarding capability, which permits users 
to forward calls to an outside number. Remote Call Forwarding must be enabled in order for an 
extension user to activate Centrex Transfer via Remote Call Forwarding. 

If an extension with Remote Call Forwarding has one or more Personal Lines assigned, that 
extension can be assigned as the principal user, and calls received on that line are forwarded to 
outside numbers. See ‘‘Principal User for Personal Line’’ on page 3-34.

Summary: Remote Call Forwarding 3

Programmable by System Manager

■ This feature is not recommended with loop-start lines with unreliable disconnect. See 
‘‘Disconnect Signaling Reliability’’ on page 3-24. 

■ Ensure that the number of rings for Remote Call Forwarding is less than the Coverage 
Delay or the call will not forward.

■ Use the Forwarding feature.
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Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting Disallowed

Valid Entries Disallowed, allowed

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Remote Frwd→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→
→Toggle letter R On/Off or type ext. no.→�→ 
�→� 

Delayed Call Forwarding 3

Delayed Call Forwarding allows a user to answer or screen a call arriving at an extension before 
the call is forwarded through Call Forwarding, Remote Call Forwarding, or Follow Me. The 
forwarding delay is the number of rings before the call is forwarded. This delay can range from 0 to 
9 rings. If the forwarding delay is set to 0, the call is forwarded immediately.

Use this procedure to assign or remove Delayed Call Forwarding from an extension. If you are 
assigning Delayed Call Forwarding to a group of sequential extensions, begin by programming the 
lowest extension number to take advantage of the Next screen key (see “Standard Procedures”).

Summary: Delayed Call Forwarding 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone

When Do Not Disturb is activated at an extension, it overrides Delayed Call Forwarding 
and the call is forwarded immediately.
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4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting 0 rings

Valid Entries 0–9 rings

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Delay Frwd→Dial ext. no.→Enter→
Drop→Dial no. of delay rings (0–9)→Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→7+I→
Type no. of delay rings (0–9)→�→�→� 

Trunk-to-Trunk Transfer 3

Use this procedure to enable or disable trunk-to-trunk transfer at an extension. When trunk-to-
trunk transfer is disabled, users cannot transfer an outside call to an outside line. 

Summary: Trunk-to-Trunk Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)

Factory Setting Disabled

Valid Entries Enabled, Disabled

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→  or More→TrkTransfer→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→�→�→Toggle letter R On/Off or type ext. no.→
�→�→� 
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Primary Cover Ring Delay 3

Use this procedure to specify the following:

■ The delay before a Primary Cover button, programmed for Delay Ring, begins to ring audibly.

■ The delay, in addition to the Group Coverage Ring Delay, before sending calls to Group 
Coverage when the sender has Primary or Secondary Coverage and any receiver is available.

The Primary Cover Ring Delay is programmed for each sender’s extension.

Summary: Primary Cover Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 2 rings

Valid Entries 1–6 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Primary→Dial sender’s extension→Enter→Dial no. of rings
(1–6)→Enter→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→
Type no. of rings (1–6)→�→� 

Secondary Cover Ring Delay 3

Use this procedure to specify the delay, in addition to the fixed Secondary Coverage Delay Interval 
(two rings), before a Secondary Cover button programmed for Delay Ring begins to ring audibly.

The Secondary Cover Ring Delay is programmed for each sender’s extension.
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Summary: Secondary Cover Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 2 rings

Valid Entries 1–6 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Secondary→Dial sender’s extension→Enter→Dial no. of rings
(1–6)→Enter→ Back→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→ 
Type no. of rings (1–6)→�→�→� 

Group Coverage Ring Delay 3

Use this procedure to specify the following:

■ The number of rings before sending calls to Group Coverage when the sender does not have 
Primary or Secondary Coverage or the receivers are not available, and the Group Coverage 
receiver is either a Calling Group only or the QCC queue only (no Group Cover buttons on 
multiline telephones)

■ The number of rings, in addition to the Primary Cover Ring delay, before sending calls to 
Group Coverage when the sender has Primary or Secondary Coverage and the receivers are 
available

The Group Coverage Ring Delay is programmed for each sender’s extension.

Summary: Group Coverage Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required
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Planning Form 4m,Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 3 rings

Valid Entries 1–9 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Group→Dial sender’s extension→Enter→Dial no. of rings 
(1–9)→Enter→Back→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→
Type no. of rings (1–9)→�→�→� 

HotLine 3

Use this procedure to enable or disable the HotLine feature on a tip/ring single-line telephone or 
device. 

Summary: HotLine 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4f, Tip/Ring Equipment

Factory Setting Disabled

Valid Entries Yes, No

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→HotLine→
Enter HotLine extension→Enter→Back→Back 

PC Procedure �→�→�→�→Type HotLine extension→�→�→
� 
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Display Preference 3

Use this procedure to specify display preferences for incoming inside calls. 

Summary: Display Preference 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Factory Setting Calling Number

Valid Entries Calling Name, Calling Number, Both

Inspect No

Copy Option Yes

Console Procedure Extensions→  or More→  or More→DisplayPref→
Dial extension no.→Enter→Select display option (Calling Name, 
Calling Number, or Both)→Enter→ Back→Back 

PC Procedure �→�→�→�→Type extension no.→�→
Select display option (Calling Name, Calling Number, or Both)→
�→�→� 

Service Observing 3

Use this procedure to configure up to 16 Service Observing groups on a system. Each Service 
Observing group consists of one Service Observer and a list of the stations (up to the system 
maximum of 200) that the observer is allowed to monitor. A warning tone is programmed on a per 
group basis to provide an audible indication that a station is being observed.

Service Observing may be subject to federal, state, or local laws, rules, or regulations or 
require the consent of one or both of the call parties. You must check in your jurisdiction 
and comply with all applicable laws, rules, and regulations before using this feature. 
Failure to comply may result in severe penalties.
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Summary: Service Observing 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
4m, Multiline 4400-Series Telephone
5b, Direct-Line Console (DLC)
11, Service Observing: Group Assignment

Factory Setting Warning: Yes

Valid Entries Warning: Yes, No

Inspect Yes

Copy Option No

Console Procedure To assign a Service Observer to a Service Observing group:
Extensions→  or More→  or More→ServiceObs→ 
Observer→Dial group no. (1–32)→Enter→Dial ext. no. of Service 
Observer→Enter or Delete→ Back→Back 

To enable or disable Warning Tone on a per group basis:
Extensions→  or More→  or More→ ServiceObs→ 
Warning→Dial group no. (1–32)→Enter→Yes or No→ 
Enter→Back→Back 

To assign a member extension to a Service Observing group:
Extensions→  or More→  or More→ServiceObs→ 
Members→Dial group no. (1–32)→Enter→Dial ext. no.→
Enter or Delete→Back→Back→Back 

PC Procedure To assign a Service Observer to a Service Observing group:
�→�→�→�→�→Type group no. (1–32)→�→
Type ext. no. of Service Observer→� or 
→�→� 

To enable or disable Warning Tone on a per group basis:
�→�→�→�→�→Type group no. (1–32)→�→
� or �→�→�→� 

To assign a member extension to a Service Observing group:
�→�→�→�→�→Type group no. (1–32)→�→
Type ext. no.→� or 
→�→�→� 
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Optional Operator Features 3

The summaries in this section affect feature programming for both DLC and QCC operator 
positions and include the following:

■ Operator Hold Timer

■ DLC Operator Automatic Hold

QCC operator features are covered in the next section.

Operator Hold Timer 3

Use this procedure to set the length of the operator hold timer for all DLCs and QCCs. If the 
system operator does not pick up the call within the time programmed, an abbreviated ring 
reminds the operator that a call is being held.

This option cannot be programmed for individual operator positions.

Summary: Operator Hold Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 60 seconds

Valid Entries 10 to 255 seconds

Inspect No

Copy Option No

Console Procedure Operator→Hold Timer→Drop→Dial no. of seconds (10–255)→ 
Enter→Back 

PC Procedure �→�→7+I→Type no. of seconds(10–255)→�→� 
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DLC Operator Automatic Hold 3

Use this procedure to enable or disable the DLC Operator Automatic Hold feature for DLC operator 
positions. When this feature is enabled, it prevents accidental call disconnection.

Summary: DLC Operator Automatic Hold 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disabled

Valid Entries Disabled, Enabled

Inspect No

Copy Option No

Console Procedure Operator→DLC Hold→Automatic Hold Enable or Automatic 
Hold Disable→Enter→Back 

PC Procedure �→�→� or �→�→� 

QCC Optional Features 3

This section contains programming summaries for the following options for QCC operator 
positions:

■ Hold Return

■ Automatic Hold or Release

■ Queue over Threshold

■ Elevate Priority

■ Calls-in-Queue Alert

■ QCC Operator to Receive Call Types

■ Call Type Queue Priority Level

■ Message Center Operation

■ Automatic or Manual Extended (Directed) Call Completion

■ Return Ring

■ Position Busy Backup
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■ Voice Announce

Hold Return 3

Use this procedure to determine whether calls on hold are returned to the QCC queue or remain 
on hold, on the QCC operator console, after the hold timer has expired twice. After the hold timer 
expires the first time, the operator hears an abbreviated ring as a call-on-hold reminder. If another 
call is received at the same time that the hold timer expires, 10 seconds are added to the 
programmed operator hold timer interval for the first call. If the QCC operator does not pick up a 
call by the time the hold timer expires twice, the call can be programmed to either remain on hold 
or return to the QCC queue.

This option cannot be programmed for individual QCC operator positions. The single setting 
applies to all QCC operator positions.

Summary: Hold Return 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Calls remain on hold

Valid Entries Remain on hold, Return to QCC queue

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Hold Rtrn→Select Return to 
Queue or Remain on Hold→Enter→Back→Back 

PC Procedure �→�→�→Select Return to Queue or Remain on 
Hold→�→�→� 

These options are available in Hybrid/PBX mode only.
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Automatic Hold or Release 3

Use this procedure to specify whether a call in progress (on a Call button) is automatically put on 
hold (Automatic Hold) or disconnected (Automatic Release) when the operator presses another 
button.

This option cannot be programmed for individual QCC operator positions. The single setting 
applies to all QCC operator positions.

Summary: Automatic Hold or Release 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Automatic Release

Valid Entries Auto Hold, Auto Release

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→HoldRelease→Select
Auto Hold or Auto Release→Enter→Back→Back 

PC Procedure �→�→�→Select Auto Hold or Auto Release→
�→�→� 

Queue over Threshold 3

Use this procedure to specify the maximum number of calls (threshold) in the QCC queue before 
system operators are notified with a tone that the threshold has been reached or exceeded. If the 
threshold is set to 0, operators are not notified.

Summary: Queue over Threshold 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 0

Valid Entries 0 to 99

Inspect No
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Copy Option No

Console Procedure Operator→Queued Call→Threshold→Drop→
Dial no. of calls (0–99)→Enter→Back→Back 

PC Procedure �→�→�→7+I→Type no. of calls(0–99)→�→�→
� 

Elevate Priority 3

Use this procedure to specify the length of time before calls waiting in the QCC queue are 
automatically reprioritized to a higher level. If priority is set to 0, calls are not prioritized.

Summary: Elevate Priority 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting 0 seconds

Valid Entries 0 and 5 to 30 seconds

Inspect No

Copy Option No

Console Procedure Operator→QueuedCall→ElvatePrior→Drop→Dial no. of 
seconds (0 and 5–30)→ Enter→Back→Back 

PC Procedure �→�→�→7+I→Type no. of seconds (0 and 5–30)→
�→�→� 
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Calls-In-Queue Alert 3

Use this procedure to specify whether each QCC operator is notified (with a single beep) when a 
new call enters the QCC queue.

Summary: Calls-In-Queue Alert 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disable

Valid Entries Enable, Disable

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→InQue Alert→Dial ext. no.→
Enter→Select InQue Alert Enable or InQue Alert Disable→
Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→Select InQue Alert 
Enable or InQue Alert Disable→�→�→� 

QCC Operator to Receive Call Types 3

Use this procedure to specify which QCC operators receive the following types of calls:

■ Dial 0 calls (internal calls to the system operator)

■ DID calls to invalid destinations (unassigned extension numbers)

■ Calls to the Listed Directory Number (extension for the QCC queue)

■ Calls programmed to return to the QCC queue (returning from directing, camped-on, held 
calls, and operator parked calls)

■ Group Coverage calls

■ Forward/Follow Me calls

The QCC queue can be a receiver for the maximum number of coverage 
groups (30).
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Summary: QCC Operator to Receive Call Types 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting QCC operator receives the following calls:
Dial 0
Unassigned DID
Listed Directory Number
Returning

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→Call Types→Select a call 
type→Operator→Dial coverage group no.→Enter→
Dial ext. no.→Enter→Back→Back→Back→Back→Back 

PC Procedure �→�→	→Select a call type→�→Type coverage group 
no.→�→Type ext. no.→�→�→�→�→�→� 

■ If you want a QCC operator position to operate as a message center (receiving 
returning parked and directed calls, Group Coverage calls, and calls to 
unassigned DID numbers), program the Message Center option before you 
assign the operator to receive call types.

■ This procedure does not include use of the menu options Follow/Frwd or QCC 
Ext. These two options are used to assign queue priorities and are not associated 
with individual QCC operators. See ‘‘Call Type Queue Priority Level’’ on page 
3-97.

■ This procedure does not include programming the operator position to receive 
calls on individual lines or trunks. 

■ Programming an operator position to receive DID calls to invalid destinations 
does not cause the calls to ring into the QCC queue unless you program such 
calls to be sent to a backup extension. When no operator is assigned to receive 
the call types, the call does not ring into the QCC queue, and the caller hears an 
error tone.

■ If a trunk assigned to ring into the QCC queue is to be assigned shared Remote 
Access, assign that trunk Remote Access before performing this procedure. See 
‘‘Remote Access Features’’ on page 3-133.
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Call Type Queue Priority Level 3

Use this procedure to assign a priority value (1 to 7) that determines the order in which calls 
programmed to ring into the QCC queue are sent to QCC system operator positions. A value of 1 
is the highest priority. The QCC queue priority level is assigned for the following types of calls:

■ Dial 0 calls (internal calls to the system operator)

■ DID calls to invalid destinations (unassigned extension numbers)

■ Calls to the Listed Directory Number (extension for the QCC queue)

■ Calls programmed to return to the QCC queue (returning from extending, camped-on, held 
calls, and operator parked calls)

■ Group Coverage calls

■ Calls signed in (Follow) or forwarded to the system operator

■ Calls to a system operator extension number

This procedure does not include programming the QCC queue priority level for individual lines or 
trunks to ring into the queue. See ‘‘QCC Queue Priority Level’’ on page 3-35.

Summary: Call Type Queue Priority Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 4

Valid Entries 1 to 7

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Call Types→Select call 
type→Priority→Dial group coverage number (1–30)→Enter→
Drop→Dial priority level (1–7)→Enter→Back→Back→Back→
Back 

PC Procedure �→�→	→Select call type→�→Type Group Coverage 
number (1–30)→�→7+I→Type priority level (1–7)→�→
�→�→�→� 
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Message Center Operation 3

Use this procedure to designate one or more QCC operator positions to operate as a message 
center. The following options are automatically set for the message center position:

■ Incoming calls are not directed to this position

■ Returning calls are directed to this position (return from extending and operator parked calls)

■ All group coverage calls are directed to this position

■ All DID calls to invalid destinations are directed to this position

Designating message center operation does not change any call type option programming, except 
that the call types mentioned above are added to the calls received at the QCC Message Center.

Summary: Message Center Operation 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Not applicable

Valid Entries QCC extension numbers

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→Msg Center→Dial ext. no.→
Enter→Back→Back→Back 

PC Procedure �→�→
→Type ext. no.→�→�→� 

Extended (Directed) Call Completion 3

Use this procedure to specify one of the two basic options shown below for QCC operator 
positions with a DSS only:

■ Automatic Completion. Allows one-touch call transfer—that is, calls are transferred by touching 
only an extension button on the DSS. The operator does not have to press the release button.

■ Manual Completion. QCC operators must press the release button to direct a call using a DSS.

This option cannot be programmed for individual QCC operator positions. The setting applies to all 
QCC operator positions.
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Summary: Extended (Directed) Call Completion 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Automatic Extended Completion

Valid Entries Automatic, Manual

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→ExtndComplt→Select Automatic 
Complete or Manual Complete→Enter→Back→Back 

PC Procedure �→�→�→Select Automatic Complete or Manual 
Complete→�→�→� 

Return Ring 3

Use this procedure to specify the number of rings before an unanswered directed call is returned 
to the QCC queue or QCC Message Center position.

This option cannot be programmed for individual QCC operator positions. The setting applies to all 
QCC operator positions.

Summary: Return Ring 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 4 rings

Valid Entries 1 to 15 rings

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Return Ring→Drop→
Dial no. of rings (1–15)→Enter→Back→Back 

If you want unanswered calls to proceed to voice mail, lengthen the return ring setting.
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PC Procedure �→�→�→7+I→Type no. of rings (1–15)→�→
�→� 

Position Busy Backup 3

Use this procedure to designate or remove the Calling Group to provide the backup position for the 
QCC queue. The specified Calling Group receives incoming calls when all QCC operator positions 
are in position-busy mode.

Position Busy Backup is programmed for the QCC queue rather than for individual QCC operator 
positions. The Calling Group designated as the QCC queue backup serves as the backup for the 
Remote Access feature and as backup when the QCC is being used as the system programming 
console. 

Only one Position Busy Backup can be programmed per system.

Summary: Position Busy Backup 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting No backup

Valid Entries Calling Group number

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→  or More→QCC Backup→Drop→
Dial ext. number→Select Enter or Delete→Back→Back 

PC Procedure �→�→�→�→7+I→Type ext. number→Select 
Enter or Delete→�→� 

Voice Announce 3

Use this procedure to enable or disable Voice Announce for the QCC. 

When Voice Announce is enabled, every QCC in the system has one Voice Announce Call button, 
the Call 5 (Ring/Voice) button. All Intercom calls that originate from a QCC Call 5 (Ring/Voice) 
button are delivered as Voice Announce calls. 

When Voice Announce is disabled, all Intercom calls originating at the QCC Call buttons are 
Intercom Ringing calls.
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Summary: Voice Announce 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disabled

Valid Entries Disabled, Enabled

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→  or More→Voice Annc→Select
Enabled or Disabled→Enter→Back→Back 

PC Procedure �→�→�→�→Select Enabled or Disabled→�→
�→� 

Optional Group Features 3

This section contains programming summaries for the following optional features:

■ Pickup Groups

■ Group Paging

■ Group Coverage Member Assignments

■ Group Calling Member Assignments

■ Group Calling Line/Trunk or Pool Assignments

■ Priority Call Queuing for Group Calling

Pickup Groups 3

Use this procedure to assign or remove an extension from a call pickup group. A pickup group 
consists of telephone users who can answer each other’s calls either by pressing a button or by 
dialing a code.

■ A maximum of 30 pickup groups, with a maximum of 15 extensions per group, is 
allowed.

■ An extension can belong to only one group.

■ Before reassigning an extension to a new group, you must remove it from its current 
group.
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Summary: Pickup Groups 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7a, Pickup Groups

Factory Setting Not applicable

Valid Entries Pickup group number, extension number

Inspect Yes

Copy Option No

Console Procedure Extensions→Call Pickup→Dial pickup group no.→Enter→
Dial ext. no.→Enter→Enter→ Back→Back 

PC Procedure �→�→Type pickup group no.→�→Type ext. no.→�→
�→� 

Group Paging 3

Use this procedure to assign or remove an extension from a Paging Group. A Paging Group 
consists of telephone users who hear common announcements over the telephone speakerphone. 
Only multiline 4400-Series, ETR, and MLX telephones with speakerphones can be members of a 
Paging Group.

A maximum of six Paging Groups with a maximum of 10 extensions per group is allowed. A 
seventh Paging Group, called the Page All group, is not limited and includes all telephones 
connected to the system. Extensions cannot be added to or removed from the Page All group.

To reassign an extension to a new Paging Group, just assign it; the extension is automatically 
removed from its old Paging Group.

Summary: Group Paging 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7b, Group Paging

Factory Setting Not applicable

Valid Entries Extension number

Inspect Yes

Copy Option No
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Console Procedure Extensions→  or More→Group Page→Dial Paging 
Group no.→Enter→Dial ext. no.→Enter→Back→Back 

PC Procedure �→�→�→Type Paging Group no.→�→Type ext. no.→
�→�→� 

Group Coverage Member Assignments 3

Use this procedure to assign or remove an extension from a coverage group. A coverage group is 
a group of senders. Coverage is an arrangement in which calls from a group of senders are 
redirected to one or more receivers. 

A maximum of 30 coverage groups are allowed, each with an unlimited number of members. Up to 
eight receivers can be assigned per coverage group.

An extension can be a sender in only one group; it can be a receiver for more than one coverage 
group. A Calling Group can be assigned as a receiver for a coverage group (see ‘‘Group Coverage 
Receiver’’ on page 3-109). In Hybrid/PBX mode only, the QCC queue can be a receiver for up to 
30 coverage groups. See ‘‘QCC Operator to Receive Calls’’ on page 3-36.

If the sender’s extension has one or more Personal Lines assigned, the sender can be assigned as 
the principal user so that calls received on the Personal Line are sent to receivers programmed for 
Individual or Group Coverage. See ‘‘Principal User for Personal Line’’ on page 3-34.

To reassign an extension to a new coverage group, just make the assignment; the extension is 
automatically removed from its old group.

Summary: Group Coverage Member Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Extension numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Group Cover→Dial group no.
(1–30)→Enter→Dial ext. no.→Enter→ Back→Back 

■ This procedure assigns senders. Before you begin, make certain that the receivers for 
the coverage group are also programmed. Receivers can be assigned through 
individual or centralized telephone programming.
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PC Procedure �→�→�→Type group no. (1–30)→�→Type ext. no.→
�→�→� 

Group Calling Member Assignments 3

Use this procedure to assign or remove an extension to or from a Calling Group. A Calling Group is 
used to direct calls to a group of people who all handle the same type of call. A single extension 
number is assigned to the group and is used by both inside and outside callers to reach the group.

To reassign an extension to a new Calling Group, you must remove it from its old group before 
programming the new assignment.

Summary: Group Calling Member Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Extension numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Members→
Dial Calling Group ext. no.→Enter→Dial ext. no.→ Enter→ 
Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type ext. no.→�→�→�→� 

■ If a linear hunting pattern is indicated on the back of the system planning form (6d), be 
sure to assign extensions to the group in the exact order that they are shown on the 
form. The system searches for an available member in the order in which you assign 
the extensions to the group.

■ A maximum of 32 Calling Groups with a maximum of 20 extensions per group is 
allowed.

■ An extension can belong to only one Calling Group. A QCC cannot be a member of a 
Calling Group. A delay announcement device should not be programmed as a Calling 
Group member.

■ The extension status feature must be set to the Calling Group or CMS mode before 
you assign members to the group. See ‘‘Extension Status’’ on page 3-123.
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Group Calling Line/Trunk or Pool Assignments 3

Use this procedure to assign or remove lines, trunks, or pools (Hybrid/PBX only) that ring directly 
into a Calling Group.

Incoming calls on each line/trunk or pool can be directed to only one Calling Group. 

To reassign a line/trunk or pool to a new Calling Group, you must remove it from its old group 
before making the new assignment.

Summary: Group Calling Line/Trunk or Pool 
Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Not applicable

Valid Entries Line, trunk, or pool number

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Line/Pool→
Dial Calling Group ext. no.→Enter→Dial line/trunk no.→Enter→
Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type line/trunk no.→�→�→�→� 

Priority Call Queuing 3

Use this procedure to establish a supportive relationship between Calling Groups. Calls that arrive 
in one Calling Group (a home group) can be processed by another Calling Group (a support 
group) when no one from the first Calling Group is available to answer the call.

A Calling Group can be assigned a priority level between 1 (highest priority) and 32 (lowest 
priority) and then designated as a support group for a home group. There can be only one support 
group per home group. Each support group can support up to 31 home groups.
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Summary: Priority Call Queuing 3

Programmable by System Manager

Mode All

Idle Condition Not Required

Planning Form 7d, Group Calling

Factory Setting 16

Valid Entries Priority Level (1 to 32)

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→  or More→ 
Priority→Enter extension number of group→ Enter→
Enter Group Priority (1–32)→(To program the next group, select 
Next)→Enter→Back→ Support→Enter extension number of 
group→ Enter→Enter Support Group→(To program the next 
group, select Next)→ Enter→Back→Back→Back 

PC Procedure �→�→�→�→�→Type extension number of 
group→�→Type Group Priority (1–32)→(To program the next 
group, press �)→ �→�→�→Type extension number of 
group→�→Type support group→(To program the next group, 
press �)→�→�→�→� 

Optional Group Calling Features 3

This section includes programming summaries for the following optional group calling features:

■ Hunt Type

■ Group Calling Delay Announcements

■ Group Calling Announcement Interval

■ Group Calling Repeat Announcement

■ Group Coverage Receiver

■ Group Calling Overflow and Thresholds

■ Group Calling Message-Waiting Indicator

■ Group Calling Calls-in-Queue Alarm Threshold

■ Group Calling External Alert for Calls-in-Queue Alarm

■ Group Type

■ Queue Control 

Hunt Type 3
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Use this procedure to assign one of the following hunt-type patterns to Calling Groups:

■ Circular Hunting Pattern. The system distributes calls to group members by hunting in a 
circular pattern for the first available extension after the one that received the last call to the 
group.

■ Linear Hunting Pattern. The system searches for an available group member in the order in 
which the extensions were assigned to the Calling Group.

■ Most Idle Hunting Pattern. The system searches for the available member that is “most idle.” 
This distribution scheme can be more equitable than the circular hunting pattern. 

Summary: Hunt Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Circular hunting pattern

Valid Entries Circular, Linear, Most Idle

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Hunt Type→Dial 
Calling Group ext. no.→Enter→Circular, Linear, or Most 
Idle→Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→
�→� or � or �→�→�→�→� 

Group Calling Delay Announcements 3

Use this procedure to designate the announcement devices used to play messages to callers 
while they are waiting in the queue.

Two announcement devices can be designated for each Calling Group; however, more than one 
Calling Group can use the same announcement device. The extensions to which the delay 
announcement devices are connected should not be programmed as a Calling Group member.

If the extension jack or MFM was previously programmed as a regular extension, you must remove 
all line/trunk button assignments before you designate the extension jack as a delay 
announcement device.

Summary: Group Calling Delay Announcement 3

Programmable by System Manager

Mode All
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Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No delay announcement devices are assigned

Valid Entries Primary Announcement, Secondary Announcement

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Enter→
Select Primary Announcement or Secondary Announcement→
Enter extension number of announcement device→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Select Primary Announcement or Secondary Announcement→ 
Enter ext. no. of announcement device→�→�→� 

Group Calling Announcement Interval 3

Use this procedure to set the delay before the secondary announcement is played and/or 
repeated.

Summary: Group Calling Announcement Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting 0 (disabled)

Valid Entries 0–900 seconds

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Announcement Interval→
Enter the Announcement Interval (0–900)→Enter→ Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type the Announcement Interval (0–900)→�→�→� 

Group Calling Repeat Announcement 3
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Use this procedure to set the secondary announcement to repeat after the Announcement 
Interval.

Summary: Group Calling Repeat Announcement 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No repeat

Valid Entries Yes, No

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Enter→Repeat 
Announcement→Select Yes or No→Enter→Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
Select Yes or No→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Group Coverage Receiver 3

Use this procedure to assign or remove a Calling Group as a receiver for a coverage group.

Calling Group member assignments must be made before you assign the group as a receiver for a 
coverage group.

Summary: Group Coverage Receiver 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Group numbers

Inspect Yes

Copy Option No
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Console Procedure Extensions→  or More→Grp Calling→Grp Coverage→
Dial Calling Group ext. no.→Enter→Dial coverage group no.→
Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type coverage group no.→�→�→�→� 

Group Calling Overflow and Thresholds 3

Use this procedure to designate either another Calling Group or the QCC queue (Hybrid/PBX only) 
to receive overflow calls. This procedure also specifies Overflow Threshold and methods.

Call overflow occurs in one of the three following ways:

■ The number of calls waiting in the queue for a Calling Group is equal to or greater than the 
programmed threshold (Overflow Threshold). 

■ The time that a call has spent in the queue exceeds the programmed timeout value (Overflow 
Threshold Time).

■ A caller responds to a voice prompt by pressing the # key to indicate that his or her call should 
be handled as an overflow call. For example, a delay announcement may specify that a caller 
can press # to leave a message with voice mail or an operator. 

If the Overflow Threshold Time is set to 0 seconds (factory setting), then overflow by time is turned 
off. Prompt-based overflow distribution can coexist with either or both of the other methods. 
Overflow distribution based on the number of calls in the queue or the time spent in the queue 
takes precedence over calls that go to overflow because of the caller’s prompt.

Overflow coverage can be provided only by Calling Groups or the QCC queue (Hybrid/PBX only), 
not by individual extensions.

A Calling Group or the QCC queue (Hybrid/PBX only) can provide overflow coverage for more than 
one Calling Group; however, the particular group whose calls go to an available member in the 
overflow Calling Group is unpredictable.

The factory-set extension number for the QCC Listed Directory Number is 800.

Summary: Group Calling Overflow and Thresholds 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Overflow coverage: none
Threshold: 1 call
Timeout: 0 sec
Prompt-based overflow: Disabled
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Valid Entries Overflow coverage: Backup extension number
Threshold: 1 to 99 calls
Timeout: 0 to 900 seconds
Prompt-based overflow: Enabled, Disabled

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Overflow→
Dial Calling Group ext. no.→Enter→Dial overflow ext. no.→
Enter→Number Based Overflow→Drop→Dial no. of calls 
(1-99)→Enter→Time Based Overflow→Drop→
Dial no. of seconds(0-900)→Enter→Prompt Based Overflow→
Select Yes or No→Enter→Back→
Back→Back 

PC Procedure �→�→�→
→Type Calling Group ext. no.→�→
Type overflow ext. no.→�→�→7+I→Type no. of calls(1-
99)→�→�→7+I→Type no. of seconds(0-900)→�→
�→Select Yes or No→�→�→�→� 

Group Calling Message-Waiting Indicator 3

Use this procedure to designate the extension to receive message-waiting indications (MWIs) for 
the Calling Group.

Only one extension can be designated as a message-waiting receiver for each Calling Group; 
however, more than one Calling Group can use the same message-waiting receiver. The extension 
assigned as a message-waiting receiver does not have to be a member of the Calling Group.

Message-waiting indications cannot be sent to the extension assigned to the group unless this 
option is programmed. The message-waiting receiver cannot distinguish between messages left 
for the Calling Group and personal messages.
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Summary: Group Calling Message-Waiting Indicator 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No message-waiting receiver assigned

Valid Entries Extension number

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Message→
Dial Calling Group ext. no.→Enter→Dial ext. no. for MWI 
receiver→Enter→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type ext. no. for MWI receiver→�→�→� 

Group Calling Calls-In-Queue Alarm Thresholds 3

Use this procedure to specify the number of unanswered calls that wait in the Calling Group queue 
before group members are notified with either an external alert (an external alert is turned on when 
the third threshold is met) or a light on the telephone. Group members are notified when the 
number of calls waiting in the queue is equal to or greater than the programmed thresholds as 
follows:

■ First Threshold, flashing light

■ Second Threshold, winking light

■ Third Threshold, solid light

Summary: Group Calling Calls-In-Queue Alarm 
Thresholds 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Settings 1 call, for all Thresholds

To configure only one threshold, set all thresholds to the same number. The LED 
states are off and on. To configure only two thresholds, set two of the thresholds to 
be the same number.
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Valid Entries 1 to 99

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Queue Alarm→
Dial Calling Group ext. no.→Enter→Select Alarm Threshold 1 or 
Alarm Threshold 2 or Alarm Threshold 3→Drop→
Dial no. of calls (1–99)→ Enter→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→
�→7+I→Select Alarm Threshold 1 or Alarm Threshold 2 
or Alarm Threshold 3→Type no. of calls (1–99)→�→
�→� 

Group Calling External Alert for 
Calls-In-Queue Alarm 3

Use this procedure to designate the external alert device used to notify Calling Group members 
when the number of calls in the queue reaches the programmed Threshold 3.

Only one external alert device can be designated for each Calling Group. Since the external alert 
signal is continuous, it is recommended that only light-type external alert devices be designated for 
the Calls-in-Queue alarm.

Summary: Group Calling External Alert for Calls-In-
Queue Alarm 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Not applicable

Valid Entries Extension number

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Xtnl Alert→
Dial Calling Group ext. no.→Enter→Drop→Dial ext. no. for alert→
Enter→Back→Back 

PC Procedure �→�→�→	→Type Calling Group ext. no.→�→
7+I→Type ext. no. for alert→�→�→� 
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Group Type 3

Use this procedure to determine whether or not the system automatically logs in members of a 
Calling Group after a power failure. This setting also determines the type of voice messaging 
interface when the Calling Group is used to connect voice messaging or Automated Attendant 
applications. The settings are listed below.

■ Automatic Log Out. Used for Calling Groups to specify that the system does not 
automatically log in Calling Group members after a power failure. Calling Group members 
must manually log themselves into the group.

■ Automatic Log In. Used for Calling Groups that consist of fax machines or data workstations 
(also called data hunt groups) to specify that the system automatically logs in Calling Group 
members after a power failure. This setting can also be used for Calling Groups consisting of 
telephones. 

■ Integrated VMI. Used when a voice messaging system that requires special signaling for 
integrated operation (for example, MERLIN Messaging, Intuity AUDIX, or IS III) is connected to 
one or more extension jacks assigned to a Calling Group. The system automatically logs in the 
group members after a power failure.

■ Generic VMI. Used when a voice messaging system that does not need special signaling is 
connected to one or more extension jacks assigned to a Calling Group. The system 
automatically logs in the group members after a power failure.

If the System Manager changes a VMI port to non-VMI port, the restrictions are not turned off. To 
remove restrictions, the System Manager must change them through system programming.

Summary: Group Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Automatic Log Out

Valid Entries Automatic login, Automatic logout, Integrated VMI, Generic VMI

Inspect No

Copy Option No

Any port programmed as a VMI port is programmed with:

■ Outward restriction on

■ A factory set FRL of 0 (the most restrictive)

■ A factory set Disallowed List (List 7) that includes the numbers frequently 
associated with fraud
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Console Procedure Extensions→  or More→Grp Calling→More→ Group 
Type→Dial Calling Group ext. no.→Enter→Specify login type 
(Auto login, Auto logout, Integrated VMI, or Generic VMI)→ Enter→ 
Back→Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
�→Specify login type (Auto login, Auto logout, Integrated VMI, or 
Generic VMI)→�→�→�→� 

Queue Control 3

The System Manager can control the maximum number of calls allowed in the primary Calling 
Group queue for calls that arrive on the following types of facilities:

■ DID (Direct Inward Dialing), DIOD (Direct Inward and Outward Dialing), and dial-in TIE

■ All calls transferred from a VMI (voice messaging interface) port

■ Internal calls to the Calling Group

■ Internal calls to the Calling Group through the QCC Position-Busy backup (PBB)

■ Intrasystem calls to the Calling Group

When the number of the calls in queue reaches the programmed maximum, subsequent callers 
receive a busy signal.

Remote-access calls to a Calling Group, coverage calls directed to a Calling Group, and all 
outside/central office calls are not eligible for queue control.

Queue control does not apply to calls received directly on any of the following facilities:

■ Loop-start lines

■ Auto-in tie trunks

■ E1 facilities emulating loop-start lines/trunks

When a call arrives on one of the above facilities, it is added to the Calling Group queue, even if 
that queue has reached or exceeded the programmed maximum number of calls. For example, if 
the maximum number of Calling Group calls is set to 40, and 40 calls have come in, subsequent 
callers on eligible facilities hear the busy tone. Calls that come in on a loop-start line, however, are 
added to the queue. 

Summary: Queue Control 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting 99 calls
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Valid Entries 0–99 (0 indicates no calls are queued)

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→More→Queue 
Ctrl→Dial Calling Group ext. no.→Enter→
Dial no. of calls allowed in queue (0–99)→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
�→Type no. of calls allowed in queue (0–99)→�→�→�→
� 
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3Programming Procedures

System Features 3

This section contains programming summaries for the optional system features that affect all or 
most system users and includes the following:

■ Transfer Return Time

■ One-Touch Transfer/Hold

■ Transfer Audible

■ Type of Transfer

■ Camp-On Return Time

■ Call Park Return Time

■ Delay Ring Interval

■ Automatic Callback Interval

■ Extension Status

■ SMDR Language

■ SMDR Call Report Format

■ SMDR Call Length

■ SMDR Calls Recorded on Call Report

■ SMDR Account Code Format

■ SMDR Talk Time

■ SMDR UDP Calls Recorded on Call Report

■ Inside Dial Tone

■ Reminder Service Cancel

■ Redirect Outside Calls to Unassigned Extension Numbers

■ Host System Dial Codes for Behind Switch Mode

■ Recall Timer

■ Interdigit Timers

■ Allowed Lists

■ Assign Allowed Lists to Extensions

■ Disallowed Lists

■ Assign Disallowed Lists to Extensions
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Transfer Return Time 3

Use this procedure to specify the number of times the telephone rings before a call transferred to 
another inside telephone is returned to the originator. A setting of 0 means that transferred calls 
are never returned to the originator.

Summary: Transfer Return Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 4 rings

Valid Entries 0 to 9 rings

Inspect No

Copy Option No

Console Procedure Options→Transfer→Return Time→Drop→
Dial no. of rings (0–9)→Enter→Back→Back 

PC Procedure 	→�→�→7+I→Type no. of rings (0–
9)→�→�→� 

One-Touch Transfer/One-Touch Hold 3

Use this procedure to assign either the One-Touch Transfer or One-Touch Hold feature.

One-Touch Transfer allows users to initiate transfers to another extension by pressing an Auto Dial 
or DSS button for that extension. If the One-Touch Transfer feature is assigned, you must also 
specify whether the transfer completion is manual (the user has to press another button to 
complete the transfer) or automatic (the transfer is completed automatically).

The transfer return time should not be set to 0 in a system with single-line telephones.

The One-Touch Transfer feature is not available on single-line telephones.



Programming Procedures

System Features

3-119

One-Touch Hold applies to incoming central office calls only. When the user presses an Auto Dial 
or DSS button to initiate a transfer, the outside caller is put on hold. The system automatically 
selects an intercom facility and dials the transfer destination. There is no transfer return function 
with this method. Consequently, if the transfer destination does not answer or is busy, the user who 
initiates the transfer must notify the outside caller, or the outside caller will remain on hold.

Summary: One-Touch Transfer/Hold 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting One-Touch Transfer, automatic completion

Valid Entries Transfer, Hold

Inspect No

Copy Option No

Console Procedure To program One-Touch Transfer:
Options→Transfer→One Touch→Transfer→ 
Enter→Select Manual or Automatic→Enter→ Back→Back 

To program One-Touch Hold:
Options→Transfer→One Touch→Hold→Enter→Back→
Back 

PC Procedure To program One-Touch Transfer:
	→�→�→�→�→Select Manual or Automatic→ 
�→�→� 

To program One-Touch Hold:
	→�→�→�→�→�→� 
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Transfer Audible 3

Use this procedure to specify whether an outside caller hears ringing (also called ringback) or 
Music-On-Hold while being transferred. Inside callers always hear ringback during a transfer.

Summary: Transfer Audible 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Music-On-Hold

Valid Entries Music-On-Hold, Ringback

Inspect No

Copy Option No

Console Procedure Options→Transfer→Audible→Select
Music-On-Hold or Ringback→Enter→Back→Back 

PC Procedure 	→�→�→Select Music-On-Hold or Ringback→ 
�→�→� 

Type of Transfer 3

Use this procedure to specify whether the system automatically selects an Intercom or System 
Access Ring or Voice button when the Transfer button or an Auto Dial or DSS button (for One-
Touch Transfer) is pressed.

■ If you use equipment that rebroadcasts music or other copyrighted materials, you may 
be required to obtain a copyright license from and pay license fees to a third party 
(such as the American Society of Composers, Artists, and Producers or Broadcast 
Music Incorporated). Magic On Hold requires no such license and can be purchased 
from Lucent Technologies.

■ When extensions are programmed to use the Centrex Transfer via Remote Call 
Forwarding feature, do not program Music-On-Hold as the transfer audible. If Music-
On-Hold is programmed in this case, a caller being transferred hears a click, three 
seconds of Music-On-Hold, a second click, silence for about 10 seconds, then 
ringback or a busy tone from the central office. This can confuse callers, who may then 
hang up.
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Summary: Type of Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Ring button (Intercom or System Access) is automatically selected

Valid Entries Voice Announce, Ring

Inspect No

Copy Option No

Console Procedure Options→Transfer→Type→Select Voice Announce or 
Ring→Enter→Back→Back 

PC Procedure 	→�→�→Select Voice Announce or Ring→ 
�→�→� 

Camp-On Return Time 3

Use this procedure to specify the number of seconds before a camped-on call (a call transferred to 
a busy telephone with the Camp-On feature) is returned to the originator.

Summary Camp-On Return Time: 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6f, System Features

Factory Setting 90 seconds

Valid Entries 30 to 300 seconds, in 10-second increments

Inspect No

Copy Option No

Console Procedure Options→CampOn→Drop→Dial no. of seconds (30–300)→
Enter→Back 

PC Procedure 	→�→7+I→Type no. of seconds (30–300)→�→� 
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Call Park Return Time 3

Use this procedure to specify the number of seconds before a call put on hold with the Park feature 
is returned to the originator.

Summary: Call Park Return Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 180 seconds

Valid Entries 30 to 300 seconds, in 10-second increments

Inspect No

Copy Option No

Console Procedure Options→CallParkRtn→Drop→Dial no. of seconds (30–300)→
Enter→Back 

PC Procedure 	→�→7+I→Type no. of seconds (30–300)→�→� 

Automatic Callback Interval 3

Use this procedure to specify the number of times the telephone rings at the originator’s telephone 
before the system cancels a Callback request.

Summary: Automatic Callback Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 3 rings

Valid Entries 1 to 6 rings

Inspect No

Copy Option No

Console Procedure Options→Callback→Drop→Dial no. of rings 
(1–6)→Enter→Back 

PC Procedure 	→�→7+I→Type no. of rings (1–6)→�→� 
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Extension Status 3

Use this procedure to specify whether the Extension Status (ES) feature is used in Hotel mode or 
Group Calling Supervisor mode.

The calling mode affects the meaning of the LEDs and the use of Auto Dial or DSS buttons when 
the DLC operator position is in Extension Status mode.

In Hotel mode, telephones are restricted from making calls in Extension Status states 1 and 2 
(ES1 and ES2). In Group Calling Supervisor mode, ES states reflect member or agent status 
without restricting the telephones. In the Group Calling Supervisor mode, the Extension Status 
feature is used by the agents to log in and out, and by the supervisor to see agent status.

Summary: Extension Status 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Group Calling Supervisor 

Valid Entries Group Calling Supervisor, Hotel mode

Inspect No

Copy Option No

Console Procedure Options→Ext Status→Select Hotel or GrpCallSupv→
Enter→Back 

PC Procedure 	→	→Select Hotel or GrpCallSupv→�→� 

SMDR Language 3

Use this procedure to change the language of the SMDR reports. The report language is initially 
set to the same as that set for the system language. See ‘‘System Language’’ on page 3-4.

Summary: SMDR Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English (matches System Language setting)
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Valid Entries U.S. English, Canadian French, Latin American Spanish, Brazilian 
Portuguese

Inspect No

Copy Option No

Console Procedure More→Language→SMDR→Select language (U.S. English, 
Canadian French, Latin American Spanish, Brazilian Portuguese)→ 
Enter→Back 

PC Procedure �→�→�→Select language (U.S. English, Canadian French, 
Latin American Spanish, Brazilian Portuguese)→�→� 

SMDR Call Report Format 3

Use this procedure to specify whether the SMDR call reports are printed in Basic format or ISDN 
format. In ISDN format, Automatic Number Identification appears in the Calling Number field in 
place of IN (which appears in the Basic report format). The call recording type for these calls is I in 
ISDN format and C in Basic format.

ISDN format should be used only in conjunction with ANI or Caller ID service subscription.

Summary: SMDR Call Report Format 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Basic format

Valid Entries Basic, ISDN

Inspect No

Copy Option No

Console Procedure Options→SMDR→Format→Select Basic SMDR or ISDN SMDR→
Enter→Back→Back 

PC Procedure 	→
→�→Select Basic SMDR or ISDN SMDR→�→�→
� 
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SMDR Call Length 3

Use this procedure to set the minimum time length of a call before it is recorded on SMDR call 
reports.

Summary: SMDR Call Length 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 40 seconds

Valid Entries 0 to 255 seconds

Inspect No

Copy Option No

Console Procedure Options→SMDR→Call Length→Drop→Dial no. of seconds 
(0–255)→Enter→Back→Back 

PC Procedure 	→
→�→7+I→Type no. of seconds (0–255)→�→
�→� 

SMDR Calls Recorded on Call Report 3

Use this procedure to specify whether SMDR information should be recorded for both incoming 
and outgoing calls or for outgoing calls only.

Summary: SMDR Calls Recorded on Call Report 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Incoming and outgoing

Valid Entries In/Out, Out Only

■ The outbound call of a Centrex Transfer via Remote Call Forwarding call will not be 
recorded unless the minimum time length is set to zero (0). The inbound Centrex call 
to the Principle User who has Centrex Transfer via Remote Call Forwarding will also 
not be recorded unless the minimum time length is 0.
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Inspect No

Copy Option No

Console Procedure Options→SMDR→Call Report→Select In/Out or Out Only→
Enter→Back→Back 

PC Procedure 	→
→�→Select In/Out or Out Only→�→�→� 

SMDR Account Code Format 3

For calls made using an authorization code, SMDR can be programmed to have either the “home 
extension” or the actual authorization codes recorded in the Account Code field if no Account 
Code is entered. Account Code overrides the Authorization Code entry in the SMDR record when 
both features are used. 

Summary: SMDR Account Code Format 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6h, Authorization Codes

Factory Setting Home Extension Number

Valid Entries Home Extension Number, Authorization Code

Inspect No

Copy Option No

Console Procedure Options→SMDR→Auth Code→Select Home Extension Number 
or Authorization Code→Enter→Back→Back 

PC Procedure 	→
→�→Select Home Extension Number or 
Authorization Code→�→�→� 

SMDR Talk Time 3

The Talk field was added to the SMDR call record. The Talk field is designed for the MERLIN 
MAGIX Reporter application that is used to capture detailed information on incoming and outgoing 
voice and data calls with a special emphasis on Calling Groups. The Talk field contains the talk-
time duration—the amount of time (59:59 maximum) that a Calling Group agent spends on an 
incoming call, including any actions that the agent takes while handling the call.

If your system includes an MERLIN MAGIX Reporter, the Talk Time option must be enabled. All 
other configurations must have the Talk Time option disabled. 
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Summary: SMDR Talk Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Disabled

Valid Entries Enable, Disable

Inspect No

Copy Option No

Console Procedure Options→SMDR→Talk Time→Select Enable or 
Disable→Enter→Back→Back

PC Procedure 	→
→	→Select Enable or Disable→�→�→� 

Inside Dial Tone 3

Use this procedure to set the inside (system) dial tone to be either different from, or the same as 
the outside line/trunk dial tone.

Summary: Inside Dial Tone 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Inside dial tone is different from outside dial tone

Valid Entries Inside, Outside

Inspect No

Copy Option No

Console Procedure Options→InsideDial→Select Inside or 
Outside→Enter→Back 

PC Procedure 	→�→Select Inside or Outside→�→� 

The inside dial tone must be the same as the outside dial tone when the internal dial tone 
is not recognized by software applications or modems.



System Programming

System Features

3-128

Reminder Service Cancel 3

Use this procedure to set the time of day when all programmed Reminder Service calls are 
automatically cancelled.

To deactivate Reminder Service Cancel, erase the currently programmed time and do not enter a 
new time.

Summary: Reminder Service Cancel 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Not applicable

Valid Entries 0000 to 2359

Inspect No

Copy Option No

 Console Procedure To deactivate Reminder Service Cancel:
Options→Reminder Srv→Drop→Enter→Back 

To set Reminder Service Cancel time:
Options→Reminder Srv→Drop→Dial time (0000–2359)→
Enter→Back 

PC Procedure To deactivate Reminder Service Cancel:
	→�→7+I→�→� 

To set Reminder Service Cancel time:
	→�→7+I→Type time (0000–2359)→�→� 

Redirect Outside Calls to Unassigned Extension 
Numbers 3

Use this procedure to specify the extension number to receive redirected calls. Redirected calls 
include calls made to unassigned numbers by Remote Access users, by users on DID trunks 
(Hybrid/PBX only), or by users on dial-in tie trunks. Calls can be redirected to the following 
locations:

■ QCC queue (Hybrid/PBX only)

■ Another extension number

■ A Calling Group
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This setting does not affect calls received on DID trunks if you have specified that calls to 
unassigned DID extensions are to receive a fast busy signal. See ‘‘Invalid Destination’’ on page 
3-61

Summary: Redirect Outside Calls to Unassigned 
Extension Numbers 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Extension number of primary operator

Valid Entries QCC queue extension number, other extension number

Inspect No

Copy Option No

Console Procedure To select QCC queue:
Options→More→Unassigned→QCC Queue→Enter→Back 

To select extension or Calling Group:
Options→More→Unassigned→Select Extension or 
Grp Calling→Enter→Dial ext. no. or group no.→Enter→Back 

PC Procedure To select QCC queue:
	→�→�→�→�→� 

To select extension or Calling Group:
	→�→�→Select Extension or Grp Calling→Type ext. 
no. or group no.→�→� 
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Recall Timer 3

Use this procedure to designate the length of the timed flash that is sent when Recall is used to 
disconnect a call and get a new dial tone without hanging up. Both the interval of the timed flash 
and the way Recall works depend on the type of telephone and system operating mode.

The recall timer should be reset if multiline telephone users experience either of the following 
problems:

■ Nothing happens when the user presses the Recall button on an outside call. This indicates 
that the interval is too short and should be increased to 650 milliseconds or one second.

■ In a system operating in Behind Switch mode, the call is disconnected when the user presses 
the Recall button on an outside call. This indicates that the interval is too long and should be 
decreased to 350 milliseconds.

Summary: Recall Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 450 ms

Valid Entries 350 ms, 450 ms, 650 ms, 1 second

Inspect No

Copy Option No

Console Procedure Options→More→RecallTimer→Select time (350 ms, 450 ms, 
650 ms, or 1 second)→Enter→Back 

PC Procedure 	→�→�→Select time (350 ms, 450 ms, 650 ms, or 1 
second)→�→� 

Interdigit Timers 3

Programming for interdigit timers is reserved for Lucent Technologies technical support personnel 
or authorized dealers.

Interdigit timers are used by the MERLIN MAGIX Integrated System to determine when a user 
originating an outside call has completed dialing the digits. The information is necessary to allow 
the system to perform subsequent operations. You should not change the factory settings for 
interdigit timers unless instructed to do so by Lucent Technologies technical support or by an 
authorized dealer.
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Allowed Lists 3

Use this procedure to establish Allowed Lists. These lists are telephone numbers that can be 
dialed from specified telephones, regardless of any calling restrictions  assigned to the telephones.

A maximum of eight lists (numbered 0 through 7) with a maximum of 10 numbers each (numbered 
0 through 9) are allowed. Each allowed number can be no more than six digits (an area code plus 
an exchange) or six digits with a leading 1, where required.

If you program 0 as the first digit of a list entry, any Toll Restriction assigned to the extension is 
removed for calls that can be placed by a toll operator. 

Special characters (such as Pause) are not permitted in Allowed List entries.

Summary: Allowed Lists 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting Not applicable

Valid Entries Area code/exchange (1- to 6-digits with leading 1, if necessary)

Inspect No

Copy Option No

Console Procedure Tables→AllowList→Dial list no. (0–7) and entry no. (0–9)→
Enter→Drop→Dial no.→Enter→Back 

PC Procedure 
→�→Type list no. (0–7) and entry no. (0–9)→�→
7+I→Type no.→�→� 

Assign Allowed Lists to Extensions 3

Use this procedure to assign individual extensions access to established Allowed Lists. More than 
one Allowed List can be assigned to an extension.

Summary: Assign Allowed Lists to Extensions 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists
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Factory Setting Not applicable

Valid Entries 0 to 7

Inspect Yes

Copy Option Yes

Console Procedure Tables→AllowTo→Dial list no. (0–7)→Enter→Dial ext. no.→
Enter→Back→Back 

PC Procedure 
→�→Type list no. (0–7)→�→Type ext. no.→�→�→
� 

Disallowed Lists 3

Use this procedure to establish Disallowed Lists. These lists are telephone numbers that cannot 
be dialed from specified extensions (including unrestricted extensions).

A maximum of eight lists (numbered 0 through 7) with 10 entries each (numbered 0 through 9) is 
allowed. Each number can have a maximum of 11 digits, including wildcards. The Pause character 
(entered by pressing the Hold button) is used to designate a wildcard character—for example, to 
indicate that calls to a given exchange are restricted in every area code.

SECURITY ALERT:
Create a Disallowed List or use the pre-prepared Disallowed List number 7 to disallow dialing 
0, 11, 10, 1700, 1809, 1900, and 976 or 1(wildcard)976. Lucent Technologies 
recommends that you add any other numbers in your country that should be restricted. 
Assign all voice mail port extensions to this Disallowed List. Lucent Technologies 
recommends assigning Disallowed List number 7. This is an added layer of security in case 
outward restriction is inadvertently removed. (Voice messaging ports are assigned, 3 by 
default, to Disallowed List number 7.) 

Summary: Disallowed Lists 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting List #7, containing the following:
0, 10, 11, 1809, 1700, 1900, 976, 1ppp976 (p = wildcard), *

Valid Entries 1- to 11-digits (including wildcards)

Inspect No

Copy Option No

Console Procedure Tables→Disallow→Dial list no.(0–7) and entry no. (0–9)→
Enter→Drop→Dial no.→Enter→Back 
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PC Procedure 
→�→Type list no.(0–7) and entry no. (0–9)→�→7+I→
Type no.→�→� 

Assign Disallowed Lists to Extensions 3

Use this procedure to assign established Disallowed Lists to individual extensions. Each restricted 
extension can be assigned to more than one list.

Summary: Assign Disallowed Lists to Extensions 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting Not applicable

Valid Entries 0 to 7

Inspect Yes

Copy Option Yes

Console Procedure Tables→DisallowTo→Dial list no. (0–7)→Enter→
Dial ext. no.→Enter→Back→Back 

PC Procedure 
→�→Type list no. (0–7)→�→Type ext. no.→�→�→
� 

Remote Access Features 3

This section covers the following Remote Access features:

■ Remote Access Trunk Assignment

■ Remote Access Automatic Callback

■ Remote Access without Barrier Codes

■ Remote Access Barrier Codes

■ Remote Access with Barrier Codes

SECURITY ALERT:
As a customer of a new system, you should be aware that telephone fraud has become an 
increasingly prevalent problem. It can occur in many forms, despite the numerous efforts of 
telephone companies and telephone equipment manufacturers to control it. Some individuals 
use electronic devices to prevent or falsify records of these calls. Others charge calls to 
someone else’s number by illegally using lost or stolen calling cards, billing innocent parties, 
clipping on to someone else’s line, or breaking into someone else’s telephone equipment 



System Programming

Remote Access Features

3-134

physically or electronically. In certain instances, unauthorized individuals make connections 
to the public switched network through the use of Remote Access features.

The Remote Access feature of your system, if you choose to use it, permits off-premises 
callers to access the system from a remote telephone by using an 800 number or a 7- or 10-
digit telephone number. The system returns an acknowledgment signaling the user to key in 
his or her barrier code, which is selected and programmed by the System Manager. After the 
barrier code is accepted, the system returns dial tone to the user. If you do not program 
specific restrictions, the user will be able to place any call normally dialed from a telephone 
associated with the system. Such an off-premises network call is originated at and will be 
billed from the system location.

The Remote Access feature helps the customer, through proper administration, to minimize 
the ability of unauthorized persons to gain access to the network. Most commonly, telephone 
numbers and codes are compromised when overheard in a public location, through theft of a 
wallet or purse containing access information, or through carelessness (writing codes on a 
piece of paper and improperly discarding it). Additionally, hackers may use a computer to dial 
an access code and then publish the information to other hackers. Enormous charges can be 
run up quickly. It is the customer’s responsibility to take the appropriate steps to properly 
implement the features, evaluate and program the various restriction levels, and protect and 
distribute access codes only to individuals who have been fully advised of the sensitive 
nature of the access information.

Common carriers are required by law to collect their tariffed charges. While these charges 
are fraudulent charges when made by persons with criminal intent, applicable tariffs state 
that the customer of record is responsible for payment of all long-distance or other network 
charges. Lucent Technologies cannot be responsible for such charges and will not make any 
allowance or give any credit for charges that result from unauthorized access.

To minimize the risk of unauthorized access to your system, follow these basic rules:

■ Use a nonpublished Remote Access number.

■ Assign barrier codes randomly to users on a need-to-have basis, keeping a log of ALL 
authorized users and assigning one code to one person.

■ Use random sequence barrier codes, which are less likely to be broken.

■ Deactivate all unassigned codes promptly.

■ Ensure that Remote Access users are aware of their responsibility to keep the telephone 
number and any barrier codes secure.

■ When possible, restrict the off-network capability of off-premises callers using the Calling 
Restrictions and Disallowed List capabilities.

■ When possible, block out-of-hours calling.

■ Frequently monitor system call detail reports for quicker detection of any unauthorized or 
abnormal calling patterns.

■ Limit remote call forward to persons on a need-to-have basis.

■ Always use the longest length password allowed on the system.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of digits.
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Remote Access Trunk Assignment 3

Use this procedure to assign or remove the trunks used for Remote Access. You can also use this 
procedure to specify whether the Remote Access feature is dedicated (always used for Remote 
Access) or shared (used for Remote Access only when Night Service is activated).

Trunks used for dedicated Remote Access must not be assigned to ring into a Calling Group or the 
QCC queue (Hybrid/PBX mode only).

In Hybrid/PBX mode, if a trunk assigned to ring into the QCC queue is also used for shared 
Remote Access, perform the procedure below before you attempt the procedure ‘‘QCC Operator to 
Receive Calls’’ on page 3-36.

Summary: Remote Access Trunk Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Remote Access is not assigned

Valid Entries Dedicated, Shared, No Remote

Inspect Yes

Copy Option No

Console Procedure LinesTrunks→RemoteAccss→LinesTrunks→
Dial line/trunk no.→Enter→specify how trunk is used (Dedicated, 
Shared, No Remote)→Enter→Back→Back

PC Procedure �→
→�→Type line/trunk no.→�→
specify how trunk is used (Dedicated, Shared, No Remote)→�→
�→� 

Remote Access Automatic Callback 3

Use this procedure either to allow Remote Access users to use the Automatic Callback feature to 
request busy lines/trunks or pools or to prevent use of the Automatic Callback feature.

A loop-start line must be programmed for Reliable Disconnect if it is to be used for 
Remote Access (See ‘‘Disconnect Signaling Reliability’’ on page 3-24).

This feature applies to Hybrid/PBX mode only.
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Summary: Remote Access Automatic Callback 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Disable

Valid Entries Disable, Enable

Inspect No

Copy Option No

Console Procedure LinesTrunks→RemoteAccss→AutoQueuing→Select
Enable or Disable→Enter→Back→Back

PC Procedure �→
→�→Select Enable or Disable→�→�→� 

Remote Access without Barrier Codes 3

Use this procedure to change the class of restriction for one of the following:

■ All non-tie lines/trunks

■ All tie trunks and DID/DIOD trunks with Remote Access

■ DID/DIOD Remote Access code

SECURITY ALERT:
Your system will be highly susceptible to toll fraud if you activate the Remote Access feature 
without barrier codes.

The class of restriction assigned may be one of the following:

■ Restriction. Determines whether Remote Access users can make local and/or toll calls and 
includes the following settings:

— Unrestricted

— Toll Restricted

— Outward Restricted

■ ARS Facility Restriction Level (Hybrid/PBX only). Allows or disallows use of outgoing trunks 
by assigning a facility restriction level from 0 through 6. The FRL ranges from 0 (most 
restrictive) to 6 (least restrictive). The FRL value assigned here is the opposite of the FRL 
value assigned to the ARS route, where a value of 0 is the least restrictive and a value of 6 is 
the most restrictive.

If barrier code requirements have been established for Remote Access users, use 
‘‘Remote Access with Barrier Codes’’ on page 3-140; do not use this procedure.
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■ Allowed Lists Assignment. Assigns Allowed Lists and is used when Remote Access users 
are restricted from making local or toll calls.

■ Disallowed Lists Assignment. Assigns Disallowed Lists and is used when Remote Access 
users are not restricted from making local or toll calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to lines/trunks.

Class of restriction settings are assigned either to all non-tie trunks or to all tie trunks and DID/
DIOD trunks. They cannot be assigned to each trunk on an individual basis.

Summary: Remote Access without Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Call restriction: Outward restricted
ARS restriction level: 3

Valid Entries Unrestricted, Toll Restricted, Outward Restricted; 0 to 6

Inspect No

Copy Option No

Console Procedure To change calling restrictions:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
Restriction→Select restriction→Enter→Back→Back→
Back→Back 

To change ARS Facility Restriction Level:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
ARS Restrict→Drop→Dial FRL value→Enter→Back→Back→
Back→Back 

To assign/remove Allowed Lists:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
Allow List→Dial list no.→Enter→Back→Back→Back→Back 

To assign/remove Disallowed Lists:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
DisallowLst→Dial list no.→ Enter→Back→Back→Back→
Back 

PC Procedure To change calling restrictions:
�→
→Select Non-TIE or TIE Lines→�→Select 
restriction→�→�→�→�→� 

To change ARS Facility Restriction Level:
�→
→Select Non-TIE or TIE Lines→�→7+I→
Type FRL value→�→�→�→�→� 
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To assign/remove Allowed Lists:
�→
→Select Non-TIE or TIE Lines→�→Type list no.→ 
�→�→�→� 

To assign/remove Disallowed Lists:
�→
→Select Non-TIE or TIE Lines→�→Type list no.→
�→�→�→�→� 

Remote Access Barrier Codes 3

Use this procedure to establish or remove barrier code requirements, as well as to establish or 
remove the barrier codes themselves. 

Barrier codes are security passwords that restrict users from making unauthorized Remote Access 
calls on tie and non-tie lines and trunks. Callers are allowed three attempts per call to enter the 
correct Remote Access barrier code. If the caller enters an incorrect barrier code or times out 
during code entry, the caller hears the retry tone. The caller can erase an entered code by dialing 
** (two asterisks). Code erasure is counted as one of the three permitted attempts. After three 
unsuccessful attempts, the caller hears a reorder tone and the call is disconnected. If this 
happens, the SMDR contains sixteen 0s in the Account Code field to flag the three failed attempts.

A maximum of 16 barrier codes are allowed for all lines/trunks. Each of the 16 barrier codes may 
be programmed with its own class of restriction (COR). 

The system-wide barrier code length can range from a minimum of 4 characters to a maximum of 
11 characters. The factory setting length is 7. If you enter a length that is less than 4 or greater 
than 11, the entry is erased and the previous entry displays on the screen. When the barrier code 
length is changed, all barrier codes are erased and must be reassigned. If the barrier code length 
is changed and barrier codes are not reassigned, users can dial into Remote Access trunks and 
enter a barrier code, but are denied access into the Remote Access trunks no matter what code is 
entered.

SECURITY ALERT:
Always use the longest length barrier code allowed on the system. The code
should consist of a random, non-repetitive, hard-to-guess sequence of digits. 

The time and date of the most recent change made to the system-wide barrier code length is 
shown during the system programming procedure, as well as on the Remote Access DISA 
Information report. The SMDR record for incoming Remote Access trunks includes the barrier 
code IDs established in this procedure.

Use numbers 0 through 9 and the asterisk (*) to enter the barrier codes. The codes cannot start 
with an asterisk and cannot contain two consecutive asterisks. (The use of two consecutive 
asterisks is reserved for users to erase an incorrect barrier code entry.) 

See ‘‘Remote Access without Barrier Codes’’ on page 3-136 to allow or deny use of system 
features for each barrier code assigned.
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Summary: Remote Access Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting No barrier codes are established

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure To establish or remove code requirements:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
BarrierCode→Specify whether barrier codes are required→
Enter→Back→Back→Back

 To change barrier code length:
LinesTrunks→RemoteAccss→BarrierCode→Code Info→
Code Length→Drop→Dial code length→Enter→Yes→Back→
Back→Back 

To change barrier code:
LinesTrunks→RemoteAccss→BarrierCode→Code Info→
Code Entry→Dial code ID→Enter→Drop→Dial code→Enter→
Back→Back→Back 

PC Procedure To establish or remove code requirements:
�→
→Select Non-TIE or TIE Lines→�→
Specify whether barrier codes are required→�→�→�→� 

To change barrier code length:
�→
→�→�→�→7+I→Type code length→�→
�→�→�→� 

To change barrier code:
�→
→�→�→�→Type Code ID→�→7+I→
Dial code length→�→�→�→� 
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Remote Access with Barrier Codes 3

Use this procedure to change the class of restriction for individual Remote Access barrier codes. 
The class of restriction assigned to each barrier code allows or denies the use of the following 
system features:

■ Restriction. Determines whether Remote Access users can make local and/or toll calls, and 
includes the following settings:

— Unrestricted

— Toll Restricted

— Outward Restricted

■ ARS Facility Restriction Level (Hybrid/PBX only). Allows or restricts use of outgoing trunks 
by assigning a facility restriction level (FRL) from 0 through 6. The FRL ranges from 0 (most 
restrictive) to 6 (least restrictive). The FRL value assigned here is the opposite of the FRL 
value assigned to the ARS route, where a value of 0 is the least restrictive and a value of 6 is 
the most restrictive.

■ Allowed Lists Assignment. Assigns Allowed Lists and is used when Remote Access users 
are restricted from making local or toll calls.

■ Disallowed Lists Assignment. Assigns Disallowed Lists and is used when Remote Access 
users are not restricted from making local or toll calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to each barrier code. Class of 
restriction settings apply to individual barrier codes.

Summary: Remote Access with Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Calling restrictions:
Barrier Code: outward restricted
All other barrier codes: unrestricted
ARS restriction level: 3

Valid Entries Unrestricted, Toll Restricted, Outward Restricted; 
0 to 6

Inspect No

Copy Option No

If barrier code requirements have not been established or have been removed for 
Remote Access users, do not use this procedure. See ‘‘Remote Access without Barrier 
Codes’’ on page 3-136.
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Console Procedure LinesTrunks→RemoteAccss→BarrierCode→
Restriction→Dial barrier code no.→Enter→Select restriction→
Enter→ARS Restrict→Dial barrier code no.→Enter→Drop→
Dial FRL value→Enter→Select Allow List or Disallow List→
Dial barrier code no. (1–16)→Enter→Dial list no.→Enter→
Back→Back→Back→Back 

PC Procedure �→
→�→�→Type barrier code no.→�→
Select restriction→�→�→Type barrier code no. (1–16)→
�→7+I→Type FRL value→�→Select Allow List or 
Disallow List→Dial barrier code no.→ �→�→�→�→
� 

Call Progress Tones 3

Call Progress Tones are those specific tones (at a particular frequency and cadence) that are sent 
to the public network central office and/or to the outside party or MERLIN MAGIX user (depending 
upon who initiates the call) by the MERLIN MAGIX system.

The following call progress tones can be programmed:

■ Outside Dialtone—what the user expects to hear when originating an outside call through the 
public network central office.

■ Inside Dialtone—what the MERLIN MAGIX user expects to hear when originating an inside 
call to a MERLIN MAGIX extension.

■ Ringback—what the user expects to hear if a call is routed successfully to an endpoint (such 
as a telephone extension or QCC queue).

■ DID/TIE Ringback—what the user expects to hear if a call is routed successfully to an 
endpoint using DID/TIE facilities.

■ Reorder—(also known as fast-busy or congestion tone) what the user expects to hear when 
dialing is correct but resources may not be available (for example, facilities in a pool).

■ Number Unobtainable—what the user expects to hear when using DID or TIE lines and 
dialing an invalid destination.

■ Busy—what the user expects to hear when dialing is correct but the destination has no 
resources (such as System Access buttons) to answer the call.

■ Intercept—what the MERLIN MAGIX user expects to hear when dialing an invalid endpoint. 

Each of the above programmable call progress tones can consist of up to five individual steps, with 
each step consisting of up to three elements.
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Summary: Call Progress Tones 3

Programmable by System Manager

Mode All

Idle Condition Not required

Factory Setting Outside Dial Tone:

1. Continuous, 350/440 Hz

Inside Dial Tone:

1. Continuous, 350/1050/1750 Hz

Ringback:

1. On, 440/480 Hz, 1000 ms

2. Off, No Tone, 3000 ms

3. Go back 2

DID/TIE Ringback:

1. On, 440/480 Hz, 1000 ms

2. Off, No Tone, 3000 ms

3. Go back 2

Reorder:

1. On, 480/620 Hz, 250 ms

2. Off, No Tone, 250 ms

3. Go back 2

Number Unobtainable:

1. On, 480/620 Hz, 250 ms

2. Off, No Tone, 250 ms

3. Go back 2

Busy:

1. On, 480/620 Hz, 500 ms

2. Off, No Tone, 500 ms

3. Go back 2

Intercept:

1. On, 440 Hz, 250 ms

2. On, 620 Hz, 250 ms

3. Go back 2
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Valid Entries Action: On, Off, Continuous, No action, Go back 2, Go back 3, Go 
back 4
Frequency: 440 Hz, 620 Hz, 350/440 Hz, 440/480 Hz, 480/620 Hz, 
350/1050/1750 Hz, No Tone
Duration: 25 to 6375 ms in 25-ms increments

Inspect Yes

Copy Option No

Tables and 3-4 and 3-5 provide information on valid options for current action settings and valid 
next actions that are used in the following procedures.

Table 3-4. Valid Selections for Further Programming

Current Action Action Frequency Duration

Continuous X X

On X X X

Off X X

Go Back 2 X

Go Back 3 X

Go Back 4 X

No Action X

Table 3-5. Valid Next Actions

Action Continuous On Off 
Go 
Back 2 

Go 
Back 3 

Go 
Back 4 

No 
Action

Continuous X

On X X X X X X

Off X X X X X

Go Back 2 X

Go Back 3 X

Go Back 4 X

No Action X
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Console Procedure Options→More→More→Call Tones→Select the tone you want 
to program (the tone you selected appears at the top of each screen 
in the procedure)→Dial step no. (1-5)→Enter→Action→Select 
action (refer to Table 3-4 and Table 3-5 for valid entries)→ 
Frequency→Select frequency value (refer to Table 3-4 and 
Table 3-5 for valid entries)→Enter→Duration→Select duration 
(refer to Table 3-4 and Table 3-5 for valid entries)→Enter→Back→ 
Back→Back→Back 

PC Procedure 	→�→�→�→Select the tone you want to program (the 
tone you selected appears at the top of each screen in the 
procedure)→Type step no. (1-5)→�→�→Select action (refer to 
Table 3-4 and Table 3-5 for valid entries)→�→Select frequency 
value (refer to Table 3-4 and Table 3-5 for valid 
entries)→�→�→Select duration (refer to Table 3-4 and 
Table 3-5 for valid entries)→�→�→�→�%→� 

Automatic Route Selection 3

This section contains programming procedures for the following Automatic Route Selection (ARS) 
features:

■ 1 + 7-Digit Dialing Requirements

■ ARS Tables

■ Start and Stop Times for Subpatterns

■ Pool Routing

■ Facility Restriction Level (FRL)

■ Digit Absorption

■ Other Digits

■ Dial 0 Table

■ Voice and/or Data Routing

ARS applies to Hybrid/PBX mode only.
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1 + 7-Digit Dialing Requirements 3

Use this procedure for calls placed within the same (home) area code as the system. The 
procedure allows you to specify whether or not the local telephone company requires a 1 to 
precede the 7-digit number. The two available settings are:

■ Within Area Code. Requires that a 1 plus a 7-digit number must be dialed; the system checks 
the 1 plus 7-digit tables for routing.

■ Not within Area Code. Does not require that a 1 precede the 7-digit number (the system does 
this automatically).

Summary: 1 + 7-Digit Dialing Requirements 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting Not within area code

Valid Entries Not within area code, Within area code

Inspect No

Copy Option No

Console Procedure Tables→ARS→ARS 1+7Dial→Select Within Area Code or 
Not within Area Code→Enter→Back→Back 

PC Procedure 
→�→�→Select Within Area Code or Not within Area 
Code→�→�→� 

ARS Tables 3

Use this procedure for the following tasks:

■ To specify type of table (6-digit, area code, exchange, or 1 plus 7-digit number)

■ To add or change area codes to be included in each table

■ To add or change exchanges to be included in each table

A maximum of 16 tables can be established, numbered 1 through 16. Each table can have a 
maximum of 100 entries, numbered 1 through 100. Tables 17 and 18, the Default Toll and Default 
Local tables respectively, cannot be changed.

The first entry in a 6-digit table must be the area code. Subsequent entries consist of exchanges 
within that area code.

Area code tables can contain only area codes. 
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Exchange and 1 plus 7-digit tables can contain only exchanges.

The wildcard character (Pause) cannot be used to enter area codes or exchanges in ARS tables.

Summary: ARS Tables 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Tables→ARS→ARS Input→Dial table no.→Enter→
Specify table type→Enter→Dial entry no.→Enter→Drop→
Dial no.→Enter→Back→Back 

PC Procedure 
→�→�→Type table no.→�→Select table type→�→
Type entry no.→�→7+I→Type no.→�→�→� 

Start and Stop Times for Subpatterns 3

Use this procedure to specify the time of day that calls are routed using Subpattern B routing 
information.

Subpatterns are used to provide two different routing patterns according to the time of day. This 
allows you to take advantage of lower rates that may apply to some or all lines, or to change 
restrictions on some facilities during off hours.

The stop time for Subpattern B is the start time for Subpattern A.

Enter the time in 4-digit, 24-hour notation, using leading zeros as necessary.

Summary: Start and Stop Times for Subpatterns 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and
Special Numbers Tables
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Factory Setting No time is specified, thus all calls are routed according to Subpattern 
A.

Valid Entries 0000 to 2359

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub B Start→Dial table no.→Enter→Drop→
Dial start time (0000–2359)→Enter→Sub B Stop→
Dial table no.→Enter→Drop→Dial stop time→Enter→Back→
Back 

PC Procedure 
→�→
→Type table no.→�→7+I→
Type start time (0000–2359)→�→
→Type table no.→�→
7+I→Type stop time→�→�→� 

Pool Routing 3

Use this procedure to identify the trunk pools on which to route calls to area codes and/or 
exchanges included in ARS tables.

A maximum of six routes (numbered 1 through 6) can be specified for each subpattern. Pool 
routing is programmed for Tables 1 through 16. Tables 17 and 18, the Default Toll and Default 
Local tables respectively, are factory set to the main pool and can be changed.

Summary: Pool Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub A Pools or Sub B Pool→
Dial table no. and pool route no.→Enter→
Dial pool dial-out code→Enter→Back→Back 

PC Procedure 
→�→� or �→Type table no. and pool route no.→
�→Type pool dial-out code→�→�→� 
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Facility Restriction Level 3

Use this procedure to assign a Facility Restriction Level (FRL) to each route. The FRL ranges from 
0 (least restrictive) to 6 (most restrictive) and is used to restrict user access to the route. The FRL 
assigned to extensions and Remote Access users is the opposite of the FRL assigned to routes, 
where 0 is the most restrictive and 6 is the least restrictive.

Facility Restriction Levels are assigned to Tables 1 through 18. Tables 17 and 18, the Default Toll 
and Default Local tables respectively, cannot be changed.

Summary: Facility Restriction Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting 3 (Table 18, the Default Local table has a factory setting of 2)

Valid Entries 0 to 6

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub A FRL  or More and Sub B FRL→
Dial table no. (1–18) and pool route no. (1–6)→Enter→
Dial restriction level (0–6)→Enter→Back→Back 

PC Procedure 
→�→� or%�%and �→Type table no. (1–18) and pool 
route no. (1–6)→�→Type restriction level (0–6)→�→�→� 

Digit Absorption 3

Use this procedure to specify how many of the digits dialed (0 through 11) by the caller should be 
absorbed (not sent to the telephone company’s central office) by the system when a call is made 
on an identified route.

Entries of 1 through 11 indicate that the system should not send the specified number of digits, 
starting with the first digit dialed by the user after the dial-out code.

Digit absorption is assigned to Tables 1 through 18.

Pool routes must be programmed before you assign Facility Restriction Levels.
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Summary: Digit Absorption 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting 0

Valid Entries 0 to 11

Inspect No

Copy Option No

Console Procedure Tables→ARS→SubA Absorb or  or More and SubB Absorb→
Dial table no. (1–18) and pool route no. (1–6)→Enter→Drop→
Dial no. of digits to absorb (0–11)→Enter→Back→Back 

PC Procedure 
→�→� or � and �→Type table no. (1–18) and pool 
route no. (1–6)→�→7+I→Type no. of digits to absorb 
(0–11)→�→�→� 

Other Digits 3

Use this procedure to specify other (extra) digits that must be added by the system to the 
beginning of the number dialed by the caller when calls are placed on an identified route.

A maximum of 20 digits can be added in any combination of the digits 0 through 9.

Special characters such as switchhook flash, Stop, and # cannot be included as extra digits. Pause 
is allowed in every position but the first.

Other digits are assigned to Tables 1 through 18.

Summary: Other Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting 0

Valid Entries Up to 20 digits (any combination of 0 to 9)

Inspect No

Copy Option No
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Console Procedure Tables→ARS→Sub A Digit or  or More and Sub B Digit→
Dial table no. (1–18) and pool route no. (1–6)→Enter→Drop→
Dial digits to be added (up to 20 digits; any combination of 0–9)→
Enter→Back→Back 

PC Procedure 
→�→	 or � and �→Type table no. (1–18) and pool 
route no. (1–6)→�→7+I→ Type digits to be added (up to 20 
digits; any combination of 0–9)→�→�→� 

Dial 0 Table 3

Use this procedure to specify pool routing, FRL, and Other Digits for the Dial 0 table.

Only one route can be specified. The Subpattern B route cannot be specified for this table, and 
digit absorption cannot be specified.

Summary: Dial 0 Table 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting 3

Valid Entries 0 to 6 

Inspect No

Copy Option No

Console Procedure Tables→ARS→  or More→Dial 0→Select ARS Pool or ARS FRL 
(0–6) or ARS Digits→Dial value→Enter→Back→Back→Back 

PC Procedure 
→�→�→�→Select ARS Pool or ARS FRL (0–6) or 
ARS Digits→Type value→�→�→�→� 
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Voice and/or Data Routing 3

Use this procedure to route voice, data, or voice and data. The voice/data specification is not 
supported with MERLIN MAGIX Release 1.0i.

Summary: Voice and/or Data Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting Voice

Valid Entries Voice Only, Data Only, Voice/Data

Inspect No

Copy Option No

Console Procedure Tables→ARS→  or More→Sub A Data or Sub B Data→
Dial table no. and route no.→Enter→Select capability (Voice Only, 
Data Only, or Voice/Data)→Enter→Back→Back 

PC Procedure 
→�→�→	 or 
→Type table no. and route no.→�→
Select capability (Voice Only, Data Only, or Voice/Data)→�→
�→� 

Night Service 3

The procedures in this section cover how to program the following optional Night Service features:

■ Night Service Group Assignment

■ Night Service with Outward Restriction

■ Night Service with Time Set

■ Night Service with Coverage Control

Night Service Group Assignment 3

Use this procedure to assign extensions and Calling Groups to a Night Service group for coverage 
after hours.

A maximum of eight Night Service groups can be assigned (no more than one for each operator 
position assigned). Any number of extensions can be assigned to a Night Service group, and an 
extension can belong to more than one group.
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A Calling Group can also be assigned to a Night Service group.

This option allows the System Manager to assign outside lines to Night Service groups in addition 
to extensions and Calling Groups for coverage after hours.

Any number of outside lines can be assigned to a Night Service group. Each outside line can 
belong to more than one group.

Summary: Night Service Group Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9a, Night Service: Group Assignment

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes (extensions only)

Copy Option No

Console Procedure To assign a Calling Group to a Night Service group:
NightSrvce→GroupAssign→Calling Group→Dial ext. no. of 
Night Service operator→Enter→Dial Calling Group no.→Enter→
Back→Back 

To assign an extension to a Night Service group:
NightSrvce→GroupAssign→Extensions→Dial ext. no. of 
Night Service operator→Enter→Dial no. of extension→Enter→
Back→Back 

To assign an outside line to a Night Service group:
NightSrvce→GroupAssign→Lines→Dial ext. no. of Night 
Service operator→Enter→Dial outside line number (801–880)→
Enter→Back→Back 

PC Procedure To assign a Calling Group to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type Calling Group no.→�→�→� 

To assign an extension to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type no. of extension→�→�→� 

To assign an outside line to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type outside line number (801–880)→�→�→� 
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Night Service with Outward Restriction 3

Use this procedure to prevent unauthorized use of telephones after hours. This feature requires 
the user to enter a password to make a call when Night Service is activated, unless one of the lists 
below applies. It also requires an operator to enter a password in order to activate Night Service 
manually.

To remove the password requirement, follow the procedure below and delete the current password 
(press the Drop button).

This procedure is also used to establish the following lists:

■ Emergency Allowed List. A list of telephone numbers that can be dialed without a password.

■ Exclusion List. A list of extensions that are exempt from password requirements.

A maximum of 10 telephone numbers can be included on the Emergency Allowed List, each 
number with a maximum of 12 digits.

Extensions included in the Exclusion List keep normal call restrictions (if any are assigned); 
however, they are not protected in any other way from unauthorized use after hours.

Summary: Night Service with Outward Restriction 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9b, Night Service: Outward Restrictions

Factory Setting No password

Valid Entries Four digits (any combination of 0 to 9)

Inspect Yes (Exclusion List)

Copy Option No

Console Procedure NightSrvce→OutRestrict→Drop→Dial password (4 digits; 
0–9)→Enter→Emergency→Dial item no.→Enter→Drop→
Dial telephone no.→Enter→ExcludeList→Dial ext. no.→
Enter→Back→Back

PC Procedure �→�→7+I→Type password (4 digits; 0–9)→�→�→
Type item no.→�→7+I→Type telephone no.→�→�→
Type ext. no.→�→�→� 
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Night Service with Time Set 3

Use this procedure to specify the time of day and the days of the week when Night Service is to be 
activated and deactivated.

Enter the time of day as four digits, using 24-hour notation. Enter the day of the week as a single 
digit (0 to 6), with 0 being Sunday. If you enter an invalid number, the system truncates the number.

If you change the system time while Night Service is active, Night Service is deactivated 
automatically and you must manually reactivate it.

Operators can override the timer and turn Night Service on and off manually. This feature can be 
deactivated when out-of-the-ordinary situations occur (for example, a midweek holiday).

If system programming information is being loaded into memory from a backup diskette, the 
current day of the week must be reset.

Night Service can be turned off by using the following procedure:

NightSrvce→Day of Week→Dial 9→Enter→Back 

Summary: Night Service with Time Set 3

Programmable by  System Manager

Mode  All

Idle Condition  Not required

Planning Form 9c, Night Service: Time Set

Factory Setting Not applicable

Valid Entries Day: 0 to 6; Time: 0000 to 2359

Inspect No

Copy Option No

Console Procedure To add or change start/stop time:
NightSrvce→Start→Drop→Dial start day (0–6) and time (0000–
2359)→Enter→Stop→Drop→Dial stop day and time→Enter→
Back 

To activate/deactivate:
NightSrvce→Time Control→Off or On→Enter→Back 

PC Procedure To add or change start/stop time:
�→�→7+I→Type start day (0–6) and time (0000–2359)→
�→	→7+I→Type stop day (0–6) and time (0000–2359)→
�→� 

To activate/deactivate:
�→
→� or �→�→� 
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Night Service with Coverage Control 3

Use this procedure to enable or disable the Night Service Coverage Control option to automatically 
control the status of programmed Coverage VMS Off buttons.

When the Coverage Control option is enabled, a transition into Night Service (either by pressing a 
Night Service button or automatically by the Time Set option) automatically deactivates the VMS 
Coverage Off buttons (LED is off) and allows outside calls to go to VMS Coverage at night. When 
the system is taken out of Night Service (either by pressing a Night Service button or automatically 
by the Time Set option), programmed VMS Coverage Off buttons are activated (LED is on) and 
outside calls are prevented from going to VMS Coverage during the day.

When the Coverage Control option is disabled, Night Service status has no effect on programmed 
VMS Coverage Off buttons.

Summary: Night Service with Coverage Control 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9c, Night Service: Options

Factory Setting Disabled

Valid Entries Enable or Disable

Inspect No

Copy Option No

Console Procedure NightSrvce→CoverContrl→Select Enable or 
Disable→Enter→Back 

PC Procedure �→�→Select Enable or Disable→�→� 

Labeling 3

The procedures in this section cover how to add or change labels for the following:

■ Extension Directory

■ Lines or Trunks

■ Posted Message

■ Group Calling

■ System Speed Dial Directory

Programming on the system programming console:
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Use the buttons next to the display to specify the letters A through I and punctuation. Use the line/
feature buttons to specify additional alphanumeric characters for labels. Use the template provided 
with the 4424LD+ or MLX-20L telephone to see which line buttons correspond to which 
alphanumeric characters.

Programming with WinSPM:

■ Use the PC keyboard for labels. All letters appear on the screen in uppercase.

Extension Directory 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
the person calling or leaving a message. This procedure is also used to program the Extension 
Directory feature for the 4412D+, 4424D+, and 4424LD+ Telephones and for the MLX telephones.

Summary: Extension Directory 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option

No

Console Procedure  or More→Labeling→Directory→Extension→Dial ext. 
no.→Enter→Drop→Enter label→Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type ext. no.→�→7+I→
Type label→�→�→�→� 

See the 4424LD+ User’s Guide or the MLX-20L User’s Guide for instructions on creating 
or editing a personal directory.

A label can have a maximum of seven characters.
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Lines or Trunks 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
the line or trunk being used.

Summary: Lines or Trunks 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure  or More→Labeling→LinesTrunks→Dial line/trunk no.→ 
Enter→Drop→Enter label→Enter→Back→Back 

PC Procedure �→�→�→Type line/trunk no.→�→7+I→
Type label→�→�→� 

Posted Message 3

Use this procedure to add or change existing posted messages. The posted messages allow 
callers with display telephones to know why the called extension does not answer.

Each posted message can have a maximum of 16 characters. Messages 2 through 20 can be 
changed through programming. Message 1, Do Not Disturb, cannot be changed.

Summary: Posted Messages 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, Label Form: Posted Message

Factory Setting First 10 messages

Valid Entries 1 to 20

Inspect No

Copy Option No



System Programming

Labeling

3-158

Console Procedure  or More→Labeling→PostMessage→Dial message no.
(1–20)→Enter→Drop→Enter message→Enter→Back→Back 

PC Procedure �→�→�→Type message no. (1–20)→�→7+I→
Type message→�→�→� 

Group Calling 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
Calling Groups.

A label can have a maximum of seven characters.

Summary: Group Calling 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6e, Group Calling

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure  or More→Labeling→Grp Calling→Dial Calling Group ext. 
no.→Enter→Drop→Enter label→Enter→Back→Back

PC Procedure �→�→�→Type Calling Group ext. no.→�→7+I→
Type label→�→�→� 

System Speed Dial Directory 3

Use this procedure to establish System Speed Dial numbers for all system users. You can also use 
this procedure to enter the alphanumeric labels shown on display telephones (for the System 
Directory feature of the MLX telephone).

A total of 130 System Speed Dial numbers can be entered, with a maximum of 11 characters per 
label.

Speed dial code assignments are 600 through 729.
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Summary: System Speed Dial Directory 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8b, System Speed Dial

Factory Setting Not applicable

Valid Entries 600 to 729

Inspect No

Copy Option No

Console Procedure  or More→Labeling→Directory→System→
Dial dial code no. (600–729)→Enter→Drop→Enter label→
Enter→Backspace→Dial telephone no. (up to 20 digits and 
special characters)→Enter→ Yes or No→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→Type dial code no. (600–729)→�→
7+I→Type label→�→�→Type telephone no. (up to 20 
digits and special characters)→�→� or 
�→�→�→�→� 

Print Reports 3

Use the procedures in this section to change the language for system reports and to print the 
system reports.

Report Language 3

Use this procedure to change the language of the system reports. Unless you change the report 
language, reports are printed in the language chosen as the system language.

Summary: Report Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English

Valid Entries U.S. English, Canadian French, Latin American Spanish, or Brazilian 
Portuguese

Inspect No
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Copy Option No

Console Procedure  or More→Language→Printer→Select English or French 
or Spanish or Portuguese→Enter→Back 

PC Procedure �→�→�→Select English or French or Spanish or 
Portuguese→�→� 

Printing System Reports 3

The system can be used to print a variety of reports. You can print individual reports or use the All 
option to print the entire set of available reports, including all report sections and options.

Use this procedure to print the reports listed below. With the exception of Trunk Information, the 
dash lists under the bullets show the sections of each report that automatically print when the 
report option is selected.

■ All

— Each report

— All report options

■ System Set Up

■ System Dial Plan

— Pools

— Telephone Paging Zones

— Direct Group Calling

— Lines/Trunks

— Stations (Extensions)

■ Label Information

— Telephone Personal Directory

— Message Numbers and Posted Messages

■ Trunk Information1

— TIE

— DID

— Loop

— General

■ E1 Information

1 Trunk option must be specified
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■ Remote Access

— General Options

— Non-TIE Restrictions

— TIE Restrictions

— Barrier Code Restrictions

■ Operator Information

— Position

— General Options

— DSS Options

— QCC Operators

— Operator Information

■ Allowed Lists

■ Allowed Lists Assigned to Extensions

■ Disallowed Lists

■ Disallowed Lists Assigned to Extensions

■ Automatic Route Selection

■ Tables

■ Extension Directory

■ System Directory

■ Group Page

■ Extension Information

■ Group Coverage

■ Group Calling

■ Night Service

■ Call Pickup Groups

■ Error Logs

■ Authorization Codes

■ BRI Information Report

■ Non-Local Dial Plan

■ Service Observing Groups

If you select a report for which there is no information, the report header still prints.

If you select the All option, keep in mind that the reports take from 30 minutes to 6 hours 
to print depending on the size of the system. You may want to schedule use of the printer 
during off-peak hours.
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Print reports if you cannot back up your system programming information.

Do not print reports if your system must handle more than 100 calls per hour.

If you are printing from the console, your printer must be connected to the SMDR port. If you are 
programming on a PC with WinSPM, you have the following choices:

■ Print reports on the SMDR printer (if available)

■ Print reports on the PC printer

■ Save reports (on hard disk or floppy)

■ View reports (browse)

See Chapter 2, ‘‘Programming with WinSPM,” for details.

Summary: Printing System Reports 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Not applicable

Factory Setting Not applicable

Valid Entries Any saved report

Inspect No

Copy Option No

Console Procedure To print trunk information:
 or More→Print→Trunk Info→Select trunk type→Back 

To print extension information:
 or More→Print→More→Ext Info→Dial extension no.→ 

Enter→Back 

To print all other reports:
 or More→Print→Select report→Back 

PC Procedure To print trunk information:
�→�→�→Select trunk type→� 

To print extension information:
�→�→�→�→Type extension no.→�→� 

To print all other reports:
�→�→Select report→� 

To save report on disk:
�→�→Select report→�→Select GOTO FLOPPY→� 

To view report:
<+
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Memory Card 3

A PCMCIA (Personal Computer Memory Card International Association) interface slot is present 
on the processor module. The slot is a standard interface through which information can be added 
to or obtained from the system using a memory card. The PCMCIA interface slot accepts one 
memory card at a time. 

This section covers the following memory card functions:

■ Memory Card Formatting

■ Backup

■ Automatic Backup

■ Restore

Card Types 3

The types of memory cards are described below. The card type is identified by a preprinted, color-
coded label.

■ Upgrade Card. This card is used for MERLIN MAGIX Integrated System software upgrades. 
The upgrade can be performed by the System Manager using the memory card and the 
Maintenance option on the SPM Main menu. See Maintenance and Troubleshooting for 
information about this feature.

This card is identified by an orange label with black lettering.

■ Translation Card. The backup and restore procedures previously available to System 
Managers through SPM (using the PC and floppy disks) can now be performed using the 
memory card and the new Backup/Restore option on the System menu. A new automatic 
backup feature permits you to set the system to perform automatic backups to the memory 
card on a daily or weekly basis. See ‘‘Backup’’ on page 3-168 and ‘‘Restore’’ on page 3-173 for 
more information.

This card is identified by a white label with black lettering.

■ Forced Installation. For use by qualified service technicians only, this card is used when the 
system software has been corrupted and a re-installation must be done at the customer site. 
The use of the card for forced installation is reserved for emergency situations in which the 
system software on the processor module has been damaged.

This card is identified by an orange label with black lettering. In addition, black stripes are 
present on the card to distinguish it from an upgrade card.
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Figure 3-4 shows a sample Translation card.

Figure 3-4. PCMCIA Memory Card

LUCENT TECHNOLOGIES PROPRIETARY
THIS MEMORY CARD CONTAINS PROPRIETARY INFORMATION OF

LUCENT TECHNOLOGIES THAT IS NOT TO BE DISCLOSED OR USED 
EXCEPT IN ACCORDANCE WITH APPLICABLE AGREEMENTS.

COPYRIGHT© 1993 LUCENT TECHNOLOGIES
ALL RIGHTS RESERVED 
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Inserting the Card 3

To insert the card, hold the card with the Lucent logo facing up and the arrow pointing toward the 
slot. See Figure 3-5 for the proper way to insert the memory card into the slot on the processor 
module.

Figure 3-5. Inserting the Memory Card

INSERT

COPYRIGHT© 1993 AT&T

ALL RIGHTS RESERVED 

AT&T PROPRIETARY

THIS MEMORY CARD CONTAINS PROPRIETARY INFORMATION OF

AT&T THAT IS NOT TO BE DISCLOSED OR USED EXCEPT

IN ACCORDANCE WITH APPLICABLE AGREEMENTS.
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Memory Card Formatting 3

The memory card may have to be formatted before you begin any manual or automatic backup 
procedures. This section details the screens and messages that appear during the format 
procedure.

CAUTION:
Formatting overwrites previous data on the memory card. Make certain that there is no 
important information on the card before you begin formatting.

Unformatted Card 3

If you begin a backup procedure with an unformatted or incorrectly formatted card, the above 
screen appears.

The inserted memory card is not the correct type. You have the option of formatting the memory 
card as a translation memory card or repeating the backup procedure with a different memory 
card.

Memory Card Backup:

Inserted Memory Card is

not the correct type.

Do you want it formatted?

Yes

No

Back

■ Only 4 MB Series I or Series II PCMCIA memory cards may be formatted, except 
those already formatted as translation cards.

■ If a memory card cannot be formatted, a message appears on screen. These 
messages are noted in the procedures as appropriate.

■ A memory card may need to be formatted if it is intended for use as a translation card 
but is currently blank or contains data other than MERLIN MAGIX Integrated System 
backup files.
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Format Warning 3

This screen appears if you respond to the system prompt to format the memory card.

Select Yes (or click �) to begin the memory card format. Table 3-6 lists the screen messages 
that may appear while formatting is in progress.

If Exit (on the 4424LD+ Telephone), Home (on the MLX-20L telephone) or Menu (on both 
telephones) is pressed during a format procedure, the format is terminated. The data on the 
memory card may be lost. See Chapter 1, ‘‘Programming Basics,” for details about these keys. 

Format Memory Card:

All data on card will be

DELETED.

Do you want to continue?

Yes

No

Back

Table 3-6. Memory Card Formatting Messages

Message What it Means

Formatting Memory Card The format is in progress.

Formatting of Memory Card 
Completed

The format was successful and has completed.

Memory Card cannot be 
formatted

The memory card cannot be formatted. Remove the card 
and repeat the procedure with another card.

Formatting of Memory Card 
FAILED

The format was unsuccessful. Remove the card and repeat 
the procedure with another card.

Missing Card or Card Not 
Inserted Correctly

Verify that the card is inserted correctly and repeat the 
procedure.
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Backup 3

Use this procedure to make a copy of your customized system data. You should create a backup at 
least three times during system installation (so that programmed information is not lost) and once 
after each system upgrade, service technician visit, or major system reconfiguration.

The Inspect feature (Inspct or%�) is available to view the attributes of the backup files on the 
memory card prior to initiating the backup procedure. The attributes included on the Inspect 
screen are the filename, the time and date of the file creation/update, the location of the system 
programming port, and information about the system software release from which the backup was 
made.

The list of backup files contains three manual backup filenames and two automatic backup 
filenames. The factory set names of the manual backup files are BACK1.*****, BACK2.*****, and 
BACK3.*****. When you select one of the backup filenames, the system automatically replaces the 
* in the filename with the current month and day (mmdd). For example, BACK1.0116 would appear 
if you selected BACK1.***** and performed the backup procedure on January 16. You can rename 
any of the three files during the backup procedure. The automatic backup filenames are 
AUTO.BACK1 and AUTO.BACK2. You cannot change the names of these files.

If you enter a filename that currently exists, the message File already exists appears. You 
must enter another filename.

While the backup is in progress, you cannot access system programming functions, your Personal 
Directory, or alarm clock functions (any programmed alarms are temporarily deactivated). You may 
terminate the backup procedure at any point prior to receiving confirmation of a successful backup.

If any type of programming is taking place at another extension when you begin the backup 
procedure, the backup is cancelled and the number of the first busy extension appears on the 
screen. Attempt the backup procedure again when the busy extension becomes idle.

If the system is turned off during a backup procedure, the backup is terminated. The system 
performs a System Reset (cold start), after which you may repeat the backup procedure.

If Exit (on the 4424LD+ Telephone), Home (on the MLX-20L telephone) or Menu (on both 
telephones) is pressed during a backup procedure, the backup is terminated. This may result in 
the deletion of an old backup file. See Chapter 1, ‘‘Programming Basics,” for details about these 
keys. 

If the system performs a System Erase (frigid start), all programming is set to the factory-
set values. If a previous backup file is available, perform a restore. If not, the system must 
be reprogrammed. See ‘‘Restore’’ on page 3-173 for information about the system restore 
procedure. Also see ‘‘Backup Messages’’ on page 3-171 for information about errors that 
may occur during the backup procedure.
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Summary: Backup 3

Programmable by System Manager

Mode All

Idle Condition Not required (No extensions are allowed to be in programming mode 
except system programming console)

Planning Form 1, System Planning

Factory Setting Not applicable

Valid Entries 1- to 11-character filename

Inspect Yes

Copy Option No

Console Procedure Insert memory card→System→Back/Restore→Backup→
Select backup file→Dial the new backup filename→Enter→Yes→
Back→Back→Back 

PC Procedure Insert memory card→�→�→�→Select backup file→
Type the new backup filename→ �→�→�→�→� 

Automatic Backup 3

To preserve the most recent copy of your customized system data, you can program the system to 
automatically backup programming information onto the translation memory card. Automatic 
backups may be set for daily or weekly operation. If automatic backup is activated, the time may be 
set for daily backup (factory setting is 2:00 am) or the time and day may be set for weekly backup 
(factory setting is 2:00 am Sunday).

The system places the automatic backup into one of two designated files: AUTO.BACK1 and 
AUTO.BACK2. If both files are empty, the system places the backup in AUTO.BACK1. If both files 
already contain backups, the system selects the older of the two files and overwrites it. The system 
performs this file “toggle” each time it performs an automatic backup.

While the backup is in progress, you cannot access system programming functions, your Personal 
Directory, or alarm clock functions (any programmed alarms are temporarily deactivated).

If any type of programming is taking place at an extension during the automatic backup procedure, 
the backup is cancelled. The system does not re-attempt the backup.

If an automatic backup fails for any reason (including a system-busy condition), all of the 
programmed alarm buttons on system operator consoles light and the information is recorded in 
both the permanent error log and the last 10 error logs. The system does not re-attempt the 
backup. 
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Also see ‘‘Backup Messages’’ on page 3-171 for information about errors that may occur during 
the automatic backup procedure.

Summary: Automatic Backup 3

Programmable by System Manager

Mode All

Idle Condition Not required (No extensions are allowed to be in programming mode, 
including the system programming console)

Planning Form 1, System Planning

Factory Setting Weekly backup: Sunday at 2:00 am
(if daily backup is selected, time is factory set for 
2:00 am)

Valid Entries Daily: hhmm (00 to 23; 00 to 59)
Weekly: dhhmm (0 to 6; 00 to 23; 00 to 59)

Inspect No

Copy Option No

Console Procedure To program daily backup:
Insert memory card→System→Back/Restore→Auto Backup→
Daily→Drop→Dial time (00–23; 00–59)→Enter→Back→Back

To program weekly backup:
Insert memory card→System→Back/Restore→Auto Backup→
Weekly→Drop→Dial day and time (0–6; 00–23; 00–59)→Enter→
Back→Back 

PC Procedure To program daily backup:
Insert memory card→�→�→�→�→7+I→
Type time (00–23; 00–59)→�→�→� 

To program weekly backup:
Insert memory card→�→�→�→�→7+I→
Type day and time (0–6; 00–23; 00–59)→�→�→� 

If an automatic backup fails for any reason (except when the failure results because the 
memory card is write-protected), the automatic backup feature is turned off. Follow the 
procedure below to reprogram automatic backups.
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Backup Messages 3

During manual or automatic backup procedures, additional screens may appear to alert you to 
problems with the translation memory card, the backup file, or the backup procedure. This section 
contains displays of each screen and information about what to do if the screen appears.

Backup Cancelled 3

If the system detects an error, either on the Memory Card or with the backup file, or if you 
terminate the backup, this screen appears.

The backup file being created is deleted and the backup is terminated. You must repeat the backup 
procedure.

Card Removed While Backup Is in Progress 3

The Memory Card is not inserted or is inserted incorrectly while a backup is in progress. The 
backup file that was being created is deleted and the backup is terminated. You must reinsert the 
Memory Card and repeat the backup procedure.

The screens shown in this section are from the manual backup procedure; however, the 
screens that may appear in both the manual and automatic backup procedures are 
similar. The screens in both procedures differ only in the appearance of the first line. On 
the automatic backup screens, Auto Memory Card Backup replaces Memory Card 
Backup shown on the screens below.

Backup x: x = backup filename 
BACKUP IS CANCELLED.

File has been DELETED.

Back

Backup x:
BACKUP IS CANCELLED.

x = backup filename

Verify that Memory Card

has been inserted

correctly.

File has been DELETED.

Back
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Card Missing or Card Not Inserted Correctly 3

The Memory Card is either not inserted or is inserted incorrectly. The backup is terminated. You 
must reinsert the Memory Card and repeat the backup procedure. This screen may also appear if 
the wrong type of Memory Card is inserted and a backup or automatic backup is requested within 
one minute of insertion. Verify that the card is a translation Memory Card.

Card Is Write-Protected 3

The Memory Card is write-protected. You must remove the Memory Card, flip the write-protect tab, 
reinsert the Memory Card, and repeat the backup procedure.

CAUTION:
The Memory Card may be write-protected to avoid the accidental erasure of the backup files. 
Make certain this is not the case before you change the Write-Protect Tab.

Memory Card Backup:

Verify that Memory Card

has been inserted

correctly.

Back

Memory Card Backup:

Memory Card is Write-

Protected.

Reset Write-Protect Tab

on Memory Card.

Back
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Card Failure 3

If the card is damaged, repeat the backup with a different card. If a backup is in progress and fails, 
the system makes two additional attempts at the backup. At the start of each attempt, a message 
appears with the percentage of the backup that is completed. If the backup fails after three 
attempts, the screen shown below appears. Repeat the backup procedure using a different file 
and/or Memory Card.

Restore 3

Use this procedure to restore system conditions that were backed up onto a translation memory 
card. The information in a backup file on the translation card is copied to the system.

The restore procedure is necessary under the following conditions:

■ System RAM is corrupt.

■ A previously stored set of system conditions is preferred over the current set.

■ Processor module is replaced.

■ After a System Erase (frigid start) has been performed.

■ System software has been reinstalled.

The Inspect feature (Inspct or%�) is available to view the attributes of the backup files on the 
memory card prior to initiating the restore procedure. The attributes included on the Inspect screen 
are the filename, the time and day of the file creation/update, the location of the system 
programming port, and information about the system software release from which the backup was 
made.

If any type of programming is taking place at another extension when you begin the restore 
procedure, the restore is cancelled and the number of the first busy extension appears on the 
screen. Repeat the restore procedure when the busy extension becomes idle.

If a line is busy (incoming call or active call) when you begin the restore procedure, the restore is 
cancelled and the number of the first active line appears on the screen. Repeat the restore 
procedure when the line becomes idle.

Also see ‘‘Restore Messages’’ on page 3-174 for information about errors that may occur during 
the restore procedure.

Memory Card Backup:

Backup Failure

Try a different file or

a new Memory Card.

Back
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Summary: Restore 3

Programmable by System Manager

Mode All

Idle Condition System Forced Idle

Planning Form Not applicable

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Insert memory card→System→Back/Restore→Restore→
Select restore file→Yes 

PC Procedure Insert memory card→�→�→�→Select restore file→
� 

Restore Messages 3

During the restore procedure, additional screens may appear to alert you to problems with the 
translation Memory Card, the backup file or the restore procedure. This section contains displays 
of each screen and information about what to do if the screen appears.

Card Missing or Card Not Inserted Correctly 3

The Memory Card is either not inserted or inserted incorrectly. The restore is aborted. You must 
reinsert the card and repeat the restore procedure. This screen may also appear if the wrong type 
of Memory Card is inserted and a restore is requested within one minute of insertion. Verify that 
the card is a translation Memory Card.

Memory Card Restore:

Verify that Memory Card

has been inserted

correctly.

Back
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Card Removed after Confirmation 3

The Memory Card was removed from the PCMCIA interface slot while the restore was in progress. 
The restore is aborted and the system performs a System Erase (frigid start). You must reinsert 
the Memory Card and repeat the restore procedure.

Wrong System Programming Port 3

The system programming port is not set to the same system programming port as that set in the 
backup file. The restore is aborted. Use the Inspect feature to view the port of the file on the card. 
Change the system programming port to match the port shown on the card (see ‘‘System 
Programming Position Assignment’’ on page 3-3) and repeat the restore procedure. 

Release Mismatch 3

This screen only appears if the releases are not compatible.

Memory Card Restore:

RESTORE IS CANCELLED.

System is DOWN.

Restore n: n = filename selected 
Change Sys Programming xxxx = system programming port 
Port to Extension xxxx extension
before Restoring.

Back

Restore n: n = filename selected
File is Not Compatible X.Y = release number
for Release X.Y

Restore Cancelled.

Conversion Required.

Back
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Card Failure Before Confirmation 3

If the restore fails because the card is damaged, repeat the restore procedure using a different file 
and/or Memory Card.

Card Failure after Confirmation 3

If the restore fails because the card is damaged, the system performs a System Erase (frigid start). 
Repeat the restore procedure using a different file and/or Memory Card.

Wrong Type of Card 3

The inserted card does not match the card option selected from the System menu. Remove the 
card and repeat the restore procedure with the correct type of card. See ‘‘Card Types’’ on page 
3-163 for information about the card labels.

Memory Card Restore:

Restore Failure.

Try a different file

or a new Memory Card.

Back

Restore n: n = filename selected
Restore Failure

RESTORE IS CANCELLED.

System is DOWN.

Memory Card Restore:

Inserted Memory Card is

not the correct type.

Remove and insert MERLIN

MAGIX Backup/Restore

Card.

Back
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AMenu Hierarchy A

Overview 3

The system programming menu hierarchy details the sequence of menu screens that appear when 
you select the system programming options. The choice of an option on the first menu screen 
leads to either a second menu screen or a data-entry screen. A second menu screen may lead to 
still another menu screen, and so on, up to six screens, as shown on the following pages.

You can use the Inspect feature in system programming to display the telephone or line/trunk 
numbers that are programmed with a specific feature. Inspect is helpful either when you must 
assign a feature to many lines/trunks or extensions and you do not have a Direct Station Selector 
(DSS) attached to the system programming console, or when you are programming using a PC 
with the WinSPM program.

Inspect can be used with the menu options on the following pages that have an asterisk (*) next to 
them. To use Inspect in system programming, choose an eligible option, and press one of the 
following:

■ Programmed Inspect button (4400-Series telephones)

■ Fixed Inspect button (MLX telephones)

■ PgDn
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* The inspect feature can be used with this menu option.
Press Inspect or PgDn.

The Inspect feature can be used in entry mode with this menu option.
Press Inspect or PgDn while in entry mode.
This feature is not supported in Release 1.0i of the MERLIN MAGIX
system. 
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